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1.Programming Overview 
SNA5000A - Vector Network Analyzer, support LAN, USB Device, and GPIB-USB Host interf
aces. By using these interfaces, in combination with programming languages and/or NI- VISA
 software, users can remotely control the analyzer based on SCPI (Standard Commands for 
Programmable Instruments) command set, and interoperate with other programmable instru
ments. 

This chapter introduces how to build communication between the spectrum analyzer and a co
ntroller computer with these interfaces. 

 

1.1Remotely Operating the Analyzer 

The analyzer provides both the USB and LAN connection which allows you to set up a remot
e operation environment with a controller computer. A controller computer could be a person
al computer (PC) or a minicomputer. Some intelligent instruments also function as controllers. 

1.1.1 Connecting the Analyzer via the USB Device port 

Refer to the following steps to finish the connection via USB-Device: 

1. Install NI-VISA on your PC for USB-TMC driver. 

2. Connect the analyzer USB Device port to a PC with a USB A-B cable. 

 

     3. Switch on the analyzer. 

The analyzer will be detected automatically as a new USB hardware. 

 

1.1.2 Connecting the Analyzer via the LAN port 

Refer to the following steps to finish the connection via LAN: 

1. Install NI-VISA on your PC for VXI driver. Or without NI-VISA, using socket or telnet i
n your PC’s Operating System. 

2. Connect the analyzer to PC or the local area network with a LAN cable 

 

3. Switch on the analyzer. 
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4. Press button on the front panel                   →LAN Status to enter the LAN Config 

5. Select the IP Config between Static and DHCP 

◆ DHCP: the DHCP server in the current network will assign the network parameters a
utomatically (IP address, subnet mask, gate way) for the analyzer. 

◆ Static: you can set the IP address, subnet mask, gate way manually. Press Apply. 

 

The analyzer will be detected automatically or manually as a new LAN point. 

 

1.1.3 Connecting the Analyzer via the USB-Host port (With USB-GPIB 
Adaptor) 

Refer to the following steps to finish the connection via USB.

1. Install NI-VISA on your PC for GPIB driver. 

2. Connect the analyzer USB Host port to a PC’s GPIB card port, with SIGLENT USB- 
GPIB adaptor. 

3. Switch on the analyzer 

4. Press button on the front panel System→GPIB to enter the GPIB number. 

The analyzer will be detected automatically as a new GPIB point. 

 

1.2Build Communication 

1.2.1 Build Communication Using VISA 

NI-VISA includes a Run-Time Engine version and a Full version. The Run-Time Engine versi
on provides NI device drivers such as USB-TMC, VXI, GPIB, etc. The full version includes th
e Run-Time Engine and a software tool named NI MAX that provides a user interface to contr
ol the device. 

You can get NI-VISA full version from: 

http://www.ni.com/download/. 

 

System 

http://www.ni.com/download/
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After download you can follow the steps below to install it: 

a. Double click the visa_full.exe, dialog shown as below: 

 

b. Click Unzip, the installation process will automatically launch after unzipping files. If you

r computer needs to install .NET Framework 4, its setup process will auto start. 

 

c. The NI-VISA installing dialog is shown above. Click Next to start the installation process. 

Set the install path, default path is "C:\Program Files\National Instruments\", you can chan

ge it. Click Next, dialog shown as above. 
d. Click Next twice, in the License Agreement dialog, select the "I accept the above 2 License Agree
ment(s).", and click Next, dialog shown as below: 

 

e. Click Next to run installation. 
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Now the installation is complete, reboot your PC. 

1.2.2 Build Communication Using Sockets/Telnet 

Through LAN interface, VXI-11, Sockets and Telnet protocols can be used to communicate w
ith the spectrum analyzer. VXI-11 is provided in NI-VISA, while Sockets and Telnet are comm
only included in PC’s OS initially. 

Sockets LAN is a method used to communicate with the vector network analyzer over the LA
N interface using the Transmission Control Protocol/Internet Protocol (TCP/IP). A socket is a f
undamental technology used for computer networking and allows applications to communicat
e using standard mechanisms built into network hardware and operating systems. The metho
d accesses a port on the spectrum analyzer from which bidirectional communication with a ne
twork computer can be established. 

Before you can use sockets LAN, you must select the analyzer’s sockets port number to use: 

◆ Standard mode. Available on port 5025. Use this port for programming. 

◆ Telnet mode. The telnet SCPI service is available on port 5024. 

 

1.3Remote Control Capabilities 

1.3.1 User-defined Programming 

Users can use SCPI commands to program and control the vector network analyzer. For det
ails, refer to the introductions in "Programming Examples". 

 

1.3.2 Send SCPI Commands via NI MAX 

Users can control the vector network analyzer remotely by sending SCPI commands via NI
-MAX software. 

1.3.2.1Using USB 

Run NI MAX software. 
1, Click "Device and interface" at the upper left corner of the software.
2, Find the "USBTMC" device symbol. 



SNA5000A Programming Guide           7 

 

 

 
 

3, Click "Open VISA Test Panel" option button, then the following interface will appear. 
4, Click the "Input/Output" option button and click the "Query" option button in order to view th
e operation information. 

 

 
 

NOTE: The "*IDN?" command (known as the Identification Query) returns the instrument manuf
acturer, instrument model, serial number, and other identification information. 
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1.3.2.2Using LAN 

Select, "Add Network Device", and select "VISA TCP/IP Resource" as shown:

 Run NI MAX software. 
1. Click "Device and interface" at the upper left corner of the software.
2. Find the "Network Devices" symbol; click "Add Network Devices". 

 
 

3. Select "Manual Entry of LAN instrument", select "Next", and enter the IP address as sho
wn. Click Finish to establish the connection: 

 
 

NOTE: Leave the LAN Device Name BLANK or the connection will fail. 
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4. After a brief scan, the connection should be shown under "Network Devices": 

 
 

5. Right-click on the product and select "Open NI-VISA Test Panel": 

 
 

6. Click "Input/Output" option button and click "Query" option button. If everything is OK, yo
u will see the Read operation information returned as shown below. 
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2.SCPI Overview 

2.1Command Format 

SCPI commands present a hierarchical tree structure containing multiple subsystems, and ea
ch of the subsystems is made up of a root keyword and several subkeywords. The command 
string usually starts with ":", the keywords are separated by ":" and the followed parameter se
ttings are separated by space. Query commands add "?" at the end of the string. 

For example: 

:SENSe:FREQuency:CENTer <freq> 

:SENSe:FREQuency:CENTer? 

SENSe is the root key of the command, FREQuency and CENTer are second and third keyw
ords. The command begins with ":", and separates the keywords at the same time, and the <f
req> separated by space and represents the parameter available for setting; "?" represents a 
query. 

2.2Symbol Instruction 

The following four symbols are not the content of SCPI commands and cannot be sent with t
he commands, but are usually used in the commands. 

 
1, Triangle Brackets < > 

The parameter in the triangle brackets must be replaced by an effective value. For example, 

Send the ":SENSe1:SWEep:POINts <value>" command in ":SENSe1:SWEep:POINts 201". 

 
2, Square Brackets [ ] 

The content in the square brackets can be ignored. When the parameter is ignored, the instru
ment will set the parameter to its default. For example, 

In the ":SENSe:CORRection:IMPedance[:INPut][:MAGNitude]?" command, sending any of th
e four commands below can generate the same effect: 

:SENSe:CORRection:IMPedance? 

:SENSe:CORRection:IMPedance:INPut? 

:SENSe:CORRection:IMPedance:MAGNitude? 

:SENSe:CORRection:IMPedance:INPut:MAGNitude? 

 
3, Vertical Bar | 

The vertical bar is used to separate multiple parameters and when sending the command, yo
u can choose one of the parameters. For example,In the ":DISPlay:MAXimize ON|OFF|1|0" c
ommand, the parameters available are "OFF", "ON", "0" or "1". 

 
4, Braces { } 

The parameters in the braces are optional which can be ignored or set for one or more times. F

or example: 

":SENSe{[1]-256}:SEGMent:LIST:CONTrol:DATA <Boolean>{,<Boolean>}" in the command, the 
{,<Boolean>} parameters can be ignored or set for one or more times. 
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2.3Parameter Type 

The parameters in the commands introduced in this manual include 6 types: Boolean, enumer
ation, integer, float, discrete and string. 

1, Boolean 

The parameters in the commands could be "OFF", "ON", "0" or "1". For exampl

e,:CALCulate#:TRACe#:SMOothing[:STATe] ON|OFF|1|0 

 
2, Enumeration 

The parameter could be any of the values listed. For example: 

:SENSe#:SWEep:TYPE LINear|LOGarithmic|POWer|CW|SEGMent 

The parameter should be "LINear", "LOGarithmic", "POWer", "CW" or "SEGMent". 

 
3, String 

The parameter should be the combinations of ASCII characters. For example: 

:SYSTem:COMMunicate:LAN:IPADdress <"xxx.xxx.xxx.xxx"> 

The parameter can be set as "192.168.1.12" string. 

 
4, Integer 

Except other notes, the parameter can be any integer within the effective value range. For exa
mple: 

:SYSTem:COMMunicate:GPIB:ADDRess <value> 

The parameter <value> can be set to any integer between 1 and 30. 

 
5, Float 

The parameter could be any value within the effective value range according to the accuracy require

ment (the default accuracy contains up to 9 digits after the decimal points). For example: 

:SENSe#:FREQuency:STARt <value> 

The parameter <value > can be set to any real number between 9k and 8.5G. 
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6, Discrete 

The parameter could only be one of the specified values and these values are discontinuous. For ex
ample: 

:SENSe#:BANDwidth[:RESolution] <numeric> 

The parameter <numeric> could only be one of 10, 15, 20, 30, 40, 50, 70, 100 … 7k, 10k …1M, 1.
5M, 3M. 

2.4Command Abbreviation 

All of the commands are not case sensitive, so you can use any of them. But if abbreviation i
s used, all the capital letters in the command must be written completely. For example: 

:CALCulate1:TRACe1:BLIMit:MINimum?  

Can be abbreviated to: 

:CALC1:TRAC1:BLIM:MIN? 
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3.System Commands 

3.1IEEE Common Commands 

3.1.1 Identification Query (*IDN) 
 

Command
 Format 

 
*IDN? 

Instruction  Returns an instrument identification information string. The string will contain th
e manufacturer, model number, serial number, and software number. 

Menu  None 

Example  *IDN? 
Return: Siglent Technologies,SNA5084X,1234567890,V1.0.0.1.5 

3.1.2 Reset (*RST) 
 

Command 
Format 

 
*RST 

Instruction  This command presets the instrument to a factory defined condition that is appr
opriate for remote programming operation. *RST is equivalent to performing the
 two commands :SYSTem:PRESet and *CLS. This command always performs a
 factory preset. 

Menu  None 

Example  *RST 

3.1.3 Clear Status (*CLS) 
 

Command 
Format 

 
*CLS 

Instruction  Clears the status byte register. It does this by emptying the error queue and cle
aring all bits in all of the event registers. The status byte register summarizes th
e states of the other registers. It is also responsible for generating service reque
sts. 

Menu  None 

Example  *CLS 
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3.1.4 Standard Event Status Enable (*ESE) 
 

Command 
Format 

 *ESE <numeric> 
*ESE? 

Instruction  Set the bits in the Standard Event Status Enable Register. This register monitor
s I/O errors and synchronization conditions such as operation complete, request
 control, query error, device dependent error, execution error, command error an
d power on. A summary bit is generated on execution of the command. 
The query returns the state of the Standard Event Status Enable Register. 

Menu  None 

Example  *ESE 16 
*ESE? 
Return: 16 

3.1.5 Standard Event Status Register Query (*ESR) 
 

Command 
Format 

 
*ESR? 

Instruction  This command reads the value of the Standard Event Status Register. Executio
n of this command clears the register value. 

Menu  None 

Example  *ESR? 

3.1.6 Operation Complete Query (*OPC) 
 

Command 
Format 

 *OPC 
*OPC? 

Instruction  Set bit 0 in the Standard Event Status Register to "1" when all pending operatio
ns have finished. 
The query stops any new commands from being processed until the current pro
cessing is complete. Then it returns a "1", and the program continues. This quer
y can be used to synchronize events of other instruments on the external bus. 
Returns a "1" if the last processing is complete. Use this query when there’s a n
eed to monitor the command execution status, such as a sweep execution. 

Menu  None 

Example  TRIG:SOUR BUS 
INIT:CONT ON 
TRIG:SING 
*OPC? 

3.1.7 Service Request Enable (*SRE) 
 

Command 
Format 

 *SRE <integer> 
*SRE? 

Instruction  This command enables the desired bits of the Service Request Enable Registe
r. The query returns the value of the register, indicating which bits are currently 
enabled. The default value is 0. 

Menu  None 

Example  *SRE 1 
*SRE? 
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3.1.8 Status Byte Query (*STB) 
 

Command
 Format 

 
*STB? 

Instruction  This command reads the value of Status Byte Register. 

Menu  None 

Example  *STB? 

3.1.9 Wait-to-Continue (*WAI) 
 

Command 
Format 

 
*WAI 

Instruction  This command causes the instrument to wait until all pending commands are co
mpleted before executing any additional commands. 
There is no query form to the command. 

Menu  None 

Example  *WAI 

3.1.10 Trigger a sweep (*TRG) 
 

Command
 Format 

 
*TRG 

Instruction  This command triggers the SNA if the trigger source is set to BUS. 

Menu  None 

Example  *TRG 
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3.2Calculate Subsystem 

3.2.1 Measurement Type (:CALCulate{[1]-256}:PARameter{[1]-256}:DE
Fine) 

 

Command 
Format 

 :CALCulate{[1]-256}:PARameter{[1]-256}:DEFine { S11|S21|S31|S41|S12|S22|
S32|S42|S13|S23|S33|S43|S14|S24|S34|S44|A|B|C|D|R1|R2|R3|R4} 
:CALCulate{[1]-256}:PARameter{[1]|-200}:DEFine? 

Instruction  This command sets and gets the measurement parameter of the selected trace,
 for the selected channel. 

Parameter 
Type 

 String 

Parameter 
Range 

 Select either one of the following: 
⚫ "S<XY>" 

 Where: 
 x=1to 4 
 Y=1to 4 

⚫ A|B|C|D 
⚫ R<X> (X=1-4) 

⚫ AUX1 or AUX2 
Return  String 

Default  S11 

Menu  Measure 

Example  :CALCulate1:PARameter1:DEFine S12 
:CALCulate1:PARameter1:DEFine? 
Return: S12 

 

3.2.2 Balance Measurement Topology (:CALCulate{[1]-256}:DTOPolog
y) 

 

Command 
Format 

 :CALCulate{[1]-256}:DTOPology <TopologyType>,<PortTopologyList> 
:CALCulate{[1]-256}:DTOPology? 

Instruction  This command sets and gets the device type for the balanced measurement. 

Parameter 
Type 

 String 

Parameter 
Range 

 Topology Type: 
B:        Balance (2 Ports) 
SB:      Single – Balance (3 Ports) 
SSB:    Single – Single – Balance (4 Ports) 
BB:      Balance – Balance (4 Ports) 

Port Topology List: 
Integers represent the ports as the port numbers, expressing the ports in th

e device topology in order. 
Return  String 

Default  B,1,2 

Menu  Measure > Balanced > Topology... 

Example  :CALCulate1:DTOPology SB,1,2,3 
:CALCulate1:DTOPology? 
Return: SB,1,2,3 

 

3.2.3 Select Trace (:CALCulate{[1]-256}:PARameter{[1]-256}:SELect) 
 

Command 
Format 

 :CALCulate{[1]-256}:PARameter{[1]-256}:SELect 

Instruction  This command sets the selected trace of the selected channel to the active trac
e. 
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Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Display > Trace Setup > Select 

Example  :CALCulate1:PARameter2:SELect 

 

3.2.4 Bandwidth Test State (:CALCulate{[1]-256}[:SELected]:BLIMit[:ST
ATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:BLIMit[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit[:STATe]? 

Instruction  1. This command turns ON/OFF the bandwidth test function, for the active trac
e of selected channel. 

2. This command turns ON/OFF the bandwidth test function of the selected tra
ce for the selected channel. 

 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Math > Analysis > Limit > Bandwidth 

Example  :CALCulate1:BLIMit ON 
:CALCulate1:BLIMit? 
Return: 1 
 
:CALCulate1:TRACe1:BLIMit OFF 
:CALCulate1:TRACe1:BLIMit? 
Return: 0 

 

3.2.5 Bandwidth Test Marker State (:CALCulate{[1]-256}[:SELected]:BL
IMit:DISPlay:MARKer) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit:DISPlay:MARKer {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:BLIMit:DISPlay:MARKer? 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:DISPlay:MARKer {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:DISPlay:MARKer? 

Instruction  1. This command turns ON/OFF the marker display of the bandwidth test, for t
he active trace of selected channel. 

2. This command turns ON/OFF the marker display of the bandwidth test of se
lected trace for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Math > Analysis > Limit > Bandwidth > Bandwidth Marker On 

Example  :CALCulate1:BLIMit:DISPlay:MARKer ON 
:CALCulate1:BLIMit:DISPlay:MARKer? 
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Return: 1 
 
:CALCulate1:TRACe1:BLIMit:DISPlay:MARKer OFF 
:CALCulate1:TRACe1:BLIMit:DISPlay:MARKer? 
Return: 0 

 

3.2.6 Bandwidth Test Value State (:CALCulate{[1]-256}[:SELected]:BLI
Mit:DISPlay:VALue) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit:DISPlay:VALue {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:BLIMit:DISPlay:VALue? 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:DISPlay:VALue {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:DISPlay:VALue? 

Instruction  1. This command turns ON/OFF the bandwidth value display of the bandwidth 
test, for the active trace of selected channel. 

2. This command turns ON/OFF the bandwidth value display of the bandwidth 
test of selected trace for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  None 

Example  :CALCulate1:BLIMit:DISPlay:VALue ON 
:CALCulate1:BLIMit:DISPlay:VALue? 
Return: 1 
 
:CALCulate1:TRACe1:BLIMit:DISPlay:VALue OFF 
:CALCulate1:TRACe1:BLIMit:DISPlay:VALue? 
Return: 0 

 

3.2.7 Get Bandwidth Test Fail Result (:CALCulate{[1]-256}[:SELected]:
BLIMit:FAIL?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit:FAIL? 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:FAIL? 

Instruction  1. This command gets the bandwidth limit test results, for the active trace of se
lected channel. 

2. This command gets the bandwidth limit test results, for the selected trace of 
selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  1|0 
1: Pass 
0: Fail 

Default  None 

Menu  None 

Example  :CALCulate1:BLIMit:FAIL? 
:CALCulate1:TRACe1:BLIMit:FAIL? 

 

3.2.8 Bandwidth Test Threshold (:CALCulate{[1]-256}[:SELected]:BLIM
it:DB) 
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Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit:DB <numeric> 
:CALCulate{[1]-256}[:SELected]:BLIMit:DB?  
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:DB <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:DB? 

Instruction  1. This command sets/gets the bandwidth threshold value (attenuation from th
e peak) of the bandwidth test, for the selected channel. 

2. This command sets/gets the bandwidth threshold value (attenuation from th
e peak) of the bandwidth test of selected trace for the selected channel. 

Parameter 
Type 

 Float, unit: dB 

Parameter 
Range 

 0-500MdB 

Return  Float, unit: dB 

Default  3 

Menu  Math > Analysis > Limit > Bandwidth > N dB Points 

Example  :CALCulate1:BLIMit:DB 3.5 
:CALCulate1:BLIMit:DB? 
Return: 3.5 
 
:CALCulate1:TRACe1:BLIMit:DB 4 
:CALCulate1:TRACe1:BLIMit:DB? 
Return: 4 

 

3.2.9 Bandwidth Test Maximum (:CALCulate{[1]-256}[:SELected]:BLIMi
t:MAXimum) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit:MAXimum <numeric> 
:CALCulate{[1]-256}[:SELected]:BLIMit:MAXimum?  
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:MAXimum <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:MAXimum? 

Instruction  1. This command sets/gets the upper limit value of the bandwidth test, for the 
selected channel. 

2. This command sets/gets the upper limit value of the bandwidth test of select
ed trace for the selected channel. 

Parameter 
Type 

 Float 

Parameter 
Range 

 None 

Return  Float 

Default  300kHz 

Menu  Math > Analysis > Limit > Bandwidth > Max Bandwidth 

Example  :CALCulate1:BLIMit:MAXimum 3500000 
:CALCulate1:BLIMit:MAXimum? 
Return: 3500000 
 
:CALCulate1:TRACe1:BLIMit:MAXimum 4000000 
:CALCulate1:TRACe1:BLIMit:MAXimum? 
Return: 4000000 

 

3.2.10 Bandwidth Test MiNimum (:CALCulate{[1]-256}[:SELected]:BLIMi
t:MiNimum) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit:MiNimum <numeric> 
:CALCulate{[1]-256}[:SELected]:BLIMit:MiNimum?  
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:MiNimum <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:MiNimum? 
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Instruction  1. This command sets/gets the lower limit value of the bandwidth test, for the s
elected channel. 

2. This command sets/gets the lower limit value of the bandwidth test of select
ed trace for the selected channel. 

Parameter 
Type 

 Float 

Parameter 
Range 

 None 

Return  Float 

Default  10kHz 

Menu  Math > Analysis > Limit > Bandwidth > Min Bandwidth 

Example  :CALCulate1:BLIMit:MiNimum 2000000 
:CALCulate1:BLIMit:MiNimum? 
Return: 2000000 
 
:CALCulate1:TRACe1:BLIMit:MiNimum 5000000 
:CALCulate1:TRACe1:BLIMit:MiNimum? 
Return: 5000000 

 

3.2.11 Bandwidth Test Report Data (:CALCulate{[1]-256}[:SELected]:BLI
Mit:REPort[:DATA]?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:BLIMit:REPort[:DATA]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:BLIMit:REPort[:DATA]? 

Instruction  1. This command reads the bandwidth value of the bandwidth test, for the acti
ve trace of selected channel. 

2. This command reads the bandwidth value of the bandwidth test of selected 
trace for the selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float 

Default  None 

Menu  None 

Example  :CALCulate1:BLIMit:REPort? 
:CALCulate1:TRACe1:BLIMit:REPort? 

 

3.2.12 Parameter Conversion State (:CALCulate{[1]-256}[:SELected]:CO
NVersion[:STATe]) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:CONVersion[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:CONVersion[:STATe]? 
 
:CALCulate{[1]-256}:TRACe{[1]-256}:CONVersion[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:CONVersion[:STATe]? 

Instruction  1. This command sets/gets the parameter conversion state for the active trace
 of selected channel. 

2. This command sets/gets the parameter conversion state for the selected tra
ce and selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Math > Analysis > Conversion 
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Example  :CALCulate1:CONVersion:STATe 1 
:CALCulate1:CONVersion:STATe? 
Return: 1 
 
:CALCulate1:TRACe1:CONVersion:STATe 1 
:CALCulate1:TRACe1:CONVersion:STATe? 
Return: 1 

 

3.2.13 Parameter Conversion (:CALCulate{[1]-256}[:SELected]:CONVers
ion:FUNCtion) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:CONVersion:FUNCtion {ZREFlection|ZTRansm
it|YREFlection|YTRansmit|INVersion|ZTSHunt|YTSHunt|CONJugation} 
:CALCulate{[1]-256}[:SELected]:CONVersion:FUNCtion? 
 
:CALCulate{[1]-256}:TRACe{[1]-256}:CONVersion:FUNCtion {ZREFlection|ZTR
ansmit|YREFlection|YTRansmit|INVersion|ZTSHunt|YTSHunt|CONJugation} 
:CALCulate{[1]-256}:TRACe{[1]-256}:CONVersion:FUNCtion? 

Instruction  1. This command sets/gets the parameter after conversion using the paramete
r conversion function, for the active trace of selected channel. 

2. This command sets/gets the parameter after conversion using the paramete
r conversion function for the selected trace and selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 ZREFlection|ZTRansmit|YREFlection|YTRansmit|INVersion|ZTSHunt|YTSHunt|
CONJugation 

Return  Enumeration 

Default  ZREFlection 

Menu  Math > Analysis > Conversion 

Example  :CALCulate1:CONVersion:STATe 1 
:CALCulate1:CONVersion:FUNCtion ZTSHunt 
:CALCulate1:CONVersion:FUNCtion? 
Return: ZTSH 
 
:CALCulate1:TRACe1:CONVersion:STATe 1 
:CALCulate1:TRACe1:CONVersion:FUNCtion YREFlection 
:CALCulate1:TRACe1:CONVersion:FUNCtion? 
Return: YREF 

 

3.2.14 Formatted Data Array (:CALCulate{[1]-256}[:SELected]:DATA:FD
ATa) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:DATA:FDATa <numeric1>,… ,<numeric NOP*
2> 
:CALCulate{[1]-256}[:SELected]:DATA:FDATa? 
:CALCulate{[1]-256}:TRACe{[1]-256}:DATA:FDATa <numeric1>,… ,<numeric N
OP*2> 
:CALCulate{[1]-256}:TRACe{[1]-256}:DATA:FDATa? 

Instruction  1. This command sets/gets the formatted data array, for the active trace of sel
ected channel. 

2. This command sets/gets the formatted data array of selected trace for the s
elected channel. 

Parameter 
Type 

 array 

Parameter 
Range 

 Indicates the array data (formatted data array) of NOP (number of measuremen
t points)×2. Where n is an integer between 1 and NOP. 
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Data(n×2-2) :Data (primary value) at the n-th measurement point. 
 
Data(n×2-1) :Data (secondary value) at the n-th measurement point. Always 0 w
hen the data format is not the Smith chart format or the polar format. 
 
The index of the array starts from 0. 

Return  Array 

Default  None 

Menu  None 

Example  :CALCulate1:DATA:FDATa a1,b1,……,an,bn 
:CALCulate1:DATA:FDATa? 
:CALCulate1:TRACe1:DATA:FDATa a1,b1,……,an,bn 
:CALCulate1:TRACe1:DATA:FDATa? 

 

3.2.15 Corrected Data Array (:CALCulate{[1]-256}[:SELected]:DATA:FD
ATa) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:DATA:SDATa <numeric1>,… ,<numeric NOP*
2> 
:CALCulate{[1]-256}[:SELected]:DATA:SDATa? 
:CALCulate{[1]-256}:TRACe{[1]-256}:DATA:SDATa <numeric1>,… ,<numeric N
OP*2> 
:CALCulate{[1]-256}:TRACe{[1]-256}:DATA:SDATa? 

Instruction  1. This command sets/gets the corrected data array, for the active trace of sel
ected channel. 

2. This command sets/gets the corrected data array of selected trace for the s
elected channel. 

Parameter 
Type 

 array 

Parameter 
Range 

 Indicates the array data (correcte DATA:XAXis? d data array) of NOP (number 
of measurement points)×2. Where n is an integer between 1 and NOP. 
 
Data(n×2-2) :Real part of the data (complex number) at the n-th measurement p
oint. 
 
Data(n×2-1) :Imaginary part of the data (complex number) at the n-th measurem
ent point. 
 
The index of the array starts from 0. 

Return  Array 

Default  None 

Menu  None 

Example  :CALCulate1:DATA:SDATa a1,b1,……,an,bn 
:CALCulate1:DATA:SDATa? 
:CALCulate1:TRACe1:DATA:SDATa a1,b1,……,an,bn 
:CALCulate1:TRACe1:DATA:SDATa? 

 

3.2.16 Electrical Delay Time (:CALCulate{[1]-256}[:SELected]:CORRecti
on:EDELay:TIME) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:CORRection:EDELay:TIME <numeric> 
:CALCulate{[1]-256}[:SELected]:CORRection:EDELay:TIME? 
:CALCulate{[1]-256}:TRACe{[1]-256}:CORRection:EDELay:TIME <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:CORRection:EDELay:TIME? 

Instruction  1. This command sets/gets the electrical delay time of the active trace of chan
nels 1 to 200. 
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2. This command sets/gets the electrical delay time of selected trace for the se
lected channel. 

Parameter 
Type 

 Float, unit s(second) 

Parameter 
Range 

 -10~10 

Return  Float, unit s(second) 

Default  0 

Menu  Scale > Electrical Delay > Delay Time 

Example  :CALCulate1:CORRection:EDELay:TIME 1 
:CALCulate1:CORRection:EDELay:TIME? 
Return: 1 
 
:CALCulate1:TRACe1:CORRection:EDELay:TIME 2 
:CALCulate1:TRACe1:CORRection:EDELay:TIME? 
Return: 2 

 

3.2.17 Electrical Delay Distance (:CALCulate{[1]-256}:MEASure{[1]-256}:
CORRection:EDELay:DISTance) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:CORRection:EDELay:DISTance <nume
ric> 
:CALCulate{[1]-256}:MEASure{[1]-256}:CORRection:EDELay:DISTance? 

Instruction  This command sets/gets the electrical delay distance of selected trace for the s
elected channel. 

Parameter 
Type 

 Float, unit meter, feet or inch 

Parameter 
Range 

 None 

Return  Float, unit meter, feet or inch 

Default  0 

Menu  Scale > Electrical Delay > Delay Distance 

Example  :CALCulate1:MEASure1:CORRection:EDELay:DISTance 1 
:CALCulate1:MEASure1:CORRection:EDELay:DISTance? 
Return: 1 

   
 

3.2.18 Electrical Delay Distance Units (:CALCulate{[1]-256}:MEASure{[1]
-256}:CORRection:EDELay:UNIT) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:CORRection:EDELay:UNIT {METer|FE
ET|INCH} 
:CALCulate{[1]-256}:MEASure{[1]-256}:CORRection:EDELay:UNIT? 

Instruction  This command sets/gets the electrical delay distance units of selected trace for t
he selected channel. 

Parameter 
Type 

 enumration 

Parameter 
Range 

 METer|FEET|INCH 

Return  METer|FEET|INCH 

Default  METer 

Menu  Scale > Electrical Delay > Distance Units 

Example  :CALCulate1:MEASure1:CORRection:EDELay:UNIT FEET 
:CALCulate1:MEASure1:CORRection:EDELay:UNIT? 
Return: FEET 
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3.2.19 Phase Offset(:CALCulate{[1]-256}[:SELected]:CORRection:OFF

Set:PHASe) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:CORRection:OFFSet:PHASe <numeric> 
:CALCulate{[1]-256}[:SELected]:CORRection:OFFSet:PHASe? 
:CALCulate{[1]-256}:TRACe{[1]-256}:CORRection:OFFSet:PHASe <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:CORRection:OFFSet:PHASe? 

Instruction  This command sets/gets the phase offset of the active trace of selected channel 

Parameter 
Type 

 Float unit °(radian) 

Parameter 
Range 

 -360 ~ 360 

Return  Float unit °(radian) 

Default  0 

Menu  Scale > Constants > Phase offset 

Example  :CALCulate1:CORRection:OFFSet:PHASe 25 
:CALCulate1:CORRection:OFFSet:PHASe? 
Return: 25 
 
:CALCulate1:TRACe1:CORRection:OFFSet:PHASe 90 
:CALCulate1:TRACe1:CORRection:OFFSet:PHASe? 
Return: 90 

 

3.2.20 Magnitude Offset(:CALCulate{[1]-256}:MEASure{[1]-256}:OFFSet:
MAGNitude) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:OFFSet:MAGNitude <numeric> 
:CALCulate{[1]-256}:MEASure{[1]-256}:OFFSet:MAGNitude? 

Instruction  This command sets/gets the magnitude offset of the active trace of selected cha
nnel 

Parameter 
Type 

 Float unit dB 

Parameter 
Range 

 -1000 ~ 1000 

Return  Float unit dB 

Default  0 

Menu  Scale > Constants > Mag offset 

Example  :CALCulate1:MEASure1:OFFSet:MAGNitude 90 
:CALCulate1:MEASure1:OFFSet:MAGNitude? 
Return: 90 

 

3.2.21 Magnitude Slope(:CALCulate{[1]-256}:MEASure{[1]-256}:OFFSet:
MAGNitude:SLOPe) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:OFFSet:MAGNitude:SLOPe <numeric> 
:CALCulate{[1]-256}:MEASure{[1]-256}:OFFSet:MAGNitude:SLOPe? 

Instruction  This command sets/gets the magnitude slope of the active trace of selected cha
nnel 

Parameter 
Type 

 Float unit dB/GHz 

Parameter 
Range 

 -1000 ~ 1000 

Return  Float unit dB/GHz 

Default  0 

Menu  Scale > Constants > Mag Slope 
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Example  :CALCulate1:MEASure1:OFFSet:MAGNitude:SLOPe 10 
:CALCulate1:MEASure1:OFFSet:MAGNitude:SLOPe? 
Return: 10 

 

3.2.22 X Axis Data(:CALCulate{[1]-256}[:SELected]:DATA:XAXis?) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:DATA:XAXis? 
:CALCulate{[1]-256}:TRACe{[1]-256}:DATA:XAXis? 

Instruction  1. This command reads the data of measurement points of X axis, for the activ
e trace of selected channel. 

2. This command reads the data of measurement points of X axis of selected t
race for the selected channel. 

Parameter 
Type 

 Data array(Unit depend on sweep type) 

Parameter 
Range 

 None 

Return  Data array 

Default  None 

Menu  None 

Example  :CALCulate1:DATA:XAXis? 
:CALCulate1:TRACe1:DATA:XAXis? 

 

3.2.23 Equation State(:CALCulate{[1]-256}[:SELected]:EQUation:STATE) 
 

Command 
Format 

 :CALCulate{[1]-256} [:SELected]:EQUation:STATE {ON|OFF|1|0} 
:CALCulate{[1]-256} [:SELected]:EQUation:STATE? 
:CALCulate{[1]-256}:TRACe{[1]-256}:EQUation:STATE {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:EQUation:STATE? 

Instruction  1. This command enables/disables the Equation Editor of the active trace of se
lected channel. 

2. This command enables/disables the Equation Editor of selected trace for th
e selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Math > Analysis > Equation 

Example  :CALCulate1:EQUation:TEXT ‘S11/S22’ 
:CALCulate1:EQUation:STATE ON 
:CALCulate1:EQUation:STATE? 
Return: 1 
 
:CALCulate1:TRACe1:EQUation:STATE OFF 
:CALCulate1:TRACe1:EQUation:STATE? 
Return: 0 

 

3.2.24 Trace Statistics State (:CALCulate{[1]-256}[:SELected]:MSTatistic
s[:STATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MSTatistics[:STATe] {ON|OFF|1|0}  
:CALCulate{[1]-256}[:SELected]:MSTatistics[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MSTatistics[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MSTatistics[:STATe]? 

Instruction  This command displays and hides the trace statistics (peak-to-peak, mean, stan
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dard deviation) on the screen. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Math > Analysis > Statistics 

Example  :CALCulate1:MSTatistics:STATe 1 
:CALCulate1:MSTatistics:STATe? 
Return: 1 
 
:CALCulate1:TRACe1:MSTatistics:STATe 0 
:CALCulate1:TRACe1:MSTatistics:STATe? 
Return: 0 

 

3.2.25 Statistics Type (:CALCulate{[1]-256}:MEASure{[1]-256}:FUNCtion:
TYPE) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:FUNCtion:TYPE {PTPeak|STDEV|MEA
N} 
:CALCulate{[1]-256}:MEASure{[1]-256}:FUNCtion:TYPE? 

Instruction  This command sets statistic type of selected trace for the selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 PTPeak|STDEV|MEAN 

Return  Enumeration 

Default  PTPeak 

Menu  None 

Example  :CALCulate1:MEASure1:FUNCtion:TYPE MEAN 
:CALCulate1:MEASure1:FUNCtion:TYPE? 
Return: MEAN 

 

3.2.26 Get Statistics Data (:CALCulate{[1]-256}:TRACe{[1]-256}:MSTatist
ics:DATA?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MSTatistics:DATA? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MSTatistics:DATA? 

Instruction  Returns the trace statistic data for the selected statistic type for the specified ch
annel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  None 

Example  :CALCulate1:TRACe1:MSTatistics:STATe 1 
:CALCulate1:MEASure1:FUNCtion:TYPE MEAN 
:CALCulate1:TRACe1:MSTatistics:DATA? 
 
:CALCulate1:MSTatistics:DATA? 

 

3.2.27 Equation Text (:CALCulate{[1]-256}[:SELected]:EQUation:TEXT) 
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Command 
Format 

 :CALCulate{[1]-256}[:SELected]:EQUation:TEXT <string> 
:CALCulate{[1]-256}[:SELected]:EQUation:TEXT? 
:CALCulate{[1]-256}:TRACe{[1]-256}:EQUation:TEXT <string> 
:CALCulate{[1]-256}:TRACe{[1]-256}:EQUation:TEXT? 

Instruction  This command sets/gets the equation in the Equation Editor. For valid paramete
rs that can be used in this equation, refer to the Equation Editor. 

Parameter 
Type 

 String 

Parameter 
Range 

 None 

Return  String 

Default  None 

Menu  Math > Analysis > Equation editor 

Example  :CALCulate1:EQUation:TEXT "S11/S22" 
:CALCulate1:EQUation:TEXT? 
Return: S11/S22 
 
:CALCulate1:TRACe1:EQUation:TEXT "S11/S22" 
:CALCulate1:TRACe1:EQUation:TEXT? 
Return: S11/S22 

 

3.2.28 Get Equation Valid (:CALCulate{[1]-256} [:SELected]:EQUation:V
ALID?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:EQUation:VALID? 
:CALCulate{[1]-256}:TRACe{[1]-256}:EQUation:VALID? 

Instruction  This command returns False when the equation expression and label are correc
t but the required S-parameter data is not measured or if it refers the invalid corr
ected memory array. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Boolean 
1: Valid 
0: Invalid 

Default  None 
Menu  Math > Analysis > Equation editor 
Example  :CALCulate1:EQUation:VALID? 

:CALCulate1:TRACe1:EQUation:VALID? 
 

3.2.29 Transform State (:CALCulate{[1]-256}[:SELected]:TRANsform:TI
ME:STATe) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STATe? 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:STATe? 

Instruction  1. This command turns ON/OFF the transformation function of the time domai
n function, for the active trace of selected channel. 

2. This command turns ON/OFF the transformation function of the time domai
n function of selected trace for the selected channel. 

Parameter 
Type 

 Boolean 
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Parameter 
Range 

 {ON|OFF|1|0} 

Return  Boolean 
Default  OFF 
Menu  Math > Time Domain > Transform 
Example  :CALCulate1:TRANsform:TIME:STATe ON 

:CALCulate1:TRANsform:TIME:STATe? 
Return: 1 
 
:CALCulate1:TRACe1:TRANsform:TIME:STATe OFF 
:CALCulate1:TRACe1:TRANsform:TIME:STATe? 
Return: 0 

 

3.2.30 Transform Start (:CALCulate{[1]-256}[:SELected]:TRANsform:TIM
E:STARt) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STARt <numeric> 
:CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STARt? 
:CALCulate{[1]-256}:TRACe1:TRANsform:TIME:STARt <numeric> 
:CALCulate{[1]-256}:TRACe1:TRANsform:TIME:STARt? 

Instruction  1. This command sets/gets the start value of the transformation used for the tr
ansformation function of the time domain function, for the active trace of sel
ected channel. 

2. This command sets/gets the start value of the transformation used for the tr
ansformation function of the time domain function of selected trace for the s
elected channel. 

Parameter 
Type 

 float, unit s(second) 

Parameter 
Range 

 None 

Return  Float, unit s(second) 
Default  None 
Menu  Math > Time Domain > Start Time 
Example  :CALCulate1:TRANsform:TIME:STARt -1e-9 

:CALCulate1:TRANsform:TIME:STARt? 
Return: -1e-09 
 
:CALCulate1:TRACe1:TRANsform:TIME:STARt 1e-9 
:CALCulate1:TRACe1:TRANsform:TIME:STARt? 
Return: 1e-09 

 

3.2.31 Transform Center (:CALCulate{[1]-256}[:SELected]:TRANsform:TI
ME:CENTer) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:TRANsform:TIME:CENTer <numeric> 
:CALCulate{[1]-256}[:SELected]:TRANsform:TIME:CENTer? 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:CENTer <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:CENTer? 

Instruction  1. This command sets/gets the center value of the transformation used for the 
transformation function of the time domain function, for the active trace of se
lected channel 

2. This command sets/gets the center value of the transformation used for the 
transformation function of the time domain function of selected trace for the 
selected channel. 

Parameter 
Type 

 Float, unit s(second) 
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Parameter 
Range 

 None 

Return  Float, unit s(second) 
Default  None 
Menu  Math > Time Domain > Center Time 
Example  :CALCulate1:TRANsform:TIME:CENTer 12e-9 

:CALCulate1:TRANsform:TIME:CENTer? 
Return: 1.2e-08 
 
:CALCulate1:TRACe1:TRANsform:TIME:CENTer 15e-9 
:CALCulate1:TRACe1:TRANsform:TIME:CENTer? 
Return: 1.5e-08 

 

3.2.32 Transform Stop (:CALCulate{[1]-256}[:SELected]:TRANsform:TIM
E:STOP) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STOP <numeric> 
:CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STOP? 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:STOP <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:STOP? 

Instruction  1. This command sets/gets the stop value of the transformation used for the tr
ansformation function of the time domain function, for the active trace of sel
ected channel. 

2. This command sets/gets the stop value of the transformation used for the tr
ansformation function of the time domain function of selected trace for the s
elected channel. 

Parameter 
Type 

 Float, unit s(second) 

Parameter 
Range 

 None 

Return  Float, unit s(second) 
Default  None 
Menu  Math > Time Domain > Stop Time 
Example  :CALCulate1:TRANsform:TIME:STOP 20e-9 

:CALCulate1:TRANsform:TIME:STOP? 
Return: 2e-08 
 
:CALCulate1:TRACe1:TRANsform:TIME:STOP 15e-9 
:CALCulate1:TRACe1:TRANsform:TIME:STOP? 
Return: 1.5e-08 

 

3.2.33 Transform Span (:CALCulate{[1]-256}[:SELected]:TRANsform:TI
ME:SPAN) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:TRANsform:TIME:SPAN <numeric> 
:CALCulate{[1]-256}[:SELected]:TRANsform:TIME:SPAN? 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:SPAN <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:SPAN? 

Instruction  1. This command sets/gets the span value of the transformation used for the tr
ansformation function of the time domain function, for the active trace of sel
ected channel. 

2. This command sets/gets the span value of the transformation used for the tr
ansformation function of the time domain function of selected trace for the s
elected channel. 

Parameter 
Type 

 Float, unit s(second) 
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Parameter 
Range 

 None 

Return  Float, unit s(second) 
Default  None 
Menu  Math > Time Domain > SPAN Time 
Example  :CALCulate1:TRANsform:TIME:SPAN 10e-9 

:CALCulate1:TRANsform:TIME:SPAN? 
Return: 1e-08 
 
:CALCulate1:TRACe1:TRANsform:TIME:SPAN 15e-9 
:CALCulate1:TRACe1:TRANsform:TIME:SPAN? 
Return: 1.5e-08 

 

3.2.34 Transform Mode (:CALCulate{[1]-256}[:SELected]:TRANsform:TI
ME[:TYPE]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:TRANsform:TIME[:TYPE] {BPASs|LPASs} 
:CALCulate{[1]-256}[:SELected]:TRANsform:TIME[:TYPE]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME[:TYPE] {BPASs|LPASs} 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME[:TYPE]? 

Instruction  1. This command sets/gets the transformation type used for the transformation
 function of the time domain function, for the active trace of selected channe
l. 

2. This command sets/gets the transformation type used for the transformation
 function of the time domain function, for the selected trace and selected ch
annel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 BPASs|LPASs 

Return  Enumeration 
Default  BPASs 
Menu  Math > Time Domain > TD Mode 
Example  :CALCulate1:TRANsform:TIME LPASs 

:CALCulate1:TRANsform:TIME? 
Return: LPAS 
 
:CALCulate1:TRACe1:TRANsform:TIME BPASs 
:CALCulate1:TRACe1:TRANsform:TIME? 
Return: BPAS 

3.2.35 Transform Stimulus (:CALCulate{[1]-256}[:SELected]:TRANsform:
TIME:STIMulus) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STIMulus {IMPulse|STEP} 
:CALCulate{[1]-256}[:SELected]:TRANsform:TIME:STIMulus? 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:STIMulus {IMPulse|STE
P} 
:CALCulate{[1]-256}:TRACe{[1]-256}:TRANsform:TIME:STIMulus? 

Instruction  1. This command sets/gets the stimulus type used for the transformation functi
on of the time domain function, for the active trace of selected channel. 

2. This command sets/gets the stimulus type used for the transformation functi
on of the time domain function of selected trace for the selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 IMPulse|STEP 
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Return  Enumeration 
Default  IMPulse 
Menu  Math > Time Domain > TD Mode 
Example  :CALCulate1:TRANsform:TIME LPASs 

:CALCulate1:TRANsform:TIME:STIMulus STEP 
:CALCulate1:TRANsform:TIME:STIMulus? 
Return: STEP 
 
:CALCulate1:TRACe1:TRANsform:TIME LPASs 
:CALCulate1:TRACe1:TRANsform:TIME:STIMulus IMPulse 
:CALCulate1:TRACe1:TRANsform:TIME:STIMulus? 
Return: IMP 

 

3.2.36 Gating State (:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIM
E:STATe) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:STATe? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:STATe? 

Instruction  1. This command turns ON/OFF the gating function of the time domain functio
n, for the active trace of selected channel. 

2. This command turns ON/OFF the gating function of the time domain functio
n of selected trace for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math > Time Gating > Gating 
Example  :CALCulate1:FILTer:TIME:STATe ON 

:CALCulate1:FILTer:TIME:STATe? 
Return: 1 
 
:CALCulate1:TRACe1:FILTer:TIME:STATe OFF 
:CALCulate1:TRACe1:FILTer:TIME:STATe? 
Return: 0 

 

3.2.37 Gating Start (:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIM
E:STARt) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:STARt <numeric> 
:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:STARt? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:STARt <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:STARt? 

Instruction  1. This command sets/gets the start value of the gate used for the gating functi
on of the time domain function, for the active trace of selected channel. 

2. This command sets/gets the start value of the gate used for the gating functi
on of the time domain function of selected trace for the selected channel. 

Parameter 
Type 

 Float, unit s(second) 

Parameter 
Range 

 -250e-9, 250e-9 

Return  float, unit s(second) 
Default  -250e-9 
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Menu  Math > Time Gating > Gate Start 
Example  :CALCulate1:FILTer:TIME:STARt -1e-9 

:CALCulate1:FILTer:TIME:STARt? 
Return: -1e-09 
 
:CALCulate1:TRACe1:FILTer:TIME:STARt -2e-9 
:CALCulate1:TRACe1:FILTer:TIME:STARt? 
Return: -2e-09 

 

3.2.38 Gating Center (:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TI
ME:CENTer) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:CENTer <numeric> 
:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:CENTer? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:CENTer <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:CENTer? 

Instruction  1. This command sets/gets the center value of the gate used for the gating fun
ction of the time domain function, for the active trace of selected channel. 

2. This command sets/gets the center value of the gate used for the gating fun
ction of the time domain function of selected trace for the selected channel. 

Parameter 
Type 

 Float, unit s(second) 

Parameter 
Range 

 None 

Return  float, unit s(second) 
Default  0 
Menu  Math > Time Gating > Gate Center 
Example  :CALCulate1:FILTer:TIME:CENTer 10e-9 

:CALCulate1:FILTer:TIME:CENTer? 
Return: 1e-08 
 
:CALCulate1:TRACe1:FILTer:TIME:CENTer 12e-9 
:CALCulate1:TRACe1:FILTer:TIME:CENTer? 
Return: 1.2e-08 

 

3.2.39 Gating Stop (:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIM
E:STOP) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:STOP <numeric> 
:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:STOP? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:STOP <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:STOP? 

Instruction  1. This command sets/gets the stop value of the gate used for the gating functi
on of the time domain function, for the active trace of selected channel. 

2. This command sets/gets the stop value of the gate used for the gating functi
on of the time domain function of selected trace for the selected channel. 

Parameter 
Type 

 Float, unit s(second) 

Parameter 
Range 

 -250e-9, 250e-9 

Return  float, unit s(second) 
Default  250e-9 
Menu  Math > Time Gating > Gate Stop 
Example  :CALCulate1:FILTer:TIME:STOP 10e-9 

:CALCulate1:FILTer:TIME:STOP? 
Return: 1e-08 
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:CALCulate1:TRACe1:FILTer:TIME:STOP 15e-9 
:CALCulate1:TRACe1:FILTer:TIME:STOP? 
Return: 1.5e-08 

 

3.2.40 Gating Span (:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIM
E:SPAN) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:SPAN <numeric> 
:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:SPAN? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:SPAN <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:SPAN? 

Instruction  1. This command sets/gets the span value of the gate used for the gating funct
ion of the time domain function, for the active trace of selected channel. 

2. This command sets/gets the span value of the gate used for the gating funct
ion of the time domain function of selected trace for the selected channel. 

Parameter 
Type 

 Float, unit s(second) 

Parameter 
Range 

 None 

Return  float, unit s(second) 
Default  500e-9 
Menu  Math > Time Gating > Gate Span 
Example  :CALCulate1:FILTer:TIME:SPAN 10e-9 

:CALCulate1:FILTer:TIME:SPAN? 
Return: 1e-08 
 
:CALCulate1:TRACe1:FILTer:TIME:SPAN 15e-9 
:CALCulate1:TRACe1:FILTer:TIME:SPAN? 
Return: 1.5e-08 

 

3.2.41 Gating Shape (:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TI
ME:SHAPe) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:SHAPe {MAXimum| WIDE
|NORMal|MINimum} 
:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:SHAPe? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:SHAPE {MAXimum| 
WIDE|NORMal|MINimum} 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:SHAPE? 

Instruction  1. This command sets/gets the shape of the gate used for the gating function o
f the time domain function, for the active trace of selected channel. 

2. This command sets/gets the shape of the gate used for the gating function o
f the time domain function of selected trace for the selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 MAXimum| WIDE|NORMal|MINimum 

Return  Enumeration 
Default  NORMal 
Menu  Math > Time Gating > Gate Shape 
Example  :CALCulate1:FILTer:TIME:SHAPe MINimum 

:CALCulate1:FILTer:TIME:SHAPe? 
Return: MIN 
 
:CALCulate1:TRACe1:FILTer:TIME:SHAPe WIDE 
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:CALCulate1:TRACe1:FILTer:TIME:SHAPe? 
Return: WIDE 

 

3.2.42 Gating Type (:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIM
E:TYPE) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:TYPE {BPASs| NOTCh} 
:CALCulate{[1]-256}[:SELected]:FILTer[:GATE]:TIME:TYPE? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:TYPE { BPASs| NOT
Ch} 
:CALCulate{[1]-256}:TRACe{[1]-256}:FILTer[:GATE]:TIME:TYPE? 

Instruction  1. This command sets/gets the type of the gate used for the gating function of t
he time domain function, for the active trace of selected channel. 

2. This command sets/gets the type of the gate used for the gating function of t
he time domain function of selected trace for the selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 BPASs| NOTCh 

Return  Enumeration 
Default  BPASs 
Menu  Math > Time Gating > Gate Type 
Example  :CALCulate1:FILTer:TIME:TYPE NOTCh 

:CALCulate1:FILTer:TIME:TYPE? 
Return: NOTC 
 
:CALCulate1:TRACe1:FILTer:TIME:TYPE BPASs 
:CALCulate1:TRACe1:FILTer:TIME:TYPE? 
Return: BPAS 

 

3.2.43 Trace Format (:CALCulate{[1]-256}[:SELected]:FORMat) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:FORMat { MLOGarithmic|PHASe|GDELay| SLI
Near|SLOGarithmic|SCOMplex|SMITh|SADMittance|PLINear|PLOGarithmic|PO
Lar|MLINear|SWR|REAL| IMAGinary|UPHase|PPHase} 
:CALCulate{[1]-256}[:SELected]:FORMat? 
:CALCulate{[1]-256}:TRACe{[1]-256}:FORMat {MLOGarithmic|PHASe|GDELay|
 SLINear|SLOGarithmic|SCOMplex|SMITh|SADMittance|PLINear|PLOGarithmic
|POLar|MLINear|SWR|REAL| IMAGinary|UPHase|PPHase} 
:CALCulate{[1]-256}:TRACe{[1]-256}:FORMat? 

Instruction  1. This command sets/gets the data format of the active trace of selected chan
nel. 

2. This command sets/gets the data format of selected trace for the selected c
hannel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 MLOGarithmic|PHASe|GDELay| SLINear|SLOGarithmic|SCOMplex|SMITh|SAD
Mittance|PLINear|PLOGarithmic|POLar|MLINear|SWR|REAL| IMAGinary|UPHa
se|PPHase 

Return  Enumeration 
Default  MLOGarithmic 
Menu  Format > Format1 or Format2 
Example  :CALCulate1:FORMat PHASe 

:CALCulate1:FORMat? 
Return: PHAS 
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:CALCulate1:TRACe1:FORMat GDELay 
:CALCulate1:TRACe1:FORMat? 
Return: GDEL 

 

3.2.44 Limit Table (:CALCulate{[1]-256}[:SELected]:LIMit:DATA) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:LIMit:DATA <numeric 1>, ... ,<numeric 1+(N*
5)> 
:CALCulate{[1]-256}[:SELected]:LIMit:DATA? 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:DATA <numeric 1>, ... ,<numeric 1+
(N*5)> 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:DATA? 

Instruction  1. This command sets/gets the limit table for the limit test, for the active trace o
f selected channel 

2. This command sets/gets the limit table for the limit test of selected trace for t
he selected channel. 

Parameter 
Type 

 Data Array 

Parameter 
Range 

 Indicates the array data (for limit line) of 1 + Num (number of limit lines)*5. Wher
e n is an integer between 1 and Num. 
 
Data(0) :The number of limit lines you want to set. Specify an integer ranging 0 t
o 100. When the number of limit lines is set to 0 (clears the limit table), the varia
ble Data is only required with Data(0). 
 
Data(n*5-4) :The type of the n-th line. 
Specify an integer 0 to 2 as follows. 
0:OFF 
1:Upper limit line 
2:Lower limit line 
 
Data(n*5-3) :The value on the horizontal axis (frequency/power/time) of the start
 point of the n-th line. 
 
Data(n*5-2) :The value on the horizontal axis (frequency/power/time) of the end 
point of the n-th line. 
 
Data(n*5-1) :The value on the vertical axis of the start point of the n-th line. 
 
Data(n*5) :The value on the vertical axis of the end point of the n-th line. 
 
The index of the array starts from 0. 

Return  Data Array 
Default  None 
Menu  Math > Analysis > Limit Table 
Example  :CALCulate1:LIMit:DATA 2,1,1E9,3E9,0,0,2,1E9,3E9,-3,-3 

:CALCulate1:LIMit:DATA? 
Return: 2,1,1000000000,3000000000,0,0,2,1000000000,3000000000,-3, 
-3 
 
:CALCulate1:TRACe1:LIMit:DATA 2,2,2E9,3E9,-3,0,1,2E9,3E9,-5,-3 
:CALCulate1:TRACe1:LIMit:DATA? 
Return: 2,2,2000000000,3000000000,-3,0,1,2000000000,3000000000, 
-5,-3 

 

3.2.45 Limit Line State (:CALCulate{[1]-256}[:SELected]:LIMit:DISPlay[:S
TATe]) 
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Command 
Format 

 :CALCulate{[1]-256}[:SELected]:LIMit:DISPlay[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:LIMit:DISPlay[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:DISPlay[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:DISPlay[:STATe]? 

Instruction  1. This command turns ON/OFF the limit line display, for the active trace of sel
ected channel. 

2. This command turns ON/OFF the limit line display of selected trace for the s
elected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math > Analysis > Limit > Limit Line ON 
Example  :CALCulate1:LIMit:DISPlay ON 

:CALCulate1:LIMit:DISPlay? 
Return: 1 
 
:CALCulate1:TRACe1:LIMit:DISPlay OFF 
:CALCulate1:TRACe1:LIMit:DISPlay? 
Return: 0 

 

3.2.46 Get Limit Test Result (:CALCulate{[1]-256}[:SELected]:LIMit:FAI
L?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:LIMit:FAIL? 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:FAIL? 

Instruction  1. This command reads the limit test result, for the active trace of selected cha
nnel. 

2. This command reads the limit test result of selected trace for the selected c
hannel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  1|0 
1: Fail 
0: Pass 

Default  None 
Menu  None 
Example  :CALCulate1:LIMit:FAIL? 

:CALCulate1:TRACe1:LIMit:FAIL? 
 

3.2.47 Limit Sound State (:CALCulate{[1]-256}[:SELected]:LIMit:SOUNd[:
STATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:SOUNd[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:SOUNd[:STATe]? 

Instruction  This command turns ON/OFF the limit testing fail sound of selected trace for the
 selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 
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Return  Boolean 
Default  OFF 
Menu  Math > Analysis > Limit > Test Sound ON 
Example  :CALCulate1:MEASure:LIMit:SOUNd ON 

:CALCulate1:MEASure:LIMit:SOUNd? 
Return: 1 

 

3.2.48 Get Limit All Report (:CALCulate{[1]-256}[:SELected]:LIMit:REPor
t:ALL?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:LIMit:REPort:ALL? 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:REPort:ALL? 

Instruction  This command reads the bandwidth test results (stimulus value, limit test result, 
upper limit value and lower limit value of all measurement points), for the active 
trace of selected channel 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Data array 
 

Indicates the array data (for limit line) of NOP (number of measurement points)x
4. Where n is an integer between 1 and NOP. 

⚫ Data(nx4-3) The stimulus value for the measurement point. 
⚫ Data(nx4-2) The limit test result. 

Specify an integer -1 to 1 as follows. 
-1:No limit 
0:Fail 
1:Pass 

⚫ Data(nx4-1) The upper limit value at the measurement point. (If ther
e is no limit at this point, reads out the 0.) 

⚫ Data(nx4) The lower limit value at the measurement point. (If there i
s no limit at this point, reads out the 0.) 

The index of the array starts from 0. 
Default  None 
Menu  None 
Example  :CALCulate1:LIMit:REPort:ALL? 

:CALCulate1:TRACe1:LIMit:REPort:ALL? 
 

3.2.49 Get Limit Failed Data (:CALCulate{[1]-256}[:SELected]:LIMit:REP
ort[:DATA]?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:LIMit:REPort[:DATA]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:REPort[:DATA]? 

Instruction  This command reads the stimulus values (frequency, power level or time) at all t
he measurement points that failed the limit test, for the active trace of selected c
hannel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Data array 
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Indicates the array data for failed measurement points. 
Default  None 
Menu  None 
Example  :CALCulate1:LIMit:REPort? 

:CALCulate1:TRACe1:LIMit:REPort? 
 

3.2.50 Get Limit Failed Points (:CALCulate{[1]-256}[:SELected]:LIMit:RE
Port:POINts?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:LIMit:REPort:POINts? 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit:REPort:POINts? 

Instruction  This command reads the number of the measurement points that failed the limit 
test, for the active trace of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  None 
Menu  None 
Example  :CALCulate1:LIMit:REPort:POINts? 

:CALCulate1:TRACe1:LIMit:REPort:POINts? 
 

3.2.51 Limit Test State (:CALCulate{[1]-256}[:SELected]:LIMit[:STATe]) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:LIMit[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:LIMit[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:LIMit[:STATe]? 

Instruction  This command turns ON/OFF the limit test function, for the active trace of select
ed channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math > Analysis > Limit > Limit Test ON 
Example  :CALCulate1:LIMit ON 

:CALCulate1:LIMit? 
Return: 1 
 
:CALCulate1:TRACe1:LIMit OFF 
:CALCulate1:TRACe1:LIMit? 
Return: 0 

3.2.52 Active Marker (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:A
CTivate) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:ACTivate 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:ACTivate 

Instruction  This command sets the marker 1 to 9 (Mk) and reference marker (Mk:10) to the 
active marker. The marker on a trace that can be repositioned either by front pa
nel controls or by programming commands, for the active trace of selected chan
nel. 

javascript:BSSCPopup('../link/Val_Mk.htm');
javascript:TextPopup(this)
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Parameter 
Type 

 Long 

Parameter 
Range 

 1 to 10 (10 is for the reference marker) 

Default  None 
Menu  Marker > Select 
Example  :CALCulate1:MARKer3:ACTivate 

:CALCulate1:TRACe1:MARKer3:ACTivate 

 

3.2.53 Bandwidth Search BW Ref To (:CALCulate{[1]-256}[:SELected]:M
ARKer{[1]-10}:BWIDth:REF) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:BWIDth:REF <type> 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:BWIDth:REF? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:BWIDth:REF <type> 

:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:BWIDth:REF？ 

Instruction  Sets or gets the bandwidth reference type for the bandwidth search of the select
ed channel and trace. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 MARKer|PEAK 

Return  Enumeration 

Default  PEAK 
Menu  Search>Bandwidth>BW Ref To 
Example  :CALCulate1:SELected:MARKer1:BWIDth:REF MARKer 

:CALCulate1:SELected:MARKer1:BWIDth:REF? 
Return :MARK 
 
:CALCulate1:TRACe1:MARKer1:BWIDth:REF PEAK 
:CALCulate1:TRACe1:MARKer1:BWIDth:REF? 
Return :PEAK 

 

3.2.54  Notch Search Notch Ref To (:CALCulate{[1]-256}[:SELected]:MA
RKer{[1]-10}:NOTCH:REF) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:NOTCH:REF <type> 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:NOTCH:REF? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:NOTCH:REF <type> 

:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:NOTCH:REF？ 

Instruction  Sets or gets the notch reference type for the selected channel and trace notch s
earch. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 MARKer|PEAK 

Return  Enumeration 

Default  PEAK 
Menu  Search>Notch>Notch Ref To 
Example  :CALCulate1:SELected:MARKer1:NOTCH:REF MARKer 

:CALCulate1:SELected:MARKer1:NOTCH:REF? 
Return :MARK 
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:CALCulate1:TRACe1:MARKer1:NOTCH:REF PEAK 
:CALCulate1:TRACe1:MARKer1:NOTCH:REF? 
Return :PEAK 

 
 

3.2.55 Bandwidth Search Result of Marker (:CALCulate{[1]-256}[:SELect
ed]:MARKer{[1]-10}:BWIDth:DATA?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:BWIDth:DATA? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:BWIDth:DATA? 

Instruction  This command reads the bandwidth search result of marker 1 to 9 (Mk) and refe
rence marker (Mk:10), for the active trace of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Indicates 4-element array data (bandwidth search result). 
⚫ Data(0) :The bandwidth. 
⚫ Data(1) :Center point frequency of the 2 cutoff frequency points. 
⚫ Data(2) :The Q value. 
⚫ Data(3) :Insertion loss 
The index of the array starts from 0.  
The bandwidth search enable switch must to be turned on before query the sear
ch result. 

Default  None 
Menu  None 
Example  :CALCulate1:MEASure1:MARKer3 ON 

:CALCulate1:MARKer:BWIDth ON 
:CALCulate1:MARKer3:BWIDth:DATA? 
:CALCulate1:TRACe1:MARKer3:BWIDth:DATA? 
Return: 254357919.225087,4162270498.174748,16.363833,-13.946911 

3.2.56 Bandwidth Search Result State of Marker  (:CALCulate{[1]-256}[:
SELected]:MARKer{[1]-10}:BWIDth[:STATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:BWIDth[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:BWIDth[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:BWIDth[:STATe] {ON|OF
F|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:BWIDth[:STATe]? 

Instruction  1. This command turns ON/OFF the bandwidth search result display, for the a
ctive trace of selected channel; 

2. This command turns ON/OFF the bandwidth search result display, for the s
elected trace of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math > analysis> Limit > Bandwith 
Example  :CALCulate1:TRACe1:MARKer1 ON 

:CALCulate1:MARKer1:BWIDth ON 
:CALCulate1:MARKer1:BWIDth? 
Return: 1 
 
:CALCulate1:TRACe1:MARKer:BWIDth OFF 
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:CALCulate1:TRACe1:MARKer:BWIDth? 
Return: 0 

3.2.57 Bandwidth Threshold of Marker  (:CALCulate{[1]-256}[:SELected]:
MARKer{[1]-10}:BWIDth:THReshold) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:BWIDth:THReshold <numeric> 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:BWIDth:THReshold? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:BWIDth:THReshold <num
eric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:BWIDth:THReshold? 

Instruction  This command sets/gets the bandwidth definition value (the value to define the 
pass-band of the filter) of marker 1 to 9 (Mk) and reference marker (Mk:10), for t
he active trace of selected channel. 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500~500 

Return  Float 
Default  -3 
Menu  Search > Bandwidth > BW Level 
Example  :CALCulate1:MARKer1:BWIDth:THReshold -3.5 

:CALCulate1:MARKer1:BWIDth:THReshold? 
Return: -3.5 
 
:CALCulate1:TRACe1:MARKer1:BWIDth:THReshold -6 
:CALCulate1:TRACe1:MARKer1:BWIDth:THReshold? 
Return: -6 

 

3.2.58 Marker Couple (:CALCulate:MARKer:COUPle) 
 

Command 
Format 

 :CALCulate:MARKer:COUPle {ALL|CHANnel|OFF} 
:CALCulate:MARKer:COUPle? 

Instruction  This command sets the marker coupling state. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 ALL|CHANnel|OFF 

Return  ALL|CHAN|OFF 
Default  OFF 
Menu  Marker > Marker Setup > Coupled 
Example  :CALCulate:MARKer:COUPle ALL 

:CALCulate:MARKer:COUPle? 
Return: ALL 

 

3.2.59 Get Response and Stimulus Data of Marker (:CALCulate{[1]-256}[:
SELected]:MARKer{[1]-10}:DATA?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:DATA? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:DATA? 

Instruction  1. This command reads the response and stimulus value of marker 1 to 9 (Mk) 
and reference marker (Mk:10), for the active trace of selected channel. 
2. This command reads the response and stimulus value of marker 1 to 9 (Mk) 
and reference marker (Mk:10), for the selected trace of selected channel. 

Parameter 
Type 

 None 
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Parameter 
Range 

 None 

Return  Data array 
 
Indicates 3-element array data (response and stimulus of marker). 
 
⚫ Data(0) :Response value (primary value) at the marker position. 
⚫ Data(1) :Response value (secondary value) at the marker position. Always 

0 when the data format is not the Smith chart format or the polar format. 
⚫ Data(2) :Stimulus value at the marker position. 
The index of the array starts from 0. 

Default  None 
Menu  None 
Example  :CALCulate1:MARKer3:DATA? 

:CALCulate1:TRACe1:MARKer3:DATA? 

 

3.2.60 Marker Discrete  (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:
DISCrete) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:DISCrete 
 {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:DISCrete? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:DISCrete {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:DISCrete? 

Instruction  This command turns ON/OFF the discrete mode (mode in which the marker mo
ves only at the measurement points) with marker 1 to 9 (Mk) and reference mar
ker (Mk:10), for the active trace of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Marker > Marker Setup > DISCrete 
Example  :CALCulate1:MARKer2:DISCrete ON 

:CALCulate1:MARKer2:DISCrete? 
Return: 1 
 
:CALCulate1:TRACe1:MARKer3:DISCrete OFF 
:CALCulate1:TRACe1:MARKer3:DISCrete? 
Return: 0 

 

3.2.61 Marker Delta (:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-
10}:DELTa) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-9}:DELTa {ON|OFF|1|0} 
:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-9}:DELTa? 

Instruction  This command turns ON/OFF the delta marker state, for the selected trace of se
lected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Marker > Marker Setup > Delta 
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Example  :CALCulate1:MEASure:MARKer3:DELTa ON 
:CALCulate1:MEASure:MARKer3:DELTa? 
Return: 1 

 

3.2.62 Marker Type  (:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]
-10}:TYPE) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10}:TYPE {NORMal|FIXed} 
:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10}:TYPE? 

Instruction  This command sets the type of marker 1 to 9 (Mk) and reference marker (Mk:1
0), for the selected trace of selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 NORMal|FIXed 

Return  Enumeration 
Default  NORM 
Menu  Marker > Marker Setup > Type 
Example  :CALCulate1:MEASure:MARKer3:TYPE FIXed 

:CALCulate1:MEASure:MARKer3:TYPE? 
Return: FIX 

 

3.2.63 Marker Format  (:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer
{[1]-10}:FORMAT) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10}:FORMAT {DEFault|MLI
Near|MLOGarithmic|IMPedance|ADMittance|PHASe|IMAGinary|REAL|POLar|G
DELay|LINPhase|LOGPhase|SWR} 
:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10}:FORMAT? 

Instruction  This command sets the measure format with marker 1 to 9 and reference marke
r (Mk:10), for the selected trace of selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 DEFault|MLINear|MLOGarithmic|IMPedance|ADMittance|PHASe|IMAGinary|RE
AL|POLar|GDELay|LINPhase|LOGPhase|SWR 

Return  Enumeration 
Default  DEF 
Menu  Marker > Marker Setup > FORMat 
Example  :CALCulate1:MEASure1:MARKer3:FORMAT MLINear 

:CALCulate1:MEASure1:MARKer3:FORMAT? 
Return: MLIN 

 

3.2.64 Marker State (:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-
10} [:STATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10} [:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10} [:STATe]? 

Instruction  This command turns ON/OFF the display of marker 1 to 9 and reference marker
 (Mk:10), for the selected trace of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 



SNA5000A Programming Guide           45 

 

 

Default  OFF 
Menu  None 
Example  :CALCulate1:MEASure1:MARKer3 ON 

:CALCulate1:MEASure1:MARKer3? 
Return: 1 

3.2.65 Marker State (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}[:S
TATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}[:STATe]? 

Instruction  1. This command turns ON/OFF the display of marker 1 to 9 and reference m
arker (Mk:10), for the active trace of selected channel; 

2. This command turns ON/OFF the display of marker 1 to 9 and reference m
arker (Mk:10), for the selected trace of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  None 
Example  :CALCulate1:MARKer3 ON 

:CALCulate1:MARKer3? 
Return: 1 
 
:CALCulate1:TRACe1:MARKer3 OFF 
:CALCulate1:TRACe1:MARKer3? 
Return: 0 

 

3.2.66 Reference Marker State (:CALCulate{[1]-256}[:SELected]:MARKer:
REFerence[:STATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:REFerence[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:MARKer:REFerence[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:REFerence[:STATe] {ON|OFF|1|
0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:REFerence[:STATe]? 

Instruction  1. This command turns ON/OFF the reference marker for the active trace of s
elected channel; 

2. This command turns ON/OFF the reference marker for the selected trace of
 selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Marker > Reference Marker 
Example  :CALCulate1:MARKer:REFerence ON 

:CALCulate1:MARKer:REFerence? 
Return: 1 
 
:CALCulate1:TRACe1:MARKer:REFerence OFF 
:CALCulate1:TRACe1:MARKer:REFerence? 
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Return: 0 

 

3.2.67 All Marker Off(:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer:A
OFF) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:MARKer:AOFF 

Instruction  This command turns OFF all markers for the selected trace of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Boolean 
Default  None 
Menu  Marker > All Off 
Example  :CALCulate1:TRACe1:MARKer3 ON 

:CALCulate1:MEASure1:MARKer:AOFF 

 

3.2.68 Marker Function (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:
SET) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:SET {STARt| STOP|CENTer|R
LEVel|DELay|RMARker|SPAN|SA} 
:CALCulate1:TRACe1:MARKer{[1]-10}:SET {STARt| STOP|CENTer|RLEVel|DE
Lay|RMARker|SPAN|SA} 

Instruction  1. This command sets the value at the position of marker 1 to 9 (Mk) and refer
ence marker (Mk:10) to the value of the instrument setting item (Param), for 
the active trace of selected channel. 

2. This command sets the value at the position of marker 1 to 9 (Mk) and refer
ence marker (Mk:10) to the value of the instrument setting item (Param), for 
the selected trace of selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 STARt| STOP|CENTer|RLEVel|DELay|RMARker|SPAN|SA 

Return  None 
Default  None 
Menu  Marker > Marker Function 
Example  :CALCulate1:MARKer1:SET RLEVel 

:CALCulate1:TRACe1:MARKer1:SET STARt 

 

3.2.69 Marker X Value (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:
X) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:X <numeric> 
:CALCulate{[1]-256}[:SELected]:MARKer:X? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:X <numeric>  
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:X? 

Instruction  1. This command set the stimulus value for marker 1 to 9 (Mk) and reference 
marker (Ch:10), for the active trace of selected channel. 

2. This command set the stimulus value for marker 1 to 9 (Mk) and reference 
marker (Ch:10), for the a selected ctive trace of selected channel. 

Parameter 
Type 

 Float 
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Parameter 
Range 

 9k~8.5GHz 

Return  float 
Default  None 
Menu  Marker> Marker x(x: 1-9 and R) 
Example  :CALCulate1:MARKer1:X 1e9 

:CALCulate1:MARKer1:X? 
Return: 1000000000 
 
:CALCulate1:TRACe1:MARKer:X 2e9 
:CALCulate1:TRACe1:MARKer:X? 
Return: 2000000000 

 

3.2.70 Get Marker Y Value (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-
10}:Y?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-256}:Y? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-256}:Y? 

Instruction  1. This command reads the response value of marker 1 to 9 (Mk) and referenc
e marker (Mk:10), for the active trace of selected channel. 

2. This command reads the response value of marker 1 to 9 (Mk) and referenc
e marker (Mk:10), for the selected trace of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Data array 
 
Indicates 2-element array data (response value of marker). 
 
⚫ Data(0) :Response value (primary value) at the marker position. 
⚫ Data(1) :Response value (secondary value) at the marker position. Always 

0 when the data format is not the Smith chart format or the polar format. 
The index of the array starts from 0. 

Default  None 
Menu  None 
Example  :CALCulate1:MARKer1:Y? 

:CALCulate1:TRACe1:MARKer1:Y? 

 

3.2.71 Add Search Domain (:CALCulate1 [:SELected]:MARKer:FUNCtio
n:DOMain:ADD) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:DOMain:ADD 

Instruction  This command adds search range of search analysis for the selected marker, fo
r the active trace of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Search > Domain > Add 
Example  :CALCulate1:MARKer:FUNCtion:DOMain:ADD 
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3.2.72 Delete Search Domain (:CALCulate1 [:SELected]:MARKer:FUNCti
on:DOMain:DELete) 

 

Command 
Format 

 :CALCulate{[1]-256} [:SELected]:MARKer:FUNCtion:DOMain:DELete <numeri
c> 

Instruction  This command deletes search range of search analysis for the selected marker,
 for the active trace of selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1 ~ 16 

Return  None 
Default  None 
Menu  Search > Domain > Delete 
Example  :CALCulate1:MARKer:FUNCtion:DOMain:DELete 1 

 

3.2.73 Select Search Range Number (:CALCulate{[1]-256}[:SELected]:M
ARKer:FUNCtion:DOMain:NUMber) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:DOMain:NUMber <n
umeric> 
:CALCulate{[1]-256} [:SELected]:MARKer{[1]-10}:FUNCtion:DOMain:NUMber? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:DOMain:NUMb
er <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:DOMain:NUMb
er? 

Instruction  1. This command selects or gets search range number of search analysis for th
e selected marker, for the active trace of selected channel. 
2. This command selects or gets search range number of search analysis for th
e selected marker, for the selected trace of selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1 ~ 16 

Return  Integer 
Default  None 
Menu  Search > Domain  
Example  :CALCulate1:TRACe1:MARKer1:FUNCtion:DOMain:NUMber 3 

:CALCulate1:TRACe1:MARKer1:FUNCtion:DOMain:NUMber? 
Return: 3 
 
:CALCulate1:MARKer:FUNCtion:DOMain:NUMber 2 
:CALCulate1:MARKer:FUNCtion:DOMain:NUMber? 
Return: 2 

 

3.2.74 Search Domain Start (:CALCulate{[1]-256}[:SELected]:MARKer:F
UNCtion:DOMain{[1]-16}:STARt) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:DOMain{[1]-16}:STARt <nu
meric> 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:DOMain{[1]-16}:STARt? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:DOMain{[1]-16}:STARt
 <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:DOMain{[1]-16}:STAR
t? 

Instruction  This command sets/gets the start value of the marker search range, for the sele
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cted channel. 

Parameter 
Type 

 Float 

Parameter 
Range 

 9k~8.5GHz 

Return  Float 
Default  None 
Menu  Search > Start 
Example  :CALCulate1:MARKer:FUNCtion:DOMain2:STARt 1e9 

:CALCulate1:MARKer:FUNCtion:DOMain2:STARt? 
Return: 1000000000 
 
:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STARt 2e9 
:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STARt? 
Return: 2000000000 

 

3.2.75 Search Domain Stop (:CALCulate{[1]-256}[:SELected]:MARKer:F
UNCtion:DOMain{[1]-16}:STOP) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:DOMain{[1]-16}:STOP <nu
meric> 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:DOMain{[1]-16}:STOP? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:DOMain{[1]-16}:STOP 
<numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:DOMain{[1]-16}:STO
P? 

Instruction  This command sets/gets the stop value of the marker search range, for the sele
cted channel. 

Parameter 
Type 

 Float 

Parameter 
Range 

 9k~8.5GHz 

Return  Float 
Default  None 
Menu  Search > Stop 
Example  :CALCulate1:MARKer:FUNCtion:DOMain2:STOP 3e9 

:CALCulate1:MARKer:FUNCtion:DOMain2:STOP? 
Return: 3000000000 
 
:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STOP 4e9 
:CALCulate1:TRACe1:MARKer:FUNCtion:DOMain2:STOP? 
Return: 4000000000 

 

3.2.76 Execute Search (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:
FUNCtion:EXECute) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:EXECute 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:EXECute 

Instruction  1. This command immediately executes the specified search function of the ac
tive trace for the selected channel. 

2. This command immediately executes the specified search function of the se
lected trace, for the selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 
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Return  None 
Default  None 
Menu  Search > Max Search/Min Search 

Search > Peak Search/Peak Right Search/Peak Left Search 
Search > Target Search/Target Right Search/Target Left Search 

Example  :CALCulate1:MARKer1:FUNCtion:TYPE MAXimum 
:CALCulate1:MARKer1:FUNCtion:EXECute 
 
:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE MINimum 
:CALCulate1:TRACe1:MARKer1:FUNCtion:EXECute 

 

3.2.77 Tracking State (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:
FUNCtion:TRACking) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TRACking {ON|OFF
|1|0} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TRACking? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TRACking {ON|
OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TRACking? 

Instruction  1. This command turns ON or OFF the tracking search capability for the specifi
ed marker of the active trace for the selected channel. 

2. This command turns ON or OFF the tracking search capability for the specifi
ed marker of the selected trace, for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean  
Default  OFF  
Menu  Search > Tracking 
Example  :CALCulate1:MARKer2:FUNCtion:TRACking ON 

:CALCulate1:MARKer2:FUNCtion:TRACking? 
Return: 1 
 
:CALCulate1:TRACe1:MARKer2:FUNCtion:TRACking OFF 
:CALCulate1:TRACe1:MARKer2:FUNCtion:TRACking? 
Return: 0 

 

3.2.78 Peak Search Excursion (:CALCulate{[1]-256}[:SELected]:MARKer
{[1]-10}:FUNCtion:PEXCursion) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:PEXCursion <numer
ic> 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:PEXCursion? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:PEXCursion <n
umeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:PEXCursion? 

Instruction  1. This command sets/gets the lower limit of peak excursion value when execu
ting the peak search with marker 1 to 9 (Mk) and reference marker (Mk:10), 
for the active trace of selected channel (Ch). Peak excursion value is the mi
nimum value of the difference relative to the right and left adjacent measure
ment points. 

2. This command sets/gets the lower limit of peak excursion value when execu
ting the peak search with marker 1 to 9 (Mk) and reference marker (Mk:10), 
for the selected trace of selected channel (Ch). Peak excursion value is the 
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minimum value of the difference relative to the right and left adjacent measu
rement points. 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500dB~500dB 

Return  Float 
Default  3dB 
Menu  Search > Peak > Excursion 
Example  :CALCulate1:MARKer2:FUNCtion:PEXCursion 2 

:CALCulate1:MARKer2:FUNCtion:PEXCursion? 
Return: 2 
 
:CALCulate1:TRACe1:MARKer2:FUNCtion:PEXCursion 6 
:CALCulate1:TRACe1:MARKer2:FUNCtion:PEXCursion? 
Return: 6 

 

3.2.79 Peak Search POLarity (:CALCulate{[1]-256}[:SELected]:MARKer
{[1]-10}:FUNCtion:PPOLarity) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:PPOLarity {POSitive
|NEGative|BOTH} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:PPOLarity? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:PPOLarity {PO
Sitive|NEGative|BOTH} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:PPOLarity? 

Instruction  1. This comamnd set/get the polarity of the peak search with marker 1 to 9 (M
k) and reference marker (Mk:10), for the active trace of selected channel (C
h). 

2. This comamnd set/get the polarity of the peak search with marker 1 to 9 (M
k) and reference marker (Mk:10), for the selected trace of selected channel 
(Ch). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 POSitive|NEGative|BOTH 

Return  Enumeration 
Default  POSitive 
Menu  Search > Peak > Peak Polarity 
Example  :CALCulate1:MARKer2:FUNCtion:PPOLarity NEGative 

:CALCulate1:MARKer2:FUNCtion:PPOLarity? 
Return: NEG 
 
:CALCulate1:TRACe1:MARKer2:FUNCtion:PPOLarity BOTH 
:CALCulate1:TRACe1:MARKer2:FUNCtion:PPOLarity? 
Return: BOTH 

 

3.2.80 Peak Search THReshold (:CALCulate{[1]-256}[:SELected]:MARKe
r{[1]-10}:FUNCtion:THReshold) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10}:FUNCtion:PEAK:THRe
shold <numeric> 
:CALCulate{[1]-256}:MEASure{[1]-256}:MARKer{[1]-10}:FUNCtion:PEAK:THRe
shold? 

Instruction  This comamnd set/get the threshold of the peak search with marker 1 to 9 (Mk) 
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and reference marker (Mk:10), for the selected trace of selected channel (Ch). 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500dB~500dB 

Return  Float 
Default  -100dB 
Menu  Search > Peak > THReshold 
Example  :CALCulate1:MEASure1:MARKer2:FUNCtion:PEAK:THReshold -20 

:CALCulate1:MEASure1:MARKer2:FUNCtion:PEAK:THReshold? 
Return: -20 

 

3.2.81 Target Search Value (:CALCulate{[1]-256}[:SELected]:MARKer{[1]
-10}:FUNCtion:TARGet) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TARGet <numeric> 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TARGet? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TARGet <nume
ric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TARGet? 

Instruction  1. This command sets/gets the target value to be searched with marker 1 to 9 
(Mk) and reference marker (Mk:10), for the active trace of selected channel 
(Ch). 

2. This command sets/gets the target value to be searched with marker 1 to 9 
(Mk) and reference marker (Mk:10), for the selected trace of selected chann
el (Ch). 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500dB~500dB 

Return  Float 
Default  0 dB 
Menu  Search > Target > Target Value 
Example  :CALCulate1:MARKer2:FUNCtion:TARGet 1 

:CALCulate1:MARKer2:FUNCtion:TARGet? 
Return: 1 
 
:CALCulate1:TRACe1:MARKer2:FUNCtion:TARGet -3 
:CALCulate1:TRACe1:MARKer2:FUNCtion:TARGet? 
Return: -3 

 

3.2.82 Transition Type of Target Search (:CALCulate{[1]-256}[:SELecte
d]:MARKer{[1]-10}:FUNCtion:TTRansition) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TTRansition  {POSiti
ve|NEGative|BOTH} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TTRansition ? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TTRansition  {P
OSitive|NEGative|BOTH} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TTRansition ? 

Instruction  1. This command selects the transition type of the target search, for marker 1 t
o 9 (Mk) and reference marker (Mk:10) of the active trace of selected chann
el (Ch). 

2. This command selects the transition type of the target search, for marker 1 t
o 9 (Mk) and reference marker (Mk:10) of the selected trace of selected cha
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nnel (Ch). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 POSitive|NEGative|BOTH 

Return  Enumeration 
Default  POSitive 
Menu  Search > Target > TRansition 
Example  :CALCulate1:MARKer2:FUNCtion:TTRansition NEGative 

:CALCulate1:MARKer2:FUNCtion:TTRansition? 
Return: NEG 
 
:CALCulate1:TRACe1:MARKer2:FUNCtion:TTRansition POSitive 
:CALCulate1:TRACe1:MARKer2:FUNCtion:TTRansition? 
Return: POS 

 

3.2.83 Marker Search Type (:CALCulate{[1]-256}[:SELected]:MARKer{[1]
-10}:FUNCtion:TYPE) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TYPE {MAXimum| 
MINimum|PEAK|LPEak|RPEak|TARGet|LTARget|RTARget} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:FUNCtion:TYPE? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TYPE {MAXim
um| MINimum|PEAK|LPEak|RPEak|TARGet|LTARget|RTARget} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:FUNCtion:TYPE? 

Instruction  1. This command selects the search type for marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the active trace of selected channel (Ch). 

2. This command selects the search type for marker 1 to 9 (Mk) and reference 
marker (Mk:10), for the selected trace of selected channel (Ch). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 MAXimum|MINimum|PEAK|LPEak|RPEak|TARGet|LTARget|RTARget 

Return  Enumeration 
Default  None 
Menu  Search > Max Search/Min Search 

Search > Peak Search/Peak Right Search/Peak Left Search 
Search > Target Search/Target Right Search/Target Left Search 

Example  :CALCulate1:MARKer1:FUNCtion:TYPE RTARget 
:CALCulate1:MARKer1:FUNCtion:TYPE? 
Return: RTAR 
 
:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE PEAK 
:CALCulate1:TRACe1:MARKer1:FUNCtion:TYPE? 
Return: PEAK 

 

3.2.84 Multi Peak Search Pexcurion (:CALCulate{[1]-256}[:SELected]:M
ARKer:FUNCtion:MULTi:PEXCursion) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion <numer
ic> 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:PEXCursion <n
umeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:PEXCursion? 
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Instruction  1. This command sets/gets the lower limit of multi peak excursion value when 
executing the peak search with marker 1 to 9 (Mk) and reference marker (M
k:10), for the active trace of selected channel (Ch). Peak excursion value is 
the minimum value of the difference relative to the right and left adjacent me
asurement points. 

2. This command sets/gets the lower limit of multi peak excursion value when 
executing the peak search with marker 1 to 9 (Mk) and reference marker (M
k:10), for the selected trace of selected channel (Ch). Peak excursion value 
is the minimum value of the difference relative to the right and left adjacent 
measurement points. 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500dB~500dB 

Return  Float 
Default  3 dB 
Menu  Search > Multi Peak&Target > Peak Excursion 
Example  :CALCulate1:MARKer:FUNCtion:MULTi:PEXCursion 2 

:CALCulate1:MARKer:FUNCtion:MULTi:PEXCursion? 
Return: 2 
 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PEXCursion 6 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PEXCursion? 
Return: 6 

 

3.2.85 Multi Peak Search POLarity (:CALCulate{[1]-256}[:SELected]:MA
RKer:FUNCtion:MULTi:PPOLarity) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity {POSitive
|NEGative|BOTH} 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:PPOLarity {PO
Sitive|NEGative|BOTH} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:PPOLarity? 

Instruction  1. This comamnd set/get the polarity of the multi peak search with marker 1 to 
9 (Mk) and reference marker (Mk:10), for the active trace of selected chann
el (Ch). 

2. This comamnd set/get the polarity of the multi peak search with marker 1 to 
9 (Mk) and reference marker (Mk:10), for the selected trace of selected cha
nnel (Ch). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 POSitive|NEGative|BOTH 

Return  Enumeration 
Default  POSitive 
Menu  Search > Multi Peak& Target > Peak Polarity 
Example  :CALCulate1:MARKer:FUNCtion:MULTi:PPOLarity BOTH 

:CALCulate1:MARKer:FUNCtion:MULTi:PPOLarity? 
Return: BOTH 
 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PPOLarity NEGative 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:PPOLarity? 
Return: NEG 

 

3.2.86 Multi Peak Search THReshold (:CALCulate{[1]-256}[:SELected]:M
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ARKer:FUNCtion:MULTi:THReshold) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:THReshold <numeri
c> 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:THReshold? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:THReshold <nu
meric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:THReshold? 

Instruction  1. This comamnd set/get the threshold of the multi peak search with marker 1 t
o 9 (Mk) and reference marker (Mk:10), for the selected trace of active chan
nel (Ch). 

2. This comamnd set/get the threshold of the multi peak search with marker 1 t
o 9 (Mk) and reference marker (Mk:10), for the selected trace of selected ch
annel (Ch). 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500dB~500dB 

Return  Float 
Default  -100 dB 
Menu  Search > Multi Peak&Target > Peak THReshold 
Example  :CALCulate1:MARKer:FUNCtion:MULTi:THReshold -20 

:CALCulate1:MARKer:FUNCtion:MULTi:THReshold? 
Return: -20 
 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold -30 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:THReshold? 
Return: -30 

 

3.2.87 Multi Target Search Value (:CALCulate{[1]-256}[:SELected]:MAR
Ker:FUNCtion:MULTi:TARGet) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:TARGet <numeric> 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:TARGet? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:TARGet <nume
ric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:TARGet? 

Instruction  1. This command sets/gets the multi target value to be searched with marker 1
 to 9 (Mk) and reference marker (Mk:10), for the active trace of selected cha
nnel (Ch). 

2. This command sets/gets the multi target value to be searched with marker 1
 to 9 (Mk) and reference marker (Mk:10), for the selected trace of selected c
hannel (Ch). 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500dB~500dB 

Return  Float 
Default  0 dB 
Menu  Search > Multi Peak&Target > Target Value  
Example  :CALCulate1:MARKer:FUNCtion:MULTi:TARGet -10 

:CALCulate1:MARKer:FUNCtion:MULTi:TARGet? 
Return: -10 
 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TARGet -5 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TARGet? 
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Return: -5 

 

3.2.88 Transition Type of Multi Target Search (:CALCulate{[1]-256}[:SEL
ected]:MARKer:FUNCtion:TTRansition) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:TTRansition  {POSiti
ve|NEGative|BOTH } 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:TTRansition ? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:TTRansition  {P
OSitive|NEGative|BOTH } 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:TTRansition ? 

Instruction  1. This command selects the transition type of the multi target search, for mark
er 1 to 9 (Mk) and reference marker (Mk:10) of the active trace of selected c
hannel (Ch). 

2. This command selects the transition type of the multi target search, for mark
er 1 to 9 (Mk) and reference marker (Mk:10) of the selected trace of selecte
d channel (Ch). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 POSitive|NEGative|BOTH 

Return  Enumeration 
Default  POSitive 
Menu  Search > Multi Peak&TTRansition  > TTRansition 
Example  :CALCulate1:MARKer:FUNCtion:MULTi:TTRansition NEGative 

:CALCulate1:MARKer:FUNCtion:MULTi:TTRansition? 
Return: NEG 
 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TTRansition POSitive 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TTRansition? 
Return: POS 

 

3.2.89 Search Type of Multi Peak&Target Search(:CALCulate{[1]-256}[:S
ELected]:MARKer:FUNCtion:MULTi:TYPE) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:TYPE {OFF| PEAK|
TARGet} 
:CALCulate{[1]-256}[:SELected]:MARKer:FUNCtion:MULTi:TYPE? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:TYPE {OFF| P
EAK|TARGet} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer:FUNCtion:MULTi:TYPE? 

Instruction  1. This command sets/gets the search type of the multi search of the active tra
ce of selected channel (Ch). 

2. This command sets/gets the search type of the multi search of the selected 
trace of selected channel (Ch). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 PEAK|TARGet|OFF 

Return  Enumeration 
Default  None 
Menu  None 
Example  :CALCulate1:MARKer:FUNCtion:MULTi:TYPE PEAK 

:CALCulate1:MARKer:FUNCtion:MULTi:TYPE? 
Return: PEAK 
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:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TYPE TARGet 
:CALCulate1:TRACe1:MARKer:FUNCtion:MULTi:TYPE? 
Return: TARG 

 

3.2.90 Notch Search State (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-
10}:NOTCh[:STATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:NOTCh[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:NOTCh[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:NOTCh[:STATe] {ON|OF
F|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:NOTCh[:STATe]? 

Instruction  1. This command turns ON/OFF the notch search result display, for the active 
trace of selected channel (Ch). 

2. This command turns ON/OFF the notch search result display, for the selecte
d trace of selected channel (Ch). 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Search > Notch  > Notch Search Enable 
Example  :CALCulate1:MARKer2:NOTCh ON 

:CALCulate1:MARKer2:NOTCh? 
Return: 1 
 
:CALCulate1:TRACe1:MARKer2:NOTCh OFF 
:CALCulate1:TRACe1:MARKer2:NOTCh? 
Return: 0 

 

3.2.91 Notch Search Level (:CALCulate{[1]-256}[:SELected]:MARKer{[1]-
10}:NOTCh:THReshold) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:NOTCh:THReshold <numeric> 
:CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:NOTCh:THReshold? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:NOTCh:THReshold <num
eric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:NOTCh:THReshold? 

Instruction  1. This command sets/gets the notch definition value of marker 1 to 9 (Mk) and
 reference marker (Mk:10), for the active trace of selected channel (Ch). 

2. This command sets/gets the notch definition value of marker 1 to 9 (Mk) and
 reference marker (Mk:10), for the selected trace of selected channel (Ch). 

Parameter 
Type 

 Float 

Parameter 
Range 

 -500dB~500dB 

Return  Float 
Default  -3 dB 
Menu  Search > Notch  > Notch Level 
Example  :CALCulate1:MARKer2:NOTCh:THReshold -6 

:CALCulate1:MARKer2:NOTCh:THReshold? 
Return: -6 
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:CALCulate1:TRACe1:MARKer2:NOTCh:THReshold -3 
:CALCulate1:TRACe1:MARKer2:NOTCh:THReshold? 
Return: -3 

 

3.2.92 Get Notch Search Data (:CALCulate{[1]-256}[:SELected]:MARKer
{[1]-10}:NOTCh:DATA?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MARKer{[1]-10}:NOTCh:DATA?  
:CALCulate{[1]-256}:TRACe{[1]-256}:MARKer{[1]-10}:NOTCh:DATA? 

Instruction  This command reads the notch search result of marker 1 to 9 (Mk) and referenc
e marker (Mk:10), for the active trace of selected channel (Ch). 
This command reads the notch search result of marker 1 to 9 (Mk) and referenc
e marker (Mk:10), for the selected trace of selected channel (Ch). 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Indicates 4-element array data (notch bandwidth search result). 
⚫ Data(0) :The bandwidth. 
⚫ Data(1) :Center point frequency of the 2 cutoff frequency points. 
⚫ Data(2) :The Q value. 
⚫ Data(3) :Insertion loss 
The index of the array starts from 0. 

Default  None 
Menu  None 
Example  :CALCulate1:MARKer2:NOTCh:DATA? 

:CALCulate1:TRACe1:MARKer2:NOTCh:DATA? 

 

3.2.93 Math Method (:CALCulate{[1]-256}[:SELected]:MATH:FUNCtion) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MATH:FUNCtion {NORMal|SUBTract|DIVide|A
DD|MULTiply} 
:CALCulate{[1]-256}[:SELected]:MATH:FUNCtion? 
:CALCulate{[1]-256}:TRACe{[1]-256}:MATH:FUNCtion {NORMal|SUBTract|DIVi
de|ADD|MULTiply} 
:CALCulate{[1]-256}:TRACe{[1]-256}:MATH:FUNCtion? 

Instruction  1. This command sets/gets the data trace display method (math method betwe
en measurement data and memory trace data), for the active trace of select
ed channel (Ch). 

2. This command sets/gets the data trace display method (math method betwe
en measurement data and memory trace data), for the selected trace of sel
ected channel (Ch). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 NORMal|SUBTract|DIVide|ADD|MULTiply 

Return  Enumeration 
Default  NORMal 
Menu  Math > Memory > Math 
Example  :CALCulate1:MATH:MEMorize 

:CALCulate1:MATH:FUNCtion SUBTract 
:CALCulate1:MATH:FUNCtion? 
Return: SUBT 
 
:CALCulate1:TRACe1:MATH:FUNCtion DIVide 
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:CALCulate1:TRACe1:MATH:FUNCtion? 
Return: DIV 

 

3.2.94 NORMalize (:CALCulate{[1]-256}[:SELected]:MATH:NORMalize) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MATH:NORMalize 
:CALCulate{[1]-256}:TRACe{[1]-256}:MATH:NORMalize 

Instruction  This command performs the same function as Data->Memory, then Data / Mem
ory.   

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Math > Memory > Normalize 
Example  :CALCulate1:MATH:NORMalize 

:CALCulate1:TRACe1:MATH:NORMalize 

 

3.2.95 Data to Memory (:CALCulate{[1]-256}[:SELected]:MATH:MEMoriz
e) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:MATH:MEMorize 
:CALCulate{[1]-256}:TRACe{[1]-256}:MATH:MEMorize 

Instruction  This command puts the active data trace into memory. You can store one mem
ory trace for every displayed trace. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Math > Memory > Data → Memory 
Example  :CALCulate1:MATH:MEMorize 

:CALCulate1:TRACe1:MATH:MEMorize 

 

3.2.96 Ripple Limit Test State (:CALCulate{[1]-256}[:SELected]:RLIMit[:S
TATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:RLIMit[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:RLIMit[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit[:STATe]? 

Instruction  1. This command turns ON/OFF the ripple test function for the active trace of s
elected channel. 

2. This command turns ON/OFF the ripple test function for the selected trace o
f selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math > Analysis > Limit > Ripple 
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Example  :CALCulate1:RLIMit ON 
:CALCulate1:RLIMit? 
Return: 1 
 
:CALCulate1:TRACe1:RLIMit OFF 
:CALCulate1:TRACe1:RLIMit? 
Return: 0 

 
 

3.2.97 Ripple Limit Test Sound State (:CALCulate{[1]-256}:MEASure{[1]-
256}:RLIMit:SOUNd) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:RLIMit:SOUNd {ON|OFF|1|0} 
:CALCulate{[1]-256}:MEASure{[1]-256}:RLIMit:SOUNd? 

Instruction  This command gets/sets Ripple limit testing fail sound state. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math > Analysis > Limit > Ripple 
Example  :CALCulate1:MEASure1:RLIMit:SOUNd ON 

:CALCulate1:MEASure1:RLIMit:SOUNd? 
Return: 1 

 

3.2.98 Ripple Limit Line State (:CALCulate{[1]-256}[:SELected]:RLIMit[:S
TATe]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:RLIMit:DISPlay:LINE {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:RLIMit:DISPlay:LINE? 
:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit:DISPlay:LINE {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit:DISPlay:LINE? 

Instruction  1. This command turns ON/OFF the ripple limit line display, for the active trac 
of selected channel (Ch). 

2. This command turns ON/OFF the ripple limit line display, for the selected tra
ce of selected channel (Ch). 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math > Analysis > Limit > Ripple 
Example  :CALCulate1:RLIMit:DISPlay:LINE ON 

:CALCulate1:RLIMit:DISPlay:LINE? 
Return: 1 
 
:CALCulate1:TRACe1:RLIMit:DISPlay:LINE OFF 
:CALCulate1:TRACe1:RLIMit:DISPlay:LINE? 
Return: 0 

 

3.2.99 Ripple Limit Data (:CALCulate{[1]-256}[:SELected]:RLIMit:DATA) 
 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:RLIMit:DATA <String> 
:CALCulate{[1]-256}[:SELected]:RLIMit:DATA? 
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:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit:DATA <String> 
:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit:DATA? 

Instruction  1. This command sets/gets the ripple limit table for the active trace of selected 
channel (Ch). 

2. This command sets/gets the ripple limit table for the selected trace of select
ed channel (Ch). 

Parameter 
Type 

 Data array 

Parameter 
Range 

 Indicates the array data (for ripple line) of 1 + Num (number of limit lines)\ 4. Wh
ere n is an integer between 1 and Num. 
 
⚫ Data(0) :The number of limit lines you want to set. Specify an integer rangin

g 0 to 12. When the number of limit lines is set to 0 (clears the limit table), t
he variable Data is only required with Data(0). 

⚫ Data(nx4-3) :The type of the n-th line. 
Specify an integer 0 to 1 as follows. 
0:UNUSED 
1:ON 
2:OFF 

⚫ Data(nx4-2) :The value on the horizontal axis (frequency/power/time) of the
 start point of the n-th line. 

⚫ Data(nx4-1) :The value on the horizontal axis (frequency/power/time) of the
 end point of the n-th line. 

⚫ Data(nx4) :The ripple line value (dB) of the n-th line. 
 
The index of the array starts from 0. 
 

Return  Data array 
Default  None 
Menu  Math > Analysis > Limit > Ripple 
Example  :CALC1:RLIM:DATA 2,1,1E9,3E9,3,1,5E9,7E9,3 

:CALC1:RLIM:DATA? 
Return: 2,1,1000000000,3000000000,3,1,5000000000,7000000000,3 
 
:CALCulate1:TRACe1:RLIMit:DATA 2,1,1E9,2E9,3,0,5E9,6E9,-3 
:CALCulate1:TRACe1:RLIMit:DATA? 
Return: 2,1,1000000000,2000000000,3,0,5000000000,6000000000,-3 

 

3.2.100 Get Ripple Result (:CALCulate{[1]-256}[:SELected]:RLIMit:REPort
[:DATA]?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:RLIMit:REPort[:DATA]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit:REPort[:DATA]? 

Instruction  1. This command reads the ripple value of the ripple test for the active trace of 
selected channel (Ch). 

2. This command reads the ripple value of the ripple test for the selected trace 
of selected channel (Ch). 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Indicates the array data (for ripple line) of 1 + Num (number of limit lines)*3. Wh
ere n is an integer between 1 and 12. 
 
⚫ Data(0): Number of ripple limit line. 
⚫ Data(nx3-2): Number of ripple limit bands. 
⚫ Data(nx3-1): Ripple value. 
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⚫ Data(nx3): Results of ripple test. 
Select from the following. 
0: PASS 
1: FAIL. 

 
The index of the array starts from 0. 

Default  0 
Menu  Math > Analysis > Limit > Ripple 
Example  :CALCulate1:RLIMit:REPort? 

:CALCulate1:TRACe1:RLIMit:REPort? 
 

3.2.101 Ripple Limit Test Result (:CALCulate{[1]-256}[:SELected]:RLIMit:
FAIL?) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:RLIMit:FAIL? 
:CALCulate{[1]-256}:TRACe{[1]-256}:RLIMit:FAIL? 

Instruction  1. This command reads the ripple test result for the active trace of selected ch
annel (Ch). 

2. This command reads the ripple test result for the selected trace of selected 
channel (Ch). 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  1|0 
1: Fail 
0: Pass  

Default  None 
Menu  None 
Example  :CALCulate1:RLIMit:FAIL? 

:CALCulate1:TRACe1:RLIMit:FAIL? 
 

3.2.102 Smooth State (:CALCulate{[1]-256}[:SELected]:SMOothing[:STAT
e]) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SMOothing[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}[:SELected]:SMOothing[:STATe]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SMOothing[:STATe] {ON|OFF|1|0} 
:CALCulate{[1]-256}:TRACe{[1]-256}:SMOothing[:STATe]? 

Instruction  1. This command turns ON/OFF the smoothing for the active trace of selected 
channel (Ch). 

2. This command turns ON/OFF the smoothing for the selected trace of select
ed channel (Ch). 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  AVG BW > Smoothing > Smoothing 
Example  :CALCulate1:SMOothing ON 

:CALCulate1:SMOothing? 
Return: 1 
 
:CALCulate1:TRACe1:SMOothing OFF 
:CALCulate1:TRACe1:SMOothing? 
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Return: 0 
 

3.2.103 Smooth Aperture (:CALCulate{[1]-256}[:SELected]:SMOothing:A
PERture) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SMOothing:APERture <numeric> 
:CALCulate{[1]-256}[:SELected]:SMOothing:APERture? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SMOothing:APERture <numeric> 
:CALCulate{[1]-256}:TRACe{[1]-256}:SMOothing:APERture? 

Instruction  1. This command sets/gets the smoothing aperture for the active trace of selec
ted channel (Ch). 

2. This command sets/gets the smoothing aperture for the selected trace of sel
ected channel (Ch). 

Parameter 
Type 

 float, unit % 

Parameter 
Range 

 0~100 

Return  Float, unit % 
Default  2.49 
Menu  AVG BW > Smoothing > Smoothing Percent 
Example  :CALCulate1:SMOothing:APERture 14.43 

:CALCulate1:SMOothing:APERture? 
Return: 14.4278606965174 
 
:CALCulate1:TRACe1:SMOothing:APERture 20 
:CALCulate1:TRACe1:SMOothing:APERture? 
Return: 19.4029850746269 

 

3.2.104 Smooth Points (:CALCulate{[1]-256}:MEASure{[1]-256}:SMOothin
g:POINts) 

 

Command 
Format 

 :CALCulate{[1]-256}:MEASure{[1]-256}:SMOothing:POINts <numeric> 
:CALCulate{[1]-256}:MEASure{[1]-256}:SMOothing:POINts? 

Instruction  This command sets/gets the smoothing points for the active trace of selected ch
annel (Ch). 

Parameter 
Type 

 interger 

Parameter 
Range 

 1~4999 

Return  Interger 
Default  5 
Menu  AVG BW > Smoothing > Smoothing Points 
Example  :CALCulate1:MEASure1:SMOothing:POINts 15 

:CALCulate1:MEASure1:SMOothing:POINts? 
Return: 15 

 

3.2.105 Reset Trace (:CALCulate{[1]-256}:TRACe{[1]-256}:HOLD:CLEar) 
 

Command 
Format 

 :CALCulate{[1]-256}:TRACe{[1]-256}:HOLD:CLEar 

Instruction  This command clears/resets the trace hold function that holds the active trace at
 either the maximum or minimum point. 

Parameter 
Type 

 None 

javascript:BSSCPopup('../link/Val_Ch.htm');
javascript:BSSCPopup('../link/Val_Ch.htm');
javascript:BSSCPopup('../link/Val_Ch.htm');


64 SNA5000A Programming Guide 

 

 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Display > Trace Setup > Trace Hold > Restart 
Example  :CALCulate1:TRACe1:HOLD:CLEar 

 

3.2.106 Trace Hold Type (:CALCulate{[1]-256}:TRACe{[1]-256}:HOLD[:TY
PE]) 

 

Command 
Format 

 :CALCulate{[1]-256}:TRACe{[1]-256}:HOLD[:TYPE] {OFF| MAXimum|MINimum} 
:CALCulate{[1]-256}:TRACe{[1]-256}:HOLD[:TYPE]? 

Instruction  This command sets/gets maximum/minimum trace hold function to hold the acti
ve trace at the maximum or minimum point. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 OFF| MAXimum|MINimum 

Return  Enumeration 
Default  OFF 
Menu  Display > Trace Setup > Trace Hold 
Example  :CALCulate1:TRACe1:HOLD MAXimum 

:CALCulate1:TRACe1:HOLD? 
Return: MAX 

 

3.2.107 Impedance (Imaginary) of Port Z Conversion (:CALCulate{[1]-256}:
FSIMulator:SENDed:ZCONversion:PORT{[1]-4}:IMAGinary) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:PORT{[1]-4}:IMAGinary
 <numeric> 
:CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:PORT{[1]-4}:IMAGinar
y? 

Instruction  This command sets/gets the impedance value (imaginary part) for the port impe
dance conversion function, for the ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 -1E+18 ~ 1E+18 

Return  Float, unit: ohm 
Default  0 
Menu  Cal > Fixtures > Port Z Conversion > jX 
Example  :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:IMAGinary 100 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:IMAGinary? 
Return: 100 

 

3.2.108 Impedance (Real) of Port Z Conversion (:CALCulate{[1]-256}:FSI
Mulator:SENDed:ZCONversion:PORT{[1]-4}:REAL) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:PORT{[1]-4}:REAL <nu
meric> 
:CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:PORT{[1]-4}:REAL? 

Instruction  This command sets/gets the impedance value (real part) for the port impedance
 conversion function, for the ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 



SNA5000A Programming Guide           65 

 

 

Parameter 
Range 

 0.001 to 1E7 

Return  Float, unit: ohm 
Default  50 
Menu  Cal > Fixtures > Port Z Conversion > R 
Example  :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:REAL 75 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:REAL? 
Return: 75 

 

3.2.109 Impedance of Port Z Conversion (:CALCulate{[1]-256}:FSIMulator:
SENDed:ZCONversion:PORT{[1]-4}:Z0[:R]) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:PORT{[1]-4}:Z0[:R] <nu
meric> 
:CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:PORT{[1]-4}:Z0[:R]? 

Instruction  This command sets/gets the impedance value for the port impedance conversio
n function, for the ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 0.001 to 1E7 

Return  Float, unit: ohm 
Default  50 
Menu  Cal > Fixtures > Port Z Conversion > R 
Example  :CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:Z0 100 

:CALCulate1:FSIMulator:SENDed:ZCONversion:PORT1:Z0? 
Return: 100 

 

 

3.2.110 State of Port Z Conversion (:CALCulate{[1]-256}:FSIMulator:SEN
Ded:ZCONversion:STATe) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:SENDed:ZCONversion:STATe? 

Instruction  This command turns ON/OFF the port impedance conversion function when the
 fixture simulator function is ON, for all the ports of the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > Port Z Conversion 
Example  :CALCulate1:FSIMulator:SENDed:ZCONversion:STATe ON 

:CALCulate1:FSIMulator:SENDed:ZCONversion:STATe? 
Return: 1 

 

 

3.2.111 C Value of the Matching Circuit (:CALCulate{[1]-256}:FSIMulator:
SENDed:PMCircuit:PORT{[1]-4}:PARameters:C{[1]-2}) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:
C{[1]-2} <numeric> 
:CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:
C{[1]-2}? 

Instruction  This command sets/gets the C value of the matching circuit, for the ports of sele
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cted channel. 

Parameter 
Type 

 Float, unit F (farad) 

Parameter 
Range 

 None 

Return  Float, unit F (farad) 
Default  0 
Menu  Cal > Fixtures > Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:C 10e-9 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:C? 
Return: 1e-08 

 

3.2.112 G Value of the Matching Circuit (:CALCulate{[1]-256}:FSIMulator:
SENDed:PMCircuit:PORT{[1]-4}:PARameters:G{[1]-2}) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:
G{[1]-2} <numeric> 
:CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:
G{[1]-2}? 

Instruction  This command sets/gets the G value of the matching circuit, for the ports of sele
cted channel. 

Parameter 
Type 

 Float, unit S (siemens) 

Parameter 
Range 

 None 

Return  Float, unit S (siemens) 
Default  0 
Menu  Cal > Fixtures > Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:G1 10 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:G1? 
Return: 10 

 

3.2.113 L Value of the Matching Circuit (:CALCulate{[1]-256}:FSIMulator:
SENDed:PMCircuit:PORT{[1]-4}:PARameters:L{[1]-2}) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:L
{[1]-2} <numeric> 
:CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:L
{[1]-2}? 

Instruction  This command sets/gets the L value of the matching circuit, for the ports of sele
cted channel. 

Parameter 
Type 

 Float, unit H (henry) 

Parameter 
Range 

 None 

Return  Float, unit H (henry) 
Default  0 
Menu  Cal > Fixtures > Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:L1 5 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:L1? 
Return: 5 

 

3.2.114 R Value of the Matching Circuit (:CALCulate{[1]-256}:FSIMulator:
SENDed:PMCircuit:PORT{[1]-4}:PARameters:R{[1]-2}) 
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Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:
R{[1]-2} <numeric> 
:CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:PARameters:
R{[1]-2}? 

Instruction  This command sets/gets the R value of the matching circuit, for the ports of sele
cted channel. 

Parameter 
Type 

 Float, unit ohm 

Parameter 
Range 

 None 

Return  Float, unit ohm 
Default  0 
Menu  Cal > Fixtures > Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:R2 25 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:PARameters:R2? 
Return: 25 

 

3.2.115 Type of the Matching Circuit (:CALCulate{[1]-256}:FSIMulator:SE
NDed:PMCircuit:PORT{[1]-4}[:TYPE]) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}[:TYPE] {NON
E| SLPC|PCSL|PLSC|SCPL|PLPC|SCPC|PCSC|SLPL|PLSL|USER} 
:CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}[:TYPE]? 

Instruction  This command sets/gets the type of the matching circuit, for the ports of selecte
d channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 ⚫ "NONE": Specifies no-circuit. 
⚫ "SLPC": Specifies the circuit that consists of series L and shunt C. 
⚫ "PCSL": Specifies the circuit that consists of shunt C and series L. 
⚫ "PLSC": Specifies the circuit that consists of shunt L and series C. 
⚫ "SCPL": Specifies the circuit that consists of series C and shunt L. 
⚫ "PLPC": Specifies the circuit that consists of shunt L and shunt C. 
⚫ "SCPC": Specifies the circuit that consists of series C and shunt C.  
⚫ "PCSC": Specifies the circuit that consists of shunt C and series C. 
⚫ "SLPL": Specifies the circuit that consists of series L and shunt L. 
⚫ "PLSL": Specifies the circuit that consists of shunt L and series L. 
⚫ "USER": Specifies the user-defined circuit. 

Return  Enumeration 
Default  SLPC 
Menu  Cal > Fixtures > Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT PLSL 

:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1? 
Return: PLSL 

 

3.2.116 Touchstone Filename for The Matching Circuit Model(:CALCulate
{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:USER:FILen
ame) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:USER:FILena
me <string> 
:CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:PORT{[1]-4}:USER:FILena
me? 

Instruction  This command sets/gets the file in which the information on the user-defined ma
tching circuit is saved (2-port touchstone file), for the ports of selected channel. 
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Parameter 
Type 

 String 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Cal > Fixtures > Port Matching > Match S2P File 
Example  :CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:USER:FILename "local/tes

t.s2p" 
:CALCulate1:FSIMulator:SENDed:PMCircuit:PORT1:USER:FILename? 
Return: local/test.s2p 

 

3.2.117 State of the Match Circuit Embedding Function (:CALCulate{[1]-2
56}:FSIMulator:SENDed:PMCircuit:STATe) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:SENDed:PMCircuit:STATe? 

Instruction  This command turns ON/OFF the matching circuit embedding function when the
 fixture simulator function is ON, for all the ports of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > Port Matching 
Example  :CALCulate1:FSIMulator:SENDed:PMCircuit:STATe ON 

:CALCulate1:FSIMulator:SENDed:PMCircuit:STATe? 
Return: 1 

 

3.2.118 State of the Network De-embedding Function (:CALCulate{[1]-25
6}:FSIMulator:SENDed:DEEMbed:STATe) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:STATe? 

Instruction  This command turns ON/OFF the network de-embedding function when the fixt
ure simulator function is ON, for all the ports of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > 2 Port De-embedding 
Example  :CALCulate1:FSIMulator:SENDed:DEEMbed:STATe ON 

:CALCulate1:FSIMulator:SENDed:DEEMbed:STATe? 
Return: 1 

 

3.2.119 Touchstone Filename for the Network De-embedding Function(:C
ALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:PORT{[1]-4}:US
ER:FILename) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:PORT{[1]-4}:USER:FILena
me <string> 
:CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:PORT{[1]-4}:USER:FILena
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me? 

Instruction  This command sets/gets the file in which the information on the user-defined net
work for the network de-embedding funciton is saved (2-port touchstone file), for
 the ports of selected channel. 

Parameter 
Type 

 String 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Cal > Fixtures > 2 Port De-embedding > Select De-embedding 
Example  :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:USER:FILename "local/te

st.s2p" 
:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:USER:FILename? 
Return: local/test.s2p 

 

3.2.120 Type of the Network De-embedding Function(:CALCulate{[1]-256}:
FSIMulator:SENDed:DEEMbed:PORT{[1]-4}[:TYPE]) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:PORT{[1]-4}[:TYPE] {NON
E|USER} 
:CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:PORT{[1]-4}[:TYPE]? 

Instruction  This command sets/gets the type of the network de-embedding funciton, for the 
ports of selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 ⚫ "NONE": Specifies no network de-embedding. 
⚫ "USER": Specifies the user-defined network de-embedding. 

Return  Enumeration 
Default  NONE 
Menu  Cal > Fixtures > 2Port De-embedding > De-embedding Type 
Example  :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1 USER 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1? 
Return: USER 

 

3.2.121 State of the Reverse Adapter Ports (:CALCulate{[1]-256}:FSIMulat
or:SENDed:DEEMbed:PORT{[1]-4}:SNP:REVerse) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:PORT{[1]-4}:SNP:REVerse
 {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:SENDed:DEEMbed:PORT{[1]-4}:SNP:REVers
e? 

Instruction  This command set and read whether or not to reverse ports on a 2-port fixture o
r adapter to be de-embedded. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > 2 Port De-embedding > Reverse Adapter Ports 
Example  :CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:SNP:REVerse ON 

:CALCulate1:FSIMulator:SENDed:DEEMbed:PORT1:SNP:REVerse? 
Return: 1 
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3.2.122 4 Port Touchstone Filename for the Network Embedding/De-emb
edding Feature(:CALCulate{[1]-256}:FSIMulator:EMBed:NETWork
{[1]-4}:FILename) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:EMBed:NETWork{[1]-4}:FILename <string> 
:CALCulate{[1]-256}:FSIMulator:EMBed:NETWork{[1]-4}:FILename? 

Instruction  This command specifies a file in which the information of network (which you wa
nt to embed/de-embed using the 4-port network embedding/de-embedding feat
ure) is saved for the selected channel. The file is saved as a 4-port touchstone fi
le with the ".s4p" extension. 

Parameter 
Type 

 String 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Cal > Fixtures > 4/6/8-Port Embed/De-embed 
Example  :CALCulate1:FSIMulator:EMBed:NETWork1:FILename "local/test.s4p" 

:CALCulate1:FSIMulator:EMBed:NETWork1:FILename? 
Return: local/test.s4p 

 

3.2.123 Processing Type of Network (:CALCulate{[1]-256}:FSIMulator:EM
Bed:NETWork{[1]-4}:TYPE) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:EMBed:NETWork{[1]-4}:TYPE {NONE|EMBed|
DEEMbed } 
:CALCulate{[1]-256}:FSIMulator:EMBed:NETWork{[1]-4}:TYPE? 

Instruction  This command sets/gets the processing type for networks, for the 4-port networ
k embedding/de-embedding feature for the selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 ⚫ "NONE": Specifies no-processing. 
⚫ "EMBed": Specifies embedding. 
⚫ "DEEMbed": Specifies de-embedding. 

Return  Enumeration 
Default  NONE 
Menu  Cal > Fixtures > 4/6/8-Port Embed/De-embed 
Example  :CALCulate1:FSIMulator:EMBed:NETWork1:TYPE DEEMbed 

:CALCulate1:FSIMulator:EMBed:NETWork1:TYPE? 
Return: DEEM 

 

3.2.124 State of 4 Port Network Embedding/De-embedding Feature (:CAL
Culate{[1]-256}:FSIMulator:EMBed:STATe) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:EMBed:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:EMBed:STATe? 

Instruction  This command turns ON/OFF the 4-port network embedding/de-embedding feat
ure when the fixture simulator feature is ON, for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > 4/6/8-Port Embed/De-embed 
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Example  :CALCulate1:FSIMulator:EMBed:STATe ON 
:CALCulate1:FSIMulator:EMBed:STATe?  
Return: 1 

 

3.2.125 Connection Mode of 4 Port Network Embedding/De-embedding F
eature (:CALCulate{[1]-256}:FSIMulator:EMBed:TYPE) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:EMBed:TYPE {A|B|C} 
:CALCulate{[1]-256}:FSIMulator:EMBed:TYPE? 

Instruction  This command selects a connection type (Topology), for the 4-port network emb
edding/de-embedding feature for channels. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 ⚫ "A":Specifies connection type A. 
⚫ "B":Specifies connection type B. 
⚫ "C":Specifies connection type C. 

Return  Enumeration 
Default  A 
Menu  Cal > Fixtures > 4/6/8-Port Embed/De-embed > Topology 
Example  :CALCulate1:FSIMulator:EMBed:TYPE B 

:CALCulate1:FSIMulator:EMBed:TYPE? 
Return: B 

 

3.2.126 Specifies Port Connections in Type A (:CALCulate{[1]-256}:FSIM
ulator:EMBed:TOPology:A:PORTs) 

 

SNA NetWork1 DUT
1

2 4

3a

b

 
 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:EMBed:TOPology:A:PORTs <numeric1>,<num
eric 2> 
:CALCulate{[1]-256}:FSIMulator:EMBed:TOPology:A:PORTs? 

Instruction  This command sets/gets the test port assignment when the connection type (To
pology) is set to A, for the 4-port network embedding/de-embedding feature for 
selected channel. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 <numeric1>: VNA Port number assigned to a in above graphic. 
<numeric2>: VNA Port number assigned to b in above graphic. 

Return  Data array 
Default  1,2 
Menu  Cal > Fixtures > 4/6/8-Port Embed/De-embed 
Example  :CALCulate1:FSIMulator:EMBed:TOPology:A:PORTs 2,1 

:CALCulate1:FSIMulator:EMBed:TOPology:A:PORTs? 
Return: 2,1 

 

3.2.127 Specifies Port Connections in Type B (:CALCulate{[1]-256}:FSIM
ulator:EMBed:TOPology:B:PORTs) 
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Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:EMBed:TOPology:B:PORTs <numeric1>,<num
eric2>,<numeric3> 
:CALCulate{[1]-256}:FSIMulator:EMBed:TOPology:B:PORTs? 

Instruction  This command sets/gets test port assignment when the connection type (Topolo
gy) is set to B, for the 4-port network embedding/de-embedding feature for sele
cted channel. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 <numeric1>: VNA Port number assigned to a in above graphic. 
<numeric2>: VNA Port number assigned to b in above graphic. 
<numeric3>: VNA Port number assigned to c in above graphic. 

Return  Data array 
Default  1,2,3 
Menu  Cal > Fixtures > 4/6/8-Port Embed/De-embed 
Example  :CALCulate1:FSIMulator:EMBed:TOPology:B:PORTs 2,1,3 

:CALCulate1:FSIMulator:EMBed:TOPology:B:PORTs? 
Return: 2,1,3 

 

3.2.128 Specifies Port Connections in Type C (:CALCulate{[1]-256}:FSIM
ulator:EMBed:TOPology:C:PORTs) 

 

SNA NetWork1 DUT
1

2 4

3a

b

SNANetWork2
3

4 2

1 c

d

 
 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:EMBed:TOPology:C:PORTs <numeric1>,<num
eric2>,<numeric3>,<numeric4> 
:CALCulate{[1]-256}:FSIMulator:EMBed:TOPology:C:PORTs? 

Instruction  This command sets/gets test port assignment when the connection type (Topolo
gy) is set to C, for the 4-port network embedding/de-embedding feature for sele
cted channel. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 <numeric1>: VNA Port number assigned to a in above graphic. 
<numeric2>: VNA Port number assigned to b in above graphic. 
<numeric3>: VNA Port number assigned to c in above graphic. 
<numeric4>: VNA Port number assigned to d in above graphic. 

Return  Data array 
Default  1,2,3,4 
Menu  Cal > Fixtures > 4/6/8-Port Embed/De-embed 
Example  :CALCulate1:FSIMulator:EMBed:TOPology:C:PORTs 2,1,3,4 

:CALCulate1:FSIMulator:EMBed:TOPology:C:PORTs? 
Return: 2,1,3,4 

 

3.2.129 State of the Differential Port Matching Function (:CALCulate{[1]-2
56}:FSIMulator:BALun:DMCircuit:STATe) 
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Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:STATe? 

Instruction  This command turns ON/OFF the differential port matching function when the fix
ture simulator function is ON, for all the logical ports of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > Differential Port Matching > Enable Differential Port Matching 
Example  :CALCulate1:FSIMulator:BALun:DMCircuit:STATe ON 

:CALCulate1:FSIMulator:BALun:DMCircuit:STATe? 
Return: 1 

3.2.130 Type of the Differential Port Matching Circuit (:CALCulate{[1]-25
6}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}[:TYPE]) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}[:TYPE] {NONE|
PLPC|USER} 
:CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}[:TYPE]? 

Instruction  This command sets/gets the type of the differential port matching circuit, for the 
logical ports of selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 "NONE": Specifies no-circuit. 
"PLPC": Specifies the circuit that consists of shunt L and shunt C. 
"USER": Specifies the user-defined circuit. 

Return  Enumeration 
Default  NONE 
Menu  Cal > Fixtures > Differential Port Matching > Select Circuit 
Example  :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1 PLPC 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1? 
Return: PLPC 

3.2.131 Touchstone Filename for the Differential Port Matching Circuit (:
CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:U
SER:FILename) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:USER:FILenam
e <string> 
:CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:USER:FILenam
e? 

Instruction  This command sets/gets the file in which the information on the user-defined net
work for the differential port matching funciton is saved (2-port touchstone file), f
or the logical ports of selected channel. 

Parameter 
Type 

 String 

Parameter 
Range 

 None 

Return  String 
Default  None 
Menu  Cal > Fixtures > Differential Port Matching > Browse... 
Example  :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:USER:FILename "local/test.

s2p" 
:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:USER:FILename? 
Return: local/test.s2p 
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3.2.132 C Value of the Differential Port Matching Circuit (:CALCulate{[1]-2

56}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:C) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:C 
<numeric> 
:CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:
C? 

Instruction  This command sets/gets the C value of the differential port matching circuit, for t
he logical ports of selected channel. 

Parameter 
Type 

 Float, unit F (farad) 

Parameter 
Range 

 None 

Return  Float, unit F (farad) 
Default  0 
Menu  Cal > Fixtures > Differential Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:C 1e-11 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:C? 
Return: 1e-11 

3.2.133 G Value of the Differential Port Matching Circuit (:CALCulate{[1]-

256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:G) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:G 
<numeric> 
:CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:
G? 

Instruction  This command sets/gets the G value of the differential port matching circuit, for t
he logical ports of selected channel. 

Parameter 
Type 

 Float, unit S (siemens) 

Parameter 
Range 

 None 

Return  Float, unit S (siemens) 
Default  0 
Menu  Cal > Fixtures > Differential Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:G 5e-2 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:G? 
Return: 5e-2 

3.2.134 L Value of the Differential Port Matching Circuit (:CALCulate{[1]-2

56}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:L) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:L 
<numeric> 
:CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:L? 

Instruction  This command sets/gets the L value of the differential port matching circuit, for t
he logical ports of selected channel. 

Parameter 
Type 

 Float, unit H (henry) 

Parameter 
Range 

 None 

Return  Float, unit H (henry) 
Default  0 
Menu  Cal > Fixtures > Differential Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:L 1e-8 
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:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:L? 
Return: 1e-8 

3.2.135 R Value of the Differential Port Matching Circuit (:CALCulate{[1]-2

56}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:R) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:R 
<numeric> 
:CALCulate{[1]-256}:FSIMulator:BALun:DMCircuit:BPORt{[1]-2}:PARameters:
R? 

Instruction  This command sets/gets the R value of the differential port matching circuit, for t
he logical ports of selected channel. 

Parameter 
Type 

 Float, unit ohm 

Parameter 
Range 

 None 

Return  Float, unit ohm 
Default  0 
Menu  Cal > Fixtures > Differential Port Matching > Circuit Model 
Example  :CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:R 25 

:CALCulate1:FSIMulator:BALun:DMCircuit:BPORt1:PARameters:R? 
Return: 25 

3.2.136 State of the Differential Port Z Conversation Function (:CALCulat
e{[1]-256}:FSIMulator:BALun:DZConversion:STATe) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:STATe? 

Instruction  This command turns ON/OFF the differential port impedance conversion functio
n when the fixture simulator function is ON, for all the logical ports of the selecte
d channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > Differential Z > Enable Differential Z Conversation 
Example  :CALCulate1:FSIMulator:BALun:DZConversion:STATe ON 

:CALCulate1:FSIMulator:BALun:DZConversion:STATe? 
Return: 1 

3.2.137 Impedance (Real) of the Differential Port (:CALCulate{[1]-256}:FSI
Mulator:BALun:DZConversion:BPORt{[1]-2}:Z0[:R]) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:BPORt{[1]-2}:Z0[:R] <nu
meric> 
:CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:BPORt{[1]-2}:Z0[:R]? 

Instruction  This command sets/gets the impedance value (real part) for the differential port 
impedance conversion function, for the logical ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 1E-3 ~ 1E7 

Return  Float, unit: ohm 
Default  100 
Menu  Cal > Fixtures > differential Z > R 
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Example  :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:Z0 100 
:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:Z0? 
Return: 100 

3.2.138 Impedance (Real) of the Differential Port (:CALCulate{[1]-256}:FSI
Mulator:BALun:DZConversion:BPORt{[1]-2}:REAL) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:BPORt{[1]-2}:REAL <nu
meric> 
:CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:BPORt{[1]-2}:REAL? 

Instruction  This command sets/gets the impedance value (real part) for the differential port 
impedance conversion function, for the logical ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 1E-3 ~ 1E7 

Return  Float, unit: ohm 
Default  100 
Menu  Cal > Fixtures > differential Z > R 
Example  :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:REAL 100 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:REAL? 
Return: 100 

3.2.139 Impedance (Imaginary) of the Differential Port (:CALCulate{[1]-25
6}:FSIMulator:BALun:DZConversion:BPORt{[1]-2}:IMAGinary) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:BPORt{[1]-2}:IMAGinary 
<numeric> 
:CALCulate{[1]-256}:FSIMulator:BALun:DZConversion:BPORt{[1]-2}:IMAGinar
y? 

Instruction  This command sets/gets the impedance value (imaginary part) for the differentia
l port impedance conversion function, for the logical ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 1E-3 ~ 1E7 

Return  Float, unit: ohm 
Default  0 
Menu  Cal > Fixtures > differential Z > jX 
Example  :CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:IMAGinary 100 

:CALCulate1:FSIMulator:BALun:DZConversion:BPORt1:IMAGinary? 
Return: 100 

3.2.140 State of the Common Port Z Conversation Function (:CALCulate
{[1]-256}:FSIMulator:BALun:CZConversion:STATe) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:STATe? 

Instruction  This command turns ON/OFF the common port impedance conversion function 
when the fixture simulator function is ON, for all the logical ports of the selected 
channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > Common Z > Enable Common Z Conversation 
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Example  :CALCulate1:FSIMulator:BALun:CZConversion:STATe ON 
:CALCulate1:FSIMulator:BALun:CZConversion:STATe? 
Return: 1 

3.2.141 Impedance (Real) of the Common Port (:CALCulate{[1]-256}:FSIM
ulator:BALun:CZConversion:BPORt{[1]-2}:Z0[:R]) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:BPORt{[1]-2}:Z0[:R] <nu
meric> 
:CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:BPORt{[1]-2}:Z0[:R]? 

Instruction  This command sets/gets the impedance value (real part) for the common port i
mpedance conversion function, for the logical ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 1E-3 ~ 1E7 

Return  Float, unit: ohm 
Default  25 
Menu  Cal > Fixtures > Common Z > R 
Example  :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:Z0 100 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:Z0? 
Return: 100 

3.2.142 Impedance (Real) of the Common Port (:CALCulate{[1]-256}:FSIM
ulator:BALun:CZConversion:BPORt{[1]-2}:REAL) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:BPORt{[1]-2}:REAL <nu
meric> 
:CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:BPORt{[1]-2}:REAL? 

Instruction  This command sets/gets the impedance value (real part) for the common port i
mpedance conversion function, for the logical ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 1E-3 ~ 1E7 

Return  Float, unit: ohm 
Default  25 
Menu  Cal > Fixtures > Common Z > R 
Example  :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:REAL 100 

:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:REAL? 
Return: 100 

3.2.143 Impedance (Imaginary) of the Common Port (:CALCulate{[1]-256}:
FSIMulator:BALun:CZConversion:BPORt{[1]-2}:IMAGinary) 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:BPORt{[1]-2}:IMAGinary 
<numeric> 
:CALCulate{[1]-256}:FSIMulator:BALun:CZConversion:BPORt{[1]-2}:IMAGinar
y? 

Instruction  This command sets/gets the impedance value (imaginary part) for the common 
port impedance conversion function, for the logical ports of selected channel. 

Parameter 
Type 

 Float, unit: ohm 

Parameter 
Range 

 1E-3 ~ 1E7 

Return  Float, unit: ohm 
Default  0 
Menu  Cal > Fixtures > Common Z > jX 
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Example  :CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:IMAGinary 100 
:CALCulate1:FSIMulator:BALun:CZConversion:BPORt1:IMAGinary? 
Return: 100 

3.2.144 State of Fixture Simulator (:CALCulate{[1]-256}:FSIMulator:STAT
e) 

 

Command 
Format 

 :CALCulate{[1]-256}:FSIMulator:STATe {ON|OFF|1|0} 
:CALCulate{[1]-256}:FSIMulator:STATe? 

Instruction  This command turns ON/OFF the fixture simulator function of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Fixtures > Apply Fixtures 
Example  :CALCulate1:FSIMulator:STATe ON 

:CALCulate1:FSIMulator:STATe? 
Return: 1 

 

3.2.145 Gets the formatted data of multiple traces (:CALCulate{[1]-256}:D
ATA:MFData?) 

Command 
Format 

 :CALCulate{[1]-256}:DATA:MFData <trc_num>? 

Instruction  gets the formatted data array of multiple traces (traces-n, m, .... to l) of the selec
ted channel (Ch). 

Parameter 
Type 

 String  

Parameter 
Range 

 "n, m, l, ..."  
where n, m, l are 1 to the maximum trace number. 
Use comma for separator of trace number. 

Return  Array 
Default  None  
Menu  None  
Example  :CALC:DATA:MFData? "1,2,3" 

Return：8.457302793195e-02,0.000000000000e+00,-1.426901425958e-01,0.0

00000000000e+00,-2.635991012650e-01,0.000000000000e+00,-2.839929320
553e-01,0.000000000000e+00,-3.315815592045e-01,0.000000000000e+00,-3.
528884698654e-01,0.000000000000e+00,-3.937646932011e-01,0.000000000
000e+00,-4.517490965595e-01… 

 

3.2.146 Gets the correction data of multiple traces (:CALCulate{[1]-256}:
DATA:MSData?) 

Command 
Format 

 :CALCulate{[1]-256}:DATA:MSData <trc_num>? 

Instruction  gets the correction data array of multiple traces (traces-n, m, .... to l) of the sele
cted channel (Ch). 

Parameter 
Type 

 String  

Parameter 
Range 

 "n, m, l, ..."  
where n, m, l are 1 to the maximum trace number. 
Use comma for separator of trace number. 
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Return  Array 
Default  None  
Menu  None  
Example  :CALC:DATA:MSData? "1,2,3" 

Return：1.010376816410e+00,-8.191833528689e-03,-6.960549382249e-01,-6.

946841837980e-01,6.925621007541e-03,9.700560127871e-01,6.9678931843
58e-01,-6.718442699877e-01,-9.629746082335e-01,-1.534994428298e-02,6.5
15030755121e-01,7.056409245766e-01,4.932709557852e-02,-9.54326369321
3e-01,-7.007103025244e-01,… 

 

3.2.147 Get the SNP data(:CALCulate{[1]-256}:DATA:SNP?) 

Command 
Format 

 :CALCulate{[1]-256}:DATA:SNP? <num> 

Instruction  This command returns SNP data without header information, and in columns, n
ot in rows as .SnP files. This means that the data returned from this command s
ends all frequency data, then all Sx1 magnitude or real data, then all Sx1 phase
 or imaginary data, and so forth. 

Parameter 
Type 

 String  

Parameter 
Range 

 1 to 4 

Return  Array 
Default  None 
Menu  None 
Example  :CALC:DATA:SNP? 1 

Return : 1.000000000000e+05,4.259950000000e+07,8.509900000000e+07,1.2
75985000000e+08,1.700980000000e+08,2.125975000000e+08, 
2.550970000000e+08,2.975965000000e+08,3.400960000000e+08, 
3.825955000000e+08, 
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3.3 Display Subsystem 

3.3.1 Set Active window (:DISPlay:WINDow{[1]-36}:ACTivate) 
 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:ACTivate 

Instruction  This command specifies selected window as the active window.(Write only). 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  1 

Menu  Display > Windowl Setup > Select 
Example  :DISPlay:WINDow2:ACTivate 

 

3.3.2 Set or get active window (:DISPlay:WINDow{[1]-36}:SELect) 
 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:SELect 
:DISPlay:WINDow:SELect? 

Instruction  This command sets/gets the active window number. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Window Setup > Select 
Example  :DISPlay:WINDow2:SELect 

:DISPlay:WINDow:SELect? 
Return: 2 

 

3.3.3 Set Active channel(:DISPlay:CHANnel{[1]-256}:ACTivate) 

Command 
Format 

 :DISPlay:CHANnel{[1]-256}:ACTivate 

Instruction  This command specifies selected channel as the active channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  1 

Menu  Display > Channel Setup > Select 
Example  :DISPlay:CHANnel2:ACTivate 

 

3.3.4 Set or get active channel(:DISPlay:CHANnel{[1]-256}:SELect) 

Command 
Format 

 :DISPlay:CHANnel{[1]-256}:SELect 
:DISPlay:CHANnel:SELect? 

Instruction  This command sets/gets the active channel number. 

Parameter 
Type 

 None 
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Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Channel Setup > Select 
Example  :DISPlay:CHANnel2:SELect 

:DISPlay:CHANnel:SELect? 
Return: 2 

 

3.3.5 Set Active trace(:DISPlay:TRACe{[1]-256}:ACTivate) 

Command 
Format 

 :DISPlay:TRACe{[1]-256}:ACTivate 

Instruction  This command specifies selected trace as the active trace. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  1 

Menu  Display > Trace Setup > Select 
Example  :DISPlay:TRACe2:ACTivate 

 

3.3.6 Set or get active trace(:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:
SELect) 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe#:SELect 
:DISPlay:WINDow:TRACe:SELect? 
:DISPlay:TRACe{[1]-256}:SELect 
:DISPlay:TRACe:SELect? 

Instruction  This command sets/gets the active trace number. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Trace Setup > Select 
Example  :DISPlay:WINDow2:TRACe3:SELect 

:DISPlay:WINDow2:TRACe3:SELect? 
Return: 2 
 
:DISPlay:TRACe2:SELect 
:DISPlay:TRACe:SELect? 
Return:2 

 

3.3.7 Get all window list(:DISPlay:WINDow:LIST?) 

Command 
Format 

 :DISPlay:WINDow:LIST? 

Instruction  Get the list of all Windows. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 
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Return  Integer 
Default  1 
Menu  Display > Window Setup > Select 
Example  :DISPlay:WINDow:LIST? 

Return:1,2,3 
 

3.3.8 The channel list of a window(:DISPlay:WINDow[1]-36:CHANnel:LI
ST?) 

Command 
Format 

 :DISPlay:WINDow[1]-36:CHANnel:LIST? 

Instruction  Get the channel list of a specified window. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Channel Setup > Select 
Example  There are CH1 and CH3 in window1, query the channel list in window 1: 

 
:DISPlay:WINDow1:CHANnel:LIST? 
Return:1,3 

 

3.3.9 The trace list of a window(:DISPlay:WINDow[1]-36:TRACe:LIST?) 

Command 
Format 

 :DISPlay:WINDow[1]-36: TRACe:LIST? 

Instruction  Get the trace list of a specified window. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Trace Setup > Select 
Example  There are Tr1 ,Tr2 and Tr4 in window1, query the trace list in window1: 

 
:DISPlay:WINDow1:TRACe:LIST? 
Return:1,2,4 

 

3.3.10 Get all channel list(:DISPlay:CHANnel:LIST?) 

Command 
Format 

 :DISPlay:CHANnel:LIST? 

Instruction  Get the list of all channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Channel Setup > Select 
Example  :DISPlay:CHANnel:LIST? 

Return:1,2,3,4 
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3.3.11 The trace list of a channel(:DISPlay:CHANnel{[1]-256}:TRACe:LIS
T?) 

Command 
Format 

 :DISPlay:CHANnel{[1]-256}:TRACe:LIST? 

Instruction  Get the trace list of a specified channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Channel Setup > Select 
Example  There are Tr1 ,Tr2 and Tr4 in channel1, query the trace list in chhanel1: 

 

:DISPlay:CHANnel1:TRACe:LIST? 

Return:1,2,4 
 

3.3.12 Get all Trace list(:DISPlay:TRACe:LIST?) 

Command 
Format 

 :DISPlay:TRACe:LIST? 

Instruction  Get the list of all channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  1 
Menu  Display > Trace Setup > Select 
Example  :DISPlay:TRACe:LIST? 

Return:1,2,3,4,5 
 

3.3.13 The title of the window(:DISPlay:WINDow{[1]-36}:TITLe:DATA) 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TITLe:DATA <string> 
:DISPlay:WINDow{[1]-36}:TITLe:DATA? 

Instruction  Sets or gets the title for the specified window 

Parameter 
Type 

 String  

Parameter 
Range 

 255 characters or less 

Return  String  
Default  1 
Menu  Display>Window Setup >Window Title 
Example  :DISPlay:WINDow1:TITLe:DATA siglent 

:DISPlay:WINDow1:TITLe:DATA? 
Return : "siglent" 

 

3.3.14 Enable the window title(:DISPlay:WINDow{[1]-36}:TITLe[:STATe]) 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TITLe[:STATe] <bool> 
:DISPlay:WINDow{[1]-36}:TITLe[:STATe]? 



84 SNA5000A Programming Guide 

 

 

Instruction  Turns ON or OFF the window title. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 On|Off|1|0 

Return  Boolean  
Default  0 
Menu  Display> Window Setup >Window Title>Enabled 
Example  :DISPlay:WINDow1:TITLe:STATe 1 

:DISPlay:WINDow1:TITLe:STATe? 
Return :1 

 

3.3.15 The title of the channel(:DISPlay:CHANnel{[1]-256}:TITLe:DATA) 

Command 
Format 

 :DISPlay:CHANnel{[1]-256}:TITLe:DATA <String> 
:DISPlay:CHANnel{[1]-256}:TITLe:DATA? 

Instruction  Sets or gets the title for the specified channel 

Parameter 
Type 

 String  

Parameter 
Range 

 255 characters or less 

Return  String  
Default  1 
Menu  Display>Channel Setup >Channel Title 
Example  :DISPlay:CHANnel1:TITLe:DATA siglent 

:DISPlay:CHANnel1:TITLe:DATA? 
Return :"siglent" 

 

3.3.16 Enable the channel title(:DISPlay:CHANnel{[1]-256}:TITLe[:STAT
e]) 

Command 
Format 

 :DISPlay: CHANnel{[1]-256}:TITLe[:STATe] <bool> 
:DISPlay:CHANnel{[1]-256}:TITLe[:STATe]? 

Instruction  Turns ON or OFF the channel title. 

Parameter 
Type 

 Boolean  

Parameter 
Range 

 On|Off|1|0 

Return  Boolean 
Default  0 
Menu  Display> Channel Setup >Channel Title>Enabled 
Example  :DISPlay:CHANnel1:TITLe:STATe 1 

:DISPlay:CHANnel1:TITLe:STATe? 
Return :1 

 

3.3.17 The title of the trace(:DISPlay:TRACe{[1]-256}:TITLe:DATA) 

Command 
Format 

 :DISPlay:TRACe {[1]-256}:TITLe:DATA <String> 
:DISPlay:TRACe{[1]-256}:TITLe:DATA? 

Instruction  Sets or gets the title for the specified trace 

Parameter 
Type 

 String  

Parameter 
Range 

 255 characters or less 

Return  String  
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Default  1 
Menu  Display>Trace Setup >Trace Title 
Example  :DISPlay:TRACe 1:TITLe:DATA siglent 

:DISPlay:TRACe1:TITLe:DATA? 
Return :"siglent" 

 

3.3.18 Enable the trace title(:DISPlay:CHANnel{[1]-256}:TITLe[:STATe]) 

Command 
Format 

 :DISPlay:TRACe{[1]-256}:TITLe[:STATe] <bool> 
:DISPlay:TRACe{[1]-256}:TITLe[:STATe]? 

Instruction  Turns ON or OFF the trace title. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 On|Off|1|0 

Return  Boolean 
Default  0 
Menu  Display> Trace Setup >Trace Title>Enabled 
Example  :DISPlay:TRACe1:TITLe:STATe 1 

:DISPlay:TRACe1:TITLe:STATe? 
Return :1 

 

3.3.19 Add New Trace(:DISPlay:ADD:FUNCtion:EXECute TRC) 

Command 
Format 

 :DISPlay:ADD:FUNCtion:EXECute TRC 

Instruction  Adds a new trace to the current working window and channel. 

Parameter 
Type 

 None  

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Display>TraceSetup >Add Trace>New Trace 
Example  :DISPlay:ADD:FUNCtion:EXECute TRC 

 

3.3.20 Add New Trace +Channel(:DISPlay:ADD:FUNCtion:EXECute CH_
TRC) 

Command 
Format 

 :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

Instruction  Add a new channel and trace in the current working window. 

Parameter 
Type 

 None  

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Display>TraceSetup >Add Trace>New Trace +Channel 
Example  :DISPlay:ADD:FUNCtion:EXECute CH_TRC 

 

3.3.21 Add New Trace +Window(:DISPlay:ADD:FUNCtion:EXECute WIN_
TRC) 
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Command 
Format 

 :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

Instruction  Add a new window and trace in the current working channel. 

Parameter 
Type 

 None  

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Display>TraceSetup >Add Trace>New Trace +Window 
Example  :DISPlay:ADD:FUNCtion:EXECute WIN_TRC 

 

3.3.22 Add New Trace+Channel+Window(:DISPlay:ADD:FUNCtion:EXEC
ute WIN_CH_TRC) 

Command 
Format 

 :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

Instruction  Add a new trace and new channel in a new window. 

Parameter 
Type 

 None  

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Display>TraceSetup >Add Trace>New Trace+Channel+Window 
Example  :DISPlay:ADD:FUNCtion:EXECute WIN_CH_TRC 

 

3.3.23 Window State (:DISPlay:WINDow{[1]-36}:STATe) 
 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:STATe {ON|OFF|1|0} 
:DISPlay:WINDow{[1]-36}:STATe? 

Instruction  This command sets/gets the display state of selected window. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  None 

Menu  None 
Example  :DISPlay:WINDow4:STATe 1 

:DISPlay:WINDow4:STATe? 
Return: 1 

 

3.3.24 Move Trace to Window (DISPlay:MEASure{[1]-256}:MOVE) 
 

Command 
Format 

 DISPlay:MEASure{[1]-256}:MOVE <numeric> 

Instruction  Moves a trace associated with measurement number to the specified window. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~200 

Return  None 
Default  None 
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Menu  Display > Trace Setup > Move Trace 
Example  DISPlay:MEASure2:MOVE 4 

 

3.3.25 Set Window Layout (:DISPlay:ARRange) 
 

Command 
Format 

 :DISPlay:ARRange {TILE|OVERlay|STACk|SPLIt |QUAD|MEASure|CHANnel} 

Instruction  Sets the layout of the windows on the LCD display. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 TILE|OVERlat|STACk|SPLIt|QUAD|MEASure|CHANnel 

Return  Enumeration 
Default  OVERlat 
Menu  Display > Window Setup > Window Layout 
Example  :DISPlay:ARRange TILE 

 

3.3.26 Active Window Maximization (:DISPlay:MAXimize) 
 

Command 
Format 

 :DISPlay:MAXimize {ON|OFF|1|0} 
:DISPlay:MAXimize? 

Instruction  This command turns ON/OFF the window maximization of the active channel. If 
the maximization is set to ON, only the window of the active channel is maximiz
ed on the LCD display and the windows of the other channels are not displayed. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  1 
Menu  Display > Window Setup > Window Max 
Example  :DISPlay:MAXimize ON 

:DISPlay:MAXimize? 
Return: 1 

 

3.3.27 Trace Display State (:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}) 
 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe{[1]-256} {ON|OFF|1|0} 
:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}? 

Instruction  This command turns ON/OFF the trace display, for the selected trace of selecte
d channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  None 
Menu  Display > Trace Setup > Add Trace / Delete Trace 
Example  :DISPlay:WINDow1:TRACe5 1 

:DISPlay:WINDow1:TRACe5? 
Return: 1 

 

3.3.28 Data Trace Display State (:DISPlay:WINDow{[1]-36}:TRACe{[1]-25
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6}:STATe) 
 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:STATe {ON|OFF|1|0} 
:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:STATe? 

Instruction  This command turns ON/OFF the data trace display, for the selected trace of se
lected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  None 
Menu  Math > Display > Data (when the memory trace display is OFF) 

Math > Display > Data & Mem (when the memory trace display is ON) 
Example  :DISPlay:WINDow1:TRACe5:STATe 0 

:DISPlay:WINDow1:TRACe5:STATe? 
Return: 0 

 

3.3.29 Memory Trace Display State (:DISPlay:WINDow{[1]-36}:TRACe{[1]
-256} :MEMory[:STATe]) 

 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:MEMory[:STATe] {ON|OFF|1|0} 
:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:MEMory[:STATe]? 

Instruction  This command turns ON/OFF the memory trace display, for the selected trace o
f selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  None 
Menu  Math > Display > Mem (when the data trace display is OFF) 

Math > Display > Data & Mem (when the data trace display is ON) 
Example  :DISPlay:WINDow1:TRACe5:MEMory ON 

:DISPlay:WINDow1:TRACe5:MEMory? 
Return: 1 

 

3.3.30 Active Trace Maximization (:DISPlay:WINDow{[1]-36}:MAXimize) 
 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:MAXimize {ON|OFF|1|0} 
:DISPlay:WINDow{[1]-36}:MAXimize? 

Instruction  This command turns ON/OFF the maximization of the active trace of selected c
hannel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  None 
Menu  Display > Trace Setup > Trace Maximize 
Example  :DISPlay:WINDow1:MAXimize 1 

:DISPlay:WINDow1:MAXimize? 
Return: 1 
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3.3.31 Auto Scale (:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:
AUTO) 

 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:AUTO 

Instruction  This command executes the auto scale function, for the selected trace (Tr) of se
lected channel (Ch). The Auto Scale function automatically adjusts the value of t
he reference division line and the scale per division to display the trace appropri
ately. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Scale > Auto Scale 
Example  :DISPlay:WINDow1:TRACe2:Y:AUTO 

 

3.3.32 Auto Scale All (:DISPlay:WINDow{[1]-36}:Y:AUTO) 
 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:Y:AUTO 

Instruction  Scales all of the traces to fit in the same window. This is equivalent to "Auto Sca
le All" from the front panel. 
Auto scale behaves differently when scale coupling is enabled. How it behaves 
depends on the scale coupling method. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Scale > Auto Scale All 
Example  :DISPlay:WINDow1:Y:AUTO 

 

3.3.33 Scale Per Division (:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:
SCALe]:PDIVision) 

 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:PDIVision <numeric> 
:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:PDIVision? 

Instruction  For the selected trace of selected channel, when the data format is not the Smit
h chart format or the polar format, sets the scale per division. When the data for
mat is the Smith chart format or the polar format, sets the full scale value (the v
alue of the outermost circumference). 

Parameter 
Type 

 Float 
Unit varies depending on the data format. 
⚫ Log magnitude: dB (decibel) 
⚫ Phase, Expanded phase or Positive phase: °   (degree) 
⚫ Group delay: s (second) 
⚫ Others: No unit 

Parameter 
Range 

 None 

Return  Float 
Default  Varies depending the data format. 

⚫ Log magnitude: 10 
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⚫ Phase, Expanded phase or Positive phase: 90 
⚫ Group delay: 1E-8 
⚫ Smith chart or Polar or SWR: 1 
⚫ Linear magnitude: 0.1 
⚫ Real or Imaginary: 0.2 

Menu  Scale > Scale 
Example  :DISPlay:WINDow1:TRACe1:Y:PDIVision 10 

:DISPlay:WINDow1:TRACe1:Y:PDIVision? 
Return: 10 

 

3.3.34 Scale Reference Level (:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:
Y[:SCALe]:RLEVel) 

 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:RLEVel <numeric> 
:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:RLEVel? 

Instruction  This command sets/gets the value of the reference division line, for the selected
 trace of selected channel. 

Parameter 
Type 

 Float 
Unit varies depending on the data format. 
⚫ Log magnitude: dB (decibel) 
⚫ Phase, Expanded phase or Positive phase: °   (degree) 
⚫ Group delay: s (second) 
⚫ Others: No unit 

Parameter 
Range 

 None 

Return  Float 
Default  0 
Menu  Scale > Reference Level 
Example  :DISPlay:WINDow1:TRACe1:Y:RLEVel 5 

:DISPlay:WINDow1:TRACe1:Y:RLEVel?  
Return: 5 

 

3.3.35 Scale Reference Position (:DISPlay:WINDow{[1]-36}:TRACe{[1]-2
56}:Y[:SCALe]:RPOSition) 

 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:RPOSition <numeric> 
:DISPlay:WINDow{[1]-36}:TRACe{[1]-256}:Y[:SCALe]:RPOSition? 

Instruction  This command specifies the position of a reference division line with its number 
(an integer assigned starting from 0 from the lowest division), for the selected tr
ace of selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 0 to the number of divisions 

Return  Integer 
Default  5 
Menu  Scale > Reference Position 
Example  :DISPlay:WINDow1:TRACe1:Y:RPOSition 6 

:DISPlay:WINDow1:TRACe1:Y:RPOSition? 
Return: 6 

 

3.3.36 Table Display Type (:DISPlay:WINDow{[1]-36}:TABLe) 
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Command 
Format 

 :DISPlay:WINDow{[1]-36}:TABLe {MARKer|LIMit|SEGMent|RLIMit|OFF} 
:DISPlay:WINDow{[1]-36}:TABLe? 

Instruction  This command selects the type of the window that appears in the lower part of t
he window display, for the selected window. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 MARKer|LIMit|SEGMent|RLIMit|OFF 

Return  Enumeration 
Default  OFF 
Menu  Marker > Marker Table 

Math > Analysis > Limit Table > Limit 
Math > Analysis > Limit Table > Ripple 
Sweep > Segment Table > Show Table 

Example  :DISPlay:WINDow2:TABLe RLIMit 
:DISPlay:WINDow2:TABLe? 
Return: RLIM 

 

3.3.37 Globle Fail Sign (:DISPlay:FSIGn) 
 

Command 
Format 

 :DISPlay:FSIGn ON|OFF|1|0 
:DISPlay:FSIGn? 

Instruction  Shows or hides the window which displays global pass/fail results. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Math> analysis> Global Pass/Fail ON 
Example  :DISPlay:FSIGn 1 

:DISPlay:FSIGn? 
Return: 1 

 

3.3.38 Display Type of the Graph Horizontal Axis  (:DISPlay:WINDow{[1]
-36}:X:SPACing) 

 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:X:SPACing LINear|OBASe 
:DISPlay:WINDow{[1]-36}:X:SPACing? 

Instruction  This command selects the display type of the graph horizontal axis of selected c
hannel for segment sweep. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 Select from the following: 
 
⚫ "LINear":Specifies the frequency base (linear frequency axis with the minim

um frequency at the left edge and the maximum frequency at the right edg
e). 

 
⚫ "OBASe" :Specifies the order base (axis in which the measurement point n

umbers are positioned evenly in the order of measurement). 
Return  Enumeration 
Default  LINear 
Menu  Sweep > Segment Table > X-Axis Point Spacing 
Example  :DISPlay:WINDow1:X:SPACing OBASe 
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:DISPlay:WINDow1:X:SPACing? 
Return: OBAS 

 

3.3.39 Clear Error Message  (:DISPlay:CCLear) 
 

Command 
Format 

 :DISPlay:CCLear 

Instruction  This command clears the error message displayed in the status bar (at the botto
m of the LCD display). 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  None 
Example  :DISPlay:CCLear 

 

3.3.40 Display System Date and Time  (:DISPlay:CLOCk) 
 

Command 
Format 

 :DISPlay:CLOCk {ON|OFF|1|0} 
:DISPlay:CLOCk? 

Instruction  This command turns ON/OFF the clock display in the instrument status bar (at t
he right bottom of the LCD display). 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  1 
Menu  System > Date&Time > Display Date Time 
Example  :DISPlay:CLOCk OFF 

:DISPlay:CLOCk? 
Return: 0 

 

3.3.41 show or hide the Marker readout(:DISPlay:WINDow{[1]-36}:ANNot
ation:MARKer:ALIGn[:STATe]) 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:ANNotation:MARKer:ALIGn[:STATe] <bool> 
:DISPlay:WINDow{[1]-36}:ANNotation:MARKer:ALIGn[:STATe]? 

Instruction  Specifies whether to show or hide the Marker readout (when markers are ON) o
n the selected window. 

Parameter 
Type 

 Boolean  

Parameter 
Range 

 On|OFF|1|0 

Return  Boolean  
Default  1 
Menu  Marker>Marker Display>Show Readout 
Example  :DISPlay:WINDow1:ANNotation:MARKer:ALIGn:STAT 0? 

:DISPlay:WINDow1:ANNotation:MARKer:ALIGn:STAT? 
Return :0 
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3.3.42 Only show the Active Trc Marker readout (:DISPlay:WINDow{[1]-3
6}:ANNotation:MARKer:SINGle[:STATe]) 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:ANNotation:MARKer:SINGle[:STATe] <bool> 
:DISPlay:WINDow{[1]-36}:ANNotation:MARKer:SINGle[:STATe]? 

Instruction  Set only shows the active trace marker readout. 

Parameter 
Type 

 Boolean  

Parameter 
Range 

 On|OFF|1|0 

Return  Boolean  
Default  0 
Menu  Marker>Marker Display> Active Trc Only 

Example  :DISPlay:WINDow1:ANNotation:MARKer:SINGle:STAT 1? 
:DISPlay:WINDow1:ANNotation:MARKer:SINGle:STAT? 
Return :1 

 

3.3.43 X-axis position of marker readout (:DISPlay:WINDow{[1]-36}:ANN
otation:MARKer:POSition:X) 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:ANNotation:MARKer:POSition:X <num> 
:DISPlay:WINDow{[1]-36}:ANNotation:MARKer:POSition:X? 

Instruction  Sets or gets the window's overall marker readout at the X axis position. 

Parameter 
Type 

 Float  

Parameter 
Range 

 1-10 

Return  Float  
Default  10 
Menu  Marker>Marker Display>Show Readout>X Div 
Example  :DISPlay:WINDow1:ANNotation:MARKer:POSition:X 6 

:DISPlay:WINDow1:ANNotation:MARKer:POSition:X? 
Return: 6 

 

3.3.44 Y-axis position of marker readout (:DISPlay:WINDow{[1]-36}:ANN
otation:MARKer:POSition:Y) 

Command 
Format 

 :DISPlay:WINDow{[1]-36}:ANNotation:MARKer:POSition:Y <num> 
:DISPlay:WINDow{[1]-36}:ANNotation:MARKer:POSition:Y? 

Instruction  Sets or gets the window's overall marker readout at the Y axis position. 

Parameter 
Type 

 Float  

Parameter 
Range 

 1-10 

Return  Float  
Default  10 
Menu  Marker>Marker Display>Show Readout>Y Div 
Example  :DISPlay:WINDow1:ANNotation:MARKer:POSition:Y 6 

:DISPlay:WINDow1:ANNotation:MARKer:POSition:Y? 
Return: 6 

 

3.3.45 Single trace marker readout of X-axis position (:DISPlay:CHANne
l{[1]-256}:TRACe{[1]-256}:ANNotation:MARKer:POSition:X) 
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Command 
Format 

 :DISPlay:CHANnel{[1]-256}:TRACe{[1]-256}:ANNotation:MARKer:POSition:X <
num> 
:DISPlay:CHANnel{[1]-256}:TRACe{[1]-256}:ANNotation:MARKer:POSition:X? 

Instruction  Sets or gets the X - axis position of the marker readout for a single trace in the 
window. 

Parameter 
Type 

 Float  

Parameter 
Range 

 1-10 

Return  Float  
Default  10 
Menu  Marker>Marker Display>Show Readout>X Div 
Example  :DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:X 5 

:DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:X? 
Return: 5 

 

3.3.1 Single trace marker readout of Y-axis position (:DISPlay:CHANne
l{[1]-256}:TRACe{[1]-256}:ANNotation:MARKer:POSition:Y) 

Command 
Format 

 :DISPlay:CHANnel{[1]-256}:TRACe{[1]-256}:ANNotation:MARKer:POSition:Y <
num> 
:DISPlay:CHANnel{[1]-256}:TRACe{[1]-256}:ANNotation:MARKer:POSition:Y? 

Instruction  Sets or gets the Y - axis position of the marker readout for a single trace in the 
window. 

Parameter 
Type 

 Float  

Parameter 
Range 

 1-10 

Return  Float  
Default  10 
Menu  Marker>Marker Display>Show Readout>Y Div 
Example  :DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:Y 7 

:DISPlay:CHANnel1:TRACe1:ANNotation:MARKer:POSition:Y? 
Return: 7 

 
 

3.4 Format Subsystem 

3.4.1 Data transfer format (:FORMat:DATA) 

Command 
Format 

 :FORMat:DATA {ASCii|REAL|REAL32} 
:FORMat:DATA? 

Instruction  Set/get the transfer format of data 

Parameter 
Type 

 enumerate 

Parameter 
Range 

 ASCii|REAL|REAL32 
ASCii: Specifies the ASCII transfer format. 
REAL: Specifies the IEEE 64-bit floating point binary transfer format. 
REAL32: Specifies the IEEE 32-bit floating point binary transfer format. 

Return   
Default  ASCii 
Menu  None 
Example  :FORMat:DATA REAL 

:FORMat:DATA? 
Return: REAL 
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3.5Initiate Subsystem 

3.5.1 Continuous Initiation Mode  (:INITiate{[1]-256}:CONTinuous {ON|
OFF|1|0}) 

 

Command 
Format 

 :INITiate{[1]-256}:CONTinuous {ON|OFF|1|0} 
:INITiate{[1]-256}:CONTinuous? 

Instruction  This command turns ON/OFF the continuous initiation mode of selected channe
l in the trigger system. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 
True or ON:Turns ON the continuous initiation mode. 
False or OFF:Turns OFF the continuous initiation mode. 

Return  Boolean 

Default  0 

Menu  Trigger > Continuous/Hold 

Example  :INITiate1:CONTinuous 1 
:INITiate1:CONTinuous? 
Return: 1 

 

3.5.2 Single Mode  (:INITiate{[1]-256}[:IMMediate]) 
 

Command 
Format 

 :INITiate{[1]-256}[:IMMediate] 

Instruction  This command changes the state of each channel of selected channel to the init
iation state in the trigger system. 
 
When this object is executed for a channel in the hold state, it goes into the sing
le state immediately. Then, after measurement is executed once, it goes back to
 the hold state. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Trigger > Single 

Example  :INITiate1 

 

3.6Memory Subsystem 

3.6.1 Enter a folder directory(:MMEMory:CDIRectory) 

Command 
Format 

 :MMEMory:CDIRectory <folderpath> 
:MMEMory:CDIRectory? 

Instruction  Toggle or query the current working directory. The default directory is "/", and th
e common working directory is "/local". If the new folder is at a different level tha
n the default, use a slash (/) before the folder name and enclose in quotes. 
, such as "/local/NewFolder" 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 

Return  String  

Default  "/" 
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Menu  SaveRecall>File Browser 

Example  1. If no external USB flash drive is inserted, only the common /local directory is 
available. The following is an example to enter a folder in the local directory: 
 
:MMEMory:CDIRectory "/local/NewFolder" 
:MMEMory:CDIRectory? 
Return: "/local/NewFolder" 
 
2. When an external USB flash drive is inserted, the working directory contains "
/local" and "/U-disk0". The following is an example of going to a folder in the US
B flash drive directory: 
 
:MMEMory:CDIRectory "/U-disk0/NewFolder" 
:MMEMory:CDIRectory? 
Return :"/ U-disk0/NewFolder" 

 

3.6.2 Makes a folder(:MMEMory:MDIRectory) 

Command 
Format 

 :MMEMory:MDIRectory <folderpath> 

Instruction  Make a folder. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 

Return  None  

Default  None  

Menu  SaveRecall>File Browser 

Example  1. In the local directory, create a folder named "123". 
MMEMory:MDIRectory "/local/123" 
 
2. When inserting a U disk, create a folder named "456" in the U disk directory. 
MMEMory:MDIRectory "/U-disk0/456" 

 

3.6.3 Delete a folder(:MMEMory:RDIRectory) 

Command 
Format 

 :MMEMory:RDIRectory <folderpath> 

Instruction  Delete the specified folder 

Parameter
 Type 

 string 

Parameter 
Range 

 255 characters or less 

Return  None  

Default  None  

Menu  SaveRecall>File Browser 

Example  1. In the local directory, delete a folder named "123". 
:MMEMory: RDIRectory "/local/123" 
 
2. When inserting a U disk, delete a folder named "456" in the U disk directory. 
:MMEMory:RDIRectory "/U-disk0/456". 

 

3.6.4 Rename a file(:MMEMory:MOVE) 

Command 
Format 

 :MMEMory:MOVE <file1>,<file2> 



SNA5000A Programming Guide           97 

 

 

Instruction  Renames <file1> to <file2>. File extensions must be specified. 

Parameter
 Type 

 string 

Parameter 
Range 

 255 characters or less 

Return  None  

Default  None  

Menu  SaveRecall>File Browser>Rename 

Example  1. In the local directory, rename the "12.csv" file to "34.csv". 

:MMEMory: MOVE "/local/123.csv",/local/789.csv" 

 
2. When inserting an U disk, rename the "11.csv" file to "22.csv" in the directory 
of the U disk. 
:MMEMory:MOVE "/U-disk0/11.csv",/local/22.csv" 

 

3.6.5 Query the directory file list(:MMEMory:CATalog[:<char>?]) 

Command 
Format 

 :MMEMory:CATalog[:<char>]? [<folderpath>] 

Instruction  Query the files in the specified directory. If the file type and folder name are not 
specified, all files in the current directory are queried. 

Parameter
 Type 

 <char> string, the type of files to list.Choose from: 
STATe|STA - Instrument states (.sta) 
CORRection|CAL- Calibration Data (.cal) 
CSARchive|CSA - Instrument state and calibration data (.csa) 
CSV - Instrument state (.csv) 
DIRectory – Instrument foler list. 
 
<folder> String - Any existing folder name. 

Parameter 
Range 

 255 characters or less 

Return  String  

Default  None  

Menu  SaveRecall>File Browser 

Example  1. Query all files in the local root directory. 
:MMEMory:CATalog? "/local" 
 
2. Query all files in the root directory of a U disk. 
:MMEMory:CATalog? "/U-disk0" 
 
3. Query all ".CSV" files in the "Test" folder of the local directory 
:MMEMory:CATalog:CSV? "/local/Test" 

 
 

3.6.6 The save date of a File(:MMEMory:DATE?) 

Command 
Format 

 :MMEMory:DATE? <fileName> 

Instruction  Returns the (year, month, day) that the specified file was last saved. 

Parameter
 Type 

 string 

Parameter 
Range 

 255 characters or less 

Return  Integer 

Default  None  
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Menu  SaveRecall>File Browser 

Example  Query the save date of the file "123.csv" in the local directory. 
:MMEM:DATE? "/local/123.csv" 
Return : 2022,11,5 

 

3.6.7 The save time of a File(:MMEMory:TIME?) 

Command 
Format 

 :MMEMory:TIME? <fileName> 

Instruction  Returns the (hour, minute,second) that the specified file was last saved. 

Parameter
 Type 

 string 

Parameter 
Range 

 255 characters or less 

Return  Integer 

Default  None  

Menu  SaveRecall>File Browser 

Example  Query the save time of the file "123.csv" in the local directory. 
:MMEM:DATE? "/local/123.csv" 
Return : 15,55,34 

 

3.6.8 Copy File (:MMEMory:COPY) 
 

Command 
Format 

 :MMEMory:COPY <file 1>,<file 2> 

Instruction  This command copies a file. If the specified copy source file does not exist, an e
rror occurs when executed and the object is ignored. Notice that, if a file with th
e same name as the specified copy destination file name exists, its contents are
 overwritten. The source file and copy destination file is seperated by comma. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  None 

Example  :MMEMory:COPY "local/test1.csv","local/test2.csv" 

 

3.6.9 Delete File (:MMEMory:DELete) 
 

Command 
Format 

 :MMEMory:DELete <string> 

Instruction  This command deletes an existing file or directory (folder). If the specified file or 
directory does not exist, an error occurs when executed and the object is ignore
d. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  None 

Example  :MMEMory:DELete "local/test1.csv" 
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3.6.10 Store Fdata (:MMEMory:STORe:FDATa) 
 

Command 
Format 

 :MMEMory:STORe:FDATa <string> 

Instruction  This command saves the formatted data array into a file in the CSV format (exte
nsion ".csv"), for the active trace of the active channel. If a file with the same na
me as the specified file name exists, its contents are overwritten. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Save Recall > Save Other > Save Trc Data 

Example  :MMEMory:STORe:FDATa "local/test.csv" 

 

3.6.11 Load Limit Table (:MMEMory:LOAD:LIMit) 
 

Command 
Format 

 :MMEMory:LOAD:LIMit <string> 

Instruction  This command recalls the specified limit table file, from the limit table for the acti
ve trace of the active channel. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Math > Analysis > Limit > Load Table 

Example  :MMEMory:LOAD:LIMit "local/test.csv" 

 

3.6.12 Store Limit Table (:MMEMory:STORE:LIMit) 
 

Command 
Format 

 :MMEMory:STORE:LIMit <string> 

Instruction  This command saves the limit table of the active trace of the active channel into 
a file in the CSV format (extension ".csv").If a file with the same name as the sp
ecified file name exists, its contents are overwritten. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Math > Analysis > Limit > Save Table 

Example  :MMEMory:STORE:LIMit "local/test.csv" 

 

3.6.13 Load Ripple Limit Table (:MMEMory:LOAD:RLIMit) 
 

Command 
Format 

 :MMEMory:LOAD:RLIMit <string> 

Instruction  This command recalls the specified ripple limit table file, from the ripple limit tabl
e for the active trace of the active channel. 
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Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Math > Analysis > Limit > Ripple > Load Table 

Example  :MMEMory:LOAD:RLIMit "local/test.csv" 

 

3.6.14 Store Ripple Limit Table (:MMEMory:STORE:LIMit) 
 

Command 
Format 

 :MMEMory:STORE:RLIMit <string> 

Instruction  This command saves the ripple limit table of the active trace of the active chann
el into a file in the CSV format (extension ".csv").If a file with the same name as 
the specified file name exists, its contents are overwritten. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Math > Analysis > Limit > Ripple > Save Table 

Example  :MMEMory:STORE:RLIMit "local/test.csv" 

 

3.6.15 Load Segment Sweep Table (:MMEMory:LOAD:SEGMent) 
 

Command 
Format 

 :MMEMory:LOAD:SEGMent <string> 

Instruction  This command recalls the specified segment sweep table file, as the segment s
weep table of the active channel. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Sweep > Segment Table  > Load Table 

Example  :MMEMory:LOAD:SEGMent "local/test.csv" 

 

3.6.16 Save Segment Sweep Table (:MMEMory:STORE:SEGMent) 
 

Command 
Format 

 :MMEMory:STORE:SEGMent <string> 

Instruction  This command saves the segment sweep table of the active channel into a file i
n the CSV format (extension ".csv").If a file with the same name as the specified
 file name exists, its contents are overwritten. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Sweep > Segment Table  > Save Table 
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Example  :MMEMory:STORE:SEGMent "local/test.csv" 

 

3.6.17 Load Instrument State (:MMEMory:LOAD[:STATe]) 
 

Command 
Format 

 :MMEMory:LOAD[:STATe] <string> 

Instruction  This command recalls the specified instrument state file. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Recall > Recall State 

Example  :MMEMory:LOAD "local/test.sta" 

 

3.6.18 Save Instrument State (:MMEMory:STORE[:STATe]) 
 

Command 
Format 

 :MMEMory:STORE[:STATe] <string> 

Instruction  This command saves the instrument state into a file (file with the .sta extensio
n). If a file with the same name as the specified file name exists, its contents are
 overwritten. 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  Sweep > Segment Table  > Save Table 

Example  :MMEMory:STORE "local/test.sta" 

 

3.6.19 Create Directory (:MMEMory:MDIRectory) 
 

Command 
Format 

 :MMEMory:MDIRectory <string> 

Instruction  This command creates a new directory (folder).  
 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  None 

Example  :MMEMory:MDIRectory "local/test1" 

 

3.6.20 Save Display Image On the LCD (:MMEMory:STORe:IMAGe) 
 

Command 
Format 

 :MMEMory:STORe:IMAGe <string> 
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Instruction  This command saves the display image on the LCD display at the execution of t
he object into a file in the bitmap (extension ".bmp") or portable network graphic
s format (extension ".png") or JPEG file interchange format (extension ".jpg"). 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 
 

Return  None 

Default  None 

Menu  None 

Example  :MMEMory:STORe:IMAGe "local/test.bmp" 

 

3.6.21 The print color for output (:HCOPy:IMAGe) 

Command 
Format 

 :HCOPy:IMAGe <string> 
:HCOPy:IMAGe? 

Instruction  sets/gets the print color for output (to the printer). 

Parameter
 Type 

 enumerat 

Parameter 
Range 

 Select from the following: 
 
"NORMal": Specifies printing in close color to the display color. 
"INVert": Specifies printing in the inverted color of the display color. 

Return  enumerate 

Default  NORMal 

Menu  System>System>Screenshot Settings… 

Example  :HCOPy:IMAGe INVert 
:HCOPy:IMAGe? 
Return :INV  

 

3.6.22 Set the area of screenshot(:HCOPy:AREA) 

Command 
Format 

 :HCOPy:AREA <string> 
:HCOPy:AREA? 

Instruction  Set or get the area of the screenshot. 

Parameter
 Type 

 enumerate 

Parameter 
Range 

 ALL|WINDow 
ALL: Capture the entire screen. 
WINDow: Only capture waveform window area (excluding toolbar, status bar an
d menu bar) 

Return  enumerate 

Default  WINDow 

Menu  System>System>Screenshot Settings… 

Example  :HCOPy:AREA ALL 
:HCOPy:AREA? 
Return :ALL 

 

3.6.23 Saves the screen image to a file(:HCOPy:FILE) 

Command 
Format 

 :HCOPy:FILE <filename> 
:HCOPy:FILE? 

Instruction  Save the screen display as a local file or an external storage device file. The file
 name must specify an extension. 
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Parameter
 Type 

 String  

Parameter 
Range 

 less than 256 characters. 
Use one of the following suffixes: 
.bmp - not recommended due to large file size 
.jpg - not recommended due to poor quality 
.png - recommended 

Return  None 

Default  None 

Menu  None 

Example  1.Save the screen display to the local local as a ".jpg" file. 
:HCOPy:FILE "/local/myfile.jpg" 
 
Save the screen display to an external USB flash drive as a.png file. 
:HCOPy:FILE "/U-disk0/myfile.png" 

 

3.6.24 Set the graphic format(:HCOPy:SDUMp:DATA:FORMat) 

Command 
Format 

 :HCOPy:SDUMp:DATA:FORMat <string> 
:HCOPy:SDUMp:DATA:FORMat? 

Instruction  Sets the graphic format for screenshot. 

Parameter
 Type 

 enumerate 

Parameter 
Range 

 Choose from: 
JPG|BMP|PNG 

Return  enumerate 

Default  PNG 

Menu  None 

Example  :HCOPy:SDUMp:DATA:FORMat BMP 
:HCOPy:SDUMp:DATA:FORMat? 
Return :BMP 

 

3.6.25 Get the arbitrary block of iamge(:HCOPy:SDUMp:DATA[:IMMediat
e]?) 

Command 
Format 

 :HCOPy:SDUMp:DATA[:IMMediate]? 

Instruction  Returns the display image in a definite-length arbitrary binary block. The format 
of the data is PNG by default. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  A definite-length arbitrary binary block 

Default  None 

Menu  None 

Example  :HCOPy:SDUMp:DATA:IMMediate? 
Return: #73072054BM6\E0.\00\00\00\00\006\00\00\00(\00\00\00\00\05\00\00\s\
03\00\00\01\00\18\00\00\00\00\00\00\E0.\00\FE\11\00\00\EB\10\00\00\00\00\00
\00\00\00\00\00\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E
8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\
E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\E9\E9\E8\... 

 

3.6.26 Read/write file data(:MMEMory:TRANsfer) 
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Command 
Format 

 :MMEMory:TRANsfer <string>,<block> 

:MMEMory:TRANsfer? 

Instruction  Data written on/read out from the file 

Parameter
 Type 

 String 

Parameter 
Range 

 <string>: File name on the built-in storage device. 
<block>: The contents of the file. 

Return  Return the data from the specified file location 

Default  None 

Menu  None 

Example  
:MMEMory:TRANsfer? "local/test.csv" 

Return: #592939"# Channel\s1" "#\sTrace 2" Frequency,Formatted Data,F

ormatted Data 1.000000000000e+05, 

-7.710605710955e-02,2.403043541994e-01 2.912437500000e+06, 
 
 

3.6.27 Store SNP File (:MMEMory:STORe:SNP[:DATA]) 
 

Command 
Format 

 :MMEMory:STORe:SNP[:DATA] <string> 

Instruction  Saves the measurement data for the active channel into a file in the touchstone 
format. You need to specify a file format and file type before saving a file. The e
xtension differs depending on file types. 
.s1p:When specifying one port 
.s2p:When specifying two port 
.s3p:When specifying three port 
.s4p:When specifying four port 

Parameter
 Type 

 String 

Parameter 
Range 

 255 characters or less 

Return  None 

Default  None 

Menu  Save Recall > Save Other > Save SnP 

Example  :MMEMory:STORe:SNP:TYPE:S2P 2,3 
:MMEMory:STORe:SNP "local/test.s2p" 

 

3.6.28 Format of SNP File (:MMEMory:STORe:SNP:FORMat) 
 

Command 
Format 

 :MMEMory:STORe:SNP:FORMat {AUTO|MA|DB|RI} 
:MMEMory:STORe:SNP:FORMat? 

Instruction  This command sets/gets the data format for saving measurement data for the a
ctive channel into a file in the touchstone format. 

Parameter
 Type 

 String 

Parameter 
Range 

 "AUTO":Specifies data format automatically according to the display format of th
e active trace. 
"MA":Specifies data format "log magnitude > angle". 
"DB":Specifies data format "linear magnitude > angle". 
"RI":Specifies data format "real part > imaginary part". 

Return  String 

Default  AUTO 

Menu  Save Recall > Save Other > SnP Format 
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Example  :MMEMory:STORe:SNP:FORMat MA 
:MMEMory:STORe:SNP:FORMat? 
Return: MA 

 

3.6.29 Port Saved in S1P File (:MMEMory:STORe:SNP:TYPE:S1P) 
 

Command 
Format 

 :MMEMory:STORe:SNP:TYPE:S1P <numeric> 
:MMEMory:STORe:SNP:TYPE:S1P? 

Instruction  This command sets/gets the specified port to the file type (1 port) when saving 
measurement data for the active channel into a file in the touchstone format. 

Parameter
 Type 

 Integer 

Parameter 
Range 

 1 ~ 4 

Return  Integer 

Default  1 

Menu  None 

Example  :MMEMory:STORe:SNP:TYPE:S1P 2 
:MMEMory:STORe:SNP:TYPE:S1P? 
Return: 2 

 

3.6.30 Ports Saved in S2P File (:MMEMory:STORe:SNP:TYPE:S2P) 
 

Command 
Format 

 :MMEMory:STORe:SNP:TYPE:S2P <numeric1>,<numeric2> 
:MMEMory:STORe:SNP:TYPE:S2P? 

Instruction  This command sets/gets the specified port to the file type (2 port) when saving 
measurement data for the active channel into a file in the touchstone format. 

Parameter
 Type 

 Data array 

Parameter 
Range 

 1 ~ 4 

Return  Data array 

Default  1,2 

Menu  None 

Example  :MMEMory:STORe:SNP:TYPE:S2P 2,3 
:MMEMory:STORe:SNP:TYPE:S2P? 
Return: 2,3 

 

3.6.31 Ports Saved in S3P File (:MMEMory:STORe:SNP:TYPE:S3P) 
 

Command 
Format 

 :MMEMory:STORe:SNP:TYPE:S3P <numeric1>,<numeric2>,<numeric3> 
:MMEMory:STORe:SNP:TYPE:S3P? 

Instruction  This command sets/gets the specified port to the file type (3 port) when saving 
measurement data for the active channel into a file in the touchstone format. 

Parameter
 Type 

 Data array 

Parameter 
Range 

 1 ~ 4 

Return  Data array 

Default  1,2,3 

Menu  None 

Example  :MMEMory:STORe:SNP:TYPE:S3P 2,3,4 
:MMEMory:STORe:SNP:TYPE:S3P? 
Return: 2,3,4 
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3.6.32 Ports Saved in S4P File (:MMEMory:STORe:SNP:TYPE:S4P) 
 

Command 
Format 

 :MMEMory:STORe:SNP:TYPE:S4P <numeric1>,<numeric2>,<numeric3>,<num
eric4> 
:MMEMory:STORe:SNP:TYPE:S4P? 

Instruction  This command sets/gets the specified port to the file type (4 port) when saving 
measurement data for the active channel into a file in the touchstone format. 

Parameter
 Type 

 Data array 

Parameter 
Range 

 1 ~ 4 

Return  Data array 

Default  1,2,3,4 

Menu  None 

Example  :MMEMory:STORe:SNP:TYPE:S4P 1,2,3,4 
:MMEMory:STORe:SNP:TYPE:S4P? 
Return: 1,2,3,4 

 

3.7Output Subsystem 

3.7.1 Output State (:OUTPut[:STATe]) 
 

Command 
Format 

 :OUTPut[:STATe] {ON|OFF|1|0} 
:OUTPut[:STATe]? 

Instruction  This command turns on/off the stimulus signal output. Measurement cannot be 
made until the stimulus signal output is turned ON. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 
 

Return  Boolean 

Default  ON 

Menu  Power > RF Power 

Example  :OUTPut 0 
:OUTPut? 
Return: 0 
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3.8 Sense Subsystem 

3.8.1 Average Restart (:SENSe{[1]-256}:AVERage:CLEar) 
 

Command 
Format 

 :SENSe{[1]-256}:AVERage:CLEar 

Instruction  This command resets the data count to 0, used for averaging of selected chann
el. Measurement data before the execution of this object is not used for averagi
ng. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  AvgBW > Averaging Restart 
Example  :SENSe1:AVERage:CLEar 

 

3.8.2 Average Count (:SENSe{[1]-256}:AVERage:COUNt) 
 

Command 
Format 

 :SENSe{[1]-256}:AVERage:COUNt  <numeric> 
:SENSe{[1]-256}:AVERage:COUNt? 

Instruction  This command sets/gets the averaging factor of selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 2~999 

Return  Integer 
Default  16 
Menu  AvgBW > Averaging 
Example  :SENSe1:AVERage:COUNt 10 

:SENSe1:AVERage:COUNt? 
Return: 10 

 

3.8.3current average number(:SENSe{[1]-256}:AVERage:CURRent?) 

 

Command 
Format 

 :SENSe{[1]-256}:AVERage:CURRent? 

Instruction  This command gets the current average number of times of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  16 
Menu  AvgBW > Averaging 
Example  :SENSe1:AVERage:CURRent? 

Return: 10 

 

3.8.4Completion status of the average(:SENSe{[1]-256}:AVERage:COMPlet
e?) 
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Command 
Format 

 :SENSe{[1]-256}:AVERage:COMPlete? 

Instruction  This command gets the completion status of the average count of selected chan
nel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Boolean 
Default  16 
Menu  AvgBW > Averaging 
Example  :SENSe1:AVERage:COMPlete? 

Return: 1 

 

3.8.5 State of Average (:SENSe{[1]-256}:AVERage[:STATe]) 
 

Command 
Format 

 :SENSe{[1]-256}:AVERage[:STATe]  {ON|OFF|1|0} 
:SENSe{[1]-256}:AVERage[:STATe]? 

Instruction  This command sets/gets the averaging function of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  0|1 
Default  0 
Menu  AvgBW > Averaging Enable 
Example  :SENSe1:AVERage 1 

:SENSe1:AVERage? 
Return: 1 

 

3.8.6 IF Bandwidth  (:SENSe{[1]-256}:BANDwidth[:RESolution]) 
 

Command 
Format 

 :SENSe{[1]-256}:BANDwidth[:RESolution] <numeric> 
:SENSe{[1]-256}:BANDwidth[:RESolution]? 

Instruction  This command sets/gets the IF bandwidth of selected channel. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 10Hz~3MHz 

Return  Float, unit: Hz 
Default  10 kHz 
Menu  AvgBW > IF Bandwidth 
Example  :SENSe1:BANDwidth 7e3 

:SENSe1:BANDwidth? 
Return: 7000 

 

3.8.7 IF Bandwidth  (:SENSe{[1]-256}:BWIDth[:RESolution]) 
 

Command 
Format 

 :SENSe{[1]-256}:BWIDth[:RESolution] <numeric> 
:SENSe{[1]-256}:BWIDth[:RESolution]? 

Instruction  This command sets/gets the IF bandwidth of selected channel. 

Parameter 
Type 

 Float, unit:Hz 
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Parameter 
Range 

 10Hz~3MHz 

Return  Float, unit:Hz 
Default  10kHz 
Menu  AvgBW > IF Bandwidth 
Example  :SENSe1:BWIDth 15e3 

:SENSe1:BWIDth? 
Return: 15000 

 

3.8.8 Clear Error Coefficient (:SENSe{[1]-256}:CORRection:CLEar) 
 

Command 
Format 

 :SENSe{[1]-256}:CORRection:CLEar 

Instruction  This command clears the error coefficient for calibration of  the select channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:CLEar 

 

3.8.9 Error Coefficient Data (:SENSe{[1]-256}:CORRection:COEFficient[:
DATA]) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient[:DATA] {ES|ER|ED|EL|ET|EX},<num
eric 1>,<numeric 2>,<numeric 3>,...,<numeric 2+n*2> 
:SENSe{[1]-256}:CORRection:COEFficient[:DATA]? {ES|ER|ED|EL|ET|EX},<nu
meric 1>,<numeric 2> 

Instruction  This command sets/gets the calibration coefficient data for specified channel. 

Parameter 
Type 

 {ES|ER|ED|EL|ET|EX}: error type 
⚫ "ES": Source match 
⚫ "ER": Reflection tracking 
⚫ "ED": Directivity 
⚫ "EL": Load match 
⚫ "ET": Transmission tracking 
⚫ "EX": Isolation 
 
<numeric 1>: Response port 
Integer. Range: 1~4 
If ES, ER, or ED is used, the response port and the stimulus port must be the sa
me, while EL, ET, or EX is used, the response port and the stimulus port must b
e different. 
 
<numeric 2>: Stimulus port 
Integer. Range: 1~4 
 
<numeric 3>,...,<numeric 2+n*2>: error coefficient 
Indicates the array data (formatted data array) of NOP (number of measuremen
t points)×2. Where n is an integer between 1 and NOP. 
Data(n×2-2): Data (primary value) at the n-th measurement point. 
Data(n×2-1): Data (secondary value) at the n-th measurement point. Always 0 w
hen the data format is not the Smith chart format or the polar format. 
The index of the array starts from 0. 
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Parameter 
Range 

 None 

Return  Indicates the array data (formatted data array) of NOP (number of measuremen
t points)×2. Where n is an integer between 1 and NOP. 
Data(n×2-2): Data (primary value) at the n-th measurement point. 
Data(n×2-1): Data (secondary value) at the n-th measurement point. Always 0 w
hen the data format is not the Smith chart format or the polar format. 
The index of the array starts from 0. 

Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:THRU 2,1 

:SENSe1:CORRection:COEFficient ET,2,1,-1,0,-0.5,0,0.5,0 
:SENSe1:CORRection:COEFficient:SAVE 
:SENSe1:CORRection:COEFficient? ET,2,1 
Return: -1.000000000000e+00,0.000000000000e+00,-5.000000000000e-01,0.
000000000000e+00,5.000000000000e-01,0.000000000000e+00 

 

3.8.10 Import Enhanced Response Data(:SENSe{[1]-256}:CORRection:C
OEFficient:METHod:ERESponse) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod:ERESponse <numeric 1>,
<numeric 2> 

Instruction  This command sets the calibration type to the enhanced response calibration be
tween the two specified ports when the calibration coefficient data array is writte
n with the SENSe(Ch):CORRection:COEFficient:DATA command, for the select
ed channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port. 
<numeric 2>: Specifies the stimulus port. 

Parameter 
Range 

 1 ~ 4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:ERESponse 1,2 

 

3.8.11 Import Response(Open) Data(:SENSe{[1]-256}:CORRection:COEF
ficient:METHod[:RESPonse]:OPEN) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod[:RESPonse]:OPEN <nume
ric> 

Instruction  This command sets the calibration type to the response calibration (open) of the
 specified port when the calibration coefficient data array is written with the SEN
Se(Ch):CORRection:COEFficient:DATA command, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:OPEN 1 

 

3.8.12 Import Response(Short) Data(:SENSe{[1]-256}:CORRection:COEF
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ficient:METHod[:RESPonse]:SHORt) 
 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod[:RESPonse]:SHORt <num
eric> 

Instruction  This command sets the calibration type to the response calibration (short) of the
 specified port when the calibration coefficient data array is written with the SEN
Se(Ch):CORRection:COEFficient:DATA command, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:SHORt 1 

 

3.8.13 Import Response(Thru) Data(:SENSe{[1]-256}:CORRection:COEFfi
cient:METHod[:RESPonse]:THRU) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod[:RESPonse]:THRU <nume
ric 1>,<numeric 2> 

Instruction  This command sets the calibration type to the response calibration(thru) betwee
n the two specified ports when the calibration coefficient data array is written wit
h the SENSe(Ch):CORRection:COEFficient:DATA command, for the selected c
hannel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port. 
<numeric 2>: Specifies the stimulus port. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:THRU 1,2 

 

3.8.14 Import 1 Port SOLT Data(:SENSe{[1]-256}:CORRection:COEFficie
nt:METHod:SOLT1) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod:SOLT1 <numeric> 

Instruction  This command sets the calibration type to the full 1-port calibration of the specifi
ed port, when the calibration coefficient data array is written with theSENSe(C
h):CORRection:COEFficient:DATA command, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:SOLT1 1 

 

3.8.15 Import 2 Port SOLT Data(:SENSe{[1]-256}:CORRection:COEFficie
nt:METHod:SOLT2) 
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Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod:SOLT2 <numeric1>,<num
eric2> 

Instruction  This command sets the calibration type to full 2-port calibration between the two
 specified ports, when the calibration coefficient data array is written with theSE
NSe(Ch):CORRection:COEFficient:DATA command, for the selected channel. 

Parameter 
Type 

 Array 
<numeric1>: Specifies a port for full 2-port calibration. 
<numeric2>: Specifies a port for full 2-port calibration. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:SOLT2 1,2 

 

3.8.16 Import 3 Port SOLT Data(:SENSe{[1]-256}:CORRection:COEFficie
nt:METHod:SOLT3) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod:SOLT3 <numeric 1>,<num
eric 2>,<numeric 3> 

Instruction  This command sets the calibration type to full 3-port calibration between the thr
ee specified ports, when the calibration coefficient data array is written with the
SENSe(Ch):CORRection:COEFficient:DATA command, for the selected channe
l. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies a port for full 3-port calibration. 
<numeric 2>: Specifies a port for full 3-port calibration. 
<numeric 3>: Specifies a port for full 3-port calibration. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:SOLT3 1,2,4 

 

3.8.17 Import 4 Port SOLT Data(:SENSe{[1]-256}:CORRection:COEFficie
nt:METHod:SOLT4) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:METHod:SOLT4 <numeric 1>,<num
eric 2>,<numeric 3>,<numeric 4> 

Instruction  This command sets the calibration type to full 4-port calibration between the fou
r specified ports, when the calibration coefficient data array is written with theSE
NSe(Ch):CORRection:COEFficient:DATA command, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies a port for full 4-port calibration. 
<numeric 2>: Specifies a port for full 4-port calibration. 
<numeric 3>: Specifies a port for full 4-port calibration. 
<numeric 4>: Specifies a port for full 4-port calibration. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:METHod:SOLT4 1,2,3,4 
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3.8.18 Save Error Coefficient Data(:SENSe{[1]-256}:CORRection:COEFfi
cient:SAVE) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COEFficient:SAVE 

Instruction  This command enables the calibration coefficients depending on the selected c
alibration type from the writing calibration data. If you execute this command bef
ore all calibration data needed for calculating the calibration coefficients are writ
ten, an error occurs and the command is ignored. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COEFficient:SAVE 

 

3.8.19 Measure Isolation Calibration Data(:SENSe{[1]-256}:CORRection:
COLLect[:ACQuire]:ISOLation) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:ISOLation <numeric 1>,<nu
meric 2> 

Instruction  This command measures the calibration data of the isolation from the specified 
stimulus port to the specified response port, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port number. 
<numeric 2>: Specifies the stimulus port number. 
If you specify the same port number to 2 port numbers, an error occurs when ex
ecuted. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Response(Thru) > Isolation-Load(Optional) 

Cal > Basic Cal > Enhanced Response > Isolation-Load(Optional) 
Cal > Basic Cal > SOLT > Isolation-Load(Optional) 
Cal > Basic Cal > SOLR > Isolation-Load(Optional) 

Example  :SENSe1:CORRection:COLLect:ISOLation 1,2 
 

3.8.20 Measure Load Calibration Data(:SENSe{[1]-256}:CORRection:CO
LLect[:ACQuire]:LOAD) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:LOAD <numeric> 

Instruction  This command measures the calibration data of the load standard for the specifi
ed port, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
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Menu  Cal > Basic Cal > Response(Open) > Load(Optional) 
Cal > Basic Cal > Response(Short) > Load(Optional) 
Cal > Basic Cal > OSL > Load 
Cal > Basic Cal > Enhanced Response > Load 
Cal > Basic Cal > SOLT > Load 
Cal > Basic Cal > SOLR > Load 

Example  :SENSe1:CORRection:COLLect:LOAD 1 
 

3.8.21 Measure Open Calibration Data(:SENSe{[1]-256}:CORRection:CO
LLect[:ACQuire]:OPEN) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:OPEN <numeric> 

Instruction  This command measures the calibration data of the OPEN standard for the spe
cified port, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Response(Open) > Open 

Cal > Basic Cal > OSL > Open 
Cal > Basic Cal > Enhanced Response > Open 
Cal > Basic Cal > SOLT > Open 
Cal > Basic Cal > SOLR > Open 

Example  :SENSe1:CORRection:COLLect:OPEN 1 
 

3.8.22 Measure Short Calibration Data(:SENSe{[1]-256}:CORRection:CO
LLect[:ACQuire]:SHORt) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:SHORt <numeric> 

Instruction  This command measures the calibration data of the Short standard for the speci
fied port, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Response(Short) > Short 

Cal > Basic Cal > OSL > Short 
Cal > Basic Cal > Enhanced Response > Short 
Cal > Basic Cal > SOLT > Short 
Cal > Basic Cal > SOLR > Short 

Example  :SENSe1:CORRection:COLLect:SHORt 1 
 

3.8.23 Measure Thru Calibration Data(:SENSe{[1]-256}:CORRection:COL
Lect[:ACQuire]:THRU) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:THRU <numeric 1>,<numeric
 2> 

Instruction  This command measures the calibration data of the Thru sdandard from the spe
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cified stimulus port to the specified response port, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port number. 
<numeric 2>: Specifies the stimulus port number. 
If you specify the same port number to 2 port numbers, an error occurs when ex
ecuted. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Response(Thru) > Thru 

Cal > Basic Cal > Enhanced Response > Thru 
Cal > Basic Cal > SOLT > Thru 
Cal > Basic Cal > SOLR > Unknown Thru 

Example  :SENSe1:CORRection:COLLect:THRU 1,4 
 

3.8.24 Measure TRL Calibration Line Data(:SENSe{[1]-256}:CORRection:
COLLect[:ACQuire]:TRLLine) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:TRLLine <numeric 1>,<nume
ric 2> 

Instruction  This command executes LINE or MATCH measurement of the TRL calibration f
or the selected calibration kit, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port number. 
<numeric 2>: Specifies the stimulus port number. 
If you specify the same port number to 2 port numbers, an error occurs when ex
ecuted. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > TRL > Line 
Example  :SENSe1:CORRection:COLLect:TRLLine 3,4 

 

3.8.25 Measure TRL Calibration Reflect Data(:SENSe{[1]-256}:CORRecti
on:COLLect[:ACQuire]:TRLReflect) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:TRLReflect <numeric> 

Instruction  This command executes the reflection measurement of the TRL calibration for t
he selected calibration kit, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > TRL > Reflect 
Example  :SENSe1:CORRection:COLLect:TRLReflect 1 

 

3.8.26 Measure TRL Calibration Thru Data(:SENSe{[1]-256}:CORRection:
COLLect[:ACQuire]:TRLThru) 
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Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect[:ACQuire]:TRLThru <numeric 1>,<num
eric 2> 

Instruction  This command executes THRU measurement of the TRL calibration for the sele
cted calibration kit, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port number. 
<numeric 2>: Specifies the stimulus port number. 
If you specify the same port number to 2 port numbers, an error occurs when ex
ecuted. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > TRL > Thru 
Example  :SENSe1:CORRection:COLLect:TRLThru 1,2 

 

3.8.27 Label of Cal Kit (:SENSe{[1]-256}:CORRection:COLLect:CKIT:LA
Bel) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:CKIT:LABel <string> 
:SENSe{[1]-256}:CORRection:COLLect:CKIT:LABel? 

Instruction  This command sets/gets the calibration kit name for the calibration kit selected, 
for selected channel. 

Parameter 
Type 

 String 

Parameter 
Range 

 None 

Return  String 
Default  None 
Menu  Cal > Cal Kit > Edit > Cal Kit Name 
Example  :SENSe1:CORRection:COLLect:CKIT:LABel "F503ME_1" 

:SENSe1:CORRection:COLLect:CKIT:LABel? 
Return: F503ME_1 

 

3.8.28 Standart for Load Measurement (:SENSe:CORRection:COLLect:C
KIT:ORDer:LOAD) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD <numeric1>{,<numeric
2>,…,<numeric n>} 
:SENSe:CORRection:COLLect:CKIT:ORDer:LOAD? 

Instruction  This command sets/gets the standard(s) used for the load measurement for a c
alibration kit selected. 

Parameter 
Type 

 Integer or array 
Specifies the order of standard. 

Parameter 
Range 

 1~21 

Return  Integer or array 
Default  None 
Menu  Cal > Cal Kit > Edit > SOLT > LOAD 
Example  :SENSe:CORRection:COLLect:CKIT:ORDer:LOAD 2 

:SENSe:CORRection:COLLect:CKIT:ORDer:LOAD? 
Return: 2 

 

3.8.29 Standart for Open Measurement (:SENSe:CORRection:COLLect:
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CKIT:ORDer:OPEN) 
 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN <numeric1>{,<numeric
2>,…,<numeric n>} 
:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 

Instruction  This command sets/gets the standard(s) used for the open measurement for a c
alibration kit selected. 

Parameter 
Type 

 Integer or array 
Specifies the order of standard. 

Parameter 
Range 

 1~21 

Return  Integer or array  
Default  None 
Menu  Cal > Cal Kit > Edit > SOLT > OPEN 
Example  :SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 2,3 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 
Return: 2,3 

3.8.30 Standart for Short Measurement (:SENSe:CORRection:COLLect:
CKIT:ORDer:SHORt) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:ORDer:SHORt <numeric1>{,<numeric
2>,…,<numeric n>} 
:SENSe:CORRection:COLLect:CKIT:ORDer:SHORt? 

Instruction  This command sets/gets the standard(s) used for the short measurement, for a 
calibration kit selected. 

Parameter 
Type 

 Integer or array 
Specifies the order of standard. 

Parameter 
Range 

 1~21 

Return  Integer or array  
Default  None 
Menu  Cal > Cal Kit > Edit > SOLT > SHORT 
Example  :SENSe1:CORRection:COLLect:CKIT:ORDer:SHORt 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:SHORt? 
Return: 3 

 

3.8.31 Standart for Thru Measurement (:SENSe:CORRection:COLLect:C
KIT:ORDer:THRU) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:ORDer:THRU <numeric1>{,<numeric
2>,…,<numeric n>} 
:SENSe:CORRection:COLLect:CKIT:ORDer:THRU? 

Instruction  This command sets/gets the standard(s) used for the thru measurement, for the
 calibration kit selected. 

Parameter 
Type 

 Integer or array 
Specifies the order of standard. 

Parameter 
Range 

 1~21 

Return  Integer or array  
Default  None 
Menu  Cal > Cal Kit > Edit > SOLT > THRU 
Example  :SENSe1:CORRection:COLLect:CKIT:ORDer:THRU 4,2 

:SENSe1:CORRection:COLLect:CKIT:ORDer:THRU? 
Return: 4,2 
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3.8.32 Standart for TRL Line Measurement (:SENSe:CORRection:COLLe
ct:CKIT:ORDer:TRLLine) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine <numeric1>{,<numeric
2>,…,<numeric n>} 
:SENSe:CORRection:COLLect:CKIT:ORDer:TRLLine? 

Instruction  This command sets/gets the standard used for the line measurement of TRL cal
ibration, for the calibration kit selected. 

Parameter 
Type 

 Integer or array 
Specifies the order of standard. 

Parameter 
Range 

 1~21 

Return  Integer or array  
Default  None 
Menu  Cal > Cal Kit > Edit > TRL > LINE/MATCH 
Example  :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLLine 2 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLLine? 
Return: 2 

 

3.8.33 Standart for TRL Reflect Measurement(:SENSe:CORRection:COL
Lect:CKIT:ORDer:TRLReflect) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect <numeric1>{,<numeric
2>,…,<numeric n>} 
:SENSe:CORRection:COLLect:CKIT:ORDer:TRLReflect? 

Instruction  This command sets/gets the standard used for the reflection measurement of th
e TRL calibration, for the calibration kit selected. 

Parameter 
Type 

 Integer or array 
Specifies the order of standard. 

Parameter 
Range 

 None 

Return  Integer or array  
Default  None 
Menu  Cal > Cal Kit > Edit > TRL > REFLECT 
Example  :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLReflect 3 

:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLReflect? 
Return: 3 

 

3.8.34 Standart for TRL Thru Measurement (:SENSe:CORRection:COLL
ect:CKIT:ORDer:TRLThru) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru <numeric1>{,<numeric
2>,…,<numeric n>} 
:SENSe:CORRection:COLLect:CKIT:ORDer:TRLThru? 

Instruction  This command sets/gets the standard used for the thru measurement of TRL ca
libration, for the calibration kit selected. 

Parameter 
Type 

 Integer or array 
Specifies the order of standard. 

Parameter 
Range 

 1~21 

Return  Integer or array 
Default  None 
Menu  Cal > Cal Kit > Edit > TRL > THRU 
Example  :SENSe1:CORRection:COLLect:CKIT:ORDer:TRLThru 3 
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:SENSe1:CORRection:COLLect:CKIT:ORDer:TRLThru? 
Return: 3 

 

3.8.35 Reset Cal Kit (:SENSe:CORRection:COLLect:CKIT:RESet) 
 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:RESet 

Instruction  This command resets the calibration kit selected to the default factory setting st
ate. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  None 
Example  :SENSe:CORRection:COLLect:CKIT 2 

:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN 1,3 
:SENSe:CORRection:COLLect:CKIT:RESet 
:SENSe:CORRection:COLLect:CKIT:ORDer:OPEN? 
Return: 2 

 

3.8.36 Select Cal Kit (:SENSe:CORRection:COLLect:CKIT[:SELect]) 
 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT[:SELect] <numeric> 
:SENSe:CORRection:COLLect:CKIT[:SELect]? 

Instruction  This command sets/gets the order of the selected calibration kit. 

Parameter 
Type 

 Integer 
Specifies the order of standard. 

Parameter 
Range 

 1~32 

Return  Integer 
Default  1 
Menu  None 
Example  :SENSe:CORRection:COLLect:CKIT 2 

:SENSe:CORRection:COLLect:CKIT? 
Return: 2 

 

3.8.37 C0 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:C0) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C0 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C0? 

Instruction  This command sets/gets the C0 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: fF (femto farad), 1E-15 F (farad) 

Parameter 
Range 

 None 

Return  Float 
Unit: fF (femto farad), 1E-15 F (farad) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C0 
Example  :SENSe:CORRection:COLLect:CKIT:STAN2:C0 100 
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:SENSe:CORRection:COLLect:CKIT:STAN2:C0? 
Return: 100 

 

3.8.38 C1 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:C1) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C1 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C1? 

Instruction  This command sets/gets the C1 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: 1E-27 F/Hz (1E-27 farad / hertz)  

Parameter 
Range 

 None 

Return  Float 
Unit: 1E-27 F/Hz (1E-27 farad / hertz) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C1 
Example  :SENSe:CORRection:COLLect:CKIT:STAN2:C1 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN2:C1? 
Return: 12.3 

 

3.8.39 C2 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:C2) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C2 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C2? 

Instruction  This command sets/gets the C2 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: 1E-36 F/Hz² (1E-36 farad /hertz²) 

Parameter 
Range 

 None 

Return  Float 
Unit: 1E-36 F/Hz² (1E-36 farad /hertz²) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C2 
Example  :SENSe:CORRection:COLLect:CKIT:STAN2:C2 25 

:SENSe:CORRection:COLLect:CKIT:STAN2:C2? 
Return: 25 

 

3.8.40 C3 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:C3) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C3 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:C3? 

Instruction  This command sets/gets the C3 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: 1E-45 F/Hz³ (1E-45 farad / hertz³) 

Parameter 
Range 

 None 

Return  Float 
Unit: 1E-45 F/Hz³ (1E-45 farad / hertz³) 
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Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Open Characteristics > C3 
Example  :SENSe:CORRection:COLLect:CKIT:STAN2:C3 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN2:C3? 
Return: 12.3 

 

3.8.41 L0 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:L0) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L0 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L0? 

Instruction  This command sets/gets the L0 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: pH (pico henry) 

Parameter 
Range 

 None 

Return  Float 
Unit: pH (pico henry) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L0 
Example  :SENSe:CORRection:COLLect:CKIT:STAN3:L0 10 

:SENSe:CORRection:COLLect:CKIT:STAN3:L0? 
Return: 10 

3.8.42 L1 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:L1) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L1 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L1? 

Instruction  This command sets/gets the L1 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: 1E-24 H/Hz (1E-24 henry / hertz) 

Parameter 
Range 

 None 

Return  Float 
Unit: 1E-24 H/Hz (1E-24 henry / hertz) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L1 
Example  :SENSe:CORRection:COLLect:CKIT:STAN3:L1 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L1? 
Return: 12.3 

 

3.8.43 L2 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:L2) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L2 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L2? 

Instruction  This command sets/gets the L2 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: 1E-33 H/Hz² (1E-33 henry / hertz²) 

Parameter 
Range 

 None 
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Return  Float 
Unit: 1E-33 H/Hz² (1E-33 henry / hertz²) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L2 
Example  :SENSe:CORRection:COLLect:CKIT:STAN3:L2 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L2? 
Return: 12.3 

 

3.8.44 L3 Value of the Standard (:SENSe:CORRection:COLLect:CKIT:ST
AN{[1]-30}:L3) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L3 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:L3? 

Instruction  This command sets/gets the L3 value of the selected standard, for the calibratio
n kit selected. 

Parameter 
Type 

 Float 
Unit: 1E-42 H/Hz³ (1E-42 henry / hertz³) 

Parameter 
Range 

 None 

Return  Float 
Unit: 1E-42 H/Hz³ (1E-42 henry / hertz³) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Short Characteristics > L3 
Example  :SENSe:CORRection:COLLect:CKIT:STAN3:L3 12.3 

:SENSe:CORRection:COLLect:CKIT:STAN3:L3? 
Return: 12.3 

 

3.8.45 Delay of the Standard (:SENSe:CORRection:COLLect:CKIT:STAN
{[1]-30}:DELay) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:DELay <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:DELay? 

Instruction  This command sets/gets the value of the offset delay of the selected standard, f
or the calibration kit selected. 

Parameter 
Type 

 Float 
Unit: s (second) 

Parameter 
Range 

 None 

Return  Float 
Unit: s (second) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Delay Characteristics > Delay 
Example  :SENSe:CORRection:COLLect:CKIT:STAN1:DELay 1 

:SENSe:CORRection:COLLect:CKIT:STAN1:DELay? 
Return: 1 

 

3.8.46 Max Frequency of the Standard (:SENSe:CORRection:COLLect:C
KIT:STAN{[1]-30}:FMAXimum) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:FMAXimum <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:FMAXimum? 

Instruction  This command sets/gets the value of the stop frequency of the selected standar
d, for the calibration kit selected. 
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Parameter 
Type 

 Float 
Unit: Hz (hertz) 

Parameter 
Range 

 None 

Return  Float 
Unit: Hz (hertz) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Frequency Range > Max 
Example  :SENSe:CORRection:COLLect:CKIT:STAN1:FMAXimum 4.5e9 

:SENSe:CORRection:COLLect:CKIT:STAN1:FMAXimum? 
Return: 4500000000 

 

3.8.47 Min Frequency of the Standard (:SENSe:CORRection:COLLect:C
KIT:STAN{[1]-30}:FMINimum) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:FMINimum <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:FMINimum? 

Instruction  This command sets/gets the value of the start frequency of the selected standar
d, for the calibration kit selected. 

Parameter 
Type 

 Float 
Unit: Hz (hertz) 

Parameter 
Range 

 None 

Return  Float 
Unit: Hz (hertz) 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Frequency Range > MIN 
Example  :SENSe:CORRection:COLLect:CKIT:STAN1:FMINimum 500e6 

:SENSe:CORRection:COLLect:CKIT:STAN1:FMINimum? 
Return: 500000000 

 

3.8.48 Label of Cal Standard (:SENSe:CORRection:COLLect:CKIT:STAN
{[1]-30}:LABel) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:LABel <string> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:LABel? 

Instruction  This command sets/gets the name of the selected standard, for the calibration k
it selected. 

Parameter 
Type 

 String 

Parameter 
Range 

 None 

Return  String 
Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Label 
Example  :SENSe:CORRection:COLLect:CKIT:STAN1:LABel "LOAD_1" 

:SENSe:CORRection:COLLect:CKIT:STAN1:LABel? 
Return: LOAD_1 

 

3.8.49 Loss of the Standard (:SENSe:CORRection:COLLect:CKIT:STAN
{[1]-30}:LOSS) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:LOSS <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:LOSS? 
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Instruction  This command sets/gets the value of the loss of the selected standard, for the c
alibration kit selected. 

Parameter 
Type 

 Float 
Unit: ohm/s 

Parameter 
Range 

 None 

Return  Float 
Unit: ohm/s 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Delay Characteristics > Loss 
Example  :SENSe:CORRection:COLLect:CKIT:STAN1:LOSS 0.5 

:SENSe:CORRection:COLLect:CKIT:STAN1:LOSS? 
Return: 0.5 

 

3.8.50 Z0 of the Standard (:SENSe:CORRection:COLLect:CKIT:STAN{[1]
-30}:Z0) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:Z0 <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:Z0? 

Instruction  This command sets/gets the value of the offset Z0 of the selected standard, for t
he calibration kit selected. 

Parameter 
Type 

 Float 
Unit: ohm 

Parameter 
Range 

 None 

Return  Float 
Unit: ohm 

Default  None 
Menu  Cal > Cal Kit > Edit Kit > Standards > Edit > Delay Characteristics > Z0 
Example  :SENSe:CORRection:COLLect:CKIT:STAN1:Z0 75 

:SENSe:CORRection:COLLect:CKIT:STAN1:Z0? 
Return: 75 

 

3.8.51 Standard Type (:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:
TYPE) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:TYPE <numeric> 
:SENSe:CORRection:COLLect:CKIT:STAN{[1]-30}:TYPE? 

Instruction  This command sets/gets the standard type for the calibration kit selected. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 OPEN|SHORt|LOAD|THRU 

Return  Enumeration 
Default  OPEN 
Menu  Cal > Cal Kit > Edit Kit > Standards > Add > Add Standard 
Example  :SENSe:CORRection:COLLect:CKIT:STAN1:TYPE LOAD 

:SENSe:CORRection:COLLect:CKIT:STAN1:TYPE? 
Return: LOAD 

 

3.8.52 TRL Reference Impedance (:SENSe:CORRection:COLLect:CKIT:T
RLoption:IMPedance) 
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Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance {LINE|SYSTem} 
:SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance? 

Instruction  This command sets/gets the reference impedance during the TRL calibration. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 LINE|SYSTem 

Return  Enumeration 
Default  SYSTem 
Menu  Cal > Cal Kit > Edit Kit > TRL > Calibration Reference Z0 
Example  :SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance LINE 

:SENSe:CORRection:COLLect:CKIT:TRLoption:IMPedance? 
Return: LINE 

 

3.8.53 TRL Calibration Plane (:SENSe:CORRection:COLLect:CKIT:TRLo
ption:RPLane) 

 

Command 
Format 

 :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane {THRU|REFLect} 
:SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane? 

Instruction  This command sets/gets the reference plane during the TRL calibration. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 THRU|REFLect 

Return  Enumeration 
Default  THRU 
Menu  Cal > Cal Kit > Edit Kit > TRL > Test Port reference Plane 
Example  :SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane REFLect 

:SENSe:CORRection:COLLect:CKIT:TRLoption:RPLane? 
Return: REFL 

 

3.8.54 Cancel the Calibration Measurement (:SENSe{[1]-256}:CORRectio
n:COLLect:CLEar) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:CLEar 

Instruction  This command clears the calibration measurement data when the frequency off
set feature is off, for the selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Cancel 

Cal > Basic Cal > Next > Cancel 
Example  :SENSe1:CORRection:COLLect:CLEar 

 

3.8.55 Set Calibration Type to Enhanced Response (:SENSe{[1]-256}:CO
RRection:COLLect:METHod:ERESponse) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:ERESponse <numeric 1>,<nu
meric 2> 

Instruction  This command sets the calibration type to the enhanced response calibration be
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tween the two specified ports, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port number. 
<numeric 2>: Specifies the stimulus port number. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Enhanced Response 
Example  :SENSe1:CORRection:COLLect:METHod:ERESponse 1,2 

 

3.8.56 Set Calibration Type to Response(Open) (:SENSe{[1]-256}:CORR
ection:COLLect:METHod[:RESPonse]:OPEN) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod[:RESPonse]:OPEN <numeri
c> 

Instruction  This command sets the calibration type to the response calibration (open) of the
 specified port, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1 to 4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Response(Open) 
Example  :SENSe1:CORRection:COLLect:METHod:OPEN 2 

 

3.8.57 Set Calibration Type to Response(Short) (:SENSe{[1]-256}:CORR
ection:COLLect:METHod[:RESPonse]:SHORt) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod[:RESPonse]:SHORt <numeri
c> 

Instruction  This command sets the calibration type to the response calibration (short) of the
 specified port, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1 to 4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Response(Short) 
Example  :SENSe1:CORRection:COLLect:METHod:SHORt 3 

 

3.8.58 Set Calibration Type to Response(Thru) (:SENSe{[1]-256}:CORRe
ction:COLLect:METHod[:RESPonse]:THRU) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod[:RESPonse]:THRU <numeric 
1>,<numeric 2> 

Instruction  This command sets the calibration type to the response calibration (thru) betwe
en the specified 2 ports, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies the response port number. 
<numeric 2>: Specifies the stimulus port number. 
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Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Response(Thru) 
Example  :SENSe1:CORRection:COLLect:METHod:THRU 1,2 

 

3.8.59 Set Calibration Type to OSL (:SENSe{[1]-256}:CORRection:COLL
ect:METHod:SOLT1) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:SOLT1 <numeric> 

Instruction  This command sets the calibration type to the 1-port calibration OSL of the spec
ified port, for the selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 1 to 4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > OSL 
Example  :SENSe1:CORRection:COLLect:METHod:SOLT1 3 

 

3.8.60 Set Calibration Type to 2-Port SOLT (:SENSe{[1]-256}:CORRectio
n:COLLect:METHod:SOLT2) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:SOLT2 <numeric 1>,<numeric
 2> 

Instruction  This command sets the calibration type to the 2-port calibration SOLT of the spe
cified port, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies port number for 2-port calibration. 
<numeric 2>: Specifies port number for 2-port calibration. 
If you specify the same port number to 2 port numbers, an error occurs when ex
ecuted. The order of the 2 port numbers to be specified is arbitrary. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > SOLT 
Example  :SENSe1:CORRection:COLLect:METHod:SOLT2 1,2 

 

3.8.61 Set Calibration Type to 3-Port SOLT (:SENSe{[1]-256}:CORRectio
n:COLLect:METHod:SOLT3) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:SOLT3 <numeric 1>,<numeric
 2>,<numeric 3> 

Instruction  This command sets the calibration type to the 3-port calibration SOLT between t
he specified 3 ports, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies port number for 3-port calibration. 
<numeric 2>: Specifies port number for 3-port calibration. 
<numeric 3>: Specifies port number for 3-port calibration. 
If you specify the same port number to 3 port numbers, an error occurs when ex
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ecuted. The order of the 3 port numbers to be specified is arbitrary. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > SOLT 
Example  :SENSe1:CORRection:COLLect:METHod:SOLT3 1,2,4 

 

3.8.62 Set Calibration Type to 4-Port SOLT (:SENSe{[1]-256}:CORRectio
n:COLLect:METHod:SOLT4) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:SOLT4 <numeric 1>,<numeric
 2>,<numeric 3>,<numeric 4> 

Instruction  This command sets the calibration type to the full 4-port calibration SOLT, for th
e selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies port number for 4-port calibration. 
<numeric 2>: Specifies port number for 4-port calibration. 
<numeric 3>: Specifies port number for 4-port calibration. 
<numeric 4>: Specifies port number for 4-port calibration. 
If you specify the same port number to 4 port numbers, an error occurs when ex
ecuted. The order of the 4 port numbers to be specified is arbitrary. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > SOLT 
Example  :SENSe1:CORRection:COLLect:METHod:SOLT4 1,2,3,4 

 

3.8.63 Set Calibration Type to 2-port TRL (:SENSe{[1]-256}:CORRection:
COLLect:METHod:TRL2) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:TRL2 <numeric 1>,<numeric 
2> 

Instruction  This command sets the calibration type to 2-port TRL between the 2 specified p
orts, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies port number for TRL 2-port calibration. 
<numeric 2>: Specifies port number for TRL 2-port calibration. 
If you specify the same port number to 2 port numbers, an error occurs when ex
ecuted. the order of the 2 port numbers to be specified is arbitrary. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > TRL 
Example  :SENSe1:CORRection:COLLect:METHod:TRL2 1,2 

 

3.8.64 Set Calibration Type to 3-port TRL (:SENSe{[1]-256}:CORRection:
COLLect:METHod:TRL3) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:TRL3 <numeric 1>,<numeric 
2>,<numeric 3> 
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Instruction  This command sets the calibration type to 3-port TRL between the 3 specified p
orts, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>: Specifies port number for TRL 3-port calibration. 
<numeric 2>: Specifies port number for TRL 3-port calibration. 
<numeric 3>: Specifies port number for TRL 3-port calibration. 
If you specify the same port number to 3 port numbers, an error occurs when ex
ecuted. the order of the 3 port numbers to be specified is arbitrary. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > TRL 
Example  :SENSe1:CORRection:COLLect:METHod:TRL3 1,2,3 

 

3.8.65 Set Calibration Type to 4-port TRL (:SENSe{[1]-256}:CORRection:
COLLect:METHod:TRL4) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:TRL4 <numeric 1>,<numeric 
2>,<numeric 3>,<numeric 4> 

Instruction  This command sets the calibration type to the 4-port calibration TRL between th
e 4 specified ports, for the selected channel. 

Parameter 
Type 

 Array 
<numeric 1>:Specifies port number for TRL 4-port calibration. 
<numeric 2>:Specifies port number for TRL 4-port calibration. 
<numeric 3>:Specifies port number for TRL 4-port calibration. 
<numeric 4>:Specifies port number for TRL 4-port calibration. 
If you specify the same port number to 4 port numbers, an error occurs when ex
ecuted. the order of the 4 port numbers to be specified is arbitrary. 

Parameter 
Range 

 1~4 

Return  None 
Default  None 
Menu  Cal > Basic Cal > TRL 
Example  :SENSe1:CORRection:COLLect:METHod:TRL4 1,2,3,4 

 

3.8.66 Get Calibration Type (:SENSe{[1]-256}:CORRection:COLLect:ME
THod:TYPE?) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:METHod:TYPE? 

Instruction  This command reads the selected calibration type of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  None 
Example  :SENSe1:CORRection:COLLect:METHod:TRL4 1,2,3,4 

:SENSe1:CORRection:COLLect:METHod:TYPE? 
Return: TRL4 

 

3.8.67 Save Calibration Data(:SENSe{[1]-256}:CORRection:COLLect:SA
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VE) 
 

Command 
Format 

 :SENSe{[1]-256}:CORRection:COLLect:SAVE 

Instruction  This command calculates the calibration coefficients depending on the calibratio
n type selection, from the measured calibration data and save it.  

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Cal > Basic Cal > Finish 
Example  :SENSe1:CORRection:COLLect:SAVE 

 

3.8.68 Frequency 1 or 2 of Port Extension (:SENSe{[1]-256}:CORRection:
EXTension:PORT{[1]|2|3|4}:FREQuency{[1]|2}) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:FREQuency{[1]|2} <n
umeric> 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:FREQuency{[1]|2}? 

Instruction  This command sets/gets the frequency used for calculation of the loss value of t
he frequency 1 and 2 of the selected port, for the selected channel. 

Parameter 
Type 

 Double, unit: Hz 

Parameter 
Range 

 9kHz~8.5GHz 

Return  Double, unit: Hz 
Default  1GHz 
Menu  Cal > Port Extension > Port Extensions… > Loss > Freq1 or Freq2 
Example   

 

3.8.69 State of Loss Value and Frequency Value (:SENSe{[1]-256}:CORR
ection:EXTension:PORT{[1]|2|3|4}:INCLude{[1]|2}[:STATe]) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:INCLude{[1]|2}[:STA
Te] {ON|OFF|1|0} 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:INCLude{[1]|2}[:STA
Te] 

Instruction  This command turns ON/OFF the set of loss value and frequency value of inclu
de 1 and 2 of the port 1 to 4, for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  0|1 
Default  OFF 
Menu  Cal > Port Extension > Port Extensions… > Loss 
Example  :SENSe1:CORRection:EXTension:PORT1:INCLude1 ON 

:SENSe1:CORRection:EXTension:PORT1:INCLude1? 
Return: 1 

 

3.8.70 DC Loss of Port Extension (:SENSe{[1]-256}:CORRection:EXTens
ion:PORT{[1]|2|3|4}:LDC) 
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Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:LDC <numeric> 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:LDC? 

Instruction  This command sets/gets the DC loss value of the port 1 to 4, for the selected ch
annel. 

Parameter 
Type 

 Float, unit dB 

Parameter 
Range 

 -90 ~ 90dB 

Return  Float, unit dB 
Default  0dB 
Menu  Cal > Port Extension > DC Loss 
Example  :SENSe1:CORRection:EXTension:PORT2:LDC 10 

:SENSe1:CORRection:EXTension:PORT2:LDC? 
Return: 10 

 

3.8.71 Loss Value of Port Extension (:SENSe{[1]-256}:CORRection:EXTe
nsion:PORT{[1]|2|3|4}:LOSS{[1]|2}) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:LOSS{[1]|2} <numeri
c> 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:LOSS{[1]|2}? 

Instruction  This command sets/gets the loss value of the loss 1 to 4 of the port 1 to 4, for th
e selected channel. 

Parameter 
Type 

 Float, unit dB 

Parameter 
Range 

 -90 ~ 90dB 

Return  Float, unit dB 
Default  0dB 
Menu  Cal > Port Extension > Port Extensions… > Loss > Loss1 or Loss2 
Example  :SENSe1:CORRection:EXTension:PORT1:LOSS1 2 

:SENSe1:CORRection:EXTension:PORT1:LOSS1? 
Return: 2 

 

3.8.72 Delay Time of Port Extension (:SENSe{[1]-256}:CORRection:EXTe
nsion:PORT{[1]|2|3|4}:TIME) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:TIME <numeric> 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:TIME? 

Instruction  This command sets or gets the value of the delay time for the port extension of 
ports 1 and 4, for the selected channel. 

Parameter 
Type 

 Float, unit s(second) 

Parameter 
Range 

 0~10s 

Return  Float, unit s(second) 
Default  0 
Menu  Cal > Port Extension > Time 
Example  :SENSe1:CORRection:EXTension:PORT1:TIME 5 

:SENSe1:CORRection:EXTension:PORT1:TIME? 
Return: 5 

 

3.8.73 Delay Distance of Port Extension (:SENSe{[1]-256}:CORRection:E
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XTension:PORT{[1]|2|3|4}:DISTance) 
 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:DISTance <numeric> 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:DISTance? 

Instruction  This command sets and returns the port extension delay in physical length (dist
ance). 

Parameter 
Type 

 Float, unit m(meter), or ft(feet), or in(inches) 

Parameter 
Range 

 None 

Return  Float, unit m(meter), or ft(feet), or in(inches) 
Default  0 
Menu  Cal > Port Extension > Distance 
Example  :SENSe1:CORRection:EXTension:PORT1:DISTance 1 

:SENSe1:CORRection:EXTension:PORT1:DISTance? 
Return: 1 

 

3.8.74 Distance Unit of Port Extension (:SENSe{[1]-256}:CORRection:EX
Tension:PORT{[1]|2|3|4}:DISTANCE:UNIT) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:DISTANCE:UNIT {M
ETers|FEET|INCHes} 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:DISTANCE:UNIT? 

Instruction  This command Sets and returns the units for specifying port extension delay in 
physical length (distance). 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 METers|FEET|INCHes 

Return  Enumeration 
Default  METers 
Menu  Cal > Port Extension > Port Extensions… > Delay > Distance Units 
Example  :SENSe1:CORRection:EXTension:PORT1:DISTANCE:UNIT INCHes 

:SENSe1:CORRection:EXTension:PORT1:DISTANCE:UNIT? 
Return: INCH 

 

3.8.75 State of Port Extension (:SENSe{[1]-256}:CORRection:EXTension[:
STATe]) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension[:STATe] {ON|OFF|1|0} 
:SENSe{[1]-256}:CORRection:EXTension[:STATe]? 

Instruction  This command turns ON/OFF or returns the status of the port extension, for the 
selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Port Extension > Port Extension 
Example  :SENSe1:CORRection:EXTension ON 

:SENSe1:CORRection:EXTension? 
Return: 1 
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3.8.76 Velocity of Port Extension (:SENSe{[1]-256}:CORRection:EXTensi
on:VELocity) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:VELFactor <numeri
c> 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]|2|3|4}:VELFactor? 

Instruction  This command sets or gets the value of Velocity coefficient, for the selected cha
nnel. 

Parameter 
Type 

 Float 

Parameter 
Range 

 0 ~ 1 

Return  Float 
Default  1 
Menu  Cal > Port Extension > Velocity 
Example  :SENSe1:CORRection:EXTension:PORT1:VELFactor 0.66 

:SENSe1:CORRection:EXTension:PORT1:VELFactor? 
Return: 0.66 

 

3.8.77 State of Velocity Couple (:SENSe{[1]-256}:CORRection:EXTensio
n:PORT{[1]-4}:SYSVelocity) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:PORT{[1]-4}:SYSVelocity {ON|OFF|1|
0} 
:SENSe{[1]-256}:CORRection:EXTension:PORT{[1]-4}:SYSVelocity? 

Instruction  This command sets or returns the state of coupling with the system Velocity Fac
tor value. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  ON 
Menu  Cal > Port Extension > Port Extensions… > Velocity > Couple to system Velocit

y Factor 
Example  :SENSe1:CORRection:EXTension:PORT1:SYSVelocity 0 

:SENSe1:CORRection:EXTension:PORT1:SYSVelocity? 
Return: 0 

 

3.8.78 Clear Port Extension Data (:SENSe{[1]-256}:CORRection:EXTensi
on:AUTO:RESet) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:AUTO:RESet 

Instruction  This command clears old port extension delay and loss data in preparation for a
cquiring new data. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Cal > Port Extension > Port Extension… > Reset 
Example  :SENSe1:CORRection:EXTension:AUTO:RESet 
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3.8.79 Calculate Method for Auto Port Extension (:SENSe{[1]-256}:COR
Rection:EXTension:AUTO:CONFig) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:AUTO:CONFig {CSPN|AMKR|USPN} 
:SENSe{[1]-256}:CORRection:EXTension:AUTO:CONFig? 

Instruction  This command sets/gets the frequency point to calculate the auto port extensio
n, for the selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 CSPN|AMKR|USPN 

Return  Enumeration 
Default  CSPN 
Menu  Cal > Port Extension > Automatic Port Extension > Method 
Example  :SENSe1:CORRection:EXTension:AUTO:CONFig USPN 

:SENSe1:CORRection:EXTension:AUTO:CONFig? 
Return: USPN 

 

3.8.80 Adjust for Mismatch State (:SENSe{[1]-256}:CORRection:EXTensi
on:AUTO:DCOFfset) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:AUTO:DCOFfset {ON|OFF|1|0} 
:SENSe{[1]-256}:CORRection:EXTension:AUTO:DCOFfset? 

Instruction  This command enables/disables or gets the usage of DC Offset value for the re
sults of the auto port extension, for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  ON 
Menu  Cal > Port Extension > Automatic Port Extension > Setting > Adjust for Mismatc

h 
Example  :SENSe1:CORRection:EXTension:AUTO:DCOFfset 0 

:SENSe1:CORRection:EXTension:AUTO:DCOFfset? 
Return: 0 

 

3.8.81 State of the Loss Compensation (:SENSe{[1]-256}:CORRection:E
XTension:AUTO:LOSS) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:AUTO:LOSS  {ON|OFF|1|0} 
:SENSe{[1]-256}:CORRection:EXTension:AUTO:LOSS? 

Instruction  This command turns ON/OFF or gets the status of the loss compensation for th
e results of the auto port extension, for the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  ON 
Menu  Cal > Port Extension > Automatic Port Extension > Setting > Include Loss 
Example  :SENSe1:CORRection:EXTension:AUTO:LOSS OFF 

:SENSe1:CORRection:EXTension:AUTO:LOSS? 
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Return: 0 
 

3.8.82 User Span Start Frequency(:SENSe{[1]-256}:CORRection:EXTens
ion:AUTO:STARt) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:AUTO:STARt <numeric> 
:SENSe{[1]-256}:CORRection:EXTension:AUTO:STARt? 

Instruction  This command gets/sets the start frequency within the frequency range of the u
ser specified auto port extension, for the selected channel. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 

Return  Float, unit: Hz 
Default  100 kHz 
Menu  Cal > Port Extension > Automatic Port Extension > User Span > Start 
Example  :SENSe1:CORRection:EXTension:AUTO:STARt 1e6 

:SENSe1:CORRection:EXTension:AUTO:STARt? 
Return: 1000000 

 

3.8.83 User Span Start Frequency(:SENSe{[1]-256}:CORRection:EXTens
ion:AUTO:STOP) 

 

Command 
Format 

 :SENSe{[1]-256}:CORRection:EXTension:AUTO:STOP <numeric> 
:SENSe{[1]-256}:CORRection:EXTension:AUTO:STOP? 

Instruction  This command get/set the stop frequency within the frequency range of the user
 specified auto port extension, for the selected channel. 

Parameter 
Type 

 Float, unit:Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 

Return  Float, unit:Hz 
Default  8.5 GHz 
Menu  Cal > Port Extension > Automatic Port Extension > User Span > Stop 
Example  :SENSe1:CORRection:EXTension:AUTO:STOP 1e9 

:SENSe1:CORRection:EXTension:AUTO:STOP?  
Return: 1000000000 

 

3.8.84 Velocity Factor (:SENSe{[1]-256}:CORRection:RVELocity:COAX) 
 

Command 
Format 

 :SENSe{[1]-256}:CORRection:RVELocity:COAX <numeric> 
:SENSe{[1]-256}:CORRection:RVELocity:COAX? 

Instruction  This command sets/gets the velocity factor, for selected channel. 

Parameter 
Type 

 Float 

Parameter 
Range 

 0~1 

Return  Float 
Default  1 
Menu  Scale > Electrical Delay > Velocity Factor 
Example  :SENSe1:CORRection:RVELocity:COAX 0.5 

:SENSe1:CORRection:RVELocity:COAX? 
Return: 0.5 
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3.8.85 Correction State (:SENSe{[1]-256}:CORRection:STATe) 
 

Command 
Format 

 :SENSe{[1]-256}:CORRection:STATe {ON|OFF|1|0} 
:SENSe{[1]-256}:CORRection:STATe? 

Instruction  This turns ON/OFF or gets the status of the error correction of selected channel 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Cal > Correction 
Example  :SENSe1:CORRection:STATe ON 

:SENSe1:CORRection:STATe? 
Return: 1 

 

3.8.86 System Impedance (:SENSe:CORRection:IMPedance[:INPut][:MA
GNitude]) 

 

Command 
Format 

 :SENSe:CORRection:IMPedance[:INPut][:MAGNitude] <numeric> 
:SENSe:CORRection:IMPedance[:INPut][:MAGNitude]? 

Instruction  This command sets/gets the system characteristic impedance (Z0) value. 

Parameter 
Type 

 Float 

Parameter 
Range 

 0~1000 

Return  Float 
Default  50 
Menu  Scale > Constants > System Z0 
Example  :SENSe:CORRection:IMPedance 75 

:SENSe:CORRection:IMPedance? 
Return: 75 

3.8.87 Get Corrected Data Array (:SENSe{[1]-256}:DATA:CORRdata? S<
XY>) 

 

Command 
Format 

 :SENSe{[1]-256}:DATA:CORRdata? S<XY> 

Instruction  This command gets S-Parameter data of selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 "S<XY>", 
Where 
X: 1 to 4 
Y: 1 to 4 

Return  Indicates the array data of NOP (number of measurement points)×2. Where n is
 an integer between 1 and NOP. 
 
Data(n×2-2): Real part of the data (complex number) at the n-th measurement p
oint. 
Data(n×2-1): Imaginary part of the data (complex number) at the n-th measurem
ent point. 
 
The index of the array starts from 0. 

Default  None 



SNA5000A Programming Guide           137 

 

 

Menu  None 
Example  :SENSe1:DATA:CORRdata? S11 

 

3.8.88 Get Raw Data Array(:SENSe{[1]-256}:DATA:RAWData? S<XY>) 
 

Command 
Format 

 :SENSe{[1]-256}:DATA:RAWData? S<XY> 

Instruction  This command gets the raw data of selected channel. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 " S<XY>", 
Where 
X: 1 to 4 
Y: 1 to 4 

Return  Indicates the array data of NOP (number of measurement points)×2. Where n is
 an integer between 1 and NOP. 
 
Data(n×2-2): Real part of the data (complex number) at the n-th measurement p
oint. 
Data(n×2-1): Imaginary part of the data (complex number) at the n-th measurem
ent point. 
 
The index of the array starts from 0. 

Default  None 
Menu  None 
Example  :SENSe1:DATA:RAWData? S11 

 

3.8.89 Center Frequency (:SENSe{[1]-256}:FREQuency:CENTer) 
 

Command 
Format 

 :SENSe{[1]-256}:FREQuency:CENTer <numeric> 
:SENSe{[1]-256}:FREQuency:CENTer? 

Instruction  This command sets/gets the center value of the sweep range of selected chann
el. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 

Return  Float, unit: Hz 
Default  4.25005 GHz 
Menu  Freq > Center 
Example  :SENSe1:FREQuency:CENTer 1e9 

:SENSe1:FREQuency:CENTer? 
Return: 1000000000 

 

3.8.90 Cw Frequency (:SENSe{[1]-256}:FREQuency:CW) 
 

Command 
Format 

 :SENSe{[1]-256}:FREQuency:CW <numeric> 
:SENSe{[1]-256}:FREQuency:CW? 

Instruction  This command sets/gets the fixed frequency (CW frequency) for the power swe
ep for channels 1 to 200. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 
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Return  Float, unit: Hz 
Default  1 GHz 
Menu  Freq > CW 
Example  :SENSe1:FREQuency:CW 2e9 

:SENSe1:FREQuency:CW? 
Return: 2000000000 

 

3.8.91 Cw Frequency (:SENSe{[1]-256}:FREQuency:FIXed) 
 

Command 
Format 

 :SENSe{[1]-256}:FREQuency:FIXed <numeric> 
:SENSe{[1]-256}:FREQuency:FIXed? 

Instruction  This command sets/gets the fixed frequency (CW frequency) for the power swe
ep for channels 1 to 200. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 

Return  Float, unit: Hz 
Default  1 GHz 
Menu  Freq > CW 
Example  :SENSe1:FREQuency:FIXed 3e9 

:SENSe1:FREQuency:FIXed? 
Return: 3000000000 

 

3.8.92 Frequency of All Measurement Points (:SENSe{[1]-256}:FREQuen
cy:DATA?) 

 

Command 
Format 

 :SENSe{[1]-256}:FREQuency:DATA? 

Instruction  This command reads the frequencies at all measurement points of channels 1 t
o 200. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Data array 
Default  None 
Menu  None 
Example  :SENSe1:FREQuency:DATA? 

 

3.8.93 Frequency SPAN (:SENSe{[1]-256}:FREQuency:SPAN) 
 

Command 
Format 

 :SENSe{[1]-256}:FREQuency:SPAN <numeric> 
:SENSe{[1]-256}:FREQuency:SPAN? 

Instruction  This command sets/gets the span value of the sweep range of selected channe
l. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 

Return  Float, unit: Hz 
Default  8.4999 GHz 
Menu  Freq > Span 
Example  :SENSe1:FREQuency:SPAN 1e6 
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:SENSe1:FREQuency:SPAN? 
Return: 1000000 

 

3.8.94 Start Frequency (:SENSe{[1]-256}:FREQuency:STARt) 
 

Command 
Format 

 :SENSe{[1]-256}:FREQuency:STARt <numeric> 
:SENSe{[1]-256}:FREQuency:STARt? 

Instruction  This command sets/gets the start value of the sweep range of selected channel. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 

Return  Float, unit: Hz 
Default  9 kHz 
Menu  Freq > Start 
Example  :SENSe1:FREQuency:STARt 100e3 

:SENSe1:FREQuency:STARt? 
Return: 100000 

 

3.8.95 Stop Frequency (:SENSe{[1]-256}:FREQuency:STOP) 
 

Command 
Format 

 :SENSe{[1]-256}:FREQuency:STOP <numeric> 
:SENSe{[1]-256}:FREQuency:STOP? 

Instruction  This command sets/gets the stop value of the sweep range of selected channel. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 9 kHz ~ 8.5 GHz 

Return  Float, unit: Hz 
Default  8.5 GHz 
Menu  Freq > Stop 
Example  :SENSe1:FREQuency:STOP 1e9 

:SENSe1:FREQuency:STOP? 
Return: 1000000000 

 

3.8.96 IF Bandwidth Per Port (:SENSe{[1]-256}:SEGMent:LIST:BWIDth:P
ORT:STATe) 

 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:LIST:BWIDth:PORT:STATe {ON|OFF|1|0} 
:SENSe{[1]-256}:SEGMent:LIST:BWIDth:PORT:STATe? 

Instruction  This command turns ON/OFF or gets the status of IFBW Per Port control in the 
segment sweep table. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  0|1 
Default  OFF 
Menu  Sweep > Segment Table > Segment Table Setting > IF Bandwidth Per Port 
Example  :SENSe1:SEGMent:LIST:BWIDth:PORT:STATe 1 

:SENSe1:SEGMent:LIST:BWIDth:PORT:STATe? 
Return: 1 
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3.8.97 IFBW of Each Segment  (:SENSe{[1]-256}:SEGMent:LIST:BWIDth:
PORT{[1]-4}[:RESolution]) 

 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:LIST:BWIDth:PORT{[1]-4}[:RESolution] <value 1>,<
value 2>,...,<value N> 
:SENSe{[1]-256}:SEGMent:LIST:BWIDth:PORT{[1]-4}[:RESolution]? 

Instruction  This command sets/gets the IFBW of each segment for the selected port and ch
annel. 
Indicates the array data of NOP (number of total segment numbers). Where n is
 an integer between 1 and NOP. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 None 

Return  Data array 
Default  10 kHz 
Menu  Sweep > Segment Table > Segment Table Setting 
Example  :SENSe1:SEGMent:LIST:BWIDth:PORT1:RESolution 10e3,20e3,30e3 

:SENSe1:SEGMent:LIST:BWIDth:PORT1? 
Return: 1.000000000000e+04,2.000000000000e+04,3.000000000000e+04 

 

3.8.98 State of Each Segment (:SENSe{[1]-256}:SEGMent:LIST:CONTrol:
DATA) 

 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:LIST:CONTrol:DATA <state 1>,<state 2>,…,<state 
N> 
:SENSe{[1]-256}:SEGMent:LIST:CONTrol:DATA? 

Instruction  This command sets/gets the state of each segment in the segment sweep table 
of selected channel. 
Indicates the array data of NOP (number of total segment numbers). Where n is
 an integer between 1 and NOP.  

Parameter 
Type 

 Data array 

Parameter 
Range 

 None 

Return  Data array 
Default  None 
Menu  Sweep > Segment Table > Segment Table Setting 
Example  :SENSe1:SEGMent:LIST:CONTrol:DATA 1,1,0 

:SENSe1:SEGMent:LIST:CONTrol:DATA? 
Return: 1,1,0 

 

3.8.99 Individual Segment State Control  (:SENSe{[1]-256}:SEGMent:LIS
T:CONTrol:STATe) 

 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:LIST:CONTrol:STATe {ON|OFF|1|0} 
:SENSe{[1]-256}:SEGMent:LIST:CONTrol:STATe? 

Instruction  This command turns ON/OFF or gets the individual segment state control in the 
segment sweep table. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
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Default  1 
Menu  None 
Example  :SENSe1:SEGMent:LIST:CONTrol:STATe 0 

:SENSe1:SEGMent:LIST:CONTrol:STATe? 
Return: 0 

 

3.8.100 Individual Power Control  (:SENSe{[1]-256}:SEGMent:LIST:POWe
r:PORT:STATe) 

 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:LIST:POWer:PORT:STATe {ON|OFF|1|0} 
:SENSe{[1]-256}:SEGMent:LIST:POWer:PORT:STATe? 

Instruction  This command turns ON/OFF the individual power control in the segment swee
p table. This command overrides the coupled port power control. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  0 
Menu  Sweep > Segment Table > Segment Table Setting > Power Level 
Example  :SENSe1:SEGMent:LIST:POWer:PORT:STATe 1 

:SENSe1:SEGMent:LIST:POWer:PORT:STATe? 
Return: 1 

 

3.8.101 Power Level of Each Segment  (:SENSe{[1]-256}:SEGMent:LIST:P
OWer:PORT{[1]-4}[:LEVel][:IMMediate][:AMPLitude]) 

 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:LIST:POWer:PORT{[1]-4}[:LEVel][:IMMediate][:AMP
Litude] <value1>,<value2>,...,<value N> 
:SENSe{[1]-256}:SEGMent:LIST:POWer:PORT{[1]-4}[:LEVel][:IMMediate][:AMP
Litude]? 

Instruction  This command sets/gets the power level of each segment for the selected port 
and channel. 
Indicates the array data of NOP (number of total segment numbers). Where n is
 an integer between 1 and NOP. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 -120~120dB 

Return  Data array 
Default  0 
Menu  Sweep > Segment Table > Segment Table Setting 
Example  :SOURce1:POWer:PORT:COUPle 1 

:SENSe1:SEGMent:DATA 5,0,0,1,0,0,3,9000,1e+06,21,-5,1e+09,2e+09,61,1,3e
+09,4e+09,101,-5 
:SENSe1:SEGMent:LIST:POWer:PORT1 -10,-20,-15 
:SENSe1:SEGMent:LIST:POWer:PORT1? 
Return: -1.000000000000e+01,-2.000000000000e+01,-1.500000000000e+01 
 
:SOURce1:POWer:PORT:COUPle 0 
:SENSe1:SEGMent:LIST:POWer:PORT2? 
Return: -5.000000000000e+00,1.000000000000e+00,-5.000000000000e+00 

 

3.8.102 Total Sweep Points of Segment Sweep (:SENSe{[1]-256}:SEGMen
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t:SWEep:POINts?) 
 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:SWEep:POINts? 

Instruction  This command reads the total number of the measurement points of all segmen
ts, for the segment sweep table of selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 
Default  21 
Menu  Sweep > Segment Table > Segment Table Setting 
Example  :SENSe1:SEGMent:DATA 5,0,0,0,0,0,3,9000,1e+06,21,1e+09,2e+09,61,3e+09,

4e+09,101 
:SENSe1:SEGMent:SWEep:POINts? 
Return: 183 

 

3.8.103 Total Sweep Time of Segment Sweep (:SENSe{[1]-256}:SEGMent:
SWEep:TIME[:DATA]?) 

 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:SWEep:TIME[:DATA]? 

Instruction  This command reads the total sweep time (including sweep delay time) of all se
gments, for the segment sweep table of the selected channel. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 
Default  None 
Menu  Sweep > Segment Table > Segment Table Setting 
Example  :SENSe1:SEGMent:DATA 5,0,0,0,0,1,3,9000,1e+06,21,1,1e+09,2e+09,61,5,3e

+09,4e+09,101,10 
:SENSe1:SEGMent:SWEep:TIME? 
Return: 16 

 

3.8.104 Segment Sweep Table (:SENSe{[1]-256}:SEGMent:DATA) 
 

Command 
Format 

 :SENSe{[1]-256}:SEGMent:DATA <String> 
:SENSe{[1]-256}:SEGMent:DATA? 

Instruction  This command creates/gets the segment sweep table of selected channel. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 Indicates the array data arranged in the following order (for the segment sweep 
table); where N is the number of segments (specified with <segm>) and n is an i
nteger between 1 and N. 
 
Data = {<buf>,<stim>,<ifbw>,<pow>,<del>,<swp>,<time>,<segm>, <star 1>,<st
op 1>,<nop 1>,<ifbw 1>,<pow 1>,<del 1>,<swp 1>,<time 1>,...  , <star n>,<stop 
n>,<nop n>,<ifbw n>,<pow n>,<del n>,<swp n>,<time n>,.... , <star N>,<stop 
N>,<nop N>,<ifbw N>,<pow N>,<del N>,<swp N>,<time N>} 
 
Each parameter in the above array data is detailed below: 
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<buf>:Always specify 5. 
<stim>:Stimulus setting mode 
 0:Specifies with start/stop values 
 1:Specifies with center/span values 
<ifbw>:ON/OFF of the IF bandwidth setting for each segment 
0:OFF, 1:ON 
<pow>:ON/OFF of the power setting for each segment 
 0:OFF, 1:ON 
<del>:ON/OFF of the sweep delay time setting for each segment 
 0:OFF, 1:ON 
<time>:ON/OFF of the sweep time setting for each segment 
 0:OFF, 1:ON 
<segm>:Number of segments 
Specify an integer ranging 1 to 201. 
<star n>:Start value/center value of the n-th segment 
<stop n>:Stop value/span value of the n-th segment 
<nop n>:Number of measurement points of the n-th segment 
<ifbw n>:IF bandwidth of the n-th segment Not necessary when the IF bandwidt
h setting for each segment is OFF (<ifbw>:0). 
<pow n>:Power of the n-th segment Not necessary when the power setting for e
ach segment is OFF (<pow>:0). 
<del n>:Sweep delay time of the n-th segment Not necessary when the sweep d
elay time setting for each segment is OFF (<del>:0). 
<time n> Sweep time of the n-th segment Not necessary when the sweep time s
etting for each segment is OFF (<time>:0). 

Return  Data array 
Default  5,0,0,0,0,0,1,100000,1e6,21 
Menu  Sweep > Segment Table > Segment Table Setting 
Example  :SENSe1:SEGMent:DATA 5,0,0,0,0,0,2,9000,1e+06,21,1e+09,2e+09,61 

:SENSe1:SEGMent:DATA? 
Return: 5.000000000000e+00,0.000000000000e+00,0.000000000000e+00,0.0
00000000000e+00,0.000000000000e+00,0.000000000000e+00,2.0000000000
00e+00,9.000000000000e+03,1.000000000000e+06,2.100000000000e+01,1.0
00000000000e+09,2.000000000000e+09,6.100000000000e+01 

 

3.8.105 Sweep Delay (:SENSe{[1]-256}:SWEep:DELay) 
 

Command 
Format 

 :SENSe{[1]-256}:SWEep:DELay <numeric> 
:SENSe{[1]-256}:SWEep:DELay? 

Instruction  This command sets/gets the sweep delay time of selected channel. 

Parameter 
Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 
Default  0 
Menu  Sweep > Sweep Delay 
Example  :SENSe1:SWEep:DELay 1 

:SENSe1:SWEep:DELay? 
Return: 1 

 

3.8.106 Sweep Point  (:SENSe{[1]-256}:SWEep:POINts) 
 

Command 
Format 

 :SENSe{[1]-256}:SWEep:POINts <numeric> 
:SENSe{[1]-256}:SWEep:POINts? 

Instruction  This command sets/gets the number of measurement points of selected channe
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l. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 None 

Return  Integer 
Default  201 
Menu  Sweep > Sweep Points 
Example  :SENSe1:SWEep:POINts 251 

:SENSe1:SWEep:POINts? 
Return: 251 

 

3.8.107 Auto Sweep (:SENSe{[1]-256}:SWEep:TIME:AUTO) 
 

Command 
Format 

 :SENSe{[1]-256}:SWEep:TIME:AUTO {ON|OFF|1|0} 
:SENSe{[1]-256}:SWEep:TIME:AUTO? 

Instruction  This command sets/gets whether to automatically set the sweep time of selecte
d channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  0|1 
Default  ON 
Menu  Sweep > Sweep Mode 
Example  :SENSe1:SWEep:TIME:AUTO 0 

:SENSe1:SWEep:TIME:AUTO? 
Return: 0 

 

3.8.108 Sweep Time (:SENSe{[1]-256}:SWEep:TIME[:DATA]) 
 

Command 
Format 

 :SENSe{[1]-256}:SWEep:TIME[:DATA] <numeric> 
:SENSe{[1]-256}:SWEep:TIME[:DATA]? 

Instruction  This command sets/gets the sweep time of selected channel. 

Parameter 
Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 
Default  None 
Menu  Sweep > Sweep Time 
Example  :SENSe1:SWEep:TIME 2 

:SENSe1:SWEep:TIME? 
Return: 2 

 

3.8.109 Sweep Type (:SENSe{[1]-256}:SWEep:TYPE) 
 

Command 
Format 

 :SENSe{[1]-256}:SWEep:TYPE {LINear| LOGarithmic| SEGMent| POWer| CW} 
:SENSe{[1]-256}:SWEep:TYPE? 

Instruction  This command sets/gets the sweep type of selected channel. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 ⚫ "LINear":Sets the sweep type to the linear sweep. 
⚫ "LOGarithmic":Sets the sweep type to the log sweep. 
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⚫ "SEGMent":Sets the sweep type to the segment sweep. 
⚫ "POWer":Sets the sweep type to the power sweep 
⚫ "CW":Sets the sweep type to the constant power sweep 

Return  Enumeration 
Default  LINear 
Menu  Sweep > Sweep Type 
Example  :SENSe1:SWEep:TYPE SEGMent 

:SENSe1:SWEep:TYPE? 
Return: SEGM 
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3.9 Service Subsystem 

3.9.1 Get Active Trace (:SERVice:CHANnel{[1]-256}:TRACe:ACTive?) 
 

Command 
Format 

 :SERVice:CHANnel{[1]-256}:TRACe:ACTive? 

Instruction  This command reads the active trace number of selected channel. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  1 

Menu  None 

Example  :SERVice:CHANnel1:TRACe:ACTive? 

 

3.9.2 Get Active Channel (:SERVice:CHANnel:ACTive?) 
 

Command 
Format 

 :SERVice:CHANnel:ACTive? 

Instruction  This command reads the active channel number. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  1 

Menu  None 

Example  :DISPlay:WINDow2:ACTivate 
:SERVice:CHANnel:ACTive? 
Return: 2 

 

3.9.3 Get Upper Limit of Numbers of Channels (:SERVice:CHANnel:CO
UNt?) 

 

Command 
Format 

 :SERVice:CHANnel:COUNt? 

Instruction  This reads the upper limit of the number of channels. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  None 

Menu  None 

Example  :SERVice:CHANnel:COUNt? 
Return: 256 

 

3.9.4 Get Upper Limit of Numbers of Traces (:SERVice:CHANnel:TRAC
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e:COUNt?) 
 

Command 
Format 

 :SERVice:CHANnel:TRACe:COUNt? 

Instruction  This reads the upper limit of the number of traces. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  None 

Menu  None 

Example  :SERVice:CHANnel:TRACe:COUNt? 
Return: 256 

 

3.9.5 Get Upper Limit of Numbers of Ports (:SERVice:PORT:COUNt?) 
 

Command 
Format 

 :SERVice:PORT:COUNt? 

Instruction  This reads the upper limit of the number of ports. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  None 

Menu  None 

Example  :SERVice:PORT:COUNt? 

 

3.9.6 Maximum Frequency (:SERVice:SWEep:FREQency:MAXimum?) 
 

Command 
Format 

 :SERVice:SWEep:FREQency:MAXimum? 

Instruction  This reads the upper limit of measurement frequency. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: Hz 

Default  8.5 GHz 

Menu  None 

Example  :SERVice:SWEep:FREQency:MAXimum? 

 

3.9.7 Minimum Frequency (:SERVice:SWEep:FREQency:MINimum?) 
 

Command 
Format 

 :SERVice:SWEep:FREQency:MINimum? 

Instruction  This reads the lower limit of measurement frequency. 

Parameter
 Type 

 None 
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Parameter 
Range 

 None 

Return  Float, unit: Hz 

Default  9 kHz 

Menu  None 

Example  :SERVice:SWEep:FREQency:MINimum? 

 

3.9.8 Get Upper Limit of Numbers of Sweep Points (:SERVice:SWEep:
POINts?) 

 

Command 
Format 

 :SERVice:SWEep:POINts? 

Instruction  This reads the upper limit of the number of sweep points. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  20001 

Menu  None 

Example  :SERVice:SWEep:POINts? 

 

3.9.9 Clear Log Data (:SERVice:LOGGing:CLEar) 
 

Command 
Format 

 :SERVice:LOGGing:CLEar 

Instruction  This command clears the log data of the instrument. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  None 

Example  :SERVice:LOGGing:CLEar 
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3.10 Source Subsystem 

3.10.1 Power Level (:SOURce{[1]-256}:POWer[:LEVel][:IMMediate][:AMP
Litude]) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer[:LEVel][:IMMediate][:AMPLitude] <numeric> 
:SOURce{[1]-256}:POWer[:LEVel][:IMMediate][:AMPLitude]? 

Instruction  This command sets/gets the power level of the selected channel. 

Parameter 
Type 

 Float, unit: dBm 

Parameter 
Range 

 None 

Return   Float, unit: dBm 
Default  0 
Menu  Power > Power Level 
Example  :SOURce1:POWer -5 

:SOURce1:POWer? 
Return: -5 

3.10.2 Power Slope (:SOURce{[1]-256}:POWer[:LEVel]:SLOPe[:DATA]) 
 

Command 
Format 

 :SOURce{[1]-256}:POWer[:LEVel]:SLOPe[:DATA] <numeric> 
:SOURce{[1]-256}:POWer[:LEVel]:SLOPe[:DATA]? 

Instruction  This command sets/gets the correction value of the power slope feature of chan
nels 1 to 200. 

Parameter 
Type 

 Float, unit: dB 

Parameter 
Range 

 -2dB~2dB 

Return  Float, unit: dB 
Default  0 
Menu  Power > Leveling&Offsets > Slope 
Example  :SOURce1:POWer:SLOPe -1 

:SOURce1:POWer:SLOPe? 
Return: -1 

 

3.10.3 Power Slope State (:SOURce{[1]-256}:POWer[:LEVel]:SLOPe:STA
Te) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer[:LEVel]:SLOPe:STATe {ON|OFF|1|0} 
:SOURce{[1]-256}:POWer[:LEVel]:SLOPe:STATe? 

Instruction  This command turns ON/OFF or gets the status of the power slope feature, for t
he selected channel. This command corrects the attenuation of simple power le
vel proportional to the frequency (attenuation due to cables etc). 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Power > Leveling&Offsets > Slope Enable 
Example  :SOURce1:POWer:SLOPe:STATe ON 

:SOURce1:POWer:SLOPe:STATe? 
Return: 1 
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3.10.4 Take Cal Sweep (:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORR
ection:COLLect[:ACQuire]) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:COLLect[:ACQuire] 

Instruction  This command excute the power calibration of select port. When the measurem
ent is complete successfully, the power level error correction is automatically tur
ned ON. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 
Default  None 
Menu  Cal > Power Cal > Take Cal Sweep 
Example  :SOURce1:POWer:PORT2:CORRection:COLLect 

 

3.10.5 Max Iteratin Count (:SOURce{[1]-256}:POWer:PORT{[1]|2}:CORRe
ction:COLLect:ITERation[:COUNt]) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2}:CORRection:COLLect:ITERation[:COU
Nt] <numeric> 
:SOURce{[1]-256}:POWer:PORT{[1]|2}:CORRection:COLLect:ITERation[:COU
Nt]? 

Instruction  This command sets/gets the maximum number of readings to take at each sour
ce power data point for the selected port and channel. 

Parameter 
Type 

 Interger 

Parameter 
Range 

 0~50 

Return  Interger 
Default  0 
Menu  Cal > Power Cal > Max Iteration 
Example  :SOURce1:POWer:PORT2:CORRection:COLLect:ITERation 10 

:SOURce1:POWer:PORT2:CORRection:COLLect:ITERation? 
Return: 10 

3.10.6 Num of Readings (:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:COR
Rection:COLLect:AVERage[:COUNt]) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:COLLect:AVERage[:C
OUNt] <numeric> 
:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:COLLect:AVERage[:C
OUNt]? 

Instruction  This command sets/gets the number of power calibration data measurements p
er measurement point for the selected port of selected channel. 

Parameter 
Type 

 Interger 

Parameter 
Range 

 1~50 

Return  Interger 
Default  1 
Menu  Cal > Power Cal > Num of Readings 
Example  :SOURce1:POWer:PORT2:CORRection:COLLect:AVERage 5 

:SOURce1:POWer:PORT2:CORRection:COLLect:AVERage? 
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Return: 5 

3.10.7 Loss Compensation State (:SOURce{[1]-256}:POWer:PORT{[1]|2|
3|4}:CORRection:COLLect:TABLe:LOSS[:STATe]) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:COLLect:TABLe:LOSS
[:STATe]  {ON|OFF|1|0} 
:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:COLLect:TABLe:LOSS
[:STATe]? 

Instruction  This command turns ON/OFF or returns the status of the loss compensation, for
 the selected port of selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Power Cal > Loss Compen Off  > Power Loss Compensation > Compens

ation On  
Example  :SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS ON 

:SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS? 
Return: 1 

 

3.10.8 Loss Compensation Data (:SOURce{[1]-256}:POWer:PORT{[1]|2|3
|4}:CORRection:COLLect:TABLe:LOSS:DATA) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:COLLect:TABLe:LOS
S:DATA <numeric 1>,...,<numeric 1+(Nx2)> 
:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:COLLect:TABLe:LOS
S:DATA? 

Instruction  This command sets/gets the loss compensation table, for the selected port of se
lected channel. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 Indicates the array data (for the loss compensation table) of 1 + Num (number o
f set data items)X2. Where n is an integer between 1 and Num. 
 
⚫ Data(0):The number of data items you want to set. Specify an integer betw

een 0 to 100. When you set the number of data items to 0 (to clear the loss 
compensation table), you specify only Data(0) as the Data variable. 

 
⚫ Data(nX2-1):The frequency of the n-th data item (1 kHz to 500 GHz). 
 
⚫ Data(nX2):The loss of the n-th data item (-100 dB to 100 dB). 
 
The index of the array starts from 0. 

Return  Data array 
Default  None 
Menu  Cal > Power Cal > Loss Compen Off  > Power Loss Compensation 
Example  :SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS:DATA 2,2e9,3,

5e9,-0.5 
:SOURce1:POWer:PORT2:CORRection:COLLect:TABLe:LOSS:DATA? 
Return: 2,2e+09,3,5e+09,-0.5 

 

3.10.9 Power Calibration Correction State (:SOURce{[1]-256}:POWer:PO
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RT{[1]|2|3|4}:CORRection[:STATe]) 
 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection[:STATe] {ON|OFF|1|0} 
:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection[:STATe]? 

Instruction  This command turns ON/OFF or returns the status of the power level error corre
ction, for the selected port of the selected channel. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Cal > Power Correction 
Example  :SOURce1:POWer:PORT1:CORRection ON 

:SOURce1:POWer:PORT1:CORRection? 
Return: 1 

 

3.10.10 Power Calibration Correction Data (:SOURce{[1]-256}:POWer:PO
RT{[1]|2|3|4}:CORRection:DATA) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:DATA <numeric 1>, ..,
<numeric NOP> 
:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}:CORRection:DATA? 

Instruction  This command sets/gets the power calibration data array, for the selected port o
f selected channel. 

Parameter 
Type 

 Data array 

Parameter 
Range 

 Indicates the array data (power calibration data array) of NOP (number of point
s). Where n is an integer between 1 and NOP. 
⚫ Data(n-1): Data at the n-th measurement point 
The index of the array starts from 0. 

Return  Data array 
Default  None 
Menu  None 
Example  :SENSe1:SWEep:POINts 5 

:SOURce1:POWer:PORT2:CORRection:DATA 1,2,3,4,5 
:SOURce1:POWer:PORT2:CORRection:DATA? 
Return: 1,2,3,4,5 

 

3.10.11 Power Level of Port (:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4}[:L
EVel][:IMMediate][:AMPLitude]) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT{[1]|2|3|4} [:LEVel][:IMMediate][:AMPLitude] <n
umeric> 
:SOURce{[1]-256}:POWer:PORT{[1]|2|3|4} [:LEVel][:IMMediate][:AMPLitude]? 

Instruction  This command sets/gets the power level, for the selected port of the selected ch
annel. 

Parameter 
Type 

 Float, unit: dBm 

Parameter 
Range 

 None 

Return  Float, unit: dBm 
Default  0 
Menu  Power > Port Power > Power Level 
Example  :SOURce1:POWer:PORT1 -5 
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:SOURce1:POWer:PORT1? 
Return: -5 

 

3.10.12 Power Level Couple State (:SOURce{[1]-256}:POWer:PORT:COU
Ple) 

 

Command 
Format 

 :SOURce{[1]-256}:POWer:PORT:COUPle {ON|OFF|1|0} 
:SOURce{[1]-256}:POWer:PORT:COUPle? 

Instruction  This command sets/gets whether to output the same power level for each port o
f channels 1 to 200. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  ON 
Menu  Power > Port Power > Coupling 
Example  :SOURce1:POWer:PORT:COUPle OFF 

:SOURce1:POWer:PORT:COUPle? 
Return: 0 

 

3.10.13 Power Start (:SOURce{[1]-256}:POWer:STARt) 
 

Command 
Format 

 :SOURce{[1]-256}:POWer:STARt <numeric> 
:SOURce{[1]-256}:POWer:STARt? 

Instruction  This command sets/gets the start value of the sweep range for the power 
sweep for channels 1 to 200. 

Parameter 
Type 

 Float, unit: dBm 

Parameter 
Range 

 None 

Return  Float, unit: dBm 
Default  -10 
Menu  Power > Port Power > Start Power 
Example  :SOURce1:POWer:STARt 5 

:SOURce1:POWer:STARt? 
Return: 5 

 

3.10.14 Power Stop (:SOURce{[1]-256}:POWer:STOP) 
 

Command 
Format 

 :SOURce{[1]-256}:POWer:STOP <numeric> 
:SOURce{[1]-256}:POWer:STOP? 

Instruction  This command sets/gets the stop value of the sweep range for the power sweep
 for channels 1 to 200. 

Parameter 
Type 

 Float, unit: dBm 

Parameter 
Range 

 None 

Return  Float, unit: dBm 
Default  0 
Menu  Power > Port Power > Stop Power 
Example  :SOURce1:POWer:STOP -5 

:SOURce1:POWer:STOP? 
Return: -5 
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3.11 System Subsystem 

3.11.1 State of Backlight (:SYSTem:BACKlight) 
 

Command 
Format 

 :SYSTem:BACKlight {ON|OFF|1|0} 
:SYSTem:BACKlight? 

Instruction  This command turns ON/OFF or returns the status of the backlight of the LCD di
splay. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  1 

Menu  None 

Example  :SYSTem:BACKlight OFF 
:SYSTem:BACKlight? 
Return: 0 

 

3.11.2 Complete Buzzer (:SYSTem:BEEPer:COMPlete:IMMediate) 
 

Command 
Format 

 :SYSTem:BEEPer:COMPlete:IMMediate 

Instruction  This command generates a beep for the notification of the completion of an ope
ration. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  System > Buzzer > Complete Test 

Example  :SYSTem:BEEPer:COMPlete:IMMediate 

 

3.11.3 Complete Buzzer State (:SYSTem:BEEPer:COMPlete:STATe) 
 

Command 
Format 

 :SYSTem:BEEPer:COMPlete:STATe {ON|OFF|1|0} 
:SYSTem:BEEPer:COMPlete:STATe? 

Instruction  This command turns ON/OFF or returns the status of the beeper for the notificat
ion of the completion of the operation. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  ON 

Menu  System > Buzzer > Complete Buzzer 

Example  :SYSTem:BEEPer:COMPlete:STATe OFF 
:SYSTem:BEEPer:COMPlete:STATe? 
Return: 0 

 

3.11.4 Warning Buzzer (:SYSTem:BEEPer:WARNing:IMMediate) 
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Command 
Format 

 :SYSTem:BEEPer:WARNing:IMMediate 

Instruction  This command generates a beep for the notification of warning/limit test results. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  System > Buzzer > Warning Test 

Example  :SYSTem:BEEPer:WARNing:IMMediate 

 

3.11.5 Warning Buzzer State (:SYSTem:BEEPer:WARNing:STATe) 
 

Command 
Format 

 :SYSTem:BEEPer:WARNing:STATe {ON|OFF|1|0} 
:SYSTem:BEEPer:WARNing:STATe? 

Instruction  This command turns ON/OFF or returns the status of the beeper for the notificat
ion of warning/limit test results. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  ON 

Menu  System > Buzzer > Warning Buzzer 

Example  :SYSTem:BEEPer:WARNing:STATe ON 
:SYSTem:BEEPer:WARNing:STATe? 
Return: 1 

 

3.11.6 Information About Power Meter (:SYSTem:COMMunicate:USB:P
METer:CATalog?) 

 

Command 
Format 

 :SYSTem:COMMunicate:USB:PMETer:CATalog? 

Instruction  This command reads the identification information string of power meters. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Returns identification information about connected power meters. 

Default  None 

Menu  None 

Example  :SYSTem:COMMunicate:USB:PMETer:CATalog? 

 

3.11.7 System Date (:SYSTem:DATE) 
 

Command 
Format 

 :SYSTem:DATE <String> 
:SYSTem:DATE? 

Instruction  This command sets/gets the date of the clock built in the VNA instrument. 

Parameter
 Type 

 Data array 
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Parameter 
Range 

 Indicates 3-element array data (date of the built-in clock). 
Data(0) Sets year(1980~2099). 
Data(1) Sets month(1~12). 
Data(2) Sets day(1~31). 
The index of the array starts from 0. 

Return  Data array 

Default  None 

Menu  System > Date & Time 

Example  :SYSTem:DATE 2020,1,1 
:SYSTem:DATE? 
Return: 2020,01,01 

 

3.11.8 System Time (:SYSTem:TIME) 
 

Command 
Format 

 :SYSTem:TIME <String> 
:SYSTem:TIME? 

Instruction  This command sets/gets the time of the clock built in the VNA instrument. 

Parameter
 Type 

 Data array 

Parameter 
Range 

 Indicates 3-element array data (date of the built-in clock). 
Data(0) Sets hour(0~23). 
Data(1) Sets minute(0~59). 
Data(2) Sets second(0~59). 
The index of the array starts from 0. 

Return  Data array 

Default  None 

Menu  System > Date & Time 

Example  :SYSTem:TIME 10,30,40 
:SYSTem:TIME? 
Return: 10,30,40 

 

3.11.9 Default Preset (:SYSTem:PRESet) 
 

Command 
Format 

 :SYSTem:PRESet 

Instruction  This command presets the setting state of the VNA to the original factory settin
g. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  System > Preset > Preset Option is "Default", and at the same time execute: 
System > Preset > Preset 

Example  :SYSTem:PRESet 

 

3.11.10 Preset Option (:SYSTem:PRESet:TYPE) 
 

Command 
Format 

 :SYSTem:PRESet:TYPE {DEFault|LAST|USER} 

Instruction  This command sets/gets the system preset type. 
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Parameter
 Type 

 Enumeration 

Parameter 
Range 

 DEFault|LAST|USER 

Return  Enumeration 

Default  None 

Menu  Preset > Preset Option 

Example  :SYSTem:PRESET:TYPE USER 
:SYSTem:PRESET:TYPE? 
Return: USER 

 

3.11.11 User Preset (:SYSTem:UPReset) 
 

Command 
Format 

 :SYSTem:UPReset 

Instruction  This command presets the VNA with the user settings. The command is execut
ed regardless of the operation mode in preset state. If you try to specify a file for
 a preset (local:/user_preset.sta) that does not exist, an error will occur and this 
command will be ignored. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  System > Preset > Preset Option is "User", and at the same time execute: 
System > Preset > Preset 

Example  :SYSTem:UPReset 

 

3.11.12 Load User Preset File (:SYSTem:UPReset:LOAD[:FILE]) 
 

Command 
Format 

 :SYSTem:UPReset:LOAD[:FILE] <String> 

Instruction  This command loads an existing instrument state file (.sta or .csa) to be used fo
r User Preset. 

Parameter
 Type 

 String 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  None 

Example  SYSTem:UPReset:LOAD "local/user_preset.sta" 

 

3.11.13 Last Preset (:SYSTem:LPReset) 
 

Command 
Format 

 :SYSTem:LPReset 

Instruction  This command presets the setting state of VNA to the settings before the last so
ftware shutdown. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 
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Return  None 

Default  None 

Menu  System > Preset > Preset Option is "Last", and at the same time execute: 
System > Preset > Preset 

Example  :SYSTem:LPReset 

 

3.11.14 Power On Line State (:SYSTem:PONLine[:STATe]) 
 

Command 
Format 

 :SYSTem:PONLine[:STATe] {ON|OFF|1|0} 
:SYSTem:PONLine[:STATe]? 

Instruction  This command turns ON/OFF or returns the status of the system power on line 
state. 

Parameter 
Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
Default  OFF 
Menu  Preset > Power On Line 
Example  :SYSTem:PONLine ON 

:SYSTem:PONLine? 
Return: 1 

 

3.11.15 Power On Option (:SYSTem:PON:TYPE) 
 

Command 
Format 

 :SYSTem:PON:TYPE {DEFault|LAST|USER} 
:SYSTem:PON:TYPE? 

Instruction  This command sets/gets the system start type after power on. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 DEFault|LAST|USER 

Return  Enumeration 

Default  DEFault 

Menu  Preset > Power On Option 

Example  :SYSTem:PON:TYPE USER 
:SYSTem:PON:TYPE? 
Return: USER 

 

3.11.16 Factory Reset (:SYSTem:FDEFault) 
 

Command 
Format 

 :SYSTem:FDEFault 

Instruction  This command reset the system status return to factory state. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Preset > Factory Reset 

Example  :SYSTem:FDEFault 
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3.11.17 GPIB Address (:SYSTem:COMMunicate:GPIB:ADDRess) 
 

Command 
Format 

 :SYSTem:COMMunicate:GPIB:ADDRess <numeric> 
:SYSTem:COMMunicate:GPIB:ADDRess? 

Instruction  Sets/gets the gpib address for the network analyzer.  

Parameter
 Type 

 Integer 

Parameter 
Range 

 1~30 

Return  Integer 

Default  18 

Menu  System > GPIB 

Example  :SYSTem:COMMunicate:GPIB:ADDRess 7 
:SYSTem:COMMunicate:GPIB:ADDRess? 
Return: 7 

 

3.11.18 State of DHCP (:SYSTem:COMMunicate:LAN:TYPE) 
 

Command 
Format 

 :SYSTem:COMMunicate:LAN:TYPE {STATIC|DHCP} 
:SYSTem:COMMunicate:LAN:TYPE? 

Instruction  Toggles the IP assignment setting between static (manual) and DHCP (dynami
c assignment) mode. 
Gets IP config. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 STATIC|DHCP 

Return  Enumeration 

Default  STATIC 

Menu  System > LAN Status > DHCP 

Example  :SYSTem:COMMunicate:LAN:TYPE DHCP 
:SYSTem:COMMunicate:LAN:TYPE? 
Return: DHCP 

 

3.11.19 IP Address (:SYSTem:COMMunicate:LAN:IPADdress) 
 

Command 
Format 

 :SYSTem:COMMunicate:LAN:IPADdress <"xxx.xxx.xxx.xxx"> 
:SYSTem:COMMunicate:LAN:IPADdress? 

Instruction  Sets a host name for the analyzer in network. 
Gets IP address. 

Parameter
 Type 

 String 

Parameter 
Range 

 Conform to the IP Sets standard (0-255:0-255:0-255:0-255). 

Return  String 

Default  None 

Menu  System > LAN Status > IP Address 

Example  :SYSTem:COMMunicate:LAN:IPADdress "10.11.13.100" 
:SYSTem:COMMunicate:LAN:IPADdress? 
Return: "10.11.13.100" 
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3.11.20 Subnet Mask (:SYSTem:COMMunicate:LAN:SMASk) 
 

Command 
Format 

 :SYSTem:COMMunicate:LAN:SMASk <"xxx.xxx.xxx.xxx"> 
:SYSTem:COMMunicate:LAN:SMASk? 

Instruction  Sets the subnet mask according to the PC network Settings. The subnet mask 
will be set automatically if the IP assignment is set to DHCP. 

Parameter
 Type 

 String 

Parameter 
Range 

 Conform to the IP Sets standard (0-255:0-255:0-255:0-255). 

Return  String 

Default  None 

Menu  System > LAN Status > SUB Mask 

Example  :SYSTem:COMMunicate:LAN:SMASk "255.255.255.0" 
:SYSTem:COMMunicate:LAN:SMASk? 
Return: "255.255.255.0" 

 

3.11.21 Gateway (:SYSTem:COMMunicate:LAN:GATeway) 
 

Command 
Format 

 :SYSTem:COMMunicate:LAN:GATeway <"xxx.xxx.xxx.xxx"> 
:SYSTem:COMMunicate:LAN:GATeway? 

Instruction  Sets the gateway for the analyzer in the network. The gateway will be f
etched automatically if the IP assignment is set to DHCP. 
Gets gateway. 

Parameter
 Type 

 String 

Parameter 
Range 

 Conform to the IP Sets standard (0-255:0-255:0-255:0-255). 

Return  String 

Default  None 

Menu  System > LAN Status > Gateway 

Example  :SYSTem:COMMunicate:LAN:GATeway "10.11.13.1" 
:SYSTem:COMMunicate:LAN:GATeway? 
Return: "10.11.13.1" 

 
 

3.11.22 State of Power Limit (:SYSTem:POWer{[1]|2|3|4}:LIMit:STATe) 
 

Command 
Format 

 :SYSTem:POWer{[1]|2|3|4}:LIMit:STATe {ON|OFF|1|0} 
:SYSTem:POWer{[1]|2|3|4}:LIMit:STATe? 

Instruction  This command enables or disables the power limit for the specified port. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Power > Leveling&Offsets > Limit Enable 

Example  :SYSTem:POWer1:LIMit:STATe ON 
:SYSTem:POWer1:LIMit:STATe? 
Return: 1 

 

3.11.23 Power Limit Value (:SYSTem:POWer{[1]|2|3|4}:LIMit) 
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Command 
Format 

 :SYSTem:POWer{[1]|2|3|4}:LIMit <numeric> 
:SYSTem:POWer{[1]|2|3|4}:LIMit? 

Instruction  This command sets and gets the power limit value for the specified port. 

Parameter
 Type 

 Float, unit: dB 

Parameter 
Range 

 -1000~1000dB 

Return  Float, unit: dB 

Default  0 

Menu  Power > Leveling&Offsets > Limit 

Example  :SYSTem:POWer1:LIMit 10 
:SYSTem:POWer1:LIMit? 
Return: 10 

 

3.11.1 System error information (:SYSTem:ERRor?) 
 

Command 
Format 

 :SYSTem:ERRor? 

Instruction  Query the system error information,and return the Error number and the Error m
essage(a character string with double quotation marks(")) 

Parameter
 Type 

 None 
 

Parameter 
Range 

 None  

Return  array 

Default  None  

Menu  None  

Example  :SYSTem:ERRor? 
 
Return: -101, "Invalid character" 

 

3.11.2 Display of limit test failure points (SYSTem:PREFerences:ITEM:R
TOF) 

Command 
Format 

 SYSTem:PREFerences:ITEM:RTOF <bool> 
SYSTem:PREFerences:ITEM:RTOF? 

Instruction  Set and return whether to display limit line failures as red trace segments or red 
data points (dots). 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 On|OFF|1|0 
ON (1)  Display failures as red trace segments. (Red Trace On Fail). 
OFF (0) Display failures as red data points (dots). 

Return  Boolean  

Default  1 

Menu  Math>Analysis>Limit…>Display 

Example  SYSTem:PREFerences:ITEM:RTOF 0 
SYSTem:PREFerences:ITEM:RTOF? 
Return :0 

 
 

3.12Trigger Subsystem 

3.12.1 Trigger Source (:TRIGger[:SEQuence]:SOURce) 
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Command
 Format 

 :TRIGger[:SEQuence]:SOURce {INTernal|EXTernal|MANual|BUS} 
:TRIGger[:SEQuence]:SOURce? 

Instruction  This command sets/gets the trigger source from the following 4 types: 
⚫ Internal Trigger 

Uses the internal trigger to generate continuous triggers automatically. 
⚫ External Trigger 

Generates a trigger when the trigger signal is inputted externally via the Ext
 Trig connector or the handler interface. 

⚫ Manual Trigger 
Generates a trigger when the key operation of Trigger > Trigger is execute
d from the front panel. 

⚫ Bus Trigger 
Generates a trigger when the SCPI.IEEE4882.TRG object is executed. 

 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 
INTernal|EXTernal|MANual|BUS 

Return  Enumeration 

Default  INTernal 

Menu  Trigger > Trigger Source 

Example  :TRIGger:SOURce EXTernal 
:TRIGger:SOURce? 
Return: EXT 

 

3.12.2 Trigger Scope (:TRIGger[:SEQuence]:SCOPe) 
 

Command 
Format 

 :TRIGger[:SEQuence]:SCOPe {ALL|ACTive} 
:TRIGger[:SEQuence]:SCOPe? 

Instruction  This command sets/gets the effective scope of triggering. When this function is 
enabled with a value of "ACTive", only active channel is triggered. When this fu
nction is enabled with a value of "ALL", all channels are triggered. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 
ALL|ACTive 

Return  Enumeration 

Default  ALL 

Menu  Trigger > Trigger Scope 

Example  :TRIGger:SCOPe ACTive 
:TRIGger:SCOPe? 
Return: ACT 

 

3.12.3 Trigger Event (:TRIGger[:SEQuence]:POINt) 
 

Command 
Format 

 :TRIGger[:SEQuence]:POINt {ON|OFF|1|0} 
:TRIGger[:SEQuence]:POINt? 

Instruction  This command turns ON/OFF or returns the status of the point trigger feature. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 
ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Trigger > Trigger Setup >Trigger Event 

mk:@MSITStore:C:/Users/Administrator/Desktop/常用手册/E5071_EN.chm::/Programming/Command_Reference/IEEE/SCPI_IEEE4882_TRG.htm
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Example  :TRIGger:POINt 1 
:TRIGger:POINt? 
Return: 1 

 

3.12.4 Polarity of the External Trigger Input Port (:TRIGger:SEQuence:E
XTernal:SLOPe) 

 

Command 
Format 

 :TRIGger:SEQuence:EXTernal:SLOPe {POSitive|NEGative} 
:TRIGger:SEQuence:EXTernal:SLOPe? 

Instruction  This command sets/gets the polarity of the External Trigger Input Port. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 
POSitive|NEGative 

Return  Enumeration 

Default  POSitive 

Menu  Trigger > Trigger Setup > Ext Trig Input 

Example  :TRIGger:SEQuence:EXTernal:SLOPe NEGative 
:TRIGger:SEQuence:EXTernal:SLOPe? 
Return: NEG 

 

3.12.5 Delay of the External Trigger Source (:TRIGger[:SEQuence]:EXTe
rnal:DELay) 

 

Command 
Format 

 :TRIGger[:SEQuence]:EXTernal:DELay <numeric> 
:TRIGger[:SEQuence]:EXTernal:DELay? 

Instruction  This command sets/gets the time that it takes from receiving the trigger to starti
ng measurement when the trigger source is external. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 
None 

Return  Float, unit: s (second) 

Default  0 

Menu  Trigger > Trigger Setup > Trigger Delay 

Example  :TRIGger:EXTernal:DELay 1 
:TRIGger:EXTernal:DELay? 
Return: 1 

 

3.12.6 External Trigger Output Port State (:TRIGger:OUTPut.STATe) 
 

Command 
Format 

 :TRIGger:OUTPut:STATe {ON|OFF|1|0} 
:TRIGger:OUTPut:STATe? 

Instruction  This command sets/gets the External Trigger Output Port state. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 
ON|OFF|1|0 

Return  Boolean 

Default  0 

Menu  Trigger > Trigger Setup > Ext Trig output 

Example  :TRIGger:OUTPut:STATe 1 
:TRIGger:OUTPut:STATe? 

javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#5. External Trigger Input Connector (Ext Trig)');
javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
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Return: 1 

 

3.12.7 Polarity of the Pulse (:TRIGger:OUTPut:POLarity) 
 

Command 
Format 

 :TRIGger:OUTPut:POLarity {POSitive|NEGative} 
:TRIGger:OUTPut:POLarity? 

Instruction  This command sets/gets the polarity of the pulse generated by the External Trig
ger Output Port. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 
POSitive|NEGative 

Return  Enumeration 

Default  POSitive 

Menu  Trigger > Trigger Setup > Polarity 

Example  :TRIGger:OUTPut:POLarity NEGative 
:TRIGger:OUTPut:POLarity? 
Return: NEG 

 

3.12.8 Position of the Pulse (:TRIGger:OUTPut:POSition) 
 

Command 
Format 

 :TRIGger:OUTPut:POSition {AFTer|BEFore} 
:TRIGger:OUTPut:POSition? 

Instruction  This command sets/gets the position of the External Trigger Output Port. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 
AFTer|BEFore 

Return  Enumeration 

Default  AFTer 

Menu  Trigger > Trigger Setup > Position 

Example  :TRIGger:OUTPut:POSition BEFore 
:TRIGger:OUTPut:POSition? 
Return: BEF 

 

3.12.9 Trigger Comand (:TRIGger[:SEQuence][:IMMediate]) 
 

Command 
Format 

 :TRIGger[:SEQuence][:IMMediate] 

Instruction  This command stops the current sweeps and immediately sends a trigger. The
n, after measurement is executed once, it goes back to the hold state. This com
mand requires trigger source to be Manual, External or Bus. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  None 

Example  :TRIG 

 

3.12.10 Trigger Comand (:TRIGger[:SEQuence]:SINGle) 

javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
javascript:BSSCPopup('../../../Overview/rear_panel_names_and_functions_of_parts.htm#20. External Trigger Output Port');
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Command 
Format 

 :TRIGger[:SEQuence]:SINGle 

Instruction  This command stops the current sweeps and immediately sends a trigger. The
n, after measurement is executed once, it goes back to the hold state. This com
mand requires trigger source to be Manual, External or Bus. 
The execution of the object finishes when the measurement (all of the sweep) in
itiated with this object is complete. In other words, you can wait for the end of th
e measurement using the "*OPC?" object. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  None 

Example  :TRIG:SING 

 

3.12.11 Trigger Restart (:ABORt) 
 

Command 
Format 

 :ABORt 

Instruction  This command stops the current sweeps and immediately sends a trigger. The
n, after measurement is executed once, it goes back to the idle state. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Trigger > Restart 

Example  :ABORt 
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4.TDR Commands 

4.1 Calculate Subsystem 

4.1.1 Channel TDR State (:CALCulate:TDR:STATe) 
 

Command 
Format 

 :CALCulate:TDR:STATe {ON|OFF|1|0} 
:CALCulate:TDR:STATe? 

Instruction  This command sets/gets TDR option enable state. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Math > TDR > TDR 

Example  :CALC:TDR:STAT ON 
:CALC:TDR:STAT? 
Return: 1 

 

4.1.2 Trace Allocation (:CALCulate:ALLocate) 
 

Command 
Format 

 :CALCulate:ALLocate {SPARameters|TPARameters|MIXed} 

Instruction  This command sets type of the parameter & format allocation for each trace. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 SPARameters|TPARameters|MIXed 

Return  None 

Default  MIXed 

Menu  TDR/TDT > Trace Control > Mixed/All T/All S 

Example  :CALCulate:ALLocate SPAR 

 

4.1.3 Select Trace (:CALCulate:ATRaces:ACTive) 
 

Command 
Format 

 :CALCulate:ATRaces:ACTive <numeric> 
:CALCulate:ATRaces:ACTive? 

Instruction  This command sets/gets active trace number. 

Parameter
 Type 

 Integer 

Parameter 
Range 

 None 

Return  Integer 

Default  None 

Menu  TDR > Trace 

Example  :CALC:ATR:ACT 6 
:CALC:ATR:ACT? 
Return: 6 
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4.1.4 Trace Count (:CALCulate:ATRaces:COUNt) 
 

Command 
Format 

 :CALCulate:ATRaces:COUNt? 

Instruction  This command returns the number of trace. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  Depending on DUT topology setting 

Menu  None 

Example  :CALC:ATR:COUN? 

 

4.1.5 Marker Coupling Enable (:CALCulate:ATRaces:MARKer:COUPle) 
 

Command 
Format 

 :CALCulate:ATRaces:MARKer:COUPle {ON|OFF|1|0} 
:CALCulate:ATRaces:MARKer:COUPle? 

Instruction  This command sets state for the marker couple mode. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  ON 

Menu  TDR/TDT > Trace Control > Coupling > Marker 

Example  :CALC:ATR:MARK:COUP OFF 
:CALC:ATR:MARK:COUP? 
Return: 0 

 

4.1.6 Time Coupling Enable (:CALCulate:ATRaces:TIME:COUPle) 
 

Command 
Format 

 :CALCulate:ATRaces:TIME:COUPle {ON|OFF|1|0} 
:CALCulate:ATRaces:TIME:COUPle? 

Instruction  This command sets state for the transform couple mode. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  ON 

Menu  TDR/TDT > Trace Control > Coupling > Time 

Example  :CALC:ATR:TIME:COUP OFF 
:CALC:ATR:TIME:COUP? 
Return: 0 

 

4.1.7 Time Stimulus Voltage (:CALCulate:ATRaces:TIME:STEP:AMPLit
ude) 
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Command 
Format 

 :CALCulate:ATRaces:TIME:STEP:AMPLitude <numeric> 
:CALCulate:ATRaces:TIME:STEP:AMPLitude? 

Instruction  This command sets/gets step amplitude value for the transform function. 

Parameter
 Type 

 Float, unit: V (Voltage) 

Parameter 
Range 

 0.001~5 

Return  Float, unit: V (Voltage) 

Default  0.2 

Menu  Setup > Basic > Stim. Ampl. 

Example  :CALC:ATR:TIME:STEP:AMPL 0.5 
:CALC:ATR:TIME:STEP:AMPL? 
Return: 0.5 

 

4.1.8 DUT topology (:CALCulate:DEVice) 
 

Command 
Format 

 :CALCulate:DEVice {SEND1|SEND2|DIF1|SEND4|DIF2} 
:CALCulate:DEVice? 

Instruction  This command sets step amplitude value for the transform function. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 SEND1|SEND2|DIF1|SEND4|DIF2 

Return  Enumeration 

Default  SEND1 

Menu  Setup > Basic > DUT topology 

Example  :CALC:DEV SEND2 
:CALC:DEV? 
Return: SEND2 

 

4.1.9 Port De-embeding S2P Filename (:CALCulate:EMBed:S2P:PORT
{[1]|2|3|4}:DEEMbed:FILename) 

 

Command 
Format 

 :CALCulate:EMBed:S2P:PORT{[1]|2|3|4}:DEEMbed:FILename <String> 
:CALCulate:EMBed:S2P:PORT{[1]|2|3|4}:DEEMbed:FILename? 

Instruction  This command sets/gets the filename of the S2P de-embedding user file. This fil
e is saved as a 2-port touchstone file with the .s2p extension. 

Parameter
 Type 

 String 

Parameter 
Range 

 None 

Return  String 

Default  None 

Menu  Setup > Adv Waveform > De-embeding > Load 

Example  :CALC:EMB:S2P:PORT1:DEEM:FIL "local/file.s2p" 
:CALC:EMB:S2P:PORT1:DEEM:FIL? 
Return: local/file.s2p 

 

4.1.10 Port De-embeding Enable State (:CALCulate:EMBed:S2P:PORT
{[1]|2|3|4}:DEEMbed:STATe) 
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Command 
Format 

 :CALCulate:EMBed:S2P:PORT{[1]|2|3|4}:DEEMbed:STATe {ON|OFF|1|0} 
:CALCulate:EMBed:S2P:PORT{[1]|2|3|4}:DEEMbed:STATe? 

Instruction  This command sets the S2P de-embedding function state ON/OFF. To turn ON,
 it is necessary to load the S2P file in advance. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Setup > Adv Waveform > De-embeding > Select De-embeding File > Enable 

Example  :CALC:EMB:S2P:PORT1:DEEM:STAT ON 
:CALC:EMB:S2P:PORT1:DEEM:STAT? 
Return: 1 

 

4.1.11 Diff Port De-embeding S4P Filename (:CALCulate:EMBed:S4P:DI
FF{[1]|2}:FILename) 

 

Command 
Format 

 :CALCulate:EMBed:S4P:DIFF{[1]|2}:FILename <String> 
:CALCulate:EMBed:S4P:DIFF{[1]|2}:FILename? 

Instruction  This command sets the filename of the S4P de-embedding user file. This file is 
saved as a 4-port touchstone file with the .s4p extension. 

Parameter
 Type 

 String 

Parameter 
Range 

 None 

Return  String 

Default  None 

Menu  Setup > Adv Waveform > De-embeding > Load 

Example  :CALC:EMB:S4P:DIFF1:FIL "local/file.s4p" 
:CALC:EMB:S4P:DIFF1:FIL? 
Return: local/file.s4p 

 

4.1.12 Diff Port De-embeding Enable State (:CALCulate:EMBed:S4P:DIF
F{[1]|2}:STATe) 

 

Command 
Format 

 :CALCulate:EMBed:S4P:DIFF{[1]|2}:STATe {ON|OFF|1|0} 
:CALCulate:EMBed:S4P:DIFF{[1]|2}:STATe? 

Instruction  This command sets the S4P de-embedding function state on/off. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Setup > Adv Waveform > De-embeding > Select De-embeding File > Enable 

Example  :CALC:EMB:S4P:DIFF1:STAT ON 
:CALC:EMB:S4P:DIFF1:STAT? 
Return: 1 

 

4.1.13 De-embeding Enable State (:CALCulate:EMBed:STATe) 
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Command 
Format 

 :CALCulate:EMBed:STATe {ON|OFF|1|0} 
:CALCulate:EMBed:STATe? 

Instruction  This command sets the embed function state on/off. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Setup > Adv Waveform > De-embeding > Enable 

Example  :CALC:EMB:STAT ON 
:CALC:EMB:STAT? 
Return: 1 

 

4.1.14 Emphasis Post 2 Cursor (:CALCulate:EMPHasis:CURSor:POST2) 
 

Command 
Format 

 :CALCulate:EMPHasis:CURSor:POST2 <numeric> 
:CALCulate:EMPHasis:CURSor:POST2? 

Instruction  This command sets the emphasis post2 level. 

Parameter
 Type 

 Float, unit: dB 

Parameter 
Range 

 -20~20 dB 

Return  Float, unit: dB 

Default  0 dB 

Menu  Setup > Adv Waveform > Emphasis > Post 2 Cursor 

Example  :CALC:EMPH:CURS:POST2 3 
:CALC:EMPH:CURS:POST2? 
Return: 3 

 

4.1.15 Emphasis Post 1 Cursor (:CALCulate:EMPHasis:CURSor:POST1) 
 

Command 
Format 

 :CALCulate:EMPHasis:CURSor:POST1 <numeric> 
:CALCulate:EMPHasis:CURSor:POST1? 

Instruction  This command sets/gets the emphasis post1 level. 

Parameter
 Type 

 Float, unit: dB 

Parameter 
Range 

 -20~20 dB 

Return  Float, unit: dB 

Default  -3.5 dB 

Menu  Setup > Adv Waveform > Emphasis > Post 1 Cursor 

Example  :CALC:EMPH:CURS:POST1 3 
:CALC:EMPH:CURS:POST1? 
Return: 3 

 

4.1.16 Emphasis Pre Cursor (:CALCulate:EMPHasis:CURSor:PRE1) 
 

Command 
Format 

 :CALCulate:EMPHasis:CURSor:PRE1 <numeric> 
:CALCulate:EMPHasis:CURSor:PRE1? 
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Instruction  This command sets the emphasis pre1 level. 

Parameter
 Type 

 Float, unit: dB 

Parameter 
Range 

 -20~20 dB 

Return  Float, unit: dB 

Default  0 dB 

Menu  Setup > Adv Waveform > Emphasis > Pre Cursor 

Example  :CALC:EMPH:CURS:PRE1 3 
:CALC:EMPH:CURS:PRE1? 
Return: 3 

 

4.1.17 Emphasis Enable (:CALCulate:EMPHasis:STATe) 
 

Command 
Format 

 :CALCulate:EMPHasis:STATe {ON|OFF|1|0} 
:CALCulate:EMPHasis:STATe? 

Instruction  This command sets the emphasis function state on/off. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Setup > Adv Waveform > Emphasis > Enable 

Example  :CALC:EMPH:STAT ON 
:CALC:EMPH:STAT? 
Return: 1 

 

4.1.18 Equalization DC Gain (:CALCulate:EQUalization:CTLE:DC) 
 

Command 
Format 

 :CALCulate:EQUalization:CTLE:DC <numeric> 
:CALCulate:EQUalization:CTLE:DC? 

Instruction  This command sets the equalization CTLE (Continuous Time Linear Equalizatio
n) DC gain parameter. 

Parameter
 Type 

 Float 

Parameter 
Range 

 0~10 

Return  Float 

Default  0.667 

Menu  Setup > Adv Waveform > Equalization > DC Gain 

Example  :CALC:EQU:CTLE:DC 0.5 
:CALC:EQU:CTLE:DC? 
Return: 0.5 

 

4.1.19 Equalization Pole1 Frequency (:CALCulate:EQUalization:CTLE:P
OLE1) 

 

Command 
Format 

 :CALCulate:EQUalization:CTLE:POLE1 <numeric> 
:CALCulate:EQUalization:CTLE:POLE1? 

Instruction  This command sets the equalization CTLE (Continuous Time Linear Equalizatio
n) Pole1 parameter. 
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Parameter
 Type 

 Float, unit: Hz 

Parameter 
Range 

 0~20GHz 

Return  Float, unit: Hz 

Default  1.95GHz 

Menu  Setup > Adv Waveform > Equalization > Pole 1 Freq 

Example  :CALC:EQU:CTLE:POLE1 2.5E9 
:CALC:EQU:CTLE:POLE1? 
Return: 2500000000 

 

4.1.20 Equalization Pole2 Frequency (:CALCulate:EQUalization:CTLE:P
OLE2) 

 

Command 
Format 

 :CALCulate:EQUalization:CTLE:POLE2 <numeric> 
:CALCulate:EQUalization:CTLE:POLE2? 

Instruction  This command sets the equalization CTLE (Continuous Time Linear Equalizatio
n) Pole2 parameter. 

Parameter
 Type 

 Float, unit: Hz 

Parameter 
Range 

 0~20GHz 

Return  Float, unit: Hz 

Default  5GHz 

Menu  Setup > Adv Waveform > Equalization > Pole 2 Freq 

Example  :CALC:EQU:CTLE:POLE2 3E9 
:CALC:EQU:CTLE:POLE2? 
Return: 3000000000 

 

4.1.21 Equalization Zero Frequency (:CALCulate:EQUalization:CTLE:PO
LE1) 

 

Command 
Format 

 :CALCulate:EQUalization:CTLE:ZERO1 <numeric> 
:CALCulate:EQUalization:CTLE:ZERO1? 

Instruction  This command sets the equalization CTLE (Continuous Time Linear Equalizatio
n) zero parameter. 

Parameter
 Type 

 Float, unit: Hz 

Parameter 
Range 

 0~20GHz 

Return  Float, unit: Hz 

Default  650MHz 

Menu  Setup > Adv Waveform > Equalization > Zero Freq 

Example  :CALC:EQU:CTLE:ZERO1 7.5E8 
:CALC:EQU:CTLE:ZERO1? 
Return: 750000000 

 

4.1.22 Equalizer User File (:CALCulate:EQUalization:FILename) 
 

Command 
Format 

 :CALCulate:EQUalization:FILename <File> 
:CALCulate:EQUalization:FILename? 

Instruction  This command sets the filename of the equalization equation user file. 
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Parameter
 Type 

 String 

Parameter 
Range 

 None 

Return  String 

Default  None 

Menu  Setup > Adv Waveform > Equalization > File > Load... 

Example  :CALC:EQU:FIL "local/equalizer.csv" 
:CALC:EQU:FIL? 
Return: local/equalizer.csv 

 

4.1.23 Equalization Enable (:CALCulate:EQUalization:STATe) 
 

Command 
Format 

 :CALCulate:EQUalization:STATe {ON|OFF|1|0} 
:CALCulate:EQUalization:STATe? 

Instruction  This command sets the equalization function state on/off. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Setup > Adv Waveform > Equalization > Enable 

Example  :CALC:EQU:STAT ON 
:CALC:EQU:STAT? 
Return: 1 

 

4.1.24 Equalizer Type (:CALCulate:EQUalization:TYPE) 
 

Command 
Format 

 :CALCulate:EQUalization:TYPE {EQUation|USER} 
:CALCulate:EQUalization:TYPE? 

Instruction  This command sets the equalization type. 

Parameter
 Type 

 String 

Parameter 
Range 

 EQUation|USER 

Return  String 

Default  EQUation 

Menu  Setup > Adv Waveform > Equalization > Type 

Example  :CALC:EQU:TYPE USER 
:CALC:EQU:TYPE? 
Return: USER 

 

4.1.25 Abort Eye Diagram Drawing (:CALCulate:EYE: ABORt) 
 

Command 
Format 

 :CALCulate:EYE: ABORt 

Instruction  This command aborts the calculation for the simulated eye diagram. 

Parameter
 Type 

 None 



SNA5000A Programming Guide           175 

 

 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Eye/Mask > Trigger > Abort 

Example  :CALC:EYE:ABOR 

 

4.1.26 Draw Eye Diagram (:CALCulate:EYE:EXECute) 
 

Command 
Format 

 :CALCulate:EYE:EXECute 

Instruction  This command performs the calculation for the simulated eye diagram for the ac
tive trace. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Eye/Mask > Trigger > Draw Eye 

Example  :CALC:EYE:EXEC 

 

4.1.27 Bit Pattern Length (:CALCulate:EYE:INPut:BPATtern:LENGth) 
 

Command 
Format 

 :CALCulate:EYE:INPut:BPATtern:LENGth <numeric> 
:CALCulate:EYE:INPut:BPATtern:LENGth? 

Instruction  This command sets bits' power of 2 for PRBS pattern. This value is used only w
hen the bit pattern type is selected at PRBS. 

Parameter
 Type 

 Discrete 

Parameter 
Range 

 3, 5, 7, 9, 11, 13, 15 

Return  Discrete 

Default  7 

Menu  Eye/Mask > Stimulus > Length 

Example  :CALC:EYE:INP:BPAT:LENG 3 
:CALC:EYE:INP:BPAT:LENG? 
Return: 3 

 

4.1.28 Bit Pattern Type (:CALCulate:EYE:INPut:BPATtern:TYPE) 
 

Command 
Format 

 :CALCulate:EYE:INPut:BPATtern:TYPE {PRBS|K285|USER|STATistical} 
:CALCulate:EYE:INPut:BPATtern:TYPE? 

Instruction  This command sets the bit pattern type for the simulated eye function. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 PRBS|K285|USER|STATistical 

Return  Enumeration 

Default  PRBS 

Menu  Eye/Mask > Stimulus > Type 

Example  :CALC:EYE:INP:BPAT:TYPE K285 
:CALC:EYE:INP:BPAT:TYPE? 
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Return: K285 

 

4.1.29 Input Data Rate (:CALCulate:EYE:INPut:DRATe) 
 

Command 
Format 

 :CALCulate:EYE:INPut:DRATe <numeric> 
:CALCulate:EYE:INPut:DRATe? 

Instruction  This command sets the bit rate for the simulated eye function. 

Parameter
 Type 

 Float, unit: b/s (bits/second) 

Parameter 
Range 

 100Mb/s ~ 2.4Gb/s 

Return  Float, unit: b/s (bits/second) 

Default  1Gb/s 

Menu  Eye/Mask > Stimulus > Date Rate 

Example  :CALC:EYE:INP:DRAT 1.2E9 
:CALC:EYE:INP:DRAT? 
Return: 1200000000 

 

4.1.30 Jiiter Display Limit (:CALCulate:EYE:INPut:JITTer:DLIMit) 
 

Command 
Format 

 :CALCulate:EYE:INPut:JITTer:DLIMit <numeric> 
:CALCulate:EYE:INPut:JITTer:DLIMit? 

Instruction  This command sets/gets the display limit value. 

Parameter
 Type 

 Float 

Parameter 
Range 

 0~1 

Return  Float 

Default  1E-8 

Menu  Eye/Mask > Advanced Waveform > Jitter > Display Limit 

Example  :CALC:EYE:INP:JITT:DLIM 10E-10 
:CALC:EYE:INP:JITT:DLIM? 
Return: 1e-09 

 

4.1.31 Periodic Jiiter Frequency (:CALCulate:EYE:INPut:JITTer:PERiodi
c:FREQuency) 

 

Command 
Format 

 :CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency <numeric> 
:CALCulate:EYE:INPut:JITTer:PERiodic:FREQuency? 

Instruction  This command sets the periodic jitter frequency. This value is used only when p
eriodic jitter function type is selected. 

Parameter
 Type 

 Float, unit: Hz 

Parameter 
Range 

 0~2MHz 

Return  Float, unit: Hz 

Default  500kHz 

Menu  Eye/Mask > Advanced Waveform > Jitter > Periodic Jiiter > Frequency 

Example  :CALC:EYE:INP:JITT:PER:FREQ 10E3 
:CALC:EYE:INP:JITT:PER:FREQ? 
Return: 10000 
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4.1.32 Periodic Jiiter Magnitude (:CALCulate:EYE:INPut:JITTer:PERiodi
c:MAGNitude) 

 

Command 
Format 

 :CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude <numeric> 
:CALCulate:EYE:INPut:JITTer:PERiodic:MAGNitude? 

Instruction  This command sets the periodic jitter magnitude in peak-peak value. This value 
is used only when periodic jitter function type is selected. 

Parameter
 Type 

 Float 

Parameter 
Range 

 0~1 UI 

Return  Float 

Default  0 

Menu  Eye/Mask > Advanced Waveform > Jitter > Periodic Jiiter > Magnitude 

Example  :CALC:EYE:INP:JITT:PER:MAGN 0.2 
:CALC:EYE:INP:JITT:PER:MAGN? 
Return: 0.2 

 

4.1.33 Random Jiiter Magnitude (:CALCulate:EYE:INPut:JITTer:RANDo
m:MAGNitude) 

 

Command 
Format 

 :CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude <numeric> 
:CALCulate:EYE:INPut:JITTer:RANDom:MAGNitude? 

Instruction  This command sets the random jitter magnitude in rms. This value is used only 
when random jitter function type is selected. 

Parameter
 Type 

 Float 

Parameter 
Range 

 0~0.25 UI 

Return  Float 

Default  0 

Menu  Eye/Mask > Advanced Waveform > Jitter > Random Jiiter > Magnitude(RMS) 

Example  :CALC:EYE:INP:JITT:RAND:MAGN 0.2 
:CALC:EYE:INP:JITT:RAND:MAGN? 
Return: 0.2 

 

4.1.34 Jiiter Enable (:CALCulate:EYE:INPut:JITTer:STATe) 
 

Command 
Format 

 :CALCulate:EYE:INPut:JITTer:STATe {ON|OFF|1|0} 
:CALCulate:EYE:INPut:JITTer:STATe? 

Instruction  This command sets the jitter function state with simulated eye on/off. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Eye/Mask > Advanced Waveform > Jitter > Enable 

Example  :CALC:EYE:INP:JITT:STAT ON 
:CALC:EYE:INP:JITT:STAT? 
Return: 1 
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4.1.35 Jiiter Type (:CALCulate:EYE:INPut:JITTer:TYPE) 
 

Command 
Format 

 :CALCulate:EYE:INPut:JITTer:TYPE {RANDom|PERiodic} 
:CALCulate:EYE:INPut:JITTer:TYPE? 

Instruction  This command sets the jitter function type for the simulated eye function. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 RANDom|PERiodic 

Return  Enumeration 

Default  PERiodic 

Menu  Eye/Mask > Advanced Waveform > Jitter > Type > Random/Periodic 

Example  :CALC:EYE:INP:JITT:TYPE RAND 
:CALC:EYE:INP:JITT:TYPE? 
Return: RAND 

 

4.1.36 Input One Level (:CALCulate:EYE:INPut:OLEVel) 
 

Command 
Format 

 :CALCulate:EYE:INPut:OLEVel <numeric> 
:CALCulate:EYE:INPut:OLEVel? 

Instruction  This command sets the voltage level for bit "1" for the simulated eye function. 

Parameter
 Type 

 Float, unit: V (Voltage) 

Parameter 
Range 

 -5 ~ 5 V 

Return  Float, unit: V (Voltage) 

Default  0.2V 

Menu  Eye/Mask > Stimulus > One Level 

Example  :CALC:EYE:INP:OLEV -0.2 
:CALC:EYE:INP:OLEV? 
Return: -0.2 

 

4.1.37 Input Rise Time (:CALCulate:EYE:INPut:RTIMe:DATA) 
 

Command 
Format 

 :CALCulate:EYE:INPut:RTIMe:DATA <numeric> 
:CALCulate:EYE:INPut:RTIMe:DATA? 

Instruction  This command sets the rise time value for the simulated eye function. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 Depending on input data rate. 

Return  Float, unit: s (second) 

Default  Depending on input data rate. 

Menu  Eye/Mask > Stimulus > Rise Time 

Example  :CALC:EYE:INP:RTIM:DATA 90e-12 
:CALC:EYE:INP:RTIM:DATA? 
Return: 9e-11 

 

4.1.38 Input Rise Time Type (:CALCulate:EYE:INPut:RTIMe:THReshold) 
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Command 
Format 

 :CALCulate:EYE:INPut:RTIMe:THReshold {T1_9|T2_8} 
:CALCulate:EYE:INPut:RTIMe:THReshold? 

Instruction  This command sets the rise time threshold for the simulated eye. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 T1_9|T2_8 

Return  Enumeration 

Default  T1_9 

Menu  Eye/Mask > Stimulus > Rise Time 

Example  :CALC:EYE:INP:RTIM:THR T2_8 
:CALC:EYE:INP:RTIM:THR? 
Return: T2_8 

 

4.1.39 Input Zero Level (:CALCulate:EYE:INPut:ZLEVel) 
 

Command 
Format 

 :CALCulate:EYE:INPut:ZLEVel <numeric> 
:CALCulate:EYE:INPut:ZLEVel? 

Instruction  This command sets the voltage level for bit "0" for the simulated eye function. 

Parameter
 Type 

 Float, unit: V (Voltage) 

Parameter 
Range 

 -5 ~ 5 V 

Return  Float, unit: V (Voltage) 

Default  0 V 

Menu  Eye/Mask > Stimulus > Zero Level 

Example  :CALC:EYE:INP:ZLEV 0.5 
:CALC:EYE:INP:ZLEV? 
Return: 0.5 

 

4.1.40 Mask Test Result (:CALCulate:EYE:MASK:FAIL?) 
 

Command 
Format 

 :CALCulate:EYE:MASK:FAIL? 

Instruction  This command returns the mask test result. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Boolean 

Default  None 

Menu  None 

Example  :CALC:EYE:MASK:FAIL? 

 

4.1.41 Mask Test Enable (:CALCulate:EYE:MASK:STATe) 
 

Command 
Format 

 :CALCulate:EYE:MASK:STATe {ON|OFF|1|0} 
:CALCulate:EYE:MASK:STATe? 

Instruction  This command sets mask test with simulated eye on/off. 
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Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Eye/Mask > Scale/Mask > Mask Test 

Example  :CALC:EYE:MASK:STAT ON 
:CALC:EYE:MASK:STAT? 
Return: 1 

 

4.1.42 Eye Diagram Result Data (:CALCulate:EYE:RESults:DATA) 
 

Command 
Format 

 :CALCulate:EYE:RESults:DATA? 

Instruction  This command returns the results of eye measurement. The 18 values are retur
ned. The minimum and maximum values are returned in addition of the displaye
d results (16 values) on the TDR application GUI. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  String 

Default  None 

Menu  Eye/Mask > Result 

Example  :CALC:EYE:RES:DATA? 

 

4.1.43 Eye Diagram Result Overlay (:CALCulate:EYE:RESults:DISPlay:S
TATe) 

 

Command 
Format 

 :CALCulate:EYE:RESults:DISPlay:STATe {ON|OFF|1|0} 
:CALCulate:EYE:RESults:DISPlay:STATe? 

Instruction  This command turns the overlay on/off. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  ON 

Menu  Eye/Mask > Resul > Overlay 

Example  :CALC:EYE:RES:DISP:STAT OFF 
:CALC:EYE:RES:DISP:STAT? 
Return: 0 

 

4.1.44 Eye Diagram Result Rise Time Type (:CALCulate:EYE:RESults:T
HReshold) 

 

Command 
Format 

 :CALCulate:EYE:RESults:THReshold {T1_9|T2_8} 
:CALCulate:EYE:RESults:THReshold? 

Instruction  This command sets the rise time threshold level for the results of eye measure
ment. 

Parameter
 Type 

 Enumeration 
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Parameter 
Range 

 T1_9|T2_8 

Return  Enumeration 

Default  T1_9 

Menu  Eye/Mask > Resul > Rise Time Def. 

Example  :CALC:EYE:RES:THR T2_8 
:CALC:EYE:RES:THR? 
Return: T2_8 

 

4.1.45 Eye Diagram Display Switch (:CALCulate:EYE:STATe) 
 

Command 
Format 

 :CALCulate:EYE:STATe {ON|OFF|1|0} 
:CALCulate:EYE:STATe? 

Instruction  This command displays the EYE/MASK window. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  None 

Example  :CALC:EYE:STAT OFF 
:CALC:EYE:STAT? 

 

4.1.46 Select Marker (:CALCulate:TRACe{Tr}:AMARkers:ACTive) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:AMARkers:ACTive <numeric> 
:CALCulate:TRACe{Tr}:AMARkers:ACTive? 

Instruction  This command sets active marker number. 

Parameter
 Type 

 Integer 

Parameter 
Range 

 None 

Return  Integer 

Default  None 

Menu  TDR > Marker 

Example  :CALC:TRAC1:AMAR:ACT 3 
:CALC:TRAC1:AMAR:ACT? 
Return: 3 

 

4.1.47 Peeling Enable (:CALCulate:TRACe{Tr}:CONVersion:PEELing:ST
ATe) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:CONVersion:PEELing:STATe {ON|OFF|1|0} 
:CALCulate:TRACe{Tr}:CONVersion:PEELing:STATe? 

Instruction  This command sets state for the peeling function. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 
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Default  OFF 

Menu  TDR/TDT > Parameter > Peeling 

Example  :CALC:TRAC1:CONV:PEEL:STAT ON 
:CALC:TRAC1:CONV:PEEL:STAT? 
Return: 1 

 

4.1.48 Get Delta Time Search Result (:CALCulate:TRACe{Tr}:DTIMe:DA
TA?) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:DTIMe:DATA? 

Instruction  This command gets delta time result value. You can get the result even if Delta 
Time Search is off. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  None 

Example  :CALC:TRAC1:DTIM:DATA? 

 

4.1.49 Delta Time Search Position (:CALCulate:TRACe{Tr}:DTIMe:POSiti
on) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:DTIMe:POSition <numeric> 
:CALCulate:TRACe{Tr}:DTIMe:POSition? 

Instruction  This command sets delta time reference position. 

Parameter
 Type 

 Float, unit: % 

Parameter 
Range 

 0 ~ 100 

Return  Float, unit: % 

Default  50 

Menu  TDR > ΔTime... > Position (%) 

Example  :CALC:TRAC1:DTIM:POS 20 
:CALC:TRAC1:DTIM:POS? 
Return: 20 

 

4.1.50 Delta Time Search Enable (:CALCulate:TRACe{Tr}:DTIMe:STATe) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:DTIMe:STATe {ON|OFF|1|0} 
:CALCulate:TRACe{Tr}:DTIMe:STATe? 

Instruction  This command displays the delta time marker in the marker search. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  TDR > ΔTime... > ΔTime Enable 
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Example  :CALC:TRAC1:DTIM:STAT ON 
:CALC:TRAC1:DTIM:STAT? 
Return: 1 

 

4.1.51 Delta Time Search Target (:CALCulate:TRACe{Tr}:DTIMe:TARGet) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:DTIMe:TARGet <numeric> 
:CALCulate:TRACe{Tr}:DTIMe:TARGet? 

Instruction  This command sets target trace number for the delta time function.  
The {Tr} is the trace number starting point for delta time.  
The <numeric> is the trace number stopping point for delta time. 

Parameter
 Type 

 Integer 

Parameter 
Range 

 None 

Return  Integer 

Default  Depending on the selected trace. 

Menu  TDR > ΔTime... > Target(Stop) 

Example  :CALC:TRAC1:DTIM:TARG 5 
:CALC:TRAC1:DTIM:TARG? 
Return: 5 

 

4.1.52 Trace Format (:CALCulate:TRACe{Tr}:FORMat) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:FORMat {MLOGarithmic|MLINear|PHASe|GDELay|SC
OMplex|POLar|SWR|REAL|IMAGinary|UPHase|PPHase|ISMITh|TLOGarithmic|
TLINear|TREAL|IMPedance|VOLT} 
:CALCulate:TRACe{Tr}:FORMat? 

Instruction  This command sets trace format. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 MLOGarithmic|MLINear|PHASe|GDELay|SCOMplex|POLar|SWR|REAL|IMAGin
ary|UPHase|PPHase|ISMITh|TLOGarithmic|TLINear|TREAL|IMPedance|VOLT 

Return  Enumeration 

Default  Depending on the selected trace. 

Menu  TDR/TDT > Parameters > Format 

Example  :CALC:TRAC1:FORM VOLT 
:CALC:TRAC1:FORM? 
Return: VOLT 

 

4.1.53 Gating Start (:CALCulate:TRACe{Tr}:GATE:STARt) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:GATE:STARt <numeric> 
:CALCulate:TRACe{Tr}:GATE:STARt? 

Instruction  This command sets start value for the gating function. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  TDR/TDT > Gating > Start 
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Example  :CALC:TRAC1:GATE:STAR 2E-9 
:CALC:TRAC1:GATE:STAR? 
Return: 2e-09 

 

4.1.54 Gating Enable (:CALCulate:TRACe{Tr}:GATE:STATe) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:GATE:STATe {ON|OFF|1|0} 
:CALCulate:TRACe{Tr}:GATE:STATe? 

Instruction  This command sets state for the gating function. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  TDR/TDT > Gating > Gating 

Example  :CALC:TRAC1:GATE:STAT ON 
:CALC:TRAC1:GATE:STAT? 
Return: 1 

 

4.1.55 Gating Stop (:CALCulate:TRACe{Tr}:GATE:STOP) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:GATE:STOP <numeric> 
:CALCulate:TRACe{Tr}:GATE:STOP? 

Instruction  This command sets stop value for the gating function. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  TDR/TDT > Gating > Stop 

Example  :CALC:TRAC1:GATE:STOP 6E-9 
:CALC:TRAC1:GATE:STOP? 
Return: 6e-09 

 

4.1.56 Gating Type (:CALCulate:TRACe{Tr}:GATE:TYPE) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:GATE:TYPE {BPASs|NOTCh} 
:CALCulate:TRACe{Tr}:GATE:TYPE? 

Instruction  This command sets gate type for the gating function. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 BPASs|NOTCh 

Return  Enumeration 

Default  BPASs 

Menu  TDR/TDT > Gating > Type > Notch/Bandpass 

Example  :CALC:TRAC1:GATE:TYPE NOTC 
:CALC:TRAC1:GATE:TYPE? 
Return: NOTC 
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4.1.57 Reference Marker Enable (:CALCulate:TRACe{Tr}:MARKer{Mk}:R
EFerence:STATe) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:MARKer{Mk}:REFerence:STATe {ON|OFF|1|0} 
:CALCulate:TRACe{Tr}:MARKer{Mk}:REFerence:STATe? 

Instruction  This command sets state for the reference marker display. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  TDR > Marker > Add Ref 

Example  :CALC:TRAC1:MARK1:REF:STAT ON 
:CALC:TRAC1:MARK1:REF:STAT? 
Return: 1 

 

4.1.58 Trace Measure Parameter (:CALCulate:TRACe{Tr}:PARameter) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:PARameter {String} 
:CALCulate:TRACe{Tr}:PARameter? 

Instruction  This command sets measurement parameter. 

Parameter
 Type 

 String 

Parameter 
Range 

 Txy|Tddxy|Tdcxy|Tcdxy|Tccxy|Sxy|Sddxy|Sdcxy|Scdxy|Sccxy, 
x=1~4, y=1~4 

Return  String 

Default  Depending on the trace and DUT topology. 

Menu  TDR/TDT > Parameter 

Example  :CALC:TRAC2:PAR T11 
:CALC:TRAC2:PAR? 
Return: T11 

 

4.1.59 Stimulus Impulse Width (:CALCulate:TRACe{Tr}:TIME:IMPulse:W
IDTh) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:TIME:IMPulse:WIDTh <numeric> 
:CALCulate:TRACe{Tr}:TIME:IMPulse:WIDTh? 

Instruction  This command sets impulse width value for the transform function. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  TDR/TDT > Parameter > Impulse Width 

Example  :CALC:TRAC1:TIME:IMP:WIDT 4.7E-11 
:CALC:TRAC1:TIME:IMP:WIDT? 
Return: 7.09810588235294e-11 
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4.1.60 Stimulus Rise Time (:CALCulate:TRACe{Tr}:TIME:STEP:RTIMe:D
ATA) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:TIME:STEP:RTIMe:DATA <numeric> 
:CALCulate:TRACe{Tr}:TIME:STEP:RTIMe:DATA? 

Instruction  This command sets rise time value for the transform function. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  TDR/TDT > Parameter > Rise Time 

Example  :CALC:TRAC1:TIME:STEP:RTIM:DATA 4.7E-11 
:CALC:TRAC1:TIME:STEP:RTIM:DATA? 
Return: 5.24995058823529e-11 

 

4.1.61 Stimulus Rise Time Type (:CALCulate:TRACe{Tr}:TIME:STEP:RTI
Me:THReshold) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:TIME:STEP:RTIMe:THReshold {T1_9|T2_8} 
:CALCulate:TRACe{Tr}:TIME:STEP:RTIMe:THReshold? 

Instruction  This command sets rise time threshold for the transform function. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 T1_9|T2_8 

Return  Enumeration 

Default  T1_9 

Menu  TDR/TDT > Parameter > Rise Time 

Example  :CALC:TRAC1:TIME:STEP:RTIM:THR T2_8 
:CALC:TRAC1:TIME:STEP:RTIM:THR? 
Return: T2_8 

 

4.1.62 Time Domain Stimulus Type (:CALCulate:TRACe{Tr}:TIME:STIMu
lus) 

 

Command 
Format 

 :CALCulate:TRACe{Tr}:TIME:STIMulus {LPSTep|LPIMpulse} 
:CALCulate:TRACe{Tr}:TIME:STIMulus? 

Instruction  This command sets stimulus type for the transform function. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 LPSTep|LPIMpulse 

Return  Enumeration 

Default  LPSTep 

Menu  TDR/TDT > Parameter > Stimulus 

Example  :CALC:TRAC1:TIME:STIM LPIMpulse 
:CALC:TRAC1:TIME:STIM? 
Return: LPIM 
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4.1.63 Rise Time Search Result (:CALCulate:TRACe{Tr}:TTIMe:DATA) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:TTIMe:DATA? 

Instruction  This command returns the rise time result value for marker search. You can get 
the data even if Rise Time Search is off. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  None 

Example  :CALC:TRAC1:TTIM:DATA? 

 

4.1.64 Rise Time Search Enable (:CALCulate:TRACe{Tr}:TTIMe:STATe) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:TTIMe:STATe {ON|OFF|1|0} 
:CALCulate:TRACe{Tr}:TTIMe:STATe? 

Instruction  This command displays the rise time marker. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  TDR > Marker Search > Rise Time(10-90%)/Rise Time(20-80%) 

Example  :CALC:TRAC1:TTIM:STAT ON 
:CALC:TRAC1:TTIM:STAT? 
Return: 1 

 

4.1.65 Rise Time Search Type (:CALCulate:TRACe{Tr}:TTIMe:STATe) 
 

Command 
Format 

 :CALCulate:TRACe{Tr}:TTIMe:THReshold {T1_9|T2_8} 
:CALCulate:TRACe{Tr}:TTIMe:THReshold? 

Instruction  This command sets the rise time threshold for the rise time in the marker search
 function. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 T1_9|T2_8 

Return  Enumeration 

Default  T1_9 

Menu  TDR > Marker Search > Rise Time(10-90%)/Rise Time(20-80%) 

Example  :CALC:TRAC1:TTIM:THR T2_8 
:CALC:TRAC1:TTIM:THR? 
Return: T2_8 
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4.2 Display Subsystem 

4.2.1 Auto Scale All (:DISPlay:ATRaces:SCALe:AUTO) 
 

Command 
Format 

 :DISPlay:ATRaces:SCALe:AUTO 

Instruction  This command executes auto scale for all traces. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  TDR > Auto Scale > All Trace 

Example  :DISP:ATR:SCAL:AUTO 

 

4.2.2 Horizontal Reference Position (:DISPlay:ATRaces:SCALe:RPOSit
ion) 

 

Command 
Format 

 :DISPlay:ATRaces:SCALe:RPOSition {LEFT|CENTer} 
:DISPlay:ATRaces:SCALe:RPOSition? 

Instruction  This command sets x-axis reference position for the time domain measurement. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 LEFT|CENTer 

Return  Enumeration 

Default  LEFT 

Menu  TDR/TDT > Horizontal > Reference Position Button 

Example  :DISP:ATR:SCAL:RPOSition CENT 
:DISP:ATR:SCAL:RPOSition? 
Return: CENT 

 

4.2.3 Waveform View Point (:DISPlay:ATRaces:VIEW) 
 

Command 
Format 

 :DISPlay:ATRaces:VIEW {STIMulus|RESPonse} 
:DISPlay:ATRaces:VIEW? 

Instruction  This command selects the view point for waveform analysis either before or  
after DUT. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 STIMulus|RESPonse 

Return  Enumeration 

Default  RESPonse 

Menu  Setup > Adv Waveform > Emphasis/Equalization > View 

Example  :DISP:ATR:VIEW STIMulus 
:DISP:ATR:VIEW? 
Return: STIM 

 

4.2.4 Eye Diagram Scale Auto (:DISPlay:EYE:Y:SCALe:AUTO) 
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Command 
Format 

 :DISPlay:EYE:Y:SCALe:AUTO 

Instruction  This command executes Y axis auto scaling for eye diagram. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Eye/Mask > Scale/Mask > Auto Scale 

Example  :DISP:EYE:Y:SCAL:AUTO 

 

4.2.5 Eye Diagram Scale Manual (:DISPlay:EYE:Y:SCALe:MANual) 
 

Command 
Format 

 :DISPlay:EYE:Y:SCALe:MANual 

Instruction  This command changes the eye diagram scaling to manual mode. This comma
nd should be executed before the :DISPlay:EYE:Y:SCALe:PDIVision or :DISPla
y:EYE:Y:SCALe:RLEVel commands are sent. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Eye/Mask > Scale/Mask > Manual 

Example  :DISP:EYE:Y:SCAL:MAN 

 

4.2.6 Eye Diagram Scale (:DISPlay:EYE:Y:SCALe:PDIVision) 
 

Command 
Format 

 :DISPlay:EYE:Y:SCALe:PDIVision <numeric> 
:DISPlay:EYE:Y:SCALe:PDIVision? 

Instruction  This command sets value of y-axis scale per division for eye diagram. The scale
 mode should be set at manual by the :DISPlay:EYE:Y:SCALe:MANual before t
his command is executed. 

Parameter
 Type 

 Float, unit: V (Voltage) 

Parameter 
Range 

 None 

Return  Float, unit: V (Voltage) 

Default  133mV 

Menu  Eye/Mask > Scale/Mask > Scale/Div 

Example  :DISP:EYE:Y:SCAL:PDIV 300E-03 
:DISP:EYE:Y:SCAL:PDIV? 
Return: 0.3 

 

4.2.7 Eye Diagram Offset (:DISPlay:EYE:Y:SCALe:RLEVel) 
 

Command 
Format 

 :DISPlay:EYE:Y:SCALe:RLEVel <numeric> 
:DISPlay:EYE:Y:SCALe:RLEVel? 

Instruction  This command sets value of eye diagram y-axis reference line. The scale mode 
should be set at manual by the :DISPlay:EYE:Y:SCALe:MANual before this com
mand is executed. 
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Parameter
 Type 

 Float, unit: V (Voltage) 

Parameter 
Range 

 None 

Return  Float, unit: V (Voltage) 

Default  0 

Menu  Eye/Mask > Scale/Mask > Offset 

Example  :DISP:EYE:Y:SCAL:RLEV 0.5 
:DISP:EYE:Y:SCAL:RLEV? 
Return: 0.5 

 

4.2.8 Trace Display Type (:DISPlay:TRACe{Tr}:DMEMory:TYPE) 
 

Command 
Format 

 :DISPlay:TRACe{Tr}:DMEMory:TYPE {OFF|DATA|MEMory|DMEMory} 
:DISPlay:TRACe{Tr}:DMEMory:TYPE? 

Instruction  This command sets type of data/memory display. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 OFF|DATA|MEMory|DMEMory 

Return  Enumeration 

Default  DATA 

Menu  TDR > Data/Mem > Off/Data/Memory/Data&Memory 

Example  :DISP:TRAC1:DMEM:TYPE DMEMory 
:DISP:TRAC1:DMEM:TYPE? 
Return: DMEM 

 

4.2.9 Trace X Axis Auto Scale (:DISPlay:TRACe{Tr}:X:SCALe:AUTO) 
 

Command 
Format 

 :DISPlay:TRACe{Tr}:X:SCALe:AUTO 

Instruction  This command executes x-axis auto scaling. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  TDR > Auto Scale > X 

Example  :DISP:TRAC1:X:SCAL:AUTO 

 

4.2.10 Trace X Axis Scale (:DISPlay:TRACe{Tr}:X:SCALe:PDIVision) 
 

Command 
Format 

 :DISPlay:TRACe{Tr}:X:SCALe:PDIVision <numeric> 
:DISPlay:TRACe{Tr}:X:SCALe:PDIVision? 

Instruction  This command sets value of x-axis scale per division. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 
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Default  None 

Menu  TDR/TDT > Horizontal > Scale 

Example  :DISP:TRAC1:X:SCAL:PDIV 1E-9 
:DISP:TRAC1:X:SCAL:PDIV? 
Return: 1e-09 

 

4.2.11 Trace X Axis Offset (:DISPlay:TRACe{Tr}:X:SCALe:RLEVel) 
 

Command 
Format 

 :DISPlay:TRACe{Tr}:X:SCALe:RLEVel <numeric> 
:DISPlay:TRACe{Tr}:X:SCALe:RLEVel? 

Instruction  This command sets value of x-axis reference line. 

Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  TDR/TDT > Horizontal > Offset 

Example  :DISP:TRAC1:X:SCAL:RLEV 2E-8 
:DISP:TRAC1:X:SCAL:RLEV? 
Return: 2e-08 

 

4.2.12 Trace Y Axis Auto Scale (:DISPlay:TRACe{Tr}:Y:SCALe:AUTO) 
 

Command 
Format 

 :DISPlay:TRACe{Tr}:Y:SCALe:AUTO 

Instruction  This command executes y-axis auto scaling. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  TDR > Auto Scale > Y 

Example  :DISP:TRAC1:Y:SCAL:AUTO 

 

4.2.13 Trace Y Axis Scale (:DISPlay:TRACe{Tr}:Y:SCALe:PDIVision) 
 

Command 
Format 

 :DISPlay:TRACe{Tr}:Y:SCALe:PDIVision <numeric> 
:DISPlay:TRACe{Tr}:Y:SCALe:PDIVision? 

Instruction  This command sets value of y-axis scale per division. 

Parameter
 Type 

 Float 

Parameter 
Range 

 None 

Return  Float 

Default  None 

Menu  TDR/TDT > Vertical > Scale 

Example  :DISP:TRAC1:Y:SCAL:PDIV 10 
:DISP:TRAC1:Y:SCAL:PDIV? 
Return: 10 
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4.2.14 Trace Y Axis Offset (:DISPlay:TRACe{Tr}:Y:SCALe:RLEVel) 
 

Command 
Format 

 :DISPlay:TRACe{Tr}:Y:SCALe:RLEVel <numeric> 
:DISPlay:TRACe{Tr}:Y:SCALe:RLEVel? 

Instruction  This command sets value of y-axis reference line. 

Parameter
 Type 

 Float 

Parameter 
Range 

 None 

Return  Float 

Default  None 

Menu  TDR/TDT > Vertical > Offset 

Example  :DISP:TRAC1:Y:SCAL:RLEV 20 
:DISP:TRAC1:Y:SCAL:RLEV? 
Return: 20 
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4.3 Memory Subsystem 

4.3.1 Load User Bit Pattern (:MMEMory:LOAD:EYE:BPATtern) 
 

Command 
Format 

 :MMEMory:LOAD:EYE:BPATtern <string> 

Instruction  This command loads the specified user bit pattern file. The extension of file sho
uld be .txt. 

Parameter
 Type 

 String 

Parameter 
Range 

 File name of user bit pattern (.txt) 

Return  None 

Default  None 

Menu  Eye/Mask > Stimulus > User Pattern > Load 

Example  :MMEM:LOAD:EYE:BPAT "local/userbit.txt" 

 

4.3.2 Load User Mask Pattern (:MMEMory:LOAD:EYE:MASK) 
 

Command 
Format 

 :MMEMory:LOAD:EYE:MASK <string> 

Instruction  This command loads eye-mask file. The extension of file should be .msk. The M
ASK pattern editing is not available through the command. 

Parameter
 Type 

 String 

Parameter 
Range 

 File name of eye mask (.msk) 

Return  None 

Default  None 

Menu  Eye/Mask > Scale/Mask > Mask Pattern > Use User-defined mask files > Load 

Example  :MMEM:LOAD:EYE:MASK "local/usermask.msk" 
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4.4 Sense Subsystem 

4.4.1 Dielectric Constant (:SENSe:CORRection:DCONstant) 
 

Command 
Format 

 :SENSe:CORRection:DCONstant <numeric> 
:SENSe:CORRection:DCONstant? 

Instruction  This command sets dielectric constant value. 

Parameter
 Type 

 Float 

Parameter 
Range 

 None 

Return  Float 

Default  1 

Menu  Setup > More Functions > Dielectric Const. 

Example  :SENS:CORR:DCON 2 
:SENS:CORR:DCON? 
Return: 2 

 

4.4.2 System Impedance (:SENSe:CORRection:RIMPedance) 
 

Command 
Format 

 :SENSe:CORRection:RIMPedance <numeric> 
:SENSe:CORRection:RIMPedance? 

Instruction  This command sets reference impedance value. 

Parameter
 Type 

 Float 

Parameter 
Range 

 None 

Return  Float 

Default  50 

Menu  Setup > More Functions > Ref. Z 

Example  :SENS:CORR:RIMP 75 
:SENS:CORR:RIMP? 
Return: 75 

 

4.4.3 Deskew Standard Type (:SENSe:CORRection:EXTension:AUTO:S
TANdard) 

 

Command 
Format 

 :SENSe:CORRection:EXTension:AUTO:STANdard {OPEN|SHORt} 
:SENSe:CORRection:EXTension:AUTO:STANdard? 

Instruction  This command sets the standard for auto port extension. 
 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 OPEN|SHORt 

Return  Enumeration 

Default  OPEN 

Menu  Setup > Basic > Deskew > Options > Standard Type 
Setup > Basic > Deskew&Loss > Options > Standard Type 

Example  :SENS:CORR:EXT:AUTO:STAN SHOR 
:SENS:CORR:EXT:AUTO:STAN? 
Return: SHOR 
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4.4.4 Execute Deskew (:SENSe:CORRection:EXTension:AUTO:IMMedi
ate) 

 

Command 
Format 

 :SENSe:CORRection:EXTension:AUTO:IMMediate 

Instruction  This command executes deskew (auto port extension). 
  

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Basic > Deskew > Deskew 

Example  :SENS:CORR:EXT:AUTO:STAN SHOR 
:SENS:CORR:EXT:AUTO:IMM 

 

4.4.5 Deskew & Loss Open (:SENSe:CORRection:COLLection:DLComp:
OPEN) 

 

Command 
Format 

 :SENSe:CORRection:COLLection:DLComp:OPEN 

Instruction  This command executes an open measurement, as a part of Loss Compensatio
n sequence. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Basic > Deskew & Loss > Measure 

Example  :SENS:CORR:COLL:DLC:OPEN 
:SENS:CORR:COLL:DLC:SAVE 

 

4.4.6 Deskew & Loss Thru (:SENSe:CORRection:COLLection:DLComp:
THRU) 

 

Command 
Format 

 :SENSe:CORRection:COLLection:DLComp:THRU 

Instruction  This command executes a thru measurement, as a part of Loss Compensation 
sequence. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Basic > Deskew & Loss > Measure 

Example  :SENS:CORR:COLL:DLC:THRU 

 

4.4.7 Deskew & Loss Load (:SENSe:CORRection:COLLection:DLComp:
LOAD) 
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Command 
Format 

 :SENSe:CORRection:COLLection:DLComp:LOAD 

Instruction  This command executes a load measurement, as a part of Loss Compensation 
sequence. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Basic > Deskew & Loss > Load x 

Example  :SENS:CORR:COLL:DLC:LOAD 

 

4.4.8 Deskew & Loss Save (:SENSe:CORRection:COLLection:DLComp:
SAVE) 

 

Command 
Format 

 :SENSe:CORRection:COLLection:DLComp:SAVE 

Instruction  This command saves the result of Loss Compensation sequence. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Basic > Deskew & Loss > Apply 

Example  :SENS:CORR:COLL:DLC:OPEN 
:SENS:CORR:COLL:DLC:THRU 
:SENS:CORR:COLL:DLC:LOAD 
:SENS:CORR:COLL:DLC:SAVE 

 

4.4.9 Measure DUT length (:SENSe:DLENgth:AUTO:IMMediate) 
 

Command 
Format 

 :SENSe:DLENgth:AUTO:IMMediate 

Instruction  This command executes auto DUT length setting. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Basic > DUT Length > Auto > Measure 

Example  :SENS:DLEN:AUTO:IMM 

 

4.4.10 DUT length (:SENSe:DLENgth:DATA) 
 

Command 
Format 

 :SENSe:DLENgth:DATA <numeric> 
:SENSe:DLENgth:DATA? 

Instruction  This command sets DUT length value. 
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Parameter
 Type 

 Float, unit: s (second) 

Parameter 
Range 

 None 

Return  Float, unit: s (second) 

Default  None 

Menu  Setup > Basic > DUT Length 

Example  :SENS:DLEN:DATA 6.26e-9 
:SENS:DLEN:DATA? 
Return: 6.26e-09 

 

4.4.11 Avoid Spurious (:SENSe:SPURious:AVOid:IMMediate) 
 

Command 
Format 

 :SENSe:SPURious:AVOid:IMMediate 

Instruction  This command executes avoid spurious.  
 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Hot TDR > Avoid Spurious 

Example  :SENS:SPUR:AVO:IMM 

 

4.4.12 Avoid Spurious State (:SENSe:SPURious:AVOid:STATe?) 
 

Command 
Format 

 :SENSe:SPURious:AVOid:STATe? 

Instruction  This command queries the avoid spurious state. This command is ON when :SE
NS:SPURious:AVOid:IMMediate command succeeds. This command is OFF w
hen :SENS:SPURious:AVOid:IMMediate command fails to find spurious. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Boolean 

Default  OFF 

Menu  Setup > Hot TDR > Avoid Spurious 

Example  :SENS:SPUR:AVO:STAT? 

 

4.4.13 Spurious Data Rate (:SENSe:SPURious:INPut:DRATe) 
 

Command 
Format 

 :SENSe:SPURious:INPut:DRATe <numeric> 
:SENSe:SPURious:INPut:DRATe? 

Instruction  This command sets the value of input bit rate for avoid spurious.  

Parameter
 Type 

 Float, unit: b/s 

Parameter 
Range 

 20Mb/s~ 2.4Gb/s 

Return  Float, unit: b/s 

Default  1Gb/s 
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Menu  Setup > Hot TDR > Data Rate 

Example  :SENS:SPUR:INP:DRAT 2e9 
:SENS:SPUR:INP:DRAT? 
Return: 2000000000 

 

4.4.14 Hot TDR State (:SENSe:SPURious:STATe?) 
 

Command 
Format 

 :SENSe:SPURious:STATe? 

Instruction  This command queries the Hot TDR mode status. 
To turn ON Hot TDR mode, use :SENSe:SPURious:AVOid:IMMediate; to turn O
FF Hot TDR mode, use :SYSTem:PRESet. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  Boolean 

Default  OFF 

Menu  None 

Example  :SENS:SPUR:STAT? 

 
 

4.5 Trigger Subsystem 

4.5.1 Average Enable (:TRIGger:AVERage) 
 

Command 
Format 

 :TRIGger:AVERage {ON|OFF|1|0} 
:TRIGger:AVERage? 

Instruction  This command sets averaging trigger on/off. When averaging trigger is on, one t
rigger makes one averaging measurement. For example, if the averaging factor 
is set at 16, one trigger makes a measurement for 16 times. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Setup > Average > Averaging 

Example  :TRIG:AVER ON 
:TRIG:AVER? 
Return: 1 

 

4.5.2 Trigger Mode(:TRIGger:AVERage) 
 

Command 
Format 

 :TRIGger:MODE {HOLD|SINGle|RUN} 
:TRIGger:MODE? 

Instruction  This command sets/gets trigger mode. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 HOLD|SINGle|RUN 

Return  Enumeration 

Default  RUN 
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Menu  Setup > Run / Stop/Single 

Example  :TRIG:MODE HOLD 
:TRIG:MODE? 
Return: HOLD 

 
 

4.6 System Subsystem 

4.6.1 TDR Option Preset (:SYSTem:TDR:PRESet) 
 

Command 
Format 

 :SYSTem:TDR:PRESet 

Instruction  This command sets the TDR option to the default state. Calibration data will be l
ost. 

Parameter
 Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Setup > Basic > Preset 

Example  :SYST:TDR:PRES 
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5.Spectrum Analyzer Commands 

5.1 SA Calculate Subsystem 

5.1.1 Active SA(:CALCulate{[1]-256}:CUSTom:DEFine) 

Command 
Format 

 :CALCulate{[1]-256}:CUSTom:DEFine <numeric1>,{<numeric2>} 

Instruction  This command activate the SA function of selecting channel trace and its meas
urement item 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 <numeric1>: "SA"|"spectrum analyzer" 

<numeric2>: "A"|"B"|"C"|"D"|"R1"|"R2"|"R3"|"R4" 

Return  Enumeration 

Default  
"SA","A" 

Menu  Meas > SA > Other…>Measurement Class> Spectrum Analyzer 

Example  :CALCulate1:CUSTom:DEFine "SA" 

 

5.1.2 SA measure mode (:CALCulate{[1]-256}[:SELected]:SA:MEASure) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:MEASure <meas_type> 
:CALCulate{[1]-256}[:SELected]:SA:MEASure? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:MEASure <meas_type> 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:MEASure? 

Instruction  Set or get SA measure mode. 

Parameter 
Type 

 Enumeration 

Parameter 
Range 

 SA|CHPower|ACPR |OBW 

 SA：Spectrum Analyzer 

 ACPR：ACPR 

 CHPower：Channel Power 

 OBW：Occupied BW 

Return  Enumeration 

Default  SA 

Menu  Meas→S-Params→Mode→SA→Meas 

Example  :CALCulate1:SELected:SA:MEASure OBW 
:CALCulate1:SELected:SA:MEASure? 
Return:OBW 
 
:CALCulate1:TRACe1:SA:MEASure ACPR 
:CALCulate1:TRACe1:SA:MEASure? 
Return:ACPR 

 
 

5.1.3 The integration bandwidth (:CALCulate{[1]-256}[:SELected]:SA:C
HPower:BWIDth:INTegration) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:CHPower:BWIDth:INTegration <freq> 
:CALCulate{[1]-256}[:SELected]:SA:CHPower:BWIDth:INTegration? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:CHPower:BWIDth:INTegration <freq> 
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:CALCulate{[1]-256}:TRACe{[1]-256}:SA:CHPower:BWIDth:INTegration? 

Instruction  Sets or gets the integral bandwidth of the selected channel and trace. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 0 Hz ~ 8.5 GHz 

Return  Float, unit: Hz 

Default  2MHz 

Menu  SA→Meas→Channel Power→Integration BW 

Example  :CALCulate1:SELected:SA:CHPower:BWIDth:INTegration 1e9 
:CALCulate1:SELected:SA:CHPower:BWIDth:INTegration? 
Return:1000000000 
 
:CALCulate1:TRACe1:SA:CHPower:BWIDth:INTegration 2e9 
:CALCulate1:TRACe1:SA:CHPower:BWIDth:INTegration? 
Return:2000000000 

 
 

5.1.4 The analyzer span for the channel power measurement (:CALCul
ate{[1]-256}[:SELected]:SA:CHPower:FREQuency:SPAN:POWer) 

 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:CHPower:FREQuency:SPAN:POWer 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:CHPower:FREQuency:SPAN:POWer 

Instruction  Sets the analyzer span of the selected channel and trace for the channel power
 measurement. Be sure the span is set larger than the integration bandwidth. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  SA→Meas→Channel Power→Span Power 

Example  :CALCulate1:SELected:SA:CHPower:FREQuency:SPAN:POWer 
 
:CALCulate1:TRACe1:SA:CHPower:FREQuency:SPAN:POWer 

 

5.1.5 Gets the main channel power and power density (:CALCulate{[1]-
256}[:SELected]:SA:CHPower?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:CHPower? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:CHPower? 

Instruction  Gets scalar results of main channel power and power density of the selected ch
annel and trace. 
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Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, Channel Power unit: dBm 

Float, Density unit: dBm/Hz 

Default  None 

Menu  SA→Meas→Channel Power 

Example  :CALCulate1:SELected:SA:CHPower? 
Return: -32.3329235931259,-125.343223549766 
 
:CALCulate1:TRACe1:SA:CHPower? 
Return: -32.3329235931259,-125.343223549766 

 

5.1.6  Gets the main channel power (:CALCulate{[1]-256}[:SELected]:S
A:CHPower:CHPower?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:CHPower:CHPower? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:CHPower:CHPower? 

Instruction  Gets scalar results of main channel power of the selected channel and trace 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, Channel Power unit: dBm 

Default  None 

Menu  SA→Meas→Channel Power 

Example  :CALCulate1:SELected:SA:CHPower:CHPower? 

Return：-32.0712381021238 

 
:CALCulate1:TRACe1:SA:CHPower:CHPower? 

Return：-32.0712381021238 

 

5.1.7 Gets the main channel power density (:CALCulate{[1]-256}[:SELe
cted]:SA:CHPower:DENSity?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:CHPower:DENSity? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:CHPower:DENSity? 

Instruction  Gets scalar results of main channel power density of the selected channel and t
race 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, Density unit: dBm/Hz 

Default  None 

Menu  SA→Meas→Channel Power 

Example  :CALCulate1:SELected:SA:CHPower:DENSity? 
Return: -125.096780027723 
 
:CALCulate1:TRACe1:SA:CHPower:DENSity? 
Return: -125.096780027723 
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5.1.8 The ACPR main channel bandwidth (:CALCulate{[1]-256}[:SELect
ed]:SA:ACPRatio:BWIDth:INTegration) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:BWIDth:INTegration <freq> 
:CALCulate{[1]-256}[:SELected]:SA:ACPRatio:BWIDth:INTegration? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:BWIDth:INTegration <freq> 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:BWIDth:INTegration? 

Instruction  Sets or gets the main channel bandwidth measured by ACPR for the selected c
hannel and trace. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 0 Hz~8.5 GHz 

Return  Float, unit: Hz 

Default  1MHz 

Menu  SA→Meas→ACPR→Main Channel 

Example  :CALCulate1:SELected:SA:ACPRatio:BWIDth:INTegration 1e9 
:CALCulate1:SELected:SA:ACPRatio:BWIDth:INTegration? 
Return: 1000000000 
 
:CALCulate1:TRACe1:SA:ACPRatio:BWIDth:INTegration 2e9 
:CALCulate1:TRACe1:SA:ACPRatio:BWIDth:INTegration? 
Return: 2000000000 

 

5.1.9 The ACPR Adjacent channel bw (:CALCulate{[1]-256}[:SELected]:
SA:ACPRatio:OFFSet:BWIDth[:INTegration]) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:OFFSet:BWIDth[:INTegration] <fr
eq> 
:CALCulate{[1]-256}[:SELected]:SA:ACPRatio:OFFSet:BWIDth[:INTegration]? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:OFFSet:BWIDth[:INTegratio
n] <freq> 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:OFFSet:BWIDth[:INTegratio
n]? 

Instruction  Sets or gets the  selected channel and trace's Adjacent channel bandwidth of A
CPR measurement. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 0 Hz~8.5 GHz 

Return  Float, unit: Hz 

Default  1MHz 

Menu  SA→Meas→ACPR→Adjacent Chn 

Example  :CALCulate1:SELected1:SA:ACPRatio:OFFSet:BWIDth:INTegration 5e6 
:CALCulate1:SELected1:SA:ACPRatio:OFFSet:BWIDth:INTegration? 
Return :5000000 
 
:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:BWIDth:INTegration 3e6 
:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:BWIDth:INTegration? 
Return :3000000 

 

 

5.1.10 The ACPR Adjacent channel space (:CALCulate{[1]-256}[:SELect
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ed]:SA:ACPRatio:OFFSet[:FREQuency]) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:OFFSet[:FREQuency] <freq> 
:CALCulate{[1]-256}[:SELected]:SA:ACPRatio:OFFSet[:FREQuency] 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:OFFSet[:FREQuency] <fre
q> 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:OFFSet[:FREQuency]? 

Instruction  Sets or gets the selected channel and trace's Adjacent channel space of ACPR 
measurement. 

Parameter 
Type 

 Float, unit: Hz 

Parameter 
Range 

 0 Hz~8.5 GHz 

Return  Float, unit: Hz 

Default  3MHz 

Menu  SA→Meas→ACPR→Adj Chn Space 

Example  :CALCulate1:SELected:SA:ACPRatio:OFFSet:FREQuency 2e6 
:CALCulate1:SELected:SA:ACPRatio:OFFSet:FREQuency? 
Return: 2000000 
 
:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:FREQuency 1e6 
:CALCulate1:TRACe1:SA:ACPRatio:OFFSet:FREQuency? 
Return: 1000000 

 

5.1.11 Gets ACPR main channel power (:CALCulate{[1]-256}[:SELected]:
SA:ACPRatio:MAIN?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:MAIN? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:MAIN? 

Instruction  Gets the selected channel and trace's main channel power of ACPR measurem
ent. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: dBm 

Default  None 

Menu  SA→Meas→ACPR 

Example  :CALCulate1:SELected:SA:ACPRatio:MAIN? 
Return : -66.460503383216 
 
:CALCulate1:TRACe1:SA:ACPRatio:MAIN? 
Return : -64.8677896852216 

 

5.1.12 Gets ACPR lower adjacent channel power ratio (:CALCulate{[1]-2
56}[:SELected]:SA:ACPRatio:LOWer?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:LOWer? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:LOWer? 

Instruction  Gets the selected channel and trace's lower adjacent channel power ratio of AC
PR measurement. 

Parameter 
Type 

 None 
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Parameter 
Range 

 None 

Return  Float, unit: dBc 

Default  None  

Menu  SA→Meas→ACPR 

Example  :CALCulate1:SELected:SA:ACPRatio:LOWer? 
Return : -20.6055355636683 
 
:CALCulate1:TRACe1:SA:ACPRatio:LOWer? 
Return : -21.1571905607897 

 

5.1.13 Gets ACPR lower adjacent channel power (:CALCulate{[1]-256}[:
SELected]:SA:ACPRatio:LOWer:POWer?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:LOWer:POWer? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:LOWer:POWer? 

Instruction  Gets the selected channel and trace's lower adjacent channel power of ACPR 
measurement. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: dBm 

Default  None  

Menu  SA→Meas→ACPR 

Example  :CALCulate1:SELected:SA:ACPRatio:LOWer:POWer? 
Return : -46.0127403678039 
 
:CALCulate1:TRACe1:SA:ACPRatio:LOWer:POWer? 
Return : -46.8181475071255 

 

5.1.14 Gets ACPR upper adjacent channel power ratio (:CALCulate{[1]-2
56}:TRACe{[1]-256}:SA:ACPRatio:UPPer?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:UPPer? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:UPPer? 

Instruction  Gets the selected channel and trace's upper adjacent channel power ratio of AC
PR measurement. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: dBc 

Default  None  

Menu  SA→Meas→ACPR 

Example  :CALCulate1:SELected:SA:ACPRatio:UPPer? 
Return : -18.6108514488295 
 
:CALCulate1:TRACe1:SA:ACPRatio:UPPer? 
Return : -21.3324563909162 

 
 

 



206 SNA5000A Programming Guide 

 

 

5.1.15 Gets ACPR upper adjacent channel power (:CALCulate{[1]-256}[:
SELected]:SA:ACPRatio:UPPer:POWer?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:ACPRatio:UPPer:POWer? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:ACPRatio:UPPer:POWer? 

Instruction  Gets the selected channel and trace's upper adjacent channel power of ACPR 
measurement. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Float, unit: dBm 

Default  None  

Menu  SA→Meas→ACPR 

Example  :CALCulate1:SELected:SA:ACPRatio:UPPer:POWer? 
Return : -45.5211570718928 
 
:CALCulate1:TRACe1:SA:ACPRatio:UPPer:POWer? 

Return：-45.9642491121815 

 

5.1.16 The OBW percentage of signal power(:CALCulate{[1]-256}[:SELe
cted]:SA:OBWidth:PERCent) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:OBWidth:PERCent <para> 
:CALCulate{[1]-256}[:SELected]:SA:OBWidth:PERCent? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:OBWidth:PERCent <para> 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:OBWidth:PERCent? 

Instruction  Sets or gets the selected channel and trace's percentage of signal power of OB
W measurement. 

Parameter 
Type 

 Float 
 

Parameter 
Range 

 10~100 

Return  Float  

Default  99 

Menu  SA→Meas→Occupied BW→Occ BW Percent 

Example  :CALCulate1:SELected:SA:OBWidth:PERCent 60 
:CALCulate1:SELected:SA:OBWidth:PERCent? 
Return :60 
 
:CALCulate1:TRACe1:SA:OBWidth:PERCent 30 
:CALCulate1:TRACe1:SA:OBWidth:PERCent? 
Return :30 

 

5.1.17 Gets OBW bandwidth and bandwidth centroid (:CALCulate{[1]-25
6}[:SELected]:SA:OBWidth?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:OBWidth? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:OBWidth? 

Instruction  Gets the selected channel and trace's occupied bandwidth and bandwidth centr
oid of OBW measurement. 

Parameter 
Type 

 None  
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Parameter 
Range 

 None  

Return  Float, unit: Hz 

Default  None 

Menu  SA→Meas→Occupied BW 

Example  :CALCulate1:SELected:SA:OBWidth? 
Return : 28580644.0096836,4249777822.00484 
 
:CALCulate1:TRACe1:SA:OBWidth? 
Return : 26997375.076252,4255988812.46187 

 

5.1.18  Gets OBW bandwidth (:CALCulate{[1]-256}[:SELected]:SA:OBWi
dth:OBWidth?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:OBWidth:OBWidth? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:OBWidth:OBWidth? 

Instruction  Gets the selected channel and trace's occupied bandwidth of OBW measureme
nt. 

Parameter 
Type 

 None  

Parameter 
Range 

 None  

Return  Float, unit: Hz 

Default  None 

Menu  SA→Meas→Occupied BW 

Example  :CALCulate1:SELected:SA:OBWidth:OBWidth? 
Return : 26715503.1180305 
 
:CALCulate1:TRACe1:SA:OBWidth:OBWidth? 
Return : 26997375.076252 

 

5.1.19  Gets OBW bandwidth centroid (:CALCulate{[1]-256}[:SELected]:S
A:OBWidth:CENTroid?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:OBWidth:CENTroid? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:OBWidth:CENTroid? 

Instruction  Gets the selected channel and trace's occupied bandwidth centroid of OBW me
asurement. 

Parameter 
Type 

 None  

Parameter 
Range 

 None  

Return  Float, unit: Hz 

Default  None 

Menu  SA→Meas→Occupied BW 

Example  :CALCulate1:SELected:SA:OBWidth:CENTroid? 
Return : 4241182953.86024 
 
:CALCulate1:TRACe1:SA:OBWidth:CENTroid? 

Return：4252382501.60254 
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5.1.20 Gets OBW transmit frequency error (:CALCulate{[1]-256}[:SELect
ed]:SA:OBWidth:FERRor?) 

Command 
Format 

 :CALCulate{[1]-256}[:SELected]:SA:OBWidth:FERRor? 
:CALCulate{[1]-256}:TRACe{[1]-256}:SA:OBWidth:FERRor? 

Instruction  Gets the selected channel and trace's transmit frequency error of OBW measur
ement. 

Parameter 
Type 

 None  

Parameter 
Range 

 None  

Return  Float, unit: Hz 

Default  None 

Menu  SA→Meas→Occupied BW 

Example  :CALCulate1:SELected:SA:OBWidth:FERRor? 
Return : 4223880936.89468 
 
:CALCulate1:TRACe1:SA:OBWidth:FERRor? 
Return : -46483.4618330002 

 
 
 

5.2 SA Sense Subsystem  

5.2.1 Resolution Bandwidth(:SENSe{[1]-256}:SA:BANDwidth[:RESoluti
on]) 

Command 
Format 

 :SENSe{[1]-256}:SA:BANDwidth[:RESolution] <numeric> 
:SENSe{[1]-256}:SA:BANDwidth[:RESolution]? 

Instruction  This command set/reads the Resolution Bandwidth value. 

Parameter
 Type 

 Integer, unit: Hz 

Parameter 
Range 

 10~1000000 

Return  Integer, unit: Hz 

Default  1MHz 

Menu  Avg BW >SA>RBW 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:BANDwidth:RESolution 3000 
:SENSe1:SA:BANDwidth:RESolution? 
 
Return: 3000 

 

5.2.2 RBW Mode(:SENSe{[1]-256}:SA:BANDwidth[:RESolution]:AUTO) 

Command 
Format 

 :SENSe{[1]-256}:SA:BANDwidth[:RESolution]:AUTO <numeric> 
:SENSe{[1]-256}:SA:BANDwidth[:RESolution]:AUTO? 

Instruction  Sets / reads the mode of the resolution bandwidth. When ON, the resolution ba
ndwidth is set based on Span/RBW ratio. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 0|1|ON|OFF 

Return  Boolean 

Default  ON 



SNA5000A Programming Guide           209 

 

 

Menu  Avg BW>SA>RBW Mode 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:BANDwidth:RESolution:AUTO 0 
:SENSe1:SA:BANDwidth:RESolution:AUTO? 
 
Return: 0 

 

5.2.3 Video Bandwidth(:SENSe{[1]-256}:SA:BANDwidth:VIDeo) 

Command 
Format 

 :SENSe{[1]-256}:SA:BANDwidth:VIDeo <numeric> 

:SENSe{[1]-256}:SA:BANDwidth:VIDeo? 

Instruction  This command set/reads the Video Bandwidth value. 

Parameter
 Type 

 Integer, unit: Hz 

Parameter 
Range 

 10~1000000 

Return  Integer, unit: Hz 

Default  1MHz 

Menu  Avg BW >SA>VBW 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:BANDwidth:VIDeo 10000 
:SENSe1:SA:BANDwidth:VIDeo? 
 
Return: 10000 

 

5.2.4 VBW Mode(:SENSe{[1]-256}:SA:BANDwidth:VIDeo:AUTO) 

Command 
Format 

 :SENSe{[1]-256}:SA:BANDwidth:VIDeo:AUTO <numeric> 
:SENSe{[1]-256}:SA:BANDwidth:VIDeo:AUTO? 

Instruction  Sets / reads the mode of the Video bandwidth. When ON, the resolution bandwi
dth is set based on RBW/VBW ratio. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 0|1|ON|OFF 

Return  Boolean 

Default  ON 

Menu  Avg BW>SA>VBW Mode 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:BANDwidth:VIDeo:AUTO 0 
:SENSe1:SA:BANDwidth:VIDeo:AUTO? 
 
Return: 0 

 

5.2.5 Averaging Type(:SENSe{[1]-256}:SA:BANDwidth:VIDeo:AVER:TY
PE) 

Command 
Format 

 :SENSe{[1]-256}:SA:BANDwidth:VIDeo:AVER:TYPE <numeric> 
:SENSe{[1]-256}:SA:BANDwidth:VIDeo:AVER:TYPE? 

Instruction  Sets / reads the type of the Averaging. 

Parameter
 Type 

 Enumeration 
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Parameter 
Range 

 Log|Power|Voltage 

Return  Enumeration 

Default  LOG 

Menu  Avg BW>SA>Avg Type 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:BANDwidth:VIDeo:AVER:TYPE Voltage 
:SENSe1:SA:BANDwidth:VIDeo:AVER:TYPE? 
 
Return: VOLT 

 

5.2.6 RBW/VBW Ratio(:SENSe{[1]-256}:SA:BANDwidth:VIDeo:RATio) 

Command 
Format 

 :SENSe{[1]-256}:SA:BANDwidth:VIDeo:RATio <numeric> 
:SENSe{[1]-256}:SA:BANDwidth:VIDeo:RATio? 

Instruction  Sets / reads the RBW/VBW ratio. 

Parameter
 Type 

 Float 

Parameter 
Range 

 0.001~1000 

Return  Float 

Default  1 

Menu  Avg BW>SA>RBW/VBW 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:BANDwidth:VIDeo:RATio 0.3 
:SENSe1:SA:BANDwidth:VIDeo:RATio? 
 
Return: 0.3 

 

5.2.7 Span/RBW Ratio(:SENSe{[1]-256}:SA:FREQuency:SPAN:BANDwi
dth[:RESolution]:RATio) 

Command 
Format 

 :SENSe{[1]-256}:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio <numeri
c> 
:SENSe{[1]-256}:SA:FREQuency:SPAN:BANDwidth:RESolution:RATio? 

Instruction  Sets / reads the Span/RBW ratio. 

Parameter
 Type 

 Integer 

Parameter 
Range 

 0.001~1000 

Return  Integer 

Default  1 

Menu  Avg BW>SA>Span/RBW 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:BANDwidth:VIDeo:RATio 10 
:SENSe1:SA:BANDwidth:VIDeo:RATio? 
 
Return: 10 

 

5.2.8 Image Reject Type(:SENSe{[1]-256}:SA:IMAGe:REJect) 

Command 
Format 

 :SENSe{[1]-256}:SA:BANDwidth:VIDeo:AVER:TYPE <numeric> 
:SENSe{[1]-256}:SA:BANDwidth:VIDeo:AVER:TYPE? 
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Instruction  Sets / reads the type of the image reject. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 None|Min|Normal|Better|Max 

Return  Enumeration 

Default  LOG 

Menu  Avg BW>SA>image reject 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:IMAGe:REJect Max 
:SENSe1:SA:IMAGe:REJect? 
 
Return: MAX 

 

5.2.9 SA Source State(:SENSe{[1]-256}:SA:SOURce{[1]-4}:STATe) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:STATe <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:STATe? 

Instruction  Sets / reads the ON/OFF state of the source. 

Parameter
 Type 

 Boolean 

Parameter 
Range 

 ON|OFF|1|Better|0 

Return  Boolean 

Default  OFF 

Menu  Sweep>SA>SA Setup…>Source> State 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:STATe 1 
:SENSe1:SA:SOURce1:STATe? 
 
Return: 1 

 

5.2.10 Source sweep type(:SENSe{[1]-256}:SA:SOURce{[1]-4}:SWEep:T
YPE) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:SWEep:TYPE <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:SWEep:TYPE? 

Instruction  Set and read the source sweep type. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 CW|LIN|POW|LFP 

Return  Enumeration 

Default  CW 

Menu  Sweep>SA>SA Setup…>Source> Type>Sweep Type 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:SWEep:TYPE LIN 
:SENSe1:SA:SOURce1:SWEep:TYPE? 
 
Return: LIN 

 

5.2.11 Source CW frequency(:SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQu
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ency:CW) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQuency:CW <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQuency:CW? 

Instruction  Set and read the source CW frequency. 

Parameter
 Type 

 Float, unit is Hz 

Parameter 
Range 

 9k~8.5GHz 

Return  Float, unit is Hz  

Default  1000000000 

Menu  Sweep>SA>SA Setup…>Source> Frequency>CW Frequency 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:FREQuency:CW 500000 
:SENSe1:SA:SOURce1:FREQuency:CW? 
 
Return: 500000 

 

5.2.12 Source start frequency(:SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQ
uency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQuency:STARt <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQuency:STARt? 

Instruction  Set and read the source start frequency. This command applies to Linear Freq 
or LinFreq+Power sweep types. 

Parameter
 Type 

 Float, unit is Hz 

Parameter 
Range 

 9k~8.5GHz 

Return  Float, unit is Hz 

Default  500000000 

Menu  Sweep>SA>SA Setup…>Source> Frequency>Start Frequency 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:SWEep:TYPE LIN 
:SENSe1:SA:SOURce1:FREQuency:STARt 600000 
:SENSe1:SA:SOURce1:FREQuency:STARt? 
 
Return: 600000 

 

5.2.13 Source stop frequency(:SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQ
uency:STOP) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQuency:STOP <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:FREQuency:STOP? 

Instruction  Set and read the source stop frequency. This command applies to Linear Freq o
r LinFreq+Power sweep types. 

Parameter
 Type 

 Float, unit is Hz 

Parameter 
Range 

 9k~8.5GHz 

Return  Float, unit is Hz 

Default  500000000 

Menu  Sweep>SA>SA Setup…>Source> Frequency >Stop Frequency 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:SWEep:TYPE LIN 
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:SENSe1:SA:SOURce1:FREQuency:STOP 900000 
:SENSe1:SA:SOURce1:FREQuency:STOP? 
 
Return: 900000 

 

5.2.14 Source output power level(:SENSe{[1]-256}:SA:SOURce{[1]-4}:P
OWer[:VALue]) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:POWer:VALue <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:POWer? 

Instruction  Set and read the source output power level. This command applies to CW or LI
Near sweep types. 

Parameter
 Type 

 Float 

Parameter 
Range 

 -55~10 dBm 

Return  Float 

Default  0 

Menu  Sweep>SA>SA Setup…>Source>Power>Power Level 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:SWEep:TYPE CW 
:SENSe1:SA:SOURce1:POWer:VALue -5 
:SENSe1:SA:SOURce1:POWer:VALue? 
 
Return: -5 

 

5.2.15 Source start power level(:SENSe{[1]-256}:SA:SOURce{[1]-4}:PO
Wer:STARt) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:POWer:STARt <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:POWer:STARt? 

Instruction  Set and read the source start power level. This command applies to Power or L
FPower sweep types. 

Parameter
 Type 

 Float  

Parameter 
Range 

 -55~10 dBm 

Return  Float  

Default  -10 

Menu  Sweep>SA>SA Setup…>Source>Power>Start Power 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:SWEep:TYPE POW 
:SENSe1:SA:SOURce1:POWer:STARt -7 
:SENSe1:SA:SOURce1:POWer:STARt? 
 
Return: -7 

 

5.2.16 Source stop power level(:SENSe{[1]-256}:SA:SOURce{[1]-4}:POW
er:STOP) 

Command 
Format 

 :SENSe{[1]-256}:SA:SOURce{[1]-4}:POWer:STOP <numeric> 
:SENSe{[1]-256}:SA:SOURce{[1]-4}:POWer:STOP? 

Instruction  Set and read the source stop power level. This command applies to Power or L
FPower sweep types. 
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Parameter
 Type 

 Float  

Parameter 
Range 

 -55~10 dBm 

Return  Float  

Default  0 

Menu  Sweep>SA>SA Setup…>Source>Power>Stop Power 

Example  :CALCulate1:CUSTom:DEFine "SA" 
:SENSe1:SA:SOURce1:SWEep:TYPE POW 
:SENSe1:SA:SOURce1:POWer:STOP 2 
:SENSe1:SA:SOURce1:POWer:STOP? 
 
Return: 2 

 

5.2.17 The detection type (:SENSe{[1]-256}[:SELected]:SA:DETector[:FU
NCtion]) 

Command 
Format 

 :SENSe{[1]-256}[:SELected]:SA:DETector[:FUNCtion] <detector_type> 
:SENSe{[1]-256}[:SELected]:SA:DETector[:FUNCtion]? 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:DETector[:FUNCtion] <detector_type> 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:DETector[:FUNCtion]? 

Instruction  Sets or gets the detection type of the selected channel and trace. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 NEGative|POSitive|SAMPle|AVERage|NORMAL 

Return  Enumeration 

Default  NORMAL 

Menu  SA→Select Trace →Detector 

Example  :SENSe1:SELected:SA:DETector:FUNCtion POS 
:SENSe1:SELected:SA:DETector:FUNCtion? 
Return :POS 
 
:SENSe:TRACe1:SA:DETector:FUNCtion AVER 
:SENSe1:TRACe1:SA:DETector:FUNCtion? 

 

5.2.18 The auto detector mode(:SENSe{[1]-256}[:SELected]:SA:DETecto
r:AUTO) 

Command 
Format 

 :SENSe{[1]-256}[:SELected]:SA:DETector:AUTO <bool> 
:SENSe{[1]-256}[:SELected]:SA:DETector:AUTO? 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:DETector:AUTO < bool > 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:DETector:AUTO? 

Instruction  Turn on or off the automatic detection mode of selected channels and traces, or
 read the switch status of the automatic detection mode. 

Parameter
 Type 

 Bool 

Parameter 
Range 

 ON|OFF|1|0 

Return  Bool 

Default  1 

Menu  None  

Example  :SENSe1:SELected1:SA:DETector:AUTO 1 
:SENSe1:SELected1:SA:DETector:AUTO? 
Return :1 
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:SENSe1:TRACe1:SA:DETector:AUTO 0 
:SENSe1:TRACe1:SA:DETector:AUTO? 

Return：0 

 

5.2.19 The display type (:SENSe{[1]-256}[:SELected]:SA:TYPE) 

Command 
Format 

 :SENSe{[1]-256}[:SELected]:SA:TYPE <type> 
:SENSe{[1]-256}[:SELected]:SA:TYPE? 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:TYPE <type> 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:TYPE? 

Instruction  Sets or gets the display mode for the selected channel and trace. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 WRITe|MAXHold|MINHold|AVERage 
 WRITe :puts the trace in the normal mode, updating the data. 
 MAXHold : displays the highest measured trace value for all the data that h

as been measured since the function was turned on. 
 MINHold: displays the lowest measured trace value for all the data that has

 been measured since the function was turned on. 
 AVERage: averages the trace for test period. 

Return  Enumeration 

Default  WRITe 

Menu  SA→Select Trace →Trace Type 

Example  :SENSe1:SELected:SA:TYPE MAXHold 
:SENSe1:SELected:SA:TYPE? 
Return :MAXH 
 
:SENSe1:TRACe1:SA:TYPE MINHold 
:SENSe1:TRACe1:SA:TYPE? 
Return : MINH 

 

5.2.20 The display status (:SENSe{[1]-256}[:SELected]:SA:DISPlay[:STA
Te]) 

Command 
Format 

 :SENSe{[1]-256}[:SELected]:SA:DISPlay[:STATe] <state> 
:SENSe{[1]-256}[:SELected]:SA:DISPlay[:STATe]? 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:DISPlay[:STATe] <state> 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:DISPlay[:STATe]? 

Instruction  Sets or gets the display status of the selection channel and trace. 

Parameter
 Type 

 Enumeration 

Parameter 
Range 

 ACTI|VIEW|BLAN| BACK 
ACTI : Trace is normal mode, update data 
VIEW: turns on the trace data so that it can be viewed on the display. 
BLAN : turns off the trace data so that it is not viewed on the display. 
BACK: turns off the display of the trace data. 

Return  Enumeration 

Default  ACTI 

Menu  SA→Select Trace →Trace State 

Example  :SENSe1:SELected:SA:DISPlay:STATe VIEW 
:SENSe1:SELected:SA:DISPlay:STATe? 
Return:VIEW 
 
:SENSe1:TRACe1:SA:DISPlay:STATe ACTI 
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:SENSe1:TRACe1:SA:DISPlay:STATe? 
Return:ACTI 

 

5.2.21 The average number (:SENSe{[1]-256}[:SELected]:SA:AVERage:
COUNt) 

Command 
Format 

 :SENSe{[1]-256}[:SELected]:SA:AVERage:COUNt <num> 
:SENSe{[1]-256}[:SELected]:SA:AVERage:COUNt? 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:AVERage:COUNt <num> 
:SENSe{[1]-256}:TRACe{[1]-256}:SA:AVERage:COUNt? 

Instruction  Sets or gets the average number of select channels and traces. 

Parameter
 Type 

 Int  

Parameter 
Range 

 1~1000 

Return  Int  

Default  16 

Menu  SA→Select Trace →Trace Type→Average 

Example  :SENSe1:SELected:SA:AVERage:COUNt 32 
:SENSe1:SELected:SA:AVERage:COUNt? 
Return :32 
 
:SENSe1TRACe1:SA:AVERage:COUNt 128 
:SENSe1:TRACe1:SA:AVERage:COUNt? 
Return :128 
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6.Frequency Offset Measurement Commands 

6.1 FOM Sense Subsystem 

6.1.1 Channel FOM State (:SENSe{[1]-256}:FOM[:STATe]) 

Command 
Format 

 :SENSe{[1]-256}:FOM[:STATe] <bool> 
:SENSe{[1]-256}:FOM[:STATe]? 

Instruction  This command sets/gets Frequency Offset Measurement Function enable state. 

Parameter 
Type 

 <bool> Boolean 

Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Freq>Freq Offset…>Freq Offset Enable 

Example  :SENS:FOM ON 
:SENS:FOM? 
Return: 1 

 

6.1.2 FOM Range Name List (:SENSe{[1]-256}:FOM:CATalog) 

Command 
Format 

 :SENSe{[1]-256}:FOM:CATalog? 

Instruction  This command gets a comma-separated list of available range names in the VN
A. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  String 

Default  None 

Menu  Freq>Freq Offset…>Annotation 

Example  :SENS:FOM:CAT? 

 

6.1.3 FOM Range Number (:SENSe{[1]-256}:FOM:COUNt) 

Command 
Format 

 :SENSe{[1]-256}:FOM:COUNt? 

Instruction  This command gets the number of valid FOM ranges in the VNA. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  None 

Menu  None 

Example  :SENS:FOM:COUN? 

 

6.1.4 FOM X-Axis Range Name (:SENSe{[1]-256}:FOM:DISPlay:SELect) 

Command 
Format 

 :SENSe{[1]-256}:FOM:DISPlay:SELect <String> 
:SENSe{[1]-256}:FOM:DISPlay:SELect? 
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Instruction  This command sets/gets the FOM range to be displayed on the SNA x-axis. 

Parameter 
Type 

 <String> string 

Parameter 
Range 

 <String> Valid FOM range name. 
Use"SENSe:FOM:CAT? to see a list of available frequency range names. 

Return  String 

Default  "Source" 

Menu  Freq>Freq Offset…>Annotation 

Example  :SENS:FOM:DISP:SEL "Source" 
:SENS:FOM:DISP:SEL? 
Return: "Source" 

 

6.1.5 FOM Range Index (:SENSe{[1]-256}:FOM:RNUM?) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RNUM? <String> 

Instruction  This command gets the range Index of specified FOM range name. 
The FOM range items are typically numbered as follows: 
1.Primary 
2.Source 
3.Receivers 

Parameter 
Type 

 <String> string 

Parameter 
Range 

 <String> Valid FOM range name. 

Return  Integer 

Default  None 

Menu  None 

Example  :SENS:FOM:RNUM? "Source" 
Return: 2 

 

6.1.6 FOM Range Name (:SENSe{[1]-256}:FOM:RANGe{Rnum}:NAME) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:NAME? 

Instruction  This command gets the range name of specified FOM range index. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} integer 

Parameter 
Range 

 {Rnum} Available frequency offset device number. 

Return  String 

Default  None 

Menu  Freq>Freq Offset…>Annotation 

Example  :SENS:FOM:RANG:NAME? 
Return: "Primary" 

 

6.1.7 FOM Range Couple State (:SENSe{[1]-256}:FOM:RANGe{Rnum}:
COUPled) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:COUPled <bool> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:COUPled? 

Instruction  This command gets the state of coupling of the specified range to the primary ra
nge. 

https://ena.support.keysight.com/e5080a/manuals/webhelp/scn/programming/gp-ib_command_finder/sense/fom.htm#cat
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{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} integer 
<bool> Boolean 

Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  ON 

Menu  Freq>Freq Offset…>Mode>Coupled 

Example  :SENS:FOM:RANG2:COUP OFF 
:SENS:FOM:RANG2:COUP? 
Return: 0 

 

6.1.8 FOM Range Sweep Type (:SENSe{[1]-256}:FOM:RANGe{Rnum}:S
WEep:TYPE) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SWEep:TYPE <char> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SWEep:TYPE? 

Instruction  This command sets/gets the sweep type to be used with the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} integer 
<char> Enumeration 

Parameter 
Range 

 <char> Sweep type. Choose from LINear| LOGarithmic| SEGMent| POWer| CW 

Return  Enumeration 

Default  LINear 

Menu  Freq>Freq Offset…>Sweep Type 

Example  :SENS:FOM:RANG2:SWE:TYPE CW 
:SENS:FOM:RANG2:SWE:TYPE? 
Return: CW 

 

6.1.9 FOM Range Multiplier (:SENSe{[1]-256}:FOM:RANGe{Rnum}:FRE
Quency:MULTiplier) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:MULTiplier <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:MULTiplier? 

Instruction  This command sets/gets the multiplier value to be used when coupling this rang
e to the primary range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<numeric> integer 

Parameter 
Range 

 <numeric> Multiplier value. The range is 1 to100. 

Return  Integer 

Default  1 

Menu  Freq>Freq Offset…>Couped>Multiplier 

Example  :SENS:FOM:RANG2:FREQ:MULT 2 
:SENS:FOM:RANG2:FREQ:MULT? 
Return: 2 

 

6.1.10 FOM Range Divisor (:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQ
uency:DIVisor) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:DIVisor <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:DIVisor? 
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Instruction  This command sets/gets the divisor value to be used when coupling this range t
o the primary range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<numeric> Integer 

Parameter 
Range 

 <numeric> divisor value. The range is 1 to100. 

Return  Integer 

Default  1 

Menu  Freq>Freq Offset…>Couped>Divisor 

Example  :SENS:FOM:RANG2:FREQ:DIV 2 
:SENS:FOM:RANG2:FREQ:DIV? 
Return: 2 

 

6.1.11 FOM Range Offset (:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQu
ency:OFFSet) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:OFFSet <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:OFFSet? 

Instruction  This command sets/gets the offset value to be used when coupling this range to
 the primary range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<numeric> Float 

Parameter 
Range 

 <numeric> Offset value. 

Return  Float 

Default  0 

Menu  Freq>Freq Offset…>Couped>Offset 

Example  :SENS:FOM:RANG2:FREQ:OFFS 1E9 
:SENS:FOM:RANG2:FREQ:OFFS? 
Return: 1000000000 

 

6.1.12 FOM Range Start Frequency (:SENSe{[1]-256}:FOM:RANGe{Rnu
m}:FREQuency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:STARt <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:STARt? 

Instruction  This command sets/gets stop value of frequency range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<numeric> Float 

Parameter 
Range 

 <numeric> Start value in Hz. Choose any frequency within the range of the SN
A. 

Return  Float 

Default  None 

Menu  Freq>Freq Offset…>Settings>Start Freq 

Example  :SENS:FOM:RANG2:FREQ:STAR 1E9 
:SENS:FOM:RANG2:FREQ:STAR? 
Return: 1000000000 

 

6.1.13 FOM Range Stop Frequency (:SENSe{[1]-256}:FOM:RANGe{Rnu
m}:FREQuency:STOP) 
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Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:STOP <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:STOP? 

Instruction  This command sets/gets start value of frequency range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<numeric> Float 

Parameter 
Range 

 <numeric> Start value in Hz. Choose any frequency within the range of the SN
A. 

Return  Float 

Default  None 

Menu  Freq>Freq Offset…>Settings>Stop Freq 

Example  :SENS:FOM:RANG2:FREQ:STOP 1E9 
:SENS:FOM:RANG2:FREQ:STOP? 
Return: 1000000000 

 

6.1.14 FOM Range CW Frequency (:SENSe{[1]-256}:FOM:RANGe{Rnum}:
FREQuency:CW) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:CW <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:FREQuency:CW? 

Instruction  This command sets/gets CW Frequency of frequency range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<numeric> Float 

Parameter 
Range 

 <numeric> CW frequency value in Hz. Choose any frequency within the range of th
e SNA. 

Return  Float 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>CW Freq 

Example  :SENS:FOM:RANG2:FREQ:CW 1E9 
:SENS:FOM:RANG2:FREQ:CW? 
Return: 1000000000 

 

6.1.15 Add a Segment in FOM Range (:SENSe{[1]-256}:FOM:RANGe{Rn
um}:SEGMent{Segnum}:ADD) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:ADD 

Instruction  This command adds a segment into the segment table of frequency range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 

Parameter 
Range 

 {Segnum} Segment number to add.  If unspecified, value is set to 1. Segment n
umbers must be sequential. If a new number is added where one currently exist
s, the existing segment and those following are incremented by one. 

Return  None 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>Segment>Add Segment 

Example  :SENS:FOM:RANG:SEGM:ADD 

 

6.1.16 Delete a Segment in FOM Range (:SENSe{[1]-256}:FOM:RANGe{R
num}:SEGMent{Segnum}:DELete) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:DELete 



222 SNA5000A Programming Guide 

 

 

Instruction  This command deletes a segment in the segment table of frequency range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 

Parameter 
Range 

 {Segnum} Number of the segment to delete. 

Return  None 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>Segment>Delete Segment 

Example  :SENS:FOM:RANG:SEGM:DEL 

 

6.1.17 Clear Segment Table of FOM Range (:SENSe{[1]-256}:FOM:RANG
e{Rnum}:SEGMent{Segnum}:DELete:ALL) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:DELete:ALL 

Instruction  This command clears the segment table of frequency range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Sweep>Segment Table>Delete All Segment 

Example  :SENS:FOM:RANG:SEGM:DEL:ALL 

 

6.1.18 Segment Number of FOM Range (:SENSe{[1]-256}:FOM:RANGe{R
num}:SEGMent:COUNt) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:COUNt? 

Instruction  This command gets the number of segments that exist for the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 

Parameter 
Range 

 None 

Return  Integer 

Default  1 

Menu  None 

Example  :SENS:FOM:RANG:SEGM:COUN? 

 

6.1.19 Segment Enable State (:SENSe{[1]-256}:FOM:RANGe{Rnum}:SE
GMent{Segnum}[:STATe]) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}[:STATe] <bool> 

:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}[:STATe]? 

Instruction  This command sets/gets enable state of the specified segment in the specified r
ange. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 <bool> Boolean 
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Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Freq>Freq Offset…>Sweep Type>Segment 

Example  :SENS:FOM:RANG:SEGM OFF 
:SENS:FOM:RANG:SEGM? 
Return: 0 

 
 

6.1.20 Segment Start Frequency (:SENSe{[1]-256}:FOM:RANGe{Rnum}:
SEGMent{Segnum}:FREQuency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:STARt 
<numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:STARt? 

Instruction  This command sets/gets the start frequency for the specified sweep segment in 
the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Start frequency in Hz. Choose any number between the minimum an
d maximum frequency of the SNA. 

Return  Float 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>Segment> Segment Table>start 

Example  :SENS:FOM:RANG:SEGM:FREQ:STAR 1E9 
:SENS:FOM:RANG:SEGM:FREQ:STAR? 
Return: 1000000000 

 

6.1.21 Segment Stop Frequency (:SENSe{[1]-256}:FOM:RANGe{Rnum}:
SEGMent{Segnum}:FREQuency:STOP) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:STOP 
<numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:STOP? 

Instruction  This command sets/gets the stop frequency for the specified sweep segment in 
the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Stop frequency in Hz. Choose any number between the minimum an
d maximum frequency of the SNA. 

Return  Float 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>Segment> Segment Table>stop 

Example  :SENS:FOM:RANG:SEGM:FREQ:STOP 1E9 
:SENS:FOM:RANG:SEGM:FREQ:STOP? 
Return: 1000000000 

 

6.1.22 Segment Center Frequency (:SENSe{[1]-256}:FOM:RANGe{Rnu
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m}:SEGMent{Segnum}:FREQuency:CENTer) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:CENTe
r <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:CENTe
r? 

Instruction  This command sets/gets the center frequency for the specified sweep segment i
n the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Center Frequency in Hz. Choose any number between the minimum an
d maximum frequency of the SNA. 

Return  Float 

Default  None 

Menu  None 

Example  :SENS:FOM:RANG:SEGM:FREQ:CENT 1E9 
:SENS:FOM:RANG:SEGM:FREQ:CENT? 
Return: 1000000000 

 

6.1.23 Segment Frequency Span (:SENSe{[1]-256}:FOM:RANGe{Rnum}:
SEGMent{Segnum}:FREQuency:SPAN) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:SPAN 
<numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:FREQuency:SPAN? 

Instruction  This command sets/gets the frequency span for the specified sweep segment in
 the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Frequency span in Hz. Choose any number between the minimum and 
maximum frequency of the SNA. 

Return  Float 

Default  None 

Menu  None 

Example  :SENS:FOM:RANG:SEGM:FREQ:SPAN 1E9 
:SENS:FOM:RANG:SEGM:FREQ:SPAN? 
Return: 1000000000 

 

6.1.24 Segment Sweep Point (:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEG
Ment{Segnum}:SWEep:POINts) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:SWEep:POINts <nu
meric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:SWEep:POINts? 

Instruction  This command sets/gets the number of data points for the specified sweep seg
ment in the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Integer 
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Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Number of points in the segment. The total number of points in all segm
ents cannot exceed 20001. A segment can have as few as 2 points. 

Return  Integer 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>Segment> Segment Table>Points 

Example  :SENS:FOM:RANG:SEGM:SWE:POIN 300 
:SENS:FOM:RANG:SEGM:SWE:POIN? 
Return: 300 

 

6.1.25  Individual Sweep Time State Control (:SENSe{[1]-256}:FOM:RAN
Ge{Rnum}:SEGMent:SWEep:TIME:CONTrol) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:SWEep:TIME:CONTrol <bool> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:SWEep:TIME:CONTrol? 

Instruction  This command sets/gets the sweep time can be set independently for each swe
ep segment in the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<bool> Boolean 

Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Freq>Freq Offset…>Sweep Type>Segment>Sweep Properties>Independent S
weep Time 

Example  :SENS:FOM:RANG:SEGM:SWE:TIME:CONT ON 
:SENS:FOM:RANG:SEGM:SWE:TIME:CONT? 
Return: 1 

 

6.1.26  Individual Sweep Time (:SENSe{[1]-256}:FOM:RANGe{Rnum}:SE
GMent{Segnum}:SWEep:TIME) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:SWEep:TIME <num
eric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:SWEep:TIME? 

Instruction  This command sets/gets the time the VNA takes to sweep the specified segmen
t in the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number for which to set sweep time. 

Return  Float 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>Segment>Sweep Properties>Independent S
weep Time>Sweep Time 

Example  :SENS:FOM:RANG:SEGM:SWE:TIME 5 
:SENS:FOM:RANG:SEGM:SWE:TIME? 
Return: 5 

 

6.1.27  Individual Sweep Delay State Control (:SENSe{[1]-256}:FOM:RAN
Ge{Rnum}:SEGMent:SWEep:DELay:CONTrol) 
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Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:SWEep:DELay:CONTrol <boo
l> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:SWEep:DELay:CONTrol? 

Instruction  This command sets/gets the sweep delay can be set independently for each sw
eep segment in the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<bool> Boolean 

Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Freq>Freq Offset…>Sweep Type>Segment>Sweep Properties>Independent S
weep Delay 

Example  :SENS:FOM:RANG:SEGM:SWE:DEL:CONT ON 
:SENS:FOM:RANG:SEGM:SWE:DEL:CONT? 
Return: 1 

 

6.1.28  Individual Sweep Delay (:SENSe{[1]-256}:FOM:RANGe{Rnum}:SE
GMent{Segnum}:SWEep:DELay) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:SWEep:DELay <nu
meric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:SWEep:DELay? 

Instruction  This command sets/gets the time the VNA waits before sweeping the specified 
segment in the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number for which to set sweep delay. 

Return  Float 

Default  None 

Menu  Freq>Freq Offset…>Sweep Type>Segment>Sweep Properties>Independent S
weep Delay>Delay 

Example  :SENS:FOM:RANG:SEGM:SWE:DEL 5 
:SENS:FOM:RANG:SEGM:SWE:DEL? 
Return: 5 

 

6.1.29  Individual IFBW State Control (:SENSe{[1]-256}:FOM:RANGe{Rnu
m}:SEGMent:BWIDth[:RESolution]:CONTrol) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:BWIDth[:RESolution]:CONTrol
 <bool> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:BWIDth[:RESolution]:CONTro
l? 

Instruction  This command sets/gets the IF Bandwidth resolution can be set independently f
or each sweep segment in the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<bool> Boolean 

Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 
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Menu  None 

Example  :SENS:FOM:RANG:SEGM:BWID:CONT ON 
:SENS:FOM:RANG:SEGM:BWID:CONT? 
Return: 1 

 

6.1.30  Individual IFBW  (:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent
{Segnum}:BWIDth[:RESolution]) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:BWIDth[:RESolutio
n] <numeric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:BWIDth[:RESolutio
n]? 

Instruction  This command sets/gets IF Bandwidth for the specified segment in the specified
 range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number for which to set IF bandwidth. 
<numeric> the range is 10Hz to 3MHz. 

Return  Float 

Default  None 

Menu  None 

Example  :SENS:FOM:RANG:SEGM:BWID 1E4 
:SENS:FOM:RANG:SEGM:BWID? 
Return: 10000 

 

6.1.31  Individual Power Level State Control (:SENSe{[1]-256}:FOM:RAN
Ge{Rnum}:SEGMent:POWer[:LEVel]:CONTrol) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:POWer[:LEVel]:CONTrol <boo
l> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent:POWer[:LEVel]:CONTrol? 

Instruction  This command sets/gets the power level can be set independently for each swe
ep segment in the specified range. 
{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
<bool> Boolean 

Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  None 

Example  :SENS:FOM:RANG:SEGM:POW:CONT ON 
:SENS:FOM:RANG:SEGM:POW:CONT? 
Return: 1 

 

6.1.32  Individual Power Level (:SENSe{[1]-256}:FOM:RANGe{Rnum}:SE
GMent{Segnum}:POWer[:LEVel]) 

Command 
Format 

 :SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:POWer[:LEVel] <nu
meric> 
:SENSe{[1]-256}:FOM:RANGe{Rnum}:SEGMent{Segnum}:POWer[:LEVel]? 

Instruction  This command sets/gets the power level for the specified segment in the specifi
ed range. 



228 SNA5000A Programming Guide 

 

 

{Rnum} Range number.  If unspecified, value is set to 1. 

Parameter 
Type 

 {Rnum} Integer 
{Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Power level in dBm,the range is -55dBm to 10dBm. 

Return  Float 

Default  None 

Menu  None 

Example  :SENS:FOM:RANG:SEGM:POW -10 
:SENS:FOM:RANG:SEGM:POW? 
Return: -10 
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7.Frequency Converter Application Commands 

7.1FCA Sense Subsystem 

7.1.1 Mixer Setup (:SENSe{[1]-256}:MIXer:APPLy) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:APPLy 

Instruction  This command applies the mixer setup settings and turns the channel ON. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Apply 

Example  :SENS:MIX:APPL 

 

7.1.2 Mixer Frequency Calculates (:SENSe{[1]-256}:MIXer:CALCulate) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:CALCulate<char> 

Instruction  This command calculates the Input, IF, or Output frequencies of the mixer setu
p. 

Parameter 
Type 

 <char> Enumeration 

Parameter 
Range 

 <char> Mixer port to be calculated, Choose from INPut| OUTPut| LO  

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Calc 

Example  :SENS:MIX:CALC Output 

 

7.1.3 The Previously-saved Mixer Setup (:SENSe{[1]-256}:MIXer:DISCa
rd) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:DISCard 

Instruction  This command cancels changes that have been made to the Converter setup a
nd reverts to the previously-saved setup. Same as the Cancel button on the mix
er setup dialog box. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Cancel 

Example  :SENS:MIX:DISC 

 

7.1.4 Mixer Input Divisor (:SENSe{[1]-256}:MIXer:INPut:FREQuency:DE
Nominator) 

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Applications/MixerConverter_Setup.htm#Mixer_setup_help
mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Applications/MixerConverter_Setup.htm#Mixer_setup_help
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Command 
Format 

 :SENSe{[1]-256}:MIXer:INPut:FREQuency:DENominator <numeric> 
:SENSe{[1]-256}:MIXer:INPut:FREQuency:DENominator? 

Instruction  This command sets/gets the denominator value of the Input Fractional Multiplie
r. 

Parameter 
Type 

 <numeric> Integer 

Parameter 
Range 

 <numeric> Input denominator value. The range is 1 to 100.  

Return  Integer 

Default  1 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Converter Model 

Example  :SENS:MIX:INP:FREQ:DEN 2 
:SENS:MIXer:INPut:FREQuency:DENominator? 
Return: 2 

 

7.1.5 Mixer Input Fixed Frequency (:SENSe{[1]-256}:MIXer:INPut:FREQ
uency:FIXed) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:INPut:FREQuency:FIXed <numeric> 
:SENSe{[1]-256}:MIXer:INPut:FREQuency:FIXed? 

Instruction  This command sets/gets the fixed frequency of the input. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> Input fixed frequency in Hz. Choose any number between the minim
um and maximum frequency of the SNA. 

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Input>Fixed 

Example  :SENS:MIX:INP:FREQ:FIX 100000 
:SENS:MIXer:INPut:FREQuency:FIXed? 
Return: 100000 

 

7.1.6 Mixer Input Sweep Mode (:SENSe{[1]-256}:MIXer:INPut:FREQuen
cy:MODE) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:INPut:FREQuency:MODE <char> 
:SENSe{[1]-256}:MIXer:INPut:FREQuency:MODE? 

Instruction  This command sets/gets the Input sweep mode. 

Parameter 
Type 

 <char> Enumeration 

Parameter 
Range 

 <char> Input sweep mode. Choose from FIXed| SWEPt 

Return  Enumeration 

Default  SWEPT 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Input 

Example  :SENS:MIX:INP:FREQ:MODE FIXED 
:SENSe:MIXer:INPut:FREQuency:MODE? 
Return: FIXED 

 

7.1.7 Mixer Input Multiplier (:SENSe{[1]-256}:MIXer:INPut:FREQuency:
NUMerator) 
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Command 
Format 

 :SENSe{[1]-256}:MIXer:INPut:FREQuency:NUMerator <numeric> 
:SENSe{[1]-256}:MIXer:INPut:FREQuency:NUMerator? 

Instruction  This command sets/gets the numerator value of the Input Fractional Multiplier. 

Parameter 
Type 

 <numeric> Integer 

Parameter 
Range 

 <numeric> Input numerator value. The range is 1 to 100. 

Return  Integer 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Converter Model 

Example  :SENS:MIX:INP:FREQ:NUM 2 
:SENS:MIXer:INPut:FREQuency:NUMerator? 
Return: 2 

 

7.1.8 Mixer Input Start Frequency (:SENSe{[1]-256}:MIXer:INPut:FREQ
uency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:INPut:FREQuency:STARt <numeric> 
:SENSe{[1]-256}:MIXer:INPut:FREQuency:STARt? 

Instruction  This command sets/gets the Input start frequency value of the mixer. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> Input start frequency in Hz. Choose any number between the minim
um and maximum frequency of the SNA. 

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Input>Start/Stop 

Example  :SENS:MIX:INP:FREQ:STAR 100000 
:SENS:MIXer:INPut:FREQuency:STARt? 
Return: 100000 

 

7.1.9 Mixer Input Stop Frequency (:SENSe{[1]-256}:MIXer:INPut:FREQu
ency:STOP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:INPut:FREQuency:STOP <numeric> 
:SENSe{[1]-256}:MIXer:INPut:FREQuency:STOP? 

Instruction  This command sets/gets the Input stop frequency value of the mixer. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> Input stop frequency in Hz. Choose any number between the minimu
m and maximum frequency of the SNA. 

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Input>Start/Stop 

Example  :SENS:MIX:INP:FREQ:STOP 100000 
:SENS:MIXer:INPut:FREQuency:STOP? 
Return: 100000 

 

7.1.10 Mixer Input Power (:SENSe{[1]-256}:MIXer:INPut:POWer) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:INPut:POWer <numeric> 
:SENSe{[1]-256}:MIXer:INPut:POWer? 
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Instruction  This command sets/gets the value of the Input Power. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> Input power in dBm. The range is -10dBm to 10dBm.  

Return  Float, in dBm 

Default  None 

Menu  Freq>Mixer Measure Setup>Power>DUT Input Port>Power Level 

Example  :SENS:MIX:INP:POW 5 
:SENS:MIXer:INPut:POWer? 
Return: 5 

 

7.1.11 Mixer LO Divisor (:SENSe{[1]-256}:MIXer:LO:FREQuency:DENom
inator) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:FREQuency:DENominator <numeric> 
:SENSe{[1]-256}:MIXer:LO:FREQuency:DENominator? 

Instruction  This command sets/gets the denominator value of the LO Fractional Multiplier. 

Parameter 
Type 

 <numeric> Integer 

Parameter 
Range 

 <numeric> LO denominator value. The range is 1 to 100.  

Return  Integer 

Default  1 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Converter Model 

Example  :SENS:MIX:LO:FREQ:DEN 2 
:SENS:MIXer:LO:FREQuency:DENominator? 
Return: 2 

 

7.1.12 Mixer LO Fixed Frequency(:SENSe{[1]-256}:MIXer:LO:FREQuenc
y:FIXed) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:FREQuency:FIXed <numeric> 
:SENSe{[1]-256}:MIXer:LO:FREQuency:FIXed? 

Instruction  This command sets/gets the fixed frequency of the LO. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> LO fixed frequency in Hz. Choose any number between the minimu
m and maximum frequency of the SNA. 

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>LO>Fixed 

Example  :SENS:MIX:LO:FREQ:FIX 100000 
:SENS:MIXer:LO:FREQuency:FIX? 
Return: 100000 

 

7.1.13 Mixer LO Frequency State(:SENSe{[1]-256}:MIXer:LO:FREQuency:
ILTI) 

 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:FREQuency:ILTI <bool> 
:SENSe{[1]-256}:MIXer:LO:FREQuency:ILTI? 
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Instruction  This command sets/gets whether to use the Input frequency that is greater tha
n the LO or less than the LO. 

Parameter 
Type 

 <bool> Boolean 

Parameter 
Range 

 <bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Output>"-">Local>"Input > LO" 

Example  :SENS:MIX:LO:FREQ:ILTI OFF 
:SENS:MIXer:LO:FREQuency:ILTI? 
Return: 0 

 

7.1.14 Mixer LO Sweep Mode (:SENSe{[1]-256}:MIXer:LO:FREQuency:M
ODE) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:FREQuency:MODE <char> 
:SENSe{[1]-256}:MIXer:LO:FREQuency:MODE? 

Instruction  This command sets/gets the LO sweep mode. 

Parameter 
Type 

 <char> Enumeration 

Parameter 
Range 

 <char> LO sweep mode. Choose from FIXed| SWEPt 

Return  Enumeration 

Default  FIXED 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>LO 

Example  :SENSe:MIX:LO:FREQ:MODE FIXED 
:SENSe:MIXer:LO:FREQuency:MODE? 
Return: FIXED 

 

7.1.15 Mixer LO Multiplier (:SENSe{[1]-256}:MIXer:LO:FREQuency:NUM
erator) 

 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:FREQuency:NUMerator <numeric> 
:SENSe{[1]-256}:MIXer:LO:FREQuency:NUMerator? 

Instruction  This command sets/gets the numerator value of the LO Fractional Multiplier. 

Parameter 
Type 

 <numeric> Integer 

Parameter 
Range 

 <numeric> LO numerator value. The range is 1 to 100. 

Return  Integer 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Converter Model 

Example  :SENS:MIX:LO:FREQ:NUM 2 
:SENS:MIXer:LO:FREQuency:NUMerator? 
Return: 2 

 

7.1.16 Mixer LO Start Frequency(:SENSe{[1]-256}:MIXer:LO:FREQuency:
STARt) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:FREQuency:STARt <numeric> 
:SENSe{[1]-256}:MIXer:LO:FREQuency:STARt? 
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Instruction  This command sets/gets the LO start frequency value of the mixer. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> LO start frequency in Hz. Choose any number between the minimum
 and maximum frequency of the SNA. 

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>LO>Start/Stop 

Example  :SENS:MIX:LO:FREQ:STAR 100000 
:SENS:MIXer:LO:FREQuency:STARt? 
Return: 100000 

 

7.1.17 Mixer LO Stop Frequency(:SENSe{[1]-256}:MIXer:LO:FREQuency:
STOP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:FREQuency:STOP <numeric> 
:SENSe{[1]-256}:MIXer:LO:FREQuency:STOP? 

Instruction  This command sets/gets the LO stop frequency value of the mixer. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> LO stop frequency in Hz. Choose any number between the minimum
 and maximum frequency of the SNA. 

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>LO>Start/Stop 

Example  :SENS:MIX:LO:FREQ:STOP 100000 
:SENS:MIXer:LO:FREQuency:STOP? 
Return: 100000 

 

7.1.18 LO Source Name(:SENSe{[1]-256}:MIXer:LO:NAME) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:NAME <String> 
:SENSe{[1]-256}:MIXer:LO:NAME? 

Instruction  This command sets/gets the name of the external source to use as the LO in a 
converter measurement. 

Parameter 
Type 

 <String> String 

Parameter 
Range 

 <String> LO Source name.  

Return  String 

Default  "Not Controlled" 

Menu  Freq>Mixer Measure Setup>Sweep>Power Sweep>Converter Model>Local 

Example  :SENS:MIX:LO:NAME "Not Controlled" 
:SENS:MIXer:LO:NAME? 
Return: "Not Controlled " 

 

7.1.19 Mixer LO Power (:SENSe{[1]-256}:MIXer:LO:POWer) 

 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:POWer <numeric> 
:SENSe{[1]-256}:MIXer:LO:POWer? 

Instruction  This command sets/gets the value of the LO Power. 
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Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> LO power in dBm. The range is -10dBm to 10dBm.  

Return  Float, in dBm 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Power Level 

Example  :SENS:MIX:LO:POW -5 
:SENS:MIXer:LO:POWer? 
Return: -5 

 

7.1.20 LO Start Power of Power Sweep (:SENSe{[1]-256}:MIXer:POWer:S
TARt) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:POWer:STARt <numeric> 
:SENSe{[1]-256}:MIXer:LO:POWer:STARt? 

Instruction  This command sets/gets the LO power start value for an LO power sweep. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> LO start power of power sweep. The range is -10dBm to 10dBm.  

Return  Float, in dBm 

Default  -10 dBm 

Menu  Freq>Mixer Measure Setup>Sweep>Power Sweep>Mixer Setup>Local:>Swpet 
Power>Start 

Example  :SENS:MIX:LO:POW:STAR -5 
:SENS:MIXer:LO:POWer:STARt? 
Return: -5 

  

7.1.21 LO Stop Power of Power Sweep (:SENSe{[1]-256}:MIXer:POWer:S
TOP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LO:POWer:STOP <numeric> 
:SENSe{[1]-256}:MIXer:LO:POWer:STOP? 

Instruction  This command sets/gets the LO power stop value for an LO power sweep. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> LO stop power of power sweep. The range is -10dBm to 10dBm.  

Return  Float, in dBm 

Default  -10 dBm 

Menu  Freq>Mixer Measure Setup>Sweep>Power Sweep>Mixer Setup>Local:>Swpet 
Power>Stop 

Example  :SENS:MIX:LO:POW:STOP -5 
:SENS:MIXer:LO:POWer:STOP? 
Return: -5 

 

7.1.22 Load Mixer File (:SENSe{[1]-256}:MIXer:LOAD) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:LOAD <String> 

Instruction  This command loads a previously-configured mixer attributes file (.mxr) 
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Parameter 
Type 

 <String> String 

Parameter 
Range 

 <String> Path and file name (including .mxr extension) to load. 

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Load… 

Example  :SENS:MIXer:LOAD "local/file.mxr" 

 

7.1.23 Mixer Output Fixed Frequency (:SENSe{[1]-256}:MIXer:OUTPut:F
REQuency:FIXed) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:OUTPut:FREQuency:FIXed <numeric> 
:SENSe{[1]-256}:MIXer:OUTPut:FREQuency:FIXed? 

Instruction  This command sets/gets the fixed frequency of the output. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> Output fixed frequency in Hz. Choose any number between the mini
mum and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Output>Fixed 

Example  :SENS:MIX:OUTP:FREQ:FIX 100000 
:SENS:MIXer:OUTPut:FREQuency:FIX? 
Return: 100000 

 

7.1.24 Mixer Output Sweep Mode (:SENSe{[1]-256}:MIXer:OUTPut:FREQ
uency:MODE) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:OUTPut:FREQuency:MODE <char> 
:SENSe{[1]-256}:MIXer:OUTPut:FREQuency:MODE? 

Instruction  This command sets/gets the Output sweep mode. 

Parameter 
Type 

 <char> Enumeration 

Parameter 
Range 

 <char> Output sweep mode. Choose from FIXed| SWEPt 

Return  Enumeration 

Default  SWEPT 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Output 

Example  :SENS:MIX:OUTP:FREQ:MODE FIXED 
:SENSe:MIXer:OUTPut:FREQuency:MODE? 
Return: FIXED 

 

7.1.25 Mixer Output FrequencyCalculate Method (:SENSe{[1]-256}:MIXer:
OUTPut:FREQuency:SIDeband) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:OUTPut:FREQuency:SIDeband <char> 
:SENSe{[1]-256}:MIXer:OUTPut:FREQuency:SIDeband? 

Instruction  This command sets/gets whether to select the sum (High) or difference (Low) pr
oducts. 

Parameter 
Type 

 <char> Enumeration 



SNA5000A Programming Guide           237 

 

 

Parameter 
Range 

 <char> Sideband value. Choose from LOW| HIGH 

Return  Enumeration 

Default  HIGH 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Output 

Example  :SENS:MIX:OUTP:FREQ:SID HIGH 
:SENSe:MIXer:OUTPut:FREQuency:SIDeband? 
Return: HIGH 

 

7.1.26 Mixer Output Start Frequency (:SENSe{[1]-256}:MIXer:OUTPut:FR
EQuency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:OUTPut:FREQuency:STARt <numeric> 
:SENSe{[1]-256}:MIXer:OUTPut:FREQuency:STARt? 

Instruction  This command sets/gets the Output start frequency value of the mixer. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> Output Start Frequency in Hz. Choose any number between the mini
mum and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Output>Start/Stop 

Example  :SENS:MIX:OUTP:FREQ:STAR 100000 
:SENS:MIXer:OUTPut:FREQuency:STARt? 
Return: 100000 

 

7.1.27 Mixer Output Stop Frequency (:SENSe{[1]-256}:MIXer:OUTPut:FR
EQuency:STOP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:OUTPut:FREQuency:STOP <numeric> 
:SENSe{[1]-256}:MIXer:OUTPut:FREQuency:STOP? 

Instruction  This command sets/gets the Output stop frequency value of the mixer. 

Parameter 
Type 

 <numeric> Float 

Parameter 
Range 

 <numeric> Output Stop Frequency in Hz. Choose any number between the mini
mum and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Mixer Frequency>Output>Start/Stop 

Example  :SENS:MIX:OUTP:FREQ:STOP 100000 
:SENS:MIXer:OUTPut:FREQuency:STOP? 
Return: 100000 

 

7.1.28 DUT Port Map (:SENSe{[1]-256}:MIXer:PMAP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:PMAP <numeric 1>,<numeric 2> 

Instruction  This command sets the PNA to DUT port map for FCA measurements. 

Parameter 
Type 

 Integer 

Parameter 
Range 

 <numeric 1> 1~2, SNA port to connect to the DUT input. 
<numeric 2> 1~2, SNA port to connect to the DUT output. 
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Return  None 

Default  1,2 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Converter Model 

Example  :SENS:MIX:PMAP 2,1 
:SENS:MIXer:PMAP? 
Return: 2,1 

 

7.1.29 DUT Input Port Query (:SENSe{[1]-256}:MIXer:PMAP:INPut?) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:PMAP:INPut? 

Instruction  This command gets the SNA port that is mapped to the DUT input. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer. Input port number. 

Default  1 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Converter Model 

Example  :SENS:MIXer:PMAP:INPut? 
Return: 1 

 

7.1.30 DUT Output Port Query (:SENSe{[1]-256}:MIXer:PMAP:OUTPut?) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:PMAP:OUTPut? 

Instruction  This command gets the SNA port that is mapped to the DUT output. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer. Output port number. 

Default  2 

Menu  Freq>Mixer Measure Setup>Mixer Setup>Converter Model 

Example  :SENS:MIXer:PMAP:OUTPut? 
Return: 2 

 

7.1.31 Mixer Recalculate (:SENSe{[1]-256}:MIXer:RECalculate) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:RECalculate 

Instruction  This command repeats the last calculation that was performed. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  None 

Example  :SENS:MIXer:RECalculate 
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7.1.32 Save Mixer Setting (:SENSe{[1]-256}:MIXer:SAVE) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SAVE <String> 

Instruction  This command saves the settings for the mixer/converter test setup to a mixer a
ttributes file. 

Parameter 
Type 

 <String> String 

Parameter 
Range 

 <String> Path and file name (including .mxr extension) to save. 

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Save… 

Example  :SENS:MIXer:SAVE "local/file.mxr" 

 

7.1.33 Add Segments to Mixer (:SENSe{[1]-256}:MIXer:SEGMent{Segnu
m}:ADD) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:ADD <numeric> 

Instruction  This command adds the specified number of segments to the scratch mixer beg
inning at the specified segment position. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Integer 

Parameter 
Range 

 {Segnum} Segment number to add.  If unspecified, value is set to 1. Segment n
umbers must be sequential. If a new number is added where one currently exist
s, the existing segment and those following are incremented by one. 
<numeric> Number of segments to add. The number of added segments is less 
than the maximum number of segments. 

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Add 

Example  :SENS:MIXer:SEGM:ADD 2 

 

7.1.34 Segment IF Bandwidth (:SENSe{[1]-256}:MIXer:SEGMent{Segnu
m}:BWIDth) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:BWIDth <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:BWIDth? 

Instruction  This command sets/gets the IF Bandwidth for the sweep segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> IF Bandwidth in Hz. The list of valid IF Bandwidths is different depen
ding on the SNA model. 

Return  Float, , in Hz. 

Default  10kHz 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>IF Ban
dwidth 

Example  :SENS:MIXer:SEGM:BWIDth 1000 
:SENS:MIXer:SEGM:BWIDth? 
Return: 1000 

 

7.1.35 Segment Frequency Calculates (:SENSe{[1]-256}:MIXer:SEGMent

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/GP-IB_Command_Finder/Sense/MixerSegment.htm#Scratch
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{Segnum}:CALCulate) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:CALCulate<char> 

Instruction  This command calculates the Input, IF, or Output frequencies of the mixer setu
p. 

Parameter 
Type 

 {Segnum} Integer 
<char> Enumeration 

Parameter 
Range 

 {Segnum} Segment number to calculate. Choose any existing segment number. 
<char> Mixer port to be calculated. Choose from INPut| OUTPut| LO  

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Calc 

Example  :SENS:MIXer:SEGM:CALCulate INPut 

 

7.1.36 Segment Number of Mixer (:SENSe{[1]-256}:MIXer:SEGMent:COU
Nt?) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent:COUNt? 

Instruction  This command gets the number of segments on the Applied mixer. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  Integer 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Segm
ent 

Example  :SENS:MIXer:SEGM:COUN? 
Return: 1 

 

7.1.37 Delete Segments from Mixer (:SENSe{[1]-256}:MIXer:SEGMent{Se
gnum}:DELete) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:DELete <numeric> 

Instruction  This command removes the specified number of segments from the scratch mix
er starting at the index position.   

Parameter 
Type 

 {Segnum} Integer 
<numeric> Integer 

Parameter 
Range 

 {Segnum} Position at which to start removing segments. 
<numeric> Number of segments to remove. The number of segments after delet
ion is not less than 0.  

Return  None 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Delete 

Example  :SENS:MIXer:SEGM:DEL 1 

 

7.1.38 Clear Segments Table of Mixer (:SENSe{[1]-256}:MIXer:SEGMent:
DELete:ALL) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent:DELete:ALL 

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/GP-IB_Command_Finder/Sense/MixerSegment.htm#Scratch
mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/COM_Reference/Objects/Converter_Object.htm#Scratch
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Instruction  This command removes all segments from the scratch mixer. 

Parameter 
Type 

 None 

Parameter 
Range 

 None 

Return  None 

Default  None 

Menu  None 

Example  :SENS:MIX:SEGM:DEL:ALL 

 

7.1.39 Segment Input Fixed Frequency (:SENSe{[1]-256}:MIXer:SEGMen
t{Segnum}:INPut:FREQuency:FIXed) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:FIXed <numeri
c> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:FIXed? 

Instruction  This command sets/gets the Input fixed frequency of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Input fixed frequency in Hz. Choose any number between the minim
um and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Input>
Fixed 

Example  :SENS:MIX:SEGM:INP:FREQ:FIX 100000 
:SENS:MIX:SEGM:INP:FREQ:FIX? 
Return: 100000 

 

7.1.40 Segment Input Sweep Mode (:SENSe{[1]-256}:MIXer:SEGMent{Se
gnum}:INPut:FREQuency:MODE) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:MODE <char> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:MODE? 

Instruction  This command sets/gets the Input sweep mode of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<char> Enumeration 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<char> Input sweep mode. Choose from FIXed| SWEPt 

Return  Enumeration 

Default  SWEPT 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Input 

Example  :SENS:MIX:SEGM:INP:FREQ:MODE FIXED 
:SENS:MIX:SEGM:INP:FREQ:MODE? 
Return: FIXED 

 

7.1.41 Segment Input Start Frequency (:SENSe{[1]-256}:MIXer:SEGMent
{Segnum}:INPut:FREQuency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:STARt <numeri
c> 

mk:@MSITStore:C:/Users/Administrator/Downloads/PNA_EN.chm::/Programming/COM_Reference/Objects/Converter_Object.htm#Scratch
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:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:STARt? 

Instruction  This command sets/gets the Input start frequency value of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Input start frequency in Hz. Choose any number between the minim
um and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Input>
Start/Stop 

Example  :SENS:MIX:SEGM:INP:FREQ:STAR 100000 
:SENS:MIX:SEGM:INP:FREQ:STAR? 
Return: 100000 

 

7.1.42 Segment Input Stop Frequency (:SENSe{[1]-256}:MIXer:SEGMent
{Segnum}:INPut:FREQuency:STOP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:STOP <numeri
c> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:FREQuency:STOP? 

Instruction  This command sets/gets the Input stop frequency value of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Input stop frequency in Hz. Choose any number between the minimu
m and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Input>
Start/Stop 

Example  :SENS:MIX:SEGM:INP:FREQ:STOP 100000 
:SENS:MIX:SEGM:INP:FREQ:STOP? 
Return: 100000 

 

7.1.43 Segment Input Power (:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:
INPut:POWer) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:POWer <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:INPut:POWer? 

Instruction  This command sets/gets the value of the Input Power of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Input power in dBm. The range is -10dBm to 10dBm. 

Return  Float, in dBm 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Input 
Power 

Example  :SENS:MIX:SEGM:INP:POW 5 
:SENS:MIX:SEGM:INP:POW? 
Return: 5 
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7.1.44 Segment LO Fixed Frequency (:SENSe{[1]-256}:MIXer:SEGMent
{Segnum}:LO:FREQuency:FIXed) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:FIXed <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:FIXed? 

Instruction  This command sets/gets the LO fixed frequency of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> LO fixed frequency in Hz. Choose any number between the minimu
m and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Local>
Fixed 

Example  :SENS:MIX:SEGM:LO:FREQ:FIX 100000 
:SENS:MIX:SEGM:LO:FREQ:FIX? 
Return: 100000 

 

7.1.45 Segment LO Frequency State (:SENSe{[1]-256}:MIXer:SEGMent{S
egnum}:LO:FREQuency:ILTI) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:ILTI <bool> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:ILTI? 

Instruction  This command sets/gets whether to use the Input frequency that is greater than 
the LO or less than the LO of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<bool> Boolean 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<bool> Optional value is ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Outpu
t>"-">Local>"Input > LO" 

Example  :SENS:MIX:SEGM:LO:FREQ:ILTI OFF 
:SENS:MIX:SEGM:LO:FREQ:ILTI? 
Return: 0 

 

7.1.46 Segment LO Sweep Mode (:SENSe{[1]-256}:MIXer:SEGMent{Segn
um}:LO:FREQuency:MODE) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:MODE <char> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:MODE? 

Instruction  This command sets/gets the LO sweep mode of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<char> Enumeration 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<char> LO sweep mode. Choose from FIXed| SWEPt 

Return  Enumeration 

Default  FIXED 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Local 

Example  :SENS:MIX:SEGM:LO:FREQ:MODE FIXED 
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:SENS:MIX:SEGM:LO:FREQ:MODE? 
Return: FIXED 

 

7.1.47 Segment LO Start Frequency (:SENSe{[1]-256}:MIXer:SEGMent{S
egnum}:LO:FREQuency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:STARt <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:STARt? 

Instruction  This command sets/gets the LO start frequency value of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> LO start frequency in Hz. Choose any number between the minimum
 and maximum frequency of the SNA.   

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Local>
Start/Stop 

Example  :SENS:MIX:SEGM:LO:FREQ:STARt 100000 
:SENS:MIX:SEGM:LO:FREQ:STARt? 
Return: 100000 

 

7.1.48 Segment LO Stop Frequency (:SENSe{[1]-256}:MIXer:SEGMent{S
egnum}:LO:FREQuency:STOP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:STOP <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:FREQuency:STOP? 

Instruction  This command sets/gets the LO stop frequency value of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> LO stop frequency in Hz. Choose any number between the minimum
 and maximum frequency of the SNA. 

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Local>
Start/Stop 

Example  :SENS:MIX:SEGM:LO:FREQ:STOP 100000 
:SENS:MIX:SEGM:LO:FREQ:STOP? 
Return: 100000 

 

7.1.49 Segment LO Power (:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:L
O:POWer) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:POWer <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:LO:POWer? 

Instruction  This command sets/gets the value of the LO Power of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> LO power in dBm. The range is -10dBm to 10dBm. 

Return  Float, in dBm 
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Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Local 
Power 

Example  :SENS:MIX:SEGM:LO:POW 5 
:SENS:MIX:SEGM:LO:POW? 
Return: 5 

 

7.1.50 Segment Output Fixed Frequency (:SENSe{[1]-256}:MIXer:SEGMe
nt{Segnum}:OUTPut:FREQuency:FIXed) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:FIXed <nume
ric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:FIXed? 

Instruction  This command sets/gets the Output fixed frequency of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Output fixed frequency in Hz. Choose any number between the mini
mum and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Outpu
t>Fixed 

Example  :SENS:MIX:SEGM:OUTP:FREQ:FIX 100000 
:SENS:MIX:SEGM:OUTP:FREQ:FIX? 
Return: 100000 

 

7.1.51 Segment Output Sweep Mode (:SENSe{[1]-256}:MIXer:SEGMent
{Segnum}:OUTPut:FREQuency:MODE) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency: MODE <cha
r> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:MODE? 

Instruction  This command sets/gets the Output sweep mode of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<char> Enumeration 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<char> Output sweep mode. Choose from FIXed| SWEPt 

Return  Enumeration 

Default  SWEPT 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Output 

Example  :SENS:MIX:SEGM:OUTP:FREQ: MODE FIXED 
:SENS:MIX:SEGM:OUTP:FREQ: MODE? 
Return: FIXED 

 

7.1.52 Segment Output Frequency  Calculate Method (:SENSe{[1]-256}:M
IXer:SEGMent{Segnum}:OUTPut:FREQuency:SIDeband) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:SIDeband <c
har> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:SIDeband? 

Instruction  This command sets/gets whether to select the sum (High) or difference (Low) pr
oducts of the segment. 
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Parameter 
Type 

 {Segnum} Integer 
<char> Enumeration 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<char> Sideband value. Choose from LOW| HIGH 

Return  Enumeration 

Default  HIGH 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Output 

Example  :SENS:MIX:SEGM:OUTP:FREQ:SID HIGH 
:SENS:MIX:SEGM:OUTP:FREQ:SID? 
Return: HIGH 

 

7.1.53 Segment Output Start Frequency (:SENSe{[1]-256}:MIXer:SEGMe
nt{Segnum}:OUTPut:FREQuency:STARt) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:STARt <num
eric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:STARt? 

Instruction  This command sets/gets the Output start frequency value of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Output start frequency in Hz. Choose any number between the mini
mum and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Outpu
t>Start/Stop 

Example  :SENS:MIX:SEGM:OUTP:FREQ:STAR 100000 
:SENS:MIX:SEGM:OUTP:FREQ:STAR? 
Return: 100000 

 

7.1.54 Segment Output Stop Frequency (:SENSe{[1]-256}:MIXer:SEGMe
nt{Segnum}:OUTPut:FREQuency:STOP) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:STOP <nume
ric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:FREQuency:STOP? 

Instruction  This command sets/gets the Output stop frequency value of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Output stop frequency in Hz. Choose any number between the mini
mum and maximum frequency of the SNA.  

Return  Float, in Hz. 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Outpu
t>Start/Stop 

Example  :SENS:MIX:SEGM:OUTP:FREQ:STOP 100000 
:SENS:MIX:SEGM:OUTP:FREQ:STOP? 
Return: 100000 

 

7.1.55 Segment Output Power (:SENSe{[1]-256}:MIXer:SEGMent{Segnu
m}:OUTPut:POWer) 
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Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:POWer <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:OUTPut:POWer? 

Instruction  This command sets/gets the value of the Output Power of the segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Float 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Output power in dBm. The range is -10dBm to 10dBm. 

Return  Float, in dBm 

Default  None 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Output
 Power 

Example  :SENS:MIX:SEGM:OUTP:POW 5 
:SENS:MIX:SEGM:OUTP:POW? 
Return: 5 

 

7.1.56 Segment Sweep Points Number (:SENSe{[1]-256}:MIXer:SEGMent
{Segnum}:POINts) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:POINts <numeric> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:POINts? 

Instruction  This command sets/gets the number of data points for the sweep segment. 

Parameter 
Type 

 {Segnum} Integer 
<numeric> Integer 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<numeric> Number of data points. 

Return  Integer 

Default  21 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Sweep
 Point 

Example  :SENS:MIX:SEGM:POIN 21 
:SENS:MIX:SEGM:POIN? 
Return: 21 

 

7.1.57 Segment State(:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:STATe) 

Command 
Format 

 :SENSe{[1]-256}:MIXer:SEGMent{Segnum}:STATe <bool> 
:SENSe{[1]-256}:MIXer:SEGMent{Segnum}:STATe? 

Instruction  This command sets/gets the ON/OFF state for the segment. 

Parameter 
Type 

 {Segnum} Integer 
<bool> Boolean 

Parameter 
Range 

 {Segnum} Segment number to modify. Choose any existing segment number. 
<bool> Segment state. Choose from ON|OFF|1|0 

Return  Boolean 

Default  OFF 

Menu  Freq>Mixer Measure Setup>Sweep>Segment Sweep>Mixer Frequency>Segm
ent Enable 

Example  :SENS:MIX:SEGM:STATe ON 
:SENS:MIX:SEGM:STATe? 
Return: 1 
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8.Programming Examples 

This chapter gives some examples for the programmer. In these examples you can see how t
o use the VISA or sockets, in combination with the commands have been described above to
 control the vna. By following these examples, you can develop many more applications. 

8.1 Examples of Using VISA 

8.1.1 Example of VC++ 

Environment: Win7 32bit system, Visual Studio 

The functions of this example: use the NI-VISA, to control the device with USBTMC or TC
P/IP access to do a write and read. 

Follow the steps to finish the example: 

1. Open Visual Studio, create a new VC++ win32 console project. 

2. Set the project environment to use the NI-VISA lib, there are two ways to use NI-VISA, stat
ic or automatic: 

(1) Static: find files: visa.h, visatype.h, visa32.lib in NI-VISA install path. Copy them to your pr
oject, and add them into project. In the projectname.cpp file, add the follow two lines: 

#include "visa.h" 

#pragma comment(lib,"visa32.lib") 

(2) Automatic: 

Set the .h file include directory, the NI-VISA install path, in our computer we set the path is: C:
\Program Files\IVI Foundation \VISA\WinNT\include. Set this path to project---properties--- c/
c++---General---Additional Include Directories. See the picture. 

 

Set lib path set lib file: 

Set lib path: the NI-VISA install path, in our computer we set the path is: C:\Program Files\IVI 
Foundation\VISA\WinNT\lib\msc. Set this path to project---properties---Linker---General---Add
itional Library Directories: as seen in the pictures below. 

 

 



SNA5000A Programming Guide           249 

 

 

Set lib file:project---properties---Linker---Command Line---Additional Options:  

visa32.lib 

 

Include visa.h file: In the projectname.cpp file: 

#include <visa.h>

 3. Add codes: 

(1) USBTMC access code. 
 
Write a function Usbtmc_test: 
int Usbtmc_test() 
{ 
/* This code demonstrates sending synchronous read & write commands */ 

/* to an USB Test & Measurement Class (USBTMC) instrument using */ 
/* NI-VISA */ 
/* The example writes the "*IDN?\n" string to all the USBTMC */ 
/* devices connected to the system and attempts to read back */ 

/* results using the write and read functions. */ 
/* The general flow of the code is */ 
/* Open Resource Manager */ 
/* Open VISA Session to an Instrument */ 
/* Write the Identification Query Using viPrintf */ 
/* Try to Read a Response With viScanf */ 
/* Close the VISA Session */ 
/***********************************************************/ 
ViSession defaultRM; 
ViSession instr;  
ViUInt32 numInstrs;  
ViFindList findList; 
ViUInt32 retCount; 
ViUInt32 writeCount; 
ViStatus status;  
Char instrResourceString[VI_FIND_BUFLEN]; 
Unsigned char buffer[100]; 
char stringinput[512]; 
int i; 

 /** First we must call viOpenDefaultRM to get the manager 
* handle. We will store this handle in defaultRM.*/ 
status=viOpenDefaultRM (&defaultRM); 
if (status<VI_SUCCESS) 
{ 
printf ("Could not open a session to the VISA Resource Manager!\n");  
return status; 
} 

/* Find all the USB TMC VISA resources in our system and store the number of resources in the system in 
numInstrs.*/ 
status = viFindRsrc (defaultRM, "USB?*INSTR", &findList, &numInstrs, instrResourceString); 
 if (status<VI_SUCCESS) 
{ 
printf ("An error occurred while finding resources.\nPress 'Enter' to continue.");  
fflush(stdin); 
getchar(); 
viClose (defaultRM);  
returnstatus; 
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} 
/** Now we will open VISA sessions to all USB TMC instruments. 
* We must use the handle from viOpenDefaultRM and we must 
* also use a string that indicates which instrument to open. This 
* is called the instrument descriptor. The format for this string 
* can be found in the function panel by right clicking on the 
* descriptor parameter. After opening a session to the 
* device, we will get a handle to the instrument which we 
* will use in later VISA functions. The AccessMode and Timeout 
* parameters in this function are reserved for future 
* functionality. These two parameters are given the value VI_NULL.*/  
for (i=0; i<int(numInstrs); i++) 
{ 
if (i> 0) 
{  
viFindNext (findList, instrResourceString); 
}  
status = viOpen (defaultRM, instrResourceString, VI_NULL, VI_NULL, &instr); 
if (status<VI_SUCCESS) 
{ 
printf ("Cannot open a session to the device %d.\n", i+1);  
continue; 
} 
/* * At this point we now have a session open to the USB TMC instrument. 
* We will now use the viPrintf function to send the device the string "*IDN?\n", 
* asking for the device's identification. */  
char * cmmand ="*IDN?\n"; 
status = viPrintf (instr, cmmand);  
if (status<VI_SUCCESS) 
{ 
printf ("Error writing to the device %d.\n", i+1);  
status = viClose (instr); 
continue; 
} 
/** Now we will attempt to read back a response from the device to 
* the identification query that was sent. We will use the viScanf 
* function to acquire the data. 
* After the data has been read the response is displayed.*/  
status = viScanf(instr, "%t", buffer); 
if (status<VI_SUCCESS) 
{  
printf ("Error reading a response from the device %d.\n", i+1); 
}  
else 
{  
printf ("\nDevice %d:%s\n", i+1, buffer); 
} 
status = viClose (instr); 
} 
/** Now we will close the session to the instrument using 
* viClose. This operation frees all system resources. */  
status = viClose (defaultRM); 
printf("Press 'Enter' to exit.");  
fflush(stdin); 
getchar(); 
return 0; 

} 
 

int _tmain(int argc, _TCHAR* argv[]) 
{ 

Usbtmc_test();  
return 0; 
} 

Run result: 
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(2) TCP/IP access code. 
Write a function TCP_IP_Test: 

int TCP_IP_Test(char *pIP) 
{ 
char outputBuffer[VI_FIND_BUFLEN];  

ViSessiondefaultRM, instr;  
ViStatusstatus; 

 

/* First we will need to open the default resource manager. */  
status = viOpenDefaultRM (&defaultRM); 
if (status<VI_SUCCESS) 
{ 
printf("Could not open a session to the VISA Resource Manager!\n"); 
} 
/* Now we will open a session via TCP/IP device */ 

char head[256] ="TCPIP0::"; 

char tail[] ="::INSTR"; 
 
strcat(head,pIP);  
strcat(head,tail); 
status = viOpen (defaultRM, head, VI_LOAD_CONFIG, VI_NULL, &instr);  
if (status<VI_SUCCESS) 
{ 

printf ("An error occurred opening the session\n");  

viClose(defaultRM); 
} 
status = viPrintf(instr, "*idn?\n"); 
status = viScanf(instr, "%t", outputBuffer);  
if (status<VI_SUCCESS) 
{ 

printf("viRead failed with error code:%x \n",status);  
viClose(defaultRM); 
} 
else 
{ 
printf ("\nMesseage read from device:%*s\n", 0,outputBuffer); 

} 

status = viClose (instr);  

status = viClose (defaultRM);  

printf("Press 'Enter' to exit."); 

fflush(stdin); 
getchar(); 
return 0; 
} 
 
int _tmain(int argc, _TCHAR* argv[]) 
{ 
printf("Please input IP address:");  
char ip[256]; 
fflush(stdin);  
gets(ip);  
TCP_IP_Test(ip);  
return 0; 
} 
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Run result:  

 
 

8.1.2 Example of VB 

Environment: Win7 32bit system, Microsoft Visual Basic 6.0 

The function of this example: Use the NI-VISA, to control the device with USBTMC and TCP/
IP access to do a write and read. 

Follow the steps to complete the example: 

1. Open Visual Basic, build a standard application program project (Standard EXE) 

2. Set the project environment to use the NI-VISA lib, Click the Existing tab of Project>>Add 
Existing Item. Search for the visa32.bas file in the include folder under the NI-VISA installatio
n path and add the file. 

 

This allows the VISA functions and VISA data types to be used in a program.  

3. Add codes: 

(1) USBTMC access code.  

(2) Write a function Usbtmc_test: 
Private Function Usbtmc_test() As Long 
' This code demonstrates sending synchronous read & write commands  
' ' to an USB Test & Measurement Class (USBTMC) instrument using 
' NI-VISA 
' The example writes the "*IDN?\n" string to all the USBTMC  
' devices connected to the system and attempts to read back  
' results using the write and read functions. 
' The general flow of the code is  
' Open Resource Manager 
' Open VISA Session to an Instrument 
' Write the Identification Query Using viWrite 
'  Try to Read a Response With viRead 
' Close the VISA Session 

 

Const MAX_CNT = 200 
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Dim defaultRM As Long  
Dim instrsesn As Long  
Dim numlnstrs As Long  
Dim findList As Long  
Dim retCount As Long 

 

Dim status As Long 
Dim instrResourceString As String * VI_FIND_BUFLEN  
Dim Buffer As String * MAX_CNT 
Dim i As Integer 
' First we must call viOpenDefaultRM to get the manager  
' handle. We will store this handle in defaultRM. 
status = viOpenDefaultRM(defaultRM) 

If (status < VI_SUCCESS) Then 

resultTxt.Text = "Could not open a session to the VISA Resource Manager!"  
Usbtmc_test = status 
Exit Function  

End If 
 

' Find all the USB TMC VISA resources in our system and store the  
' number of resources in the system in numInstrs. 
status = viFindRsrc(defaultRM, "USB?*INSTR", findList, numlnstrs, instrResourceString) 

If (status < VI_SUCCESS) Then 
resultTxt.Text = "An error occurred while finding resources."  
viClose (defaultRM) 
Usbtmc_test = status  
Exit Function 

End If 

 
' Now we will open VISA sessions to all USB TMC instruments.  
' We must use the handle from viOpenDefaultRM and we must  
' also use a string that indicates which instrument to open. This 
' is called the instrument descriptor. The format for this string 
' can be found in the function panel by right clicking on the 
' descriptor parameter. After opening a session to the 
' device, we will get a handle to the instrument which we 
' will use in later VISA functions. The AccessMode and Timeout  
' parameters in this function are reserved for future 
' functionality. These two parameters are given the value VI_NULL. 

For i = 0 To numInstrs  
If (i > 0) Then 

status = viFindNext(findList, instrResourceString) 
End If 
status = viOpen(defaultRM, instrResourceString, VI_NULL, VI_NULL, instrsesn) 
If (status < VI_SUCCESS) Then 

resultTxt.Text = "Cannot open a session to the device " + CStr(i + 1)  
GoTo NextFind 

End If 

 
' At this point we now have a session open to the USB TMC instrument. 
' We will now use the viWrite function to send the device the string "*IDN?",  
' asking for the device's identification. 

status = viWrite(instrsesn, "*IDN?", 5, retCount) 
If (status < VI_SUCCESS) Then 

resultTxt.Text = "Error writing to the device."  
status = viClose(instrsesn) 

GoTo NextFind 
End If 

' Now we will attempt to read back a response from the device to  

'  the identification query that was sent. We will use the viRead 
' function to acquire the data. 

' After the data has been read the response is displayed.  
 

status = viRead(instrsesn, Buffer, MAX_CNT, retCount) 
If (status < VI_SUCCESS) Then 

resultTxt.Text = "Error reading a response from the device." + CStr(i + 1) 

Else 
resultTxt.Text = "Read from device:" + CStr(i + 1) + " " + Buffer 
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End If 
status = viClose(instrsesn) 

Next i 
 

' Now we will close the session to the instrument using  
' viClose. This operation frees all system resources.  
status = viClose(defaultRM) 
Usbtmc_test = 0  

End Function 
 

(3) TCP/IP access code. 
Write a function TCP_IP_Test: 
Private Function TCP_IP_Test(ByVal ip As String) As Long  

Dim outputBuffer As String * VI_FIND_BUFLEN 
Dim defaultRM As Long  
Dim instrsesn As Long  
Dim status As Long  
Dim count As Long 

 
' First we will need to open the default resource manager.  
status = viOpenDefaultRM (defaultRM) 
If (status < VI_SUCCESS) Then 

resultTxt.Text = "Could not open a session to the VISA Resource Manager!" 
TCP_IP_Test = status 
Exit Function  

End If 
 

' Now we will open a session via TCP/IP device 
status = viOpen(defaultRM, "TCPIP0::" + ip + "::INSTR", VI_LOAD_CONFIG, VI_NULL, instrsesn) 
If (status < VI_SUCCESS) Then 

resultTxt.Text = "An error occurred opening the session"  
viClose (defaultRM) 

TCP_IP_Test = status  
Exit Function 

End If 
 

status = viWrite(instrsesn, "*IDN?", 5, count) 
If (status < VI_SUCCESS) Then 

resultTxt.Text = "Error writing to the device." 
End If 
status = viRead(instrsesn, outputBuffer, VI_FIND_BUFLEN, count) 
If (status < VI_SUCCESS) Then 

resultTxt.Text = "Error reading a response from the device." + CStr(i + 1) 
Else 

resultTxt.Text = "read from device:" + outputBuffer 
End If 

status = viClose(instrsesn)  
status = viClose(defaultRM) 
TCP_IP_Test = 0 

End Function 
 

(4) Button control code: 

Private Sub exitBtn_Click()
 End 

End Sub 

Private Sub tcpipBtn_Click() 

Dim stat As Long 
stat = TCP_IP_Test(ipTxt.Text) 
If (stat < VI_SUCCESS) Then

  
resultTxt.Text = Hex(stat) 

End If  
End Sub 
Private Sub usbBtn_Click() 

Dim stat As Long  
stat = Usbtmc_test 
If (stat < VI_SUCCESS) Then  
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resultTxt.Text = Hex(stat) 
End If  

End Sub 

 

Run result: 

 

8.1.3 Example of MATLAB 

Environment: Win7 32bit system, MATLAB R2013a 

The function of this example: Use the NI-VISA, to control the device with USBTMC or T
CP/IP access to do a write and read. 

Follow the steps to complete the example: 

1. Open MATLAB, modify the current directory. In this demo, the current directory is modified 
to D:\USBTMC_TCPIP_Demo. 

2. Click File>>New>>Script in the Matlab interface to create an empty M file. 

3. Add codes: 
(1)USBTMC access code 
Write a function Usbtmc_test. 
function USBTMC_test() 
% This code demonstrates sending synchronous read & write commands 
% to an USB Test & Measurement Class (USBTMC) instrument using 
% NI-VISA 

 

%Create a VISA-USB object connected to a USB instrument  
vu = visa('ni','USB0::0xF4ED::0xEE3A::sdg2000x::INSTR'); 

 
%Open the VISA object created  
fopen(vu); 

 
%Send the string "*IDN?" asking for the device's identification. 

fprintf(vu,'*IDN?'); 
 

%Request the data  
outputbuffer = fscanf(vu);  
disp(outputbuffer); 

 
%Close the VISA object  
fclose(vu); 
delete(vu);  
clear vu; 
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end 

 

Run result: 
 
 
 

 

 

 
(2)TCP/IP access code. 

Write a function TCP_IP_Test: 
function TCP_IP_test() 
% This code demonstrates sending synchronous read & write commands 

% to an TCP/IP instrument using NI-VISA 
 

%Create a VISA-TCPIP object connected to an instrument 
%configured with IP address. 

vt = visa('ni',['TCPIP0::','10.11.13.32','::INSTR']); 
 

%Open the VISA object created  
fopen(vt); 

 
%Send the string "*IDN?",asking for the device's identification.  
fprintf(vt,'*IDN?'); 

 
%Request the data  
outputbuffer = fscanf(vt);  
disp(outputbuffer); 

 
%Close the VISA object  
fclose(vt); 
delete(vt);  
clear vt; 

 
end 

Run result: 

 
 

8.1.4 Example of LabVIEW 

 

Environment: Win7 32bit system, LabVIEW 2011 

The functions of this example: use the NI-VISA, to control the device with USBTMC and TCP
/IP access to do a write and read. 

Follow the steps to complete the example: 

1. Open LabVIEW, create a VI file. 

2. Add controls. Right-click in the Front Panel interface, select and add VISA resource nam
e, error in, error out and some indicators from the Controls column. 

3. Open the Block Diagram interface. Right-click on the VISA resource name and you can 
select and add the following functions from VISA Palette from the pop-up menu: VISA Write, 
VISA Read, VISA Open and VISA Close. 

4. Connect them as shown in the figure below 
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5. Select the device resource from the VISA Resource Name list box and run the program. 

In this example, the VI opens a VISA session to a USBTMC device, writes a command to the
 device, and reads back the response. In this example, the specific command being sent is th
e device ID query. Check with your device manufacturer for the device command set. After all
 communication is complete, the VI closes the VISA session. 

6. Communicating with the device via TCP/IP is similar to USBTMC. But you need to change
 VISA Write and VISA Read Function to Synchronous I/O. The LabVIEW default is asynchro
nous I/O. Right-click the node and select Synchronous I/O Mod>>Synchronous from the shor
tcut menu to write or read data synchronously. 

7. Connect them as shown in the figure below 
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8. Input the IP address and run the program. 
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8.2 Examples of Using Sockets/Telnet 

8.2.1 Example of Python 

Python is an interpreted programming language that lets you work quickly and is very portabl
e. Python has a low-level networking module that provides access to the socket interface. Pyt
hon scripts can be written for sockets to do a variety of test and measurements tasks. 

 

Environment: Win7 32bit system, Python v2.7.5 

The functions of this example: Open a socket, sends a query, and closes the socket. It doe
s this loop 10 times. 

 
Below is the code of the script: 

#!/usr/bin/env python  
#-*- coding:utf-8 –*- 
#----------------------------------------------------------------------------- 
# The short script is a example that open a socket, sends a query,  
# print the return message and closes the socket. 
#----------------------------------------------------------------------------- 
import socket # for sockets  
import sys # for exit 
import time # for sleep 
#----------------------------------------------------------------------------- 
remote_ip = "10.11.13.32" # should match the instrument’s IP address 
port = 5024 # the port number of the instrument service 
count = 0 

 
def SocketConnect(): 

try: 
#create an AF_INET, STREAM socket (TCP) 

s = socket.socket(socket.AF_INET, socket.SOCK_STREAM)  
except socket.error: 

print ('Failed to create socket.')  
sys.exit(); 

try: 
#Connect to remote server  
s.connect((remote_ip , port))  
info = s.recv(4096) 
print (info)  

except socket.error: 
print ('failed to connect to ip ' + remote_ip)  

return s 

 
def SocketQuery(Sock, cmd): 

try : 
#Send cmd string 
Sock.sendall(cmd) 
time.sleep(1) 

except socket.error: 
#Send failed 
print ('Send failed')  
sys.exit() 

reply = Sock.recv(4096)  
return reply 

 
def SocketClose(Sock): 

#close the socket 

Sock.close() 

time.sleep(.300) 
 

def main(): 
global remote_ip  
global port  
global count 
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# Body:send the SCPI commands *IDN? 10 times and print the return message  
s = SocketConnect() 

for i in range(10): 

qStr = SocketQuery(s, b'*IDN?')  
print (str(count) + "::" + str(qStr))  
count = count + 1 

SocketClose(s) 
input('Press "Enter" to exit') 

 
if name  == ' main ': 
 proc = main() 

 
Run result: 

 

8.2.2 Example of Telnet 

Telnet SCPI: Provides the ability to send single SCPI commands from a remote PC to the analyz
er using LAN port number 5024. 

How to send single SCPI commands using Telnet: 

1. On the remote PC, click Start, then Run 

2. Type: telnet <ip address> 5024 

3. A Telnet window with a >> prompt should appear on the remote PC screen. 

 

4. From the SCPI prompt: 

• Type single SCPI commands. Press Enter to send the command. 
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• To exit the telnet window click X in the upper-right corner. 

• To get a normal telnet prompt, press Ctrl+ ] (closing bracket). 

 

• To get SCPI prompt again, type open <ip Address> 5024. 

 

• Press Enter 

 

• To close the normal telnet window, type Quit and press Enter. 
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SIGLENT is an international high-tech company, concentrating on R&D, sales, 

production and services of electronic test & measurement instruments. 

 

SIGLENT first began developing digital oscilloscopes independently in 2002. 

After more than a decade of continuous development, SIGLENT has 

extended its product line to include digital oscilloscopes, isolated handheld 

oscilloscopes, function/arbitrary waveform generators, RF/MW signal 

generators, spectrum analyzers, vector network analyzers, digitalmultimeters, 

DC power supplies, electronic loads and other general purpose test 

instrumentation. Since its first oscilloscope was launched in 2005, SIGLENT 

has become the fastest growing manufacturer of digital oscilloscopes. We 

firmly believe that today SIGLENT is the best value in electronic test & 

measurement. 
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SIGLENT Technologies Co., Ltd 
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Zone, 3rd Liuxian Road, Bao'an District, 

Shenzhen, 518101, China  

Tel: + 86 755 3688 7876 
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Email: sales@siglent.com 

Website: int.siglent.com 

 

North America: 

SIGLENT Technologies America, Inc 

6557 Cochran Rd Solon, Ohio 44139 

Tel: 440-398-5800 

Toll Free: 877-515-5551 

Fax: 440-399-1211 

Email: info@siglent.com 

Website: www.siglentna.com 

 

Europe: 

SIGLENT Technologies Germany GmbH 

Add: Staetzlinger Str.  70 

86165 Augsburg, Germany 
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